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Note

In order to be printed easily, this PDF-format manual is converted from the HTML-format instruction manual included on
the "User Manuals CD-ROM" supplied with the printer. Thus, there are descriptions that are applied only in HTML format,
and functions (video display function, etc.) that cannot be used. We appreciate your understanding.
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Printing Options Using Rolls and Sheets
The printer supports both rolls and sheets.
This section introduces the main features of each, as well as the main printing methods available. Select rolls or sheets to
suit your particular printing application.

Note
• For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Types

of Paper.") →P.773

• A variety of other ways to print are available besides those introduced here. Choose the printing method that
suits your particular printing application, referring to "Working With Various Print Jobs" and "Enhanced
Printing Options" from the table of contents.

Roll printing
Media in spooled rolls is generally called Roll Media. Rolls are loaded on the Roll Holder, which are in turn loaded in the
printer.
Rolls can be used to print large photos or create posters or banners that cannot be printed on regular sheets.

• Large-format printing
Easily print vertical or horizontal banners from familiar applications such as Microsoft Office applications.
 (See "Printing Vertical or Horizontal Banners (Large-Format Printing).") →P.122

• Borderless printing
Print without a margin (border) around posters or photos.
 (See "Borderless Printing on Paper of Equivalent Size.") →P.107
 (See "Borderless Printing by Resizing Originals to Fit the Roll Width.") →P.114
 (See "Borderless Printing at Actual Size.") →P.99

• Banner printing
You can print multiple pages as a single continuous image, without margins between pages.
 (See "Printing Multiple Pages Continuously.") →P.144

• 90-degree rotation before printing
Originals in portrait orientation are rotated 90 degrees when possible to use paper more efficiently.
 (See "Conserving Roll Paper by Rotating Originals 90 Degrees.") →P.172

• Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
 (See "Resizing Originals to Match the Paper Size.") →P.73
 (See "Resizing Originals to Fit the Roll Width.") →P.79
 (See "Resizing Originals by Entering a Scaling Value.") →P.85

• Free Layout function
Print multiple documents from multiple applications (such as word-processing programs, spreadsheet programs, and so
on) next to each other.
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 (See "Printing Multiple Originals Next to Each Other.") →P.139

Sheet printing
Sheets refer to individual sheets of paper.
Load sheets in the Top Paper Feed Slot. However, for heavyweight paper such as POP Board, load the sheet in the Front
Paper Feed Slot.

• Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
 (See "Resizing Originals to Match the Paper Size.") →P.73
 (See "Resizing Originals by Entering a Scaling Value.") →P.85

• Free Layout function
Print multiple documents from multiple applications (such as word-processing programs, spreadsheet programs, and so
on) next to each other.
 (See "Printing Multiple Originals Next to Each Other.") →P.139

Turning the Printer On and Off

Turning the printer on

1. Press the Power button to turn on the printer.
The printer will now start up.
After the Display Screen shows the Canon logo, "Starting up... Please wait." is displayed.

2. The Power Lamp is lit when the printer finishes starting up, and the printer is now in Standby.
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The printer will not go into Standby in the following situations. Take the appropriate action.

• The Top Cover is open
Close the Top Cover.

• The Ink Tank Cover is open
Close the Ink Tank Cover.

• The Printhead is not installed
see "Replacing the Printhead." →P.982

• An Ink Tank is not installed
see "Replacing Ink Tanks." →P.972

• If ERROR is shown on the Display Screen
see "Error Messages." →P.1049

• The Power Lamp and Message Lamp are not lit (even once), and nothing appears on the Display
Screen
Make sure the printer is plugged in correctly. Check the connection at the plug and electrical outlet.

Important
• Starting the printer when it is connected via the USB cable to a Macintosh computer that is off may cause the

computer to start up at the same time. To prevent this, disconnect the USB cable before starting the printer.
Connecting the printer to the computer via a USB hub may solve this issue.

Turning the printer off

Important
• Never disconnect the printer's power supply or unplug it during a print job. This may damage the printer.

1. Make sure no print jobs are in progress.
If the Message Lamp is flashing, check the message on the Display Screen and take action as necessary.  (See
"Error Messages.") →P.1049
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If the Data Lamp is flashing, the printer is receiving a print job. Turn off the printer only after printing is finished.

2. Hold down the Power button for more than a second.

After "Shut Down.. Please Wait.." is shown on the Display Screen, the printer shuts off.

Loading and Printing on Rolls
These are the basic steps for loading and printing on rolls.
Follow these steps to load and print on rolls.

• If you use the optional Stand, you can store printed documents in the Output Stacker. see "Using the Output Stacker."
→P.821

• You also can install and use the printer on a table, etc., instead of using the Stand.

Important
• Keeping a roll in the printer for a long time without printing on it may leave a depression on the leading

edge.
When printing quality is most important, we recommend setting TrimEdge Reload to On or Automat-
ic so that the paper edge is automatically cut before printing.

• Before printing banners or other long documents, spread a clean cloth or paper on the floor or use the
Output Stacker to prevent the printed surface from becoming dirty from the floor after printing.

Note
• For details on supported sizes and types of rolls, see Paper Sizes or the Paper Reference Guide.  (See

"Paper Sizes.") →P.774   (See "Types of Paper.") →P.773

• To wait until the ink dries after printing before cutting the roll, set Drying Time in the printer driver.
 (See "Specifying the Ink Drying Time for Rolls.") →P.795

• Once you have used all the paper on a roll, clean the platen. If the Platen inside the Top Cover becomes
dirty, it may soil the underside of paper.  (See "Cleaning Inside the Top Cover.") →P.998
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1. Turn the printer on.  (See "Turning the Printer On and Off.") →P.3

2. Load the roll on the Roll Holder.  (See "Loading Rolls on the Roll Holder.") →P.781
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3. Load the roll in the printer.  (See "Loading Rolls in the Printer.") →P.784
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Important
• When printing without borders, definitely set the blue Switch on the platen to the ● side. If the switch

is set incorrectly, print quality may deteriorate.  (See "Setting the Blue Switch on the Platen.")
→P.1033

4. Select the type of paper.  (See "Changing the Type of Paper.") →P.787

Note
• If no barcode has been printed on the roll and you have set ManageRemainRoll to On, specify the

roll length after the type of paper.  (See "Specifying the Paper Length.") →P.789

5. Complete settings in the printer driver for the type of paper and other details.

• Specifying Paper in the Printer Driver (Windows) →P.204

• Specifying Paper in the Printer Driver (Mac OS X) →P.488
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6. Send the print job.

• Printing in Windows →P.11

• Printing from Mac OS X →P.12

The printer now starts printing the print job.

Important
• Do not forcibly pull out paper once a roll has been advanced. This will prevent further feeding. If you acci-

dentally pull out the paper, see "Removing the Roll from the Printer." →P.790

Loading and Printing on Sheets
These are the basic steps for loading sheets and then printing.
Follow the steps below to load and print on sheets.

Note
• For details on supported types and sizes of paper, see Paper Sizes or the Paper Reference Guide.  (See

"Paper Sizes.") →P.774   (See "Types of Paper.") →P.773

• Borderless printing is not supported on sheets. For the features and the main printing methods available for
sheet printing, see "Printing Options Using Rolls and Sheets." →P.2

1. Turn the printer on.  (See "Turning the Printer On and Off.") →P.3

2. Complete settings in the printer driver for the type of paper and other details.

• Specifying Paper in the Printer Driver (Windows) →P.204

• Specifying Paper in the Printer Driver (Mac OS X) →P.488
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3. Send the print job.

• Printing in Windows →P.11

• Printing from Mac OS X →P.12
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4. Load a sheet manually.  (See "Loading Sheets in the Feed Slot.") →P.809
(Top Paper Feed Slot)
(Front Paper Feed Slot)

The printer now starts printing the print job.

Printing in Windows
Print from the application menu.

Important
• We recommend exiting unnecessary applications before printing. Running several applications while printing

may interrupt the transfer of print data and affect printing quality.

1. In the source application, select Print from the File menu to display the dialog box for printing conditions.
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2. After confirming that the printer is selected in the dialog box, click Print or OK to start printing.

Note
• The appearance of the dialog box varies depending on the software application. In most cases, the

dialog box includes basic printing options and enables you to choose the printer, specify the range of
pages, number of copies, and so on.
Example: Print dialog box displayed by the application

• If another printer is selected, select the printer you want to use under Select Printer or in the dialog
box displayed after clicking Printer.

Settings for many printing methods (including enlarged or reduced printing, borderless printing, and so on) are displayed in
the printer driver dialog box. There are two ways to access the printer driver dialog box, as follows.

• From the application
 (See "Accessing the Printer Driver Dialog Box from Applications (Windows).") →P.211

• From the operating system menu
 (See "Accessing the Printer Driver Dialog Box from the Operating System Menu (Windows).") →P.213

Printing from Mac OS X
Print from the application menu after registering the printer.

Important
• We recommend exiting unnecessary applications before printing. Running several applications while printing

may interrupt the transfer of print data and affect printing quality.

Registering the printer
Before printing, you must register the printer in imagePROGRAF PrinterSetup.app.
For instructions on registering the printer, see "Configuring the Printer Driver Destination (Mac OS X)." →P.946
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Important
• During this setup process, the printer will not be listed among available printers if it is off or disconnected.

Printing from the application software

1. In the application software, select Print from the File menu to display the dialog box for printing conditions.

Note
• This dialog box includes basic printing options and enables you to choose the printer, specify the

range of pages, number of copies, and so on.

2. Select the printer in the Printer list.

3. Click Print to start printing.
As shown in the following illustration, you can switch to other panes in this dialog box to complete settings for vari-
ous methods of printing, including enlarged and reduced printing, borderless printing, and so on.
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Canceling Print Jobs from the Control Panel
To cancel printing or reception of print jobs, press the Stop button on the Control Panel.

When you press the Stop button during printing, printer operation varies depending on the current status.

• If you press the Stop button before printing starts
Pressing the Stop button before printing starts will display a confirmation message. To cancel the print job, select
"Yes".

• If you press the Stop button during printing
Pressing the Stop button during printing will display a confirmation message. To cancel the print job immediately,
select "Yes".
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Canceling Print Jobs from Windows
In the printer window, you can cancel jobs that are being sent to the printer.
Using imagePROGRAF Status Monitor, you can cancel print jobs that have already been received by the printer or that are
currently being printed.

1. Click the printer icon in the taskbar to display the printer window.

Note
• You can also display this window by double-clicking the printer icon in the Printers and Faxes (or

Printers ) folder, accessible through the Windows start menu.

2. Right-click the job to cancel and select Cancel.

3. If the job to cancel is not shown in the printer window (that is, if the print data has already been received by the
printer), double-click the taskbar icon to display imagePROGRAF Status Monitor.

4. On the Printer Status sheet, click Cancel Job.
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Note
• The screen may differ slightly depending on the model you are using.

Canceling Print Jobs from Mac OS X
In the printer window, you can cancel jobs that are being sent to the printer.
Otherwise, you can cancel jobs from imagePROGRAF Printmonitor if they have been received by the printer or are current-
ly being printed.

Note
• Print jobs are shown in the printer window while they are being sent from the computer. After transmission,

jobs are not displayed even during printing.
• Print jobs are displayed in the imagePROGRAF Printmonitor window from the moment the printer starts re-

ceiving the print data until the moment printing is finished. They are not displayed before print data is sent to
the printer, even if the computer has started preparing the print data.

1. Click the printer icon in the Dock to display the printer window.

2. Click Pause Printer to stop printing.
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3. If there are no jobs in the printer window that can be canceled, (that is, if the print data has already been sent to the
printer), click Utility to display imagePROGRAF Printmonitor.

4. Select the print job to cancel and click  to delete the print job.

Note
• The screen may differ slightly depending on the model you are using.

The job sent to the printer is canceled.
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5. Exit imagePROGRAF Printmonitor. In the printer window, click Resume Printer.

Important
• Always follow these steps if you cancel print jobs from imagePROGRAF Printmonitor. If you do not

restart job processing, the next job cannot be printed.
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Pausing Printing
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Pausing Printing
During printing, if you set Pause Print in the Control Panel menu to On, printing is stopped at that point and the printer
enters a state in which printing is paused.  (See "Control Panel Display.") →P.892
Printing from the job queue is not possible in this state.
To restore normal operation after this state, set Pause Print to Off.

Note
• In the following cases, the status is cleared even if you do not set Pause Print to Off, and printing from the

job queue resumes.

• When paper is advanced
• When you execute Chg. Paper Type in the Paper Menu

1. During printing, on the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Job Menu is displayed.

3. Press ▲ or ▼ to select Pause Print, and then press the OK button.

4. Press ▲ or ▼ to select On or Off, and then press the OK button.
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Enhanced Printing Options

Choosing Paper for Printing 21

Printing Photos and Office Documents 22

Printing CAD Drawings 47

Adjusting Images 55

Printing enlargements or reductions 73

Printing at full size 93

Borderless Printing 107

Printing banners or at other non-standard sizes 122

Tiling and multiple pages per sheet 139

Centering originals 160

Conserving roll paper 172

Checking Images Before Printing 184

Other useful settings 186
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Choosing a Paper for Printing
Choosing the right paper for your particular printing application will give you the best printing results.

• Media Type
The printer and printer driver offer print settings optimized for various paper characteristics.

Note
• For information on the types of paper the printer supports, refer to the Paper Reference Guide.(See

"Types of Paper →P.773 ")
• The types of paper indicated in the printer driver and related software (as well as on the Control Panel )

are updated when you install the Media Configuration Tool from the User Software CD-ROM or if you
change paper information by using the Media Configuration Tool. For information about the Media
Configuration Tool, see the Media Configuration Tool →P.447  (Windows) or Media Configuration
Tool →P.676  (Macintosh).

• An error message may be displayed on the printer Control Panel if the type of paper as specified in the
printer driver does not match the type specified on the printer. Although you can print under these con-
ditions, the printing results may not be suitable.

• If the paper type is not listed for selection
If the type of paper loaded cannot be selected, try specifying glossy paper or proofing paper as a special paper (Special
1 to Special 5, in this order). BK ( Black Ink ) is used as the black ink. Try specifying other types of paper as Special 6
to Special 10. MBK ( Matte Black Ink ) is used as the black ink. Note that higher numbers in this setting enable more
vivid colors but may also cause colors to run together.
Furthermore, Register Custom Paper can also be performed using the Media Configuration Tool.
For information about the Media Configuration Tool, see Media Configuration Tool →P.447  (Windows) or Media
Configuration Tool →P.676  (Macintosh).
For instructions on specifying the paper type before printing, refer to the following topics.

• Changing the Type of Paper →P.787

Specifying Paper in the Printer Driver
If you replace the paper, complete the printer driver settings for the paper type and size.
For instructions on configuring paper settings in the printer driver, refer to the following topics, as appropriate for your
computer and operating system.

• Specifying Paper in the Printer Driver (Windows) →P.204

• Specifying Paper in the Printer Driver (Mac OS X) →P.488
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Printing Photos and Images
By selecting the following Print Target from Easy Settings of the printer driver, you can easily configure the printing of
illustrations and photos.

Print Target Description

Photo (Color) Print photographic images from digital cameras with an op-
timal setting.

Photo (Monochrome) Print monochrome photos with an optimal setting.

Poster An optimal setting for posters. Print in vivid colors with
impact and high saturation.

Faithful Color Reproduc-
tion

Print with minimum color difference. Suitable for printing
scanner images and when print results are too vivid.

Photo (Adobe RGB) Setting suitable for printing images created using the color
space of Adobe RGB in optimal color.
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Important
• Depending on the Media Type setting, some Print Target options may not be available.

Note
• You can check the settings values for each print target by clicking View Settings.
• You can also fine-tune these values as needed. ( Advanced Settings )

For details on Advanced Settings, refer to "Giving Priority to Particular Graphic Elements and Colors for
Printing →P.64 ".

For instructions on printing photos and images, refer to the following topics, as appropriate for your computer and operating
system.

• Printing Photos and Images (Windows) →P.23

• Printing Photos and Images (Mac OS X) →P.25

Printing Photos and Images (Windows)
This topic describes how to print photos based on the following example.

• Document: Photo image from a digital camera
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Glossy Photo Paper HG 170
• Roll paper width: 10 inches (254.0 mm)

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Glossy Photo Paper HG 170.
In the A Media Type, choose the type of paper used for printing, such as Glossy Paper, Coated Paper, and so on.
Make sure the paper you select is loaded in the printer.

Note
• The paper type setting in the printer driver and related software (as well as on the Control Panel ) is

updated when you install the Media Configuration Tool from the User Software CD-ROM or if you
change paper information by using the Media Configuration Tool. For details, see Media Configura-
tion Tool →P.447 .

5. After confirming that D Easy Settings is selected, click Photo (Color) in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View Settings.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In the A Page Size list, click the size of the original as specified in the application. In this case, click 10"x12".

8. Select and click a roll paper in the L Paper Source list.

9. Select the width of the loaded roll in the M Roll Paper Width list—in this case, 10-in. Roll (254.0mm).

10. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Windows) →P.202 "

11. Confirm the print settings and print as desired.

Note
• For instructions on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Printing Photos and Images (Mac OS X)
This topic describes how to print photos based on the following example.

• Document: Photo image from a digital camera
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll paper
• Paper type: Glossy Photo Paper HG 170
• Roll paper width: 10 inches (254.0 mm)
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click 10"x12".

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.

Enhanced Printing Options > Printing Photos and Office Documents >

Printing Photos and Images (Mac OS X) iPF6300S

2

26



5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Glossy Photo Paper HG 170.
Make sure the paper you select is loaded in the printer.

Note
• The types of paper indicated in the printer driver and related software (as well as on the Control Pan-

el ) are updated when you install the Media Configuration Tool from the User Software CD-ROM or
if you change paper information by using the Media Configuration Tool. For details, see Media Con-
figuration Tool →P.676 .

7. After confirming that D Easy Settings is selected, click Photo (Color) in the E Print Target list.

Note
• For information on settings optimized for printing photos and images, see "Printing Photos and Im-

ages →P.22 "

• You can check the settings values selected in the E Print Target list by clicking G View set..

8. Make your selection in the F Print Quality list.
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9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.

11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, 10 in. (254.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.
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12. Make sure C Page Size on the Page Setup pane shows the original size as specified in C Paper Size in the Page
Attributes dialog box—in this case, 10"x12".

13. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Mac OS X) →P.486 "

14. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "

Printing from Photoshop
You can print images in the Adobe RGB color space that you have created in Photoshop, the Adobe Systems photo retouch-
ing application. Using the dedicated Photoshop printer driver plug-in (provided with the printer) makes it easy to print
Adobe RGB images more attractively.

• Using the Plug-in to Print
The imagePROGRAF Print Plug-In for Photoshop is a dedicated plug-in provided with the printer that you can load in
Photoshop and customize for your printing needs. By using the plug-in, you can print while preserving the 16-bit RGB
data from Photoshop without losing the exceptional color gradations of original image. Some of the settings and cus-
tomizations available in the plug-in are as follows.

• Automatic detection of the color space (sRGB or Adobe RGB) for automatic selection of the optimal profile. This
feature eliminates the need to complete intricate settings when printing Adobe RGB images.

• Advanced gray adjustment, including adjustment of tone curves, in addition to an array of standard adjustments
for color balance, brightness, contrast, highlight, and shadow.

• Fine-tune color tones in Photoshop while viewing a preview that accurately reproduces printing results.
• With print log management, you can save and load setting parameters from past print jobs.

Note
• imagePROGRAF Print Plug-In for Photoshop for Windows and Macintosh are provided with the print-

er.
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For instructions and details on which versions of Photoshop are compatible with the imagePROGRAF Print Plug-In for
Photoshop, refer to the following topics, as appropriate for your computer and operating system.

• Print Plug-In for Photoshop/Digital Photo Professional →P.307

• Print Plug-In for Photoshop/Digital Photo Professional →P.607

• Using the Printer Driver to Print
The printer driver offers the following settings and adjustments.

• Choose the standard sRBG color space or Adobe RGB as desired.
• Adjust the color balance, brightness, contrast, saturation, and gray levels.

For instructions on using the printer driver to print Adobe RGB images created in Photoshop, refer to the following
topics, as appropriate for your computer and operating system.

• Printing Adobe RGB Images (Windows) →P.30

• Printing Adobe RGB Images (Mac OS X) →P.34

Printing Adobe RGB Images (Windows)
This topic describes how to print Adobe RGB images based on the following example.

• Document: Adobe RGB image created in Photoshop
• Page Size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Glossy Photo Paper HG 170
• Roll Paper Width: 10 inches (254.0 mm)

Important
• In Photoshop, select no color-matching.
• In the printer driver settings, select Driver Matching Mode and choose Adobe RGB in Color Space.

1. In Photoshop, create an image in the Adobe RGB color space.

Note
• The following procedures are based on the example of Photoshop CS2.
• For instructions on creating Adobe RGB images, refer to the Photoshop documentation.

2. Choose Print with Preview from the File menu to display the Print dialog box.

3. Make sure the setting mode is Color Management.

4. In the Color Handling list in Options, click No Color Management.

5. Click Print to display the Print dialog box.

6. Select the printer and click Properties to display the printer driver dialog box.
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7. Make sure the Main sheet is displayed.

8. In the A Media Type list, select the type of paper that is loaded. In this case, click Glossy Photo Paper HG 170.

9. Click D Advanced Settings to switch the print mode.

10. Click Image in the E Print Priority list.
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11. Select the print quality in the F Print Quality list.

Note
• Options displayed in the F Print Quality list vary depending on the paper type.

12. Click Color in the G Color Mode list.

13. Click H Color Settings to display the Color Settings dialog box.
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14. Click the Matching tab to display the Matching sheet.

15. In A Matching Mode, click Driver Matching Mode.

16. In C Color Space, click Adobe RGB.

17. Click OK to close the Color Settings dialog box.
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18. Click the Page Setup tab to display the Page Setup sheet.

19. In the A Page Size list, click the size of the original as specified in the source application. In this case, click
10"x12".

20. Select and click a roll paper in the L Paper Source list.

21. Select the width of the loaded roll in the M Roll Paper Width list. In this case, click 10-in. Roll (254.0mm), and
then click OK.

22. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Printing Adobe RGB Images (Mac OS X)
This topic describes how to print Adobe RGB images based on the following example.

• Document: Adobe RGB image created in Photoshop
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Glossy Photo Paper HG 170
• Roll paper width: 10 inches (254.0 mm)
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Important
• In Photoshop, select no color-matching.
• In the printer driver settings, select Driver Matching Mode and choose Adobe RGB in Color Space.

1. In Photoshop, create an image in the Adobe RGB color space.

Note
• The following procedures are based on the example of Photoshop CS3/CS4/CS5.
• For instructions on creating Adobe RGB images, refer to the Photoshop documentation.

2. Choose Print with Preview from the Photoshop menu to display the Print dialog box.

3. Make sure the setting mode is Color Management.

4. In the Color Handling list, click Printer Manages Colors.

5. Click Print.

6. Access the Main pane.

7. In the A Media Type list, select the type of paper that is loaded. In this case, click Glossy Photo Paper HG 170.
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8. Click D Advanced Settings to switch the print mode.

9. Click Image in the E Print Priority list.

10. Select the print quality in the F Print Quality list.

Note
• Options displayed in the F Print Quality list vary depending on the type of paper.

11. Click Color in the H Color Mode list.

12. Click I Set to display the Color Settings dialog box.

13. Click Matching to display the Matching pane.

14. In Matching Mode, click Driver Matching Mode.

15. In Color Space, click Adobe RGB.

16. Click OK to close the Color Settings dialog box.
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17. Access the Page Setup pane.

18. Select and click a roll paper in the A Paper Source list.

19. Make sure the width of the loaded roll paper is displayed in the B Roll Width list—here, 10-in. Roll (254.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

20. Make sure C Page Size in the Page Setup pane matches the size of the original as specified in Photoshop—in this
case, 10"x12".
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21. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X)." →P.491

Printing Office Documents
By selecting Office Document from Easy Settings of the printer driver, you can easily configure settings for printing office
documents.

Print Target Description

Office Document Setting optimized for printing general office documents
such as materials for distribution so that they can be viewed
easily.

Note
• You can check the settings values for each print target by clicking View Settings.
• You can also fine-tune these values as needed. (Advanced Settings)

For details on Advanced Settings, refer to "Giving Priority to Particular Graphic Elements and Colors for
Printing →P.64 ".

For instructions on printing office documents, refer to the following topics, as appropriate for your computer and operating
system.

• Printing Office Documents (Windows) →P.38

• Printing Office Documents (Mac OS X) →P.40

Printing Office Documents (Windows)
This topic describes how to print office documents based on the following example.

• Document: Office document created using word-processing or spreadsheet programs
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. After confirming that D Easy Settings is selected, click Office Document in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View Settings.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4.

8. Click Manual in the L Paper Source list.

9. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Windows) →P.202 "

10. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Printing Office Documents (Mac OS X)
This topic describes how to print office documents based on the following example.

• Document: Office document created using word-processing or spreadsheet programs
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4 - for Paper Tray (Large Mar-
gins).

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. After confirming that D Easy Settings is selected, click Office Document in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View set..

8. Make your selection in the F Print Quality list.
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9. Access the Page Setup pane.

10. Click Manual in the A Paper Source list.

11. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4 - for Paper Tray (Large Margins).

12. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Mac OS X) →P.486 "

13. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "
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Using PosterArtist to Compose Originals
You can print a variety of source documents from word-processing or spreadsheet programs or screen shots from web
browsers after composing an original with them using PosterArtist.
This topic describes how to use PosterArtist to compose originals from multiple applications, creating a poster layout for
printing.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box. (See "Accessing the Printer Driver
Dialog Box from Applications (Windows).") →P.211

3. Make sure the Main sheet is displayed.
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4. Click the Layout tab to display the Layout sheet.

5. Select the A Page Layout check box.

6. Click in the Edit Using PosterArtist in the A Page Layout list.

7. When you attempt to print, PosterArtist starts up and the PageCapture window is displayed. (At this point, the docu-
ment will not be printed yet.)

8. Choose the page to load in PosterArtist.
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9. Edit and rearrange the image in the PosterArtist window as desired.
Without closing the PosterArtist window, repeat steps 1-8 to arrange originals from multiple applications on the
same page.

Note
• For details on how to edit and sort images, refer to the PosterArtist Manual.

10. Print from the PosterArtist menu.
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Printing Line Drawings and Text
By selecting the following Print Target from Easy Settings of the printer driver, you can easily configure setting for print-
ing line drawings and characters.

Print Target Description

Perspective, GIS Settings optimized for printing 3D CAD drawings, perspec-
tive drawings, and maps, including GIS maps.

CAD (Color Line Draw-
ing)

Settings optimized to print intricate lines in CAD drawings
clearly.

Note
• You can check the settings values for each print target by clicking View Settings.
• You can also fine-tune these values as needed. ( Advanced Settings )

For details on Advanced Settings, refer to "Giving Priority to Particular Graphic Elements and Colors for
Printing →P.64 ".

For instructions on printing line drawings and text, refer to the following topics, as appropriate for your computer and oper-
ating system.

• Printing Line Drawings and Text (Windows) →P.47

• Printing Line Drawings and Text (Mac OS X) →P.49

Printing Line Drawings and Text (Windows)
This topic describes how to print line drawings based on the following example.

• Document: CAD drawing
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.
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2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. After confirming that D Easy Settings is selected, click CAD (Color Line Drawing) or CAD (Monochrome Line
Drawing ) in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View Settings.

Enhanced Printing Options > Printing CAD Drawings >

Printing Line Drawings and Text (Windows) iPF6300S

2

48



6. Click the Page Setup tab to display the Page Setup sheet.

7. In A Page Size, click the size of the original as specified in the application. In this case, click ISO A3.

8. Select and click a roll paper in the L Paper Source list.

9. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

10. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Windows) →P.202 "

11. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "
• You can conserve roll paper by configuring settings suitable for the document.

For details on how to conserve paper and print, refer to "Conserving Roll Paper by Rotating Origi-
nals 90 Degrees (Windows) →P.172 ".

Printing Line Drawings and Text (Mac OS X)
This topic describes how to print line drawings based on the following example.

• Document: CAD drawing
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll
• Paper type: Plain Paper

Enhanced Printing Options > Printing CAD Drawings >

iPF6300S Printing Line Drawings and Text (Mac OS X)

2

49



• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])
 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A3.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. After confirming that D Easy Settings is selected, click CAD (Color Line Drawing) in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View set..

8. Make your selection in the F Print Quality list.
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9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.

11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.
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12. Make sure C Page Size on the Page Setup pane shows the original size as specified in C Paper Size in the Page
Attributes dialog box—in this case, ISO A3.

13. Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings (Mac OS X) →P.486 "

14. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "
• You can conserve roll paper by configuring settings suitable for the document.

For details on how to conserve paper and print, refer to "Conserving Roll Paper by Rotating Origi-
nals 90 Degrees (Mac OS X) →P.174 .

Printing from AutoCAD
Printer Driver Optimization Module for AutoCAD is software for printing optimally from AutoCAD with the printer driver.
By optimally controlling the processing resolution of raster data and the memory to be used in image processing of Auto-
CAD, printing superior in reliability and productivity is realized.
If you install Printer Driver Optimization Module for AutoCAD on a computer on which supported AutoCAD is installed, it
will be installed automatically.

Note
• Printer Driver Optimization Module for AutoCAD is applied automatically when you print from AutoCAD,

and optimal printing is performed.

Confirming the Installation of Printer Driver Optimization Module for AutoCAD
You can confirm whether Printer Driver Optimization Module for AutoCAD is installed by the following method.

1. From the File menu of AutoCAD, select Print.
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2. The Printing dialog box is displayed.
Printer Driver Optimization Module for AutoCAD is installed if in Plotter of Printer/plotter this is dis-
played:iPFxxxx - Optimized driver - by Canon Inc..

Installation of Printer Driver Optimization Module for AutoCAD
If Printer Driver Optimization Module for AutoCAD is not installed, install it by the following method.

1. Insert User Software CD-ROM in the CD-ROM drive and start the installer.

2. In the Setup Menu window, click Install Individual Software.

3. Click Install of Printer Driver Optimization Module for AutoCAD.

4. Follow the instructions on the screen.
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Adjusting the Color in the Printer Driver
Color settings specified in the application for your documents are essentially given priority over other settings for each print
job, but further color adjustment is possible in the printer driver.

• Color Mode
Choose how the printer driver processes color, as desired.
The available options vary depending on the color mode.

Color Mode Description Color Adjustment

Color Print in color. You can select the color balance and
color matching functions.

Monochrome (Photo) Grayscale printing optimized for
monochrome photos.

You can adjust the color balance in
ways tailored to monochrome photos.

Monochrome Print in grayscale. You can adjust the color balance.

No color correction (*1) Prints without performing color-
matching in the printer driver.

You can adjust the color balance.

*1: If No color correction is selected, the Matching sheet / Matching pane is not displayed.

• Color Adjustment
You can adjust colors separately for images, graphics, and text documents.

Adjustment Item Description

Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

Magenta

Yellow

Gray Tone Adjust the grayscale, in a range from cool, blue tones to warm, red tones.

Brightness Adjust the brightness of printed images while keeping the darkest and lightest por-
tions intact.

Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note
• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the

color adjustment target from Image, Graphics, and Text.

Enhanced Printing Options > Adjusting Images >

iPF6300S Adjusting the Color in the Printer Driver

2

55



• Matching
You can choose the color-matching mode and method.
By adjusting the color-matching mode and method, you can make printed colors match the colors of on-screen images
more closely.

Important
• If No color correction is selected under Color Mode, the Matching cannot be changed.

Matching Mode Description Remarks

Driver Matching Mode Enables printing of optimal color
tones using a driver specific color
profile.

You should normally select this mode.
You should also select this mode if you
want to use ambient light adjustment.

ICC Matching Mode Enables color matching using ICC
profiles.
Select this if you want to print by
specifying the input profile, printer
profile, and matching method in de-
tail.

This allows you to use ICC profiles for
digital cameras and scanners, ICC pro-
files created using the profile creation
tool, etc.

Driver ICM Mode Enables color matching by the printer
driver using the ICM function of
printer driver.
Select this if you want to print by only
specifying the matching method.

Available when using Windows.

Host ICM Mode Enables color matching by the host
computer using the ICM function of
Windows.
Select this if you want to print from
an application that supports the ICM
function.

ColorSync Enables color matching by using the
ColorSync function of Mac OS.
Select this if you want to perform soft
proofing using ColorSync before
printing.

Available when using Mac OS.

Matching Method Description Remarks

Auto Color-matching optimized for images,
graphics, or text.

The available options and their display
order vary depending on your selected
color-matching mode, as well as the
operating system.Perceptual Color-matching optimized for print-

ing typical photos attractively.
Smooth gradation is a feature. This is
also an easy-to-use mode when per-
forming color adjustment using appli-
cation software.
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Matching Method Description Remarks

Colorimetric Color-matching optimized for print-
ing image data with accurate colors in
input color space. This is the easiest-
to-use mode when you want to adjust
the color and print. However, grada-
tion may be lost for colors of wider
range than the color reproduction
range of the printer. Generally, this is
also called relative colorimetric.

The available options and their display
order vary depending on your selected
color-matching mode, as well as the
operating system.

Colorimetric (No Wht-pnt Corr) The processing method of color-
matching is identical to Colorimetric.
Use this when you want to further re-
produce the target paper material col-
or of the image data. Generally, this
also is called absolute colorimetric.

Saturation Color-matching optimized for print-
ing posters, etc., vividly.

Monitor Matching Suitable for optimized printing to
match the appearance on the monitor.
Color-matching optimized for accu-
rately reproducing colors on the cali-
brated sRGB or AdobeRGB monitor.

• Gray Tone Adjustment
The following settings can be adjusted if Monochrome (Photo) is selected in Color Mode.

Gray Adjustment Items Description

Color Balance Adjust the gray tone to suit the images of monochrome photos. Choose cool black
(tinged with blue), pure black (neutral), warm black (tinged with red), and so on.
Select the color tone in the color region or from the list.

Brightness Adjust the brightness of printed images while keeping the darkest and lightest por-
tions intact.

Contrast Adjust the contrast of the darkest and lightest portions relative to each other, as de-
sired.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Highlight Adjust levels of image highlight areas.

Shadow Adjust levels of image shadow areas.

Note
• Be sure to calibrate your monitor colors correctly if you adjust the colors for printing. If monitor colors

are not calibrated correctly, you may not obtain the desired printing results. For instructions on monitor
calibration, refer to the documentation for your monitor and operating system.

For instructions on color adjustment, refer to the following topics, as appropriate for your computer and operating sys-
tem.

• Fine-Tuning Colors of Photos and Images (Windows) →P.58

• Fine-Tuning Colors of Photos and Images (Mac OS X) →P.61
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Fine-Tuning Colors of Photos and Images (Windows)
You can specify your own print settings instead of using the Print Target presets. This topic describes how to fine-tune the
color tone of photos before printing.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.
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5. Click D Advanced Settings to switch the print mode.

6. Click Color in the G Color Mode list.

7. Click H Color Settings to display the Color Settings dialog box.
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8. On the Color Adjustment sheet, adjust the color tones, brightness, and so on as desired.

Adjustment Item Description

D Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

E Magenta

F Yellow

G Gray Tone Adjust the gray tone to suit the images of monochrome photos. Choose cool black
(tinged with blue), pure black (neutral), warm black (tinged with red), and so on. Se-
lect the color tone in the color region or from the list.

H Brightness Adjust the brightness of printed images while keeping the darkest and lightest por-
tions intact.

I Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

J Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note
• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the

color adjustment target from Image, Graphics, and Text.

9. Close the Color Settings dialog box.

10. Click the Page Setup tab to display the Page Setup sheet.

11. Confirm the settings of A Page Size, L Paper Source, and so on.
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12. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Fine-Tuning Colors of Photos and Images (Mac OS X)
You can specify your own print settings instead of using the Print Target presets. This topic describes how to fine-tune the
color tone of photos before printing.

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. Choose the original size in the F Paper Size list.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded.

7. Click D Advanced Settings to switch the print mode.

8. Click Color in the H Color Mode list.
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9. Click I Set to display the Color Settings dialog box.

10. On the Color Adjustment pane, adjust the color tones, brightness, and so on as desired.

Adjustment Item Description

D Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

E Magenta

F Yellow

G Gray Tone Adjust the gray tone to suit the images of monochrome photos. Choose cool black
(tinged with blue), pure black (neutral), warm black (tinged with red), and so on. Se-
lect the color tone in the color region or from the list.

H Brightness Adjust the brightness of printed images while keeping the darkest and lightest por-
tions intact.

I Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

J Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note
• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the

color adjustment target from Images, Graphics, and Text.

11. Click OK to close the Color Settings dialog box.
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12. Access the Page Setup pane.

13. Confirm the settings of A Paper Source and C Page Size.

14. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "

Giving Priority to Particular Graphic Elements and Colors for Printing
You can specify detailed print settings as desired for the quality level, colors, and other criteria.

• Advanced Settings
For printing results that appear just as expected for your original, you can specify which graphic elements and colors to
prioritize for printing.

Note
• Easy Settings are also available, providing convenient presets. To use the presets, simply choose the

printing application.
For details on Easy Settings, refer to the following topics.

• Printing Photos and Images →P.22

• Printing Line Drawings and Text →P.47

• Printing Office Documents →P.38

• Print Priority
Choose the graphic elements that you want to emphasize for printing.
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Print Priority (*1) Description

Image A setting for posters or other documents made up mainly of photos or images, or for
emphasizing photos or images in printed documents.

Line Drawing/Text Choose this setting for CAD drawings made up mainly of intricate lines, or to en-
hance the finishing of fine text.
However, the quality may not be sufficient when printing photos or images that re-
quire a lot of color coverage. In this case, choose Image instead.

Office Document Choose this setting for better legibility of documents combining text and graphics,
such as documents and presentation material created with typical office applications.

Proof This is a setting for enhancing the reproduction of text, illustrations, and photos on
print proofs. However, this takes more time than regular printing.

*1: Options suitable for the selected type of paper are listed under Print Priority.

• Print Quality
Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality (*1) Description Print Priority

High Choose this setting to print at high resolution
when quality is most important.
Printing takes longer and consumes more ink
than in Standard or Fast modes, but this
mode offers exceptional printing quality.

Image
Line Drawing/Text
Proof

Standard Choose this setting to print at standard resolu-
tion when quality and speed are both impor-
tant.
Printing takes less time than in High mode.

Image
Line Drawing/Text
Office Document
Proof

Fast Choose this setting to print faster.
Printing in fast mode can help you work more
efficiently when checking layouts.

Image
Line Drawing/Text
Proof

*1: Options suitable for the selected Print Priority are listed under Print Quality.

• Color Settings

Setting Item Options Description

Color Mode (*1) Color
Monochrome (Photo)
Monochrome
No color correction

Choose whether to print in color or
monochrome.
(Refer to "Adjusting the Color in the
Printer Driver →P.55 ")

Color Adjustment (Images) Cyan
Magenta
Yellow
Gray Tone
Brightness
Contrast
Saturation

You can adjust the levels of cyan, ma-
genta, and yellow as well as the bright-
ness, contrast, saturation, and gray tone
separately for images, graphics, and
text documents.
If you choose Monochrome in Color
Mode only Brightness and Contrast
can be adjusted.

Color Adjustment (Graphics)

Color Adjustment (Text)
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Setting Item Options Description

Gray Adjustment Color Balance
Brightness
Contrast
Highlight
Shadow

Choose the gray tone color balance
( Cool Black or Warm Black ) and ad-
just levels of brightness, contrast, high-
light, and shadow as desired.
These levels can be adjusted when
Monochrome (Photo) is selected in
Color Mode.

Color-Matching Modes Driver Matching Mode
ICC Matching Mode

Choose the color-matching mode. Oth-
er color-matching modes may be provi-
ded by the computer operating system,
such as ICM and ColorSync.

Color-Matching Method (*2) Auto
Perceptual
Saturation
Monitor Matching
Colorimetric
other

Choose the color-matching method.
The available options vary depending
on your selection in Color-Matching
Mode.

Color Space (*3) sRGB
Adobe RGB

Choose a standard color space
( sRGB ) or an expanded color space
( Adobe RGB ).

*1: Options suitable for the selected Print Priority and Media Type are listed under Color Mode.
*2: The order of options displayed varies depending on the operating system.
*3: Adobe RGB is not available if an incompatible combination of the paper type and print quality is selected.

• Enhancing printing quality

Setting Item Description

Highest quality This prints at the highest resolution. Printing takes longer and consumes more ink
than in other modes, but this mode offers superior printing quality.

Thicken Fine Lines Prints making fine lines appear thicker.

Unidirectional Printing Prints by suppressing color variations and misaligned ruled lines. However, this
takes more time than regular printing.

Economy Printing When this mode is selected, the quality is diminished from that of regular printing,
however less ink is consumed. Select this mode if you want to conserve ink when
printing to check drawings, for example. Depending on the Media Type and Print
Quality settings, this mode may not be available.

Note
• To print at a higher level of quality, in the printer driver, choose High in Print Quality, and select

Highest quality and print.

For instructions on specifying the print quality and color settings before printing, refer to the following topics, as ap-
propriate for your computer and operating system.

• Choosing the Document Type and Printing Conditions (Windows) →P.67

• Choosing the Document Type and Printing Conditions (Mac OS X) →P.70
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Choosing the Document Type and Printing Conditions (Windows)
You can specify your own print settings instead of using the Print Target presets. This topic describes how print photo-
graphic images in monochrome.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(Refer to "Accessing the Printer
Driver Dialog Box from Applications (Windows) →P.211 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.
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5. Click D Advanced Settings to switch the print mode.

6. Click Image in the E Print Priority list.

7. Click High (600dpi) in the F Print Quality list.

Note
• Options displayed in the F Print Quality list vary depending on the type of paper.

8. Click Monochrome in the G Color Mode list.

9. To adjust the brightness and contrast, click H Color Settings.

Note
• For instructions on adjusting brightness and contrast, see "Adjusting the Color in the Printer Driver."

→P.55

Enhanced Printing Options > Adjusting Images >

Choosing the Document Type and Printing Conditions (Windows) iPF6300S

2

68



10. Click the Page Setup tab to display the Page Setup sheet.

11. Confirm the settings of A Page Size, L Paper Source, and so on.

12. Confirm the print settings and print as desired.

Note
• For details on how to check the printing settings, refer to "Confirming Print Settings (Windows)

→P.207 ".
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Choosing the Document Type and Printing Conditions (Mac OS X)
You can specify your own print settings instead of using the Print Target presets. This topic describes how print photo-
graphic images in monochrome.

1. Choose Page Setup from the application menu to display the Page Attributes dialog box.

2. Select the printer in the B Format for list.

3. Choose the original size in the C Paper Size list.

4. Click F OK to close the dialog box.

5. In the application menu, choose Print.
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6. Access the Main pane.

7. In the A Media Type list, select the type of paper that is loaded.

8. Click D Advanced Settings to switch the print mode.

9. Click Image in the E Print Priority list.
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10. Click High (600dpi) in the F Print Quality list.

Note
• Options displayed in the F Print Quality list vary depending on the paper type.

11. Click Monochrome in the H Color Mode list.

12. To adjust the brightness and contrast, click I Set.

Note
• For instructions on adjusting brightness and contrast, see "Adjusting the Color in the Printer Driv-

er →P.55 "

13. Access the Page Setup pane.

14. Confirm the settings of A Paper Source and C Page Size.

15. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "
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Resizing Originals to Match the Paper Size
You can freely adjust the size of originals by enlarging or reducing them as desired.

• Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.

• Fit Paper Size
Enlarge or reduce the original to match the size of the paper you are using.

For instructions on resizing originals to match the paper size, refer to the following topics, as appropriate for your com-
puter and operating system.

• Resizing Originals to Match the Paper Size (Windows) →P.73

• Resizing Originals to Match the Paper Size (Mac OS X) →P.75

Note
• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an

image-editing application software such as Adobe Photoshop to specify an image resolution of 150 dpi
or more at actual size.

Resizing Originals to Match the Paper Size (Windows)
This topic describes how to enlarge originals before printing to match the paper size, based on the following example.

• Document: Any Type
• Page size: A4 (210.0×297.0mm)/Letter (8.3 × 11.7 in)
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• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driver
Dialog Box from Applications (Windows) →P.211 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Select the printing application in the E Print Target list.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. Select and click a roll paper in the L Paper Source list.

8. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

9. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4.

10. Select the C Enlarged/Reduced Printing check box.

11. Select the D Fit Paper Size check box.

12. Click ISO A3 in the G Paper Size list.

13. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Resizing Originals to Match the Paper Size (Mac OS X)
This topic describes how to enlarge originals before printing to match the paper size, based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
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• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure C Page Size on the Page Setup pane shows the original size as specified in C Paper Size in the Page
Attributes dialog box—in this case, ISO A4.

13. Select the D Enlarged/Reduced Printing check box.

14. Make sure E Fit Paper Size is selected.

15. Click ISO A3 in the I Paper Size list.
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16. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "

Resizing Originals to Fit the Roll Width
You can freely adjust the size of originals by enlarging or reducing them as desired.

• Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.

• Fit Roll Paper Width
Enlarge or reduce the original as a whole to match the roll paper width, as desired.

For instructions on resizing originals to match the roll paper width, refer to the following topics, as appropriate for your
computer and operating system.

• Resizing Originals to Fit the Roll Width (Windows) →P.79

• Resizing Originals to Fit the Roll Width (Mac OS X) →P.82

Note
• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an

image-editing application software such as Adobe Photoshop to specify an image resolution of 150 dpi
or more at actual size.

Resizing Originals to Fit the Roll Width (Windows)
This topic describes how to enlarge originals before printing to match the roll width, based on the following example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)
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1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Select the printing application in the E Print Target list.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. Select and click a roll paper in the L Paper Source list.

8. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").
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9. Select the C Enlarged/Reduced Printing check box.

Note
• If the C Enlarged/Reduced Printing check box is not displayed on the Page Setup sheet, clear the

B Borderless Printing check box.

10. Click E Fit Roll Paper Width.

Note
• After you click E Fit Roll Paper Width, the Information dialog box is displayed. Select the width

of the loaded roll in the Roll Paper Width list and click OK.
• Make sure the roll paper width you specify matches the width of the loaded roll.

11. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Resizing Originals to Fit the Roll Width (Mac OS X)
This topic describes how to enlarge originals before printing to match the roll width, based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.

Enhanced Printing Options > Printing enlargements or reductions >

Resizing Originals to Fit the Roll Width (Mac OS X) iPF6300S

2

84



11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, 16 in. (406.4mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

13. Select the D Enlarged/Reduced Printing check box.

14. Click F Fit Roll Paper Width.

15. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "

Resizing Originals by Entering a Scaling Value
You can freely adjust the size of originals by enlarging or reducing them as desired.

• Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.
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• Scaling
Enlarge or reduce originals by a particular amount, as desired.

For instructions on entering a scaling value to resize originals, refer to the following topics, as appropriate for your
computer and operating system.

• Resizing Originals by Entering a Scaling Value (Windows) →P.86

• Resizing Originals by Entering a Scaling Value (Mac OS X) →P.88

Note
• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an

image-editing application software such as Adobe Photoshop to specify an image resolution of 150 dpi
or more at actual size.

Resizing Originals by Entering a Scaling Value (Windows)
This topic describes how to enlarge originals before printing by entering a scaling value, based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

Important
• In borderless printing, you cannot resize originals by entering a scaling value.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Select the printing application in the E Print Target list.

6. Click the Page Setup tab to display the Page Setup sheet.
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7. Select and click a roll paper in the L Paper Source list.

8. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

9. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4.

10. Select the C Enlarged/Reduced Printing check box.

11. Click ISO A4 in the G Paper Size list.

12. Click F Scaling and enter 120.

Note
• You can specify enlargement that exceeds the paper size, but in this case, the portions off the bottom

and right edges of the paper will not be printed.
• If the original size after enlargement or reduction is smaller than the paper size, the original is printed

in the upper-left corner. In this case, you can center originals by selecting E Print Centered on the
Layout sheet.

13. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Resizing Originals by Entering a Scaling Value (Mac OS X)
This topic describes how to enlarge originals before printing by entering a scaling value, based on the following example.

• Document: Any Type
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• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

13. Select the D Enlarged/Reduced Printing check box.
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14. Click G Scaling and enter 120.

Note
• You can specify enlargement that exceeds the paper size, but in this case, the portion off the edge of

the paper will not be printed.
• If the original size after enlargement or reduction is smaller than the paper size, the original is printed

in the upper-left corner. In this case, you can center originals by selecting the J Print Centered
check box.

15. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "

Enhanced Printing Options > Printing enlargements or reductions >

Resizing Originals by Entering a Scaling Value (Mac OS X) iPF6300S

2

92



Printing at full size
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Printing on Oversized Paper
Except in borderless printing, the actual printing area corresponds to your selected paper size minus the space for a margin
(See "Print Area →P.1081 "). To print documents or images you prepare without a margin at actual size, use an oversized
paper size.
For example, to print a A4-sized original without a margin at A4 size, print it on paper larger than A4 size and cut away the
excess margin.

Note
• If you prepare an original for printing without a margin and print it on paper of regular size, the image near

the edge will not be printed.

• Oversize
The margin required by the printer is added around the outside of a regular paper size. For example, when printing a
A4-sized original (210×297 mm), you have the following options.

• (a) Regular paper size: Gray area not printed
• (b) Page Size
• (c) Oversized paper size: Print area matches the page size (b)

Important
• When printing on oversize paper, load paper larger than the page size—a size that includes the margin

required by the printer.

• Sheets: Load paper that is at least 6 mm (0.24 in) wider and 26 mm (1 in) higher than the page size
• Rolls: Load paper that is at least 6 mm (0.24 in) wider and 6 mm (0.24 in) higher than the page size
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Note
• Paper larger than the maximum size supported by the printer cannot be used as paper for oversized

printing.(See "Paper Sizes →P.774 ")
• To specify a non-standard paper size in oversized printing, register the paper size as a Custom Paper

Size. Oversized printing is not available with Custom Size.(See "Printing on Non-Standard Paper
Sizes →P.131 ")

For instructions on oversized printing, refer to the following topics, as appropriate for your computer and operating
system.

• Printing at Full Size (Windows) →P.94

• Printing at Full Size (Mac OS X) →P.95

Printing at Full Size (Windows)
This topic describes how to print at full size based on the following example. (Oversized Printing)

• Document: Any Type
• Page Size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

3. Make sure the Main sheet is displayed.
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4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Click the Page Setup tab to display the Page Setup sheet.

6. Click O Size Options to display the Paper Size Options dialog box.

7. In the Paper Size Options dialog box, select the Oversize check box in Display Series.

8. Click OK to close the Paper Size Options dialog box.

9. Click Oversize - ISO A4 in the A Page Size list.

10. Select and click a roll paper in the L Paper Source list.

11. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

12. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Printing at Full Size (Mac OS X)
This topic describes how to print at full size based on the following example. (Oversized Printing)

• Document: Any Type
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• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In F Paper Size, click the size of the original. In this case, click ISO A4 - Oversize.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure C Page Size shows the original size as specified in C Paper Size in the Page Attributes dialog box—in
this case, ISO A4 - Oversize.

13. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "
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Borderless Printing at Actual Size
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) without a
surrounding margin, or border.

• Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you can
print documents without the margin, so that the printed image covers the entire surface of the paper.

Important
• Borderless printing is only available with rolls.
• Always set the blue Switch on the Platen to the ● side for borderless printing. Printing quality may be

affected if the Switch is incorrectly set.
• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular

widths. For information on types of paper compatible with borderless printing, refer to the Paper Refer-
ence Guide. (See "Types of Paper →P.773 ")

• If you use an A1 orA2 roll for borderless printing, insert the provided Spacer for Borderless Printing
onthe Roll Holder.(See "Loading Rolls on the Roll Holder →P.781 ")
If you do not attach the Spacer for Borderless Printing,the Platen maybe soiled from borderless printing.

• Paper incompatible with the printer's auto cut function can be printed without borders on the left and
right sides only.

• These features cannot be used in combination with borderless printing: special page layouts, centering
originals, and printing cut lines on rolls.

• If Fit Paper Size or Print Image with Actual Size (Windows only) is selected when performing bor-
derless printing, Rotate Page 90 degrees (Conserve Paper) cannot be selected.

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be
uneven at the edges. If you require higher image quality, specify No in Auto Cut in the printer driver. In
this case, the paper can be printed without borders on the left and right sides only. After ejecting and
cutting the printed document, use scissors to cut away the top and bottom edges.

• When CutDustReduct. is set to On, print without borders only on the left and right sides.
• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit

touches printing surfaces that are not dry yet, it may damage the paper or the edge of the document that
is cut, depending on frequency of use. In this case, follow these steps to change the ink drying time.

• On the Main sheet of the printer driver, click Settings in Media Type.
• Select the ink drying time in the Between Pages list of Drying Time.

• Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.
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• Print Image with Actual Size
Prints originals at actual size, without enlarging or reducing them. Originals must be prepared in a size that exceeds the
dimensions of the paper by 3 mm (0.12 in) on each side.

Note
• Not all page sizes are available.
• Even if you prepare originals of the same size as the paper size, the originals are automatically enlarged

when you print borderlessly in combination with resizing originals to match the paper size. This may
affect image quality. When image quality is most important, make the original 3 mm longer on each
side than the paper size so that the image can be printed at actual size in borderless printing.

For instructions on borderless printing of photos and images at actual size, refer to the following topics, as appropriate
for your computer and operating system.

• Borderless Printing at Actual Size (Windows) →P.100

• Borderless Printing at Actual Size (Mac OS X) →P.103

Borderless Printing at Actual Size (Windows)
This topic describes how to print borderlessly at actual size based on the following example.
If you use an A1 or A2 roll for borderless printing, insert the provided Spacer for Borderless Printing on the Roll Holder.
(See "Loading Rolls on the Roll Holder →P.781 ")
If you do not attach the Spacer for Borderless Printing, the Platen may be soiled from borderless printing.

• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. Create the original in the source application 3 mm (0.12 in) larger on each side than 254.0×304.8 mm (10 × 12 in)
—that is, 260.0×310.8 mm (10.2 × 12.2 in)

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on

specifying the margin, refer to the software documentation.
• The extra 3 mm (0.12 in) on each side will not be printed. Create the original so that it fits inside the

paper area to be printed on.

2. Choose Print in the application menu.
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3. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

6. Select the print target in the E Print Target list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. In the A Page Size list, click the size of the original as specified in the source application. In this case, click
10"x12".

9. Select and click a roll paper in the L Paper Source list.

10. Select the B Borderless Printing check box to display the Information dialog box.
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11. Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).

12. Click OK to close the Information dialog box.

13. In C Borderless Printing Method, click F Print Image with Actual Size.

14. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Borderless Printing at Actual Size (Mac OS X)
This topic describes how to print borderlessly at actual size based on the following example.
If you use an A1 or A2 roll for borderless printing, insert the provided Spacer for Borderless Printing on the Roll Holder.
(See "Loading Rolls on the Roll Holder →P.781 ")
The platen may be soiled from borderless printing if you do not attach it.

• Document: Any type
• Page size: 10 × 12 inches (254.0×304.8 mm)–Borderless
• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. Choose Page Setup from the application menu to display the Page Attributes dialog box.

2. Select the printer in the B Format for list.
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3. In the C Paper Size list, choose a paper size supported for borderless printing. Here, click 10"x12" - Borderless.

Note
• Paper sizes supported for borderless printing are indicated by -Borderless.

4. Click F OK to close the dialog box.

5. In the application, create an original that takes up the entire space of the paper size.

6. Choose Print in the application menu.

7. Access the Main pane.

8. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

9. Select the print target in the E Print Target list.
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10. Access the Page Setup pane.

11. Select and click a roll paper in the A Paper Source list.

12. Confirm that the roll paper width matches the paper size.
Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, 10 in. (254.0mm).

Note
• If the width of the loaded roll is not displayed in B Roll Width, click L Printer Information on the

Main pane and update the printer information.
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13. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, 10"x12" - Borderless.

14. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "
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Borderless Printing on Paper of Equivalent Size
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) without a
surrounding margin, or border.

• Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you can
print documents without the margin, so that the printed image covers the entire surface of the paper.

Important
• Borderless printing is only available with rolls.
• Always set the blue switch on the platen to the ● side for borderless printing. Printing quality may be

affected if the Switch is incorrectly set.
• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular

widths. For information on types of paper compatible with borderless printing, refer to the Paper Refer-
ence Guide. (See "Types of Paper →P.773 ")

• If you use an A1 orA2 roll for borderless printing, insert the provided Spacer for Borderless Printing
onthe Roll Holder.(See "Loading Rolls on the Roll Holder →P.781 ")
If you do not attach the Spacer for Borderless Printing,the Platen maybe soiled from borderless printing.

• Paper incompatible with the printer's auto cut function can be printed without borders on the left and
right sides only.

• These features cannot be used in combination with borderless printing: special page layouts, centering
originals, and printing cut lines on rolls.

• If Fit Paper Size or Print Image with Actual Size (Windows only) is selected when performing bor-
derless printing, Rotate Page 90 degrees (Conserve Paper) cannot be selected.

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be
uneven at the edges. If you require higher image quality, specify No in Auto Cut in the printer driver. In
this case, the paper can be printed without borders on the left and right sides only. After ejecting and
cutting the printed document, use scissors to cut away the top and bottom edges.

• When CutDustReduct. is set to On, print without borders only on the left and right sides.
• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit

touches printing surfaces that are not dry yet, it may damage the paper or the edge of the document that
is cut, depending on frequency of use. In this case, follow these steps to change the ink drying time.

• On the Main sheet of the printer driver, click Settings in Media Type.
• Select the ink drying time in the Between Pages list of Drying Time.

• Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.
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• Fit Paper Size
Enlarge or reduce the original to match the size of the paper you are using.

Note
• The printer driver automatically enlarges originals 3 mm (0.12 in) past the dimensions of the paper on

each side. The 3 mm portion beyond the edge on each side is not printed.

For instructions on borderless printing of photos, images, and other documents to match the paper size, refer to the
following topics, as appropriate for your computer and operating system.

• Borderless Printing by Resizing Originals to Match the Paper Size (Windows) →P.108

• Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X) →P.110

Borderless Printing by Resizing Originals to Match the Paper Size (Windows)
This topic describes how to enlarge originals before borderless printing to match the paper size, based on the following
example.
If you use an A1 or A2 roll for borderless printing, insert the provided Spacer for Borderless Printing on the Roll Holder.
(See "Loading Rolls on the Roll Holder →P.781 ")
If you do not attach the Spacer for Borderless Printing, the Platen may be soiled from borderless printing.

• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. In the application, create an original that takes up the entire space of the paper size.

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on

specifying the margin, refer to the software documentation.

2. Choose Print in the application menu.

3. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")
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4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

6. Select the print target in the E Print Target list.

7. Click the Page Setup tab to display the Page Setup sheet.
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8. In the A Page Size list, click the size of the original as specified in the application. In this case, click 10"x12".

9. Select and click a roll paper in the L Paper Source list.

10. Select the B Borderless Printing check box to display the Information dialog box.

11. Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).

12. Click OK to close the Information dialog box.

13. In C Borderless Printing Method, click D Fit Paper Size.

14. Click Match Page Size in the G Paper Size list.

15. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X)
This topic describes how to enlarge originals before borderless printing to match the paper size, based on the following
example.
If you use an A1 or A2 roll for borderless printing, insert the provided Spacer for Borderless Printing on the Roll Holder.
(See "Loading Rolls on the Roll Holder →P.781 ")
If you do not attach the Spacer for Borderless Printing, the Platen may be soiled from borderless printing.
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• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. Choose Page Setup from the application menu to display the Page Attributes dialog box.

2. Select the printer in the B Format for list.

3. In the C Paper Size list, click the size of the original. In this case, click 10"x12".

Note
• All sizes are available in borderless printing if you resize originals to match the paper size.

4. Click F OK to close the dialog box.

5. In the application, create an original that takes up the entire space of the paper size.

6. Choose Print in the application menu.
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7. Access the Main pane.

8. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

9. Select the print target in the E Print Target list.

10. Access the Page Setup pane.

11. Select and click a roll paper in the A Paper Source list.
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12. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, 10 in. (254.0mm).

Note
• If the width of the loaded roll is not displayed in B Roll Width, click L Printer Information on the

Main pane and update the printer information.

13. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, 10"x12".

14. Select the D Enlarged/Reduced Printing check box.

15. Select the H Borderless Printing check box.

16. Click E Fit Paper Size under D Enlarged/Reduced Printing.

17. In I Paper Size, click the paper size. In this case, click 10"x12" - Borderless.
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18. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "

Borderless Printing by Resizing Originals to Fit the Roll Width
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images) without a
surrounding margin, or border.

• Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you can
print documents without the margin, so that the printed image covers the entire surface of the paper.

Important
• Borderless printing is only available with rolls.
• Always set the blue Switch on the Platen to the ● side for borderless printing. Printing quality may be

affected if the Switch is incorrectly set.
• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular

widths. For information on types of paper compatible with borderless printing, refer to the Paper Refer-
ence Guide. (See "Types of Paper →P.773 ")

• If you use an A1 orA2 roll for borderless printing, insert the provided Spacer for Borderless Printing
onthe Roll Holder.(See "Loading Rolls on the Roll Holder →P.781 ")
If you do not attach the Spacer for Borderless Printing,the Platen maybe soiled from borderless printing.

• Paper incompatible with the printer's auto cut function can be printed without borders on the left and
right sides only.

• These features cannot be used in combination with borderless printing: special page layouts, centering
originals, and printing cut lines on rolls.

• If Fit Paper Size or Print Image with Actual Size (Windows only) is selected when performing bor-
derless printing, Rotate Page 90 degrees (Conserve Paper) cannot be selected.

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be
uneven at the edges. If you require higher image quality, specify No in Auto Cut in the printer driver. In
this case, the paper can be printed without borders on the left and right sides only. After ejecting and
cutting the printed document, use scissors to cut away the top and bottom edges.

• When CutDustReduct. is set to On, print without borders only on the left and right sides.
• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit

touches printing surfaces that are not dry yet, it may damage the paper or the edge of the document that
is cut, depending on frequency of use. In this case, follow these steps to change the ink drying time.

• On the Main sheet of the printer driver, click Settings in Media Type.
• Select the ink drying time in the Between Pages list of Drying Time.

• Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.
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• Scale to fit Roll Paper Width
Enlarge or reduce the original as a whole to match the roll paper width.

Note
• You can combine this function with rotating pages 90 degrees before printing so that the original width

(relative to portrait orientation) matches the roll paper width in borderless printing.

For instructions on borderless printing of photos, images, and other documents to match the roll paper width, refer to
the following topics, as appropriate for your computer and operating system.

• Borderless Printing by Resizing Originals to Fit the Roll Width (Windows) →P.115

• Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X) →P.117

Borderless Printing by Resizing Originals to Fit the Roll Width (Windows)
This topic describes how to enlarge originals before borderless printing to match the roll width, based on the following ex-
ample.
If you use an A1 or A2 roll for borderless printing, insert the provided Spacer for Borderless Printing on the Roll Holder.
(See "Loading Rolls on the Roll Holder →P.781 ")
If you do not attach the Spacer for Borderless Printing, the Platen may be soiled from borderless printing.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. In the application, create an original that takes up the entire space of the paper size.

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on

specifying the margin, refer to the software documentation.

2. Choose Print in the application menu.

3. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")
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4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

6. Select the print target in the E Print Target list.

7. Click the Page Setup tab to display the Page Setup sheet.
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8. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

9. Select and click a roll paper in the L Paper Source list.

10. Select the B Borderless Printing check box to display the Information dialog box.

11. Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).

12. Click OK to close the Information dialog box.

13. In C Borderless Printing Method, make sure E Scale to fit Roll Paper Width is selected.

14. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X)
This topic describes how to enlarge originals before printing to match the roll width, based on the following example.
If you use an A1 or A2 roll for borderless printing, insert the provided Spacer for Borderless Printing on the Roll Holder.
(See "Loading Rolls on the Roll Holder →P.781 ")
If you do not attach the Spacer for Borderless Printing, the Platen may be soiled from borderless printing.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
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• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. Choose Page Setup from the application menu to display the Page Attributes dialog box.

2. Select the printer in the B Format for list.

3. In C Paper Size, click the size of the original. In this case, click ISO A4.

Note
• All sizes are available in borderless printing if you resize originals to fit the roll width.

4. Click F OK to close the dialog box.

5. In the application, create an original that takes up the entire space of the paper size.

6. Choose Print in the application menu.
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7. Access the Main pane.

8. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight Coated Paper.

9. Select the print target in the E Print Target list.

10. Access the Page Setup pane.

11. Select and click a roll paper in the A Paper Source list.
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12. Make sure the width of the loaded roll is displayed in the B Roll Width list—here, 10 in. (254.0mm).

Note
• If the width of the loaded roll is not displayed in B Roll Width, click L Printer Information on the

Main pane and update the printer information.

13. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

14. Select the D Enlarged/Reduced Printing check box.

15. Select the H Borderless Printing check box.
This ensures that F Fit Roll Paper Width is automatically selected in D Enlarged/Reduced Printing.
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16. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "
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Printing Vertical or Horizontal Banners (Large-Format Printing)
On this printer, large-format printing of up to 18.0 m is available using rolls.
If you use Print Plug-In for Office or PosterArtist, you can easily print maximum 18.0 m vertical or horizontal banners.
(Refer to "Print Plug-In for Office features →P.372 " and "Using PosterArtist to Compose Originals →P.44 ".)
However, you may not be able to print 18.0 m due to restrictions in the settable document size according to the application
software.

Fit Roll Paper Width
To match the width of vertical and horizontal banners with the width of rolls, use the printer driver function for automatical-
ly enlarging/reducing and printing.
For example, if you automatically enlarge a document created with application software such as Microsoft Word, you can
print the full width of the roll easily.

For instructions on printing vertical or horizontal banners, refer to the following topics, as appropriate for your computer
and operating system.

• Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) →P.123

• Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X) →P.128

Important
• Before printing, check how much of the roll paper is left. If you have activated automatic detection of the

remaining roll paper, a warning message is displayed when there is not enough roll paper left.
• If not much ink is left, prepare replacement ink tanks.
• To print at a higher level of quality, in the printer driver, choose High in Print Quality, and choose Unidirec-

tional Printing as the direction of printing.
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Printing Vertical or Horizontal Banners (Large-Format Printing; Windows)
By automatic enlargement of a document created with an application software by the printer driver, you can print maximum
18.0 m vertical or horizontal banners.
However, you may not be able to print 18.0 m due to restrictions in the settable document size according to the application
software.
This topic describes how to print a banner about five times as long as the roll width based on the following example.

• Document: A horizontal banner created in Microsoft Word
• Page size: Non-standard (100×500 mm [3.9×19.7 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 in (406.4 mm)

The print procedure is as follows.

1. Register a Custom Paper Size in the printer driver.
Call a non-standard paper size registered in the printer driver with Custom Paper Size.
Once you register Custom Paper Size, you then can select it repeatedly from the paper size list.
Custom Paper Size can be set up to 18.0 m.

2. In the application, create an original in the size you registered.

3. Print the banner, using the settings that correspond to banners.

Registering a Custom Paper Size
This example describes how to register a paper size that is horizontally elongated and suitable for banners in either horizon-
tal or vertical format.

1. Display the printer driver dialog box.(See "Accessing the Printer Driver Dialog Box from the Operating System
Menu (Windows) →P.213 ")
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2. Click the Page Setup tab to display the Page Setup sheet.

3. Select and click a roll paper in the L Paper Source list.

4. Click O Size Options to display the Paper Size Options dialog box.

5. Enter a desired paper name in Custom Paper Size Name. My Horizontal Banner is used in this example.

6. In Units, click mm.

7. Under Paper Size, enter 100 in Width and 500 in Height.

8. Click Add to add the paper size of My Horizontal Banner.

9. Click OK to close the Paper Size Options dialog box.

10. Close the printer driver dialog box.

Note
• Although you can even set Custom Size for the paper size, the maximum settable size is 3.2 m. The setting

of Custom Size is disabled when you exit the application software.
For more information, see "Printing on Non-Standard Paper Sizes (Windows) →P.132 "

Creating the banner in the application
Follow the steps below to create the banner in Microsoft Word using the Custom Paper Size you registered.

1. Start Microsoft Word.
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2. Choose Page Setup from the File menu to display the Page Setup dialog box.

3. Under Paper Size, click the Custom Paper Size you registered—My Horizontal Banner in this example.

Important
• If My Horizontal Banner is not listed, make sure this printer is selected as the printer to use.
• In applications such as Microsoft PowerPoint that do not enable you to choose registered paper sizes,

use the custom paper size setting in Custom and specify 100×500 mm (3.9×19.7 in)

4. Set the printing orientation to horizontal.

5. Create the banner.

Printing the banner
Follow these steps to print the banner using the corresponding banner settings.

1. Choose Print in the Microsoft Word menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. After confirming that D Easy Settings is selected, click Poster in the E Print Target list.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In the A Page Size list, click the size you registered, My Horizontal Banner.

8. Select the C Enlarged/Reduced Printing check box.

Note
• If the C Enlarged/Reduced Printing check box is not displayed on the Page Setup sheet, clear the

B Borderless Printing check box.
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9. Select and click a roll paper in the L Paper Source list.

10. After you click E Fit Roll Paper Width, the Information dialog box is displayed.

11. Select the width of the loaded roll in the Roll Paper Width list. In this case, click 16-in. Roll (406.4mm), and then
click OK.

12. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

If printing is unsuccessful, you may be able to print after completing the following setting.

1. On the Layout sheet, click J Special Settings to display the Special Settings dialog box.

2. In the FineZoom Settings list, click Yes.
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Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X)
By automatic enlargement of a document created with an application software by the printer driver, you can print maximum
18.0 m vertical or horizontal banners.
This topic describes how to print a banner about five times as long as the roll width based on the following example.

• Document: An original designed for a horizontal banner
• Page Size: Non-standard (100×500 mm [3.9×19.7 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)

The print procedure is as follows.

1. In the application, create an original in the format of a horizontal or vertical banner.

2. In Page Setup, register Custom Page Sizes (Mac OS X 10.4.11–10.5) / Custom Paper Sizes (Mac OS X 10.6).
Once you register Custom Page Sizes / Custom Paper Sizes, you then can select it repeatedly from the paper size list.
Custom Page Sizes / Custom Paper Sizes can be set up to 18.0 m.

3. Print the banner, using the settings that correspond to banners.

Note
• The following procedures are based on Mac OS X 10.5. The method of setting up non-standard paper sizes

varies depending on the version of Mac OS X.

Register a Custom Page Sizes
This example describes how to register and print using a page size that is horizontally elongated and suitable for banners in
either horizontal or vertical format.

1. Create the document in the application.

2. Choose Print in the application menu.

3. Select the printer in the A Printer list.
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4. Click Manage Custom Sizes in the C Paper Size list to display the Custom Page Sizes dialog box.

5. Double-click Untitled in the list at left, and then enter a name for the page size you want to register. Here, enter
100*500.
If the Untitled size is not listed at left, click + below the list.

6. Under Page Size, enter 10 in Width and 50 in Height. Here, measurements are entered in centimeters.

7. Specify the margins by entering 0.3 in Printer Margins. Here, too, measurements are entered in centimeters.

8. Click OK to close the Custom Page Sizes dialog box.

9. In the C Paper Size list, click the size of the original. In this case, click 100*500, the size you registered.

10. In D Orientation, click the icon of the document in landscape orientation.

11. Click F OK to close the dialog box.

Print the banner
Follow the steps below to print the banner using the corresponding banner settings.

1. Choose Print in the application menu.
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2. Access the Main pane.

3. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

4. Make your selection in the E Print Target list.

5. Make your selection in the F Print Quality list.

6. Access the Page Setup pane.

7. Select and click a roll paper in the A Paper Source list.
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8. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, 16 in. (406.4mm).

Note
• If the width of the loaded roll is not displayed in B Roll Width, click L Printer Information on the

Main pane and update the printer information.

9. In C Page Size, make sure 100*500 is displayed, as registered in Page Setup.

10. Select the D Enlarged/Reduced Printing check box.

11. Click F Fit Roll Paper Width.

12. Confirm the print settings, and click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "

Printing on Non-Standard Paper Sizes
For printing on non-standard size paper, first register the paper size in the printer driver.
Once you register a paper size, you then can select it repeatedly from the paper size list. The paper size can be set up to 18.0
m.

Note
• In Windows, although you can even set Custom Size for the paper size, the maximum settable size is 3.2 m.

The setting of Custom Size is disabled when you exit the application software.

For instructions on specifying non-standard paper sizes for printing, refer to the following topics, as appropriate for your
computer and operating system.

• Printing on Non-Standard Paper Sizes (Windows) →P.132

• Printing on Non-Standard Paper Sizes (Mac OS X) →P.135
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Printing on Non-Standard Paper Sizes (Windows)
For printing on non-standard size paper, first register the paper size in the printer driver.
Call a non-standard paper size registered in the printer driver with Custom Paper Size.
Once you register Custom Paper Size, you then can select it repeatedly from the paper size list.
Custom Paper Size can be set up to 18.0 m.

Note
• Although you also can set Custom Size for the paper size temporarily, the maximum settable size is 3.2 m.

Also, the setting of Custom Size is disabled when you exit the application software.

Registering and Printing With a Custom Paper Size
This topic describes how to register a non-standard paper size by the name of 430 mm Squareand print based on the fol-
lowing example.

• Document: Any Type
• Page Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])
• Paper: Sheets
• Media Type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

1. Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.

2. Choose Print in the application menu.

3. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

4. Make sure the Main sheet is displayed.
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5. In the A Media Type list, select the type of paper that is loaded.

6. After confirming that D Easy Settings is selected, select from the E Print Target list.

7. Click the Page Setup tab to display the Page Setup sheet.

8. Click O Size Options to display the Paper Size Options dialog box.

9. Enter a desired paper name in Custom Paper Size Name. 430 mm Square is used in this example.

10. Select mm in Units.

11. Enter 430 (16.9 in) in both Width and Height.

Note
• If you select the Fix the Ratio of the Width to Height check box, after you enter a value in either

Width or Height, the other value will be automatically applied based on the original aspect ratio.

12. Click Add to register 430 mm Square.

13. Click OK to close the Paper Size Options dialog box.

14. Click Cut Sheet in the L Paper Source list.

15. In the A Page Size list, click the size you added,430 mm Square.
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16. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Printing by using Custom Size
This section describes how to print using Custom Size based on the following example.

• Document: Any Type
• Page size: Square of non-standard dimensions (430×430 mm [16.9×16.9 in])
• Paper: Sheets
• Paper type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

1. Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.

2. Choose Print in the application menu.

3. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded.

6. After confirming that D Easy Settings is selected, select from the E Print Target list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. Click Cut Sheet in the L Paper Source list.

9. Click Custom Size in the A Page Size list to display the Custom Size Settings dialog box.

10. Confirm that mm is selected in Units.

11. Enter 430 (16.9 in) in both Width and Height.

12. Click OK to close the Custom Size Settings dialog box.

13. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Printing on Non-Standard Paper Sizes (Mac OS X)
For printing on non-standard size paper, first register the paper size in the printer driver.
Call a non-standard paper size registered in the printer driver with Custom Page Sizes (Mac OS X 10.4.11-10.5)/ Custom
Paper Sizes (Mac OS X 10.6).
Once you register Custom Page Sizes / Custom Paper Sizes, you then can select it repeatedly from the paper size list.
Custom Page Sizes / Custom Paper Sizes can be set up to 18.0 m.
This topic describes how to register a non-standard paper size by the name of 430*430and print based on the following
example.

• Document: Any Type

Enhanced Printing Options > Printing banners or at other non-standard sizes >

iPF6300S Printing on Non-Standard Paper Sizes (Mac OS X)

2

135



• Page Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])
• Paper: Sheets
• Media Type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

Note
• The following procedures are based on Mac OS X 10.5. The method of setting up non-standard paper sizes

varies depending on the version of Mac OS X.

1. Create the document in the application.

2. Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.

3. Choose Print in the application menu.

4. Select the printer in the A Printer list.

5. Click Manage Custom Sizes in the C Paper Size list to display the Custom Page Sizes dialog box.

6. In Page Size, enter the height and width of the original. Here, enter 43.00 cm in Height and Width.
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7. In Printer Margins, enter 0.5 for the top and side margins and 2.3 for the bottom margin. Here, measurements are
entered in centimeters.

8. Double-click Untitled in the list at left in the Custom Page Sizes dialog box and enter the paper name—in this case,
430*430.

9. Click OK to close the Custom Page Sizes dialog box.

10. In the C Paper Size list, click the size of the original. In this case, click 430*430, the size you registered.

11. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.

12. Access the Main pane.

13. In the A Media Type list, select the type of paper that is loaded.

14. After confirming that D Easy Settings is selected, select from the E Print Target list.

15. Make your selection in the F Print Quality list.
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16. Access the Page Setup pane.

17. Click Cut Sheet in the A Paper Source list.

18. In C Page Size, make sure 430*430 is displayed, as registered in Page Setup.

19. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "
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Printing Multiple Originals Next to Each Other
By arranging originals from word-processing or spreadsheet programs or web browser screen shots next to each other on
single sheets, you can create highly expressive presentation materials, easy-to-understand meeting materials, and a variety
of other printed documents.

• Free Layout (Windows)
Besides combining multiple pages in a single-page layout, you can combine originals from multiple files—even multi-
ple source applications—in a single-page layout.

Note
• Free Layout cannot be used in 64-bit version of Windows.

Enhanced Printing Options > Tiling and multiple pages per sheet >

iPF6300S Printing Multiple Originals Next to Each Other

2

139



• imagePROGRAF Free Layout (Macintosh)
Besides combining multiple pages in a single-page layout, you can combine originals from multiple files—even multi-
ple source applications—in a single-page layout.

For instructions on arranging originals from multiple applications, refer to the following topics.

• Printing Multiple Originals Next to Each Other (Windows) →P.140

• Printing Multiple Originals Next to Each Other (Mac OS X) →P.142

Printing Multiple Originals Next to Each Other (Windows)
This topic describes how to arrange multiple originals using the Free Layout function.

Note
• Free Layout cannot be used in 64-bit version of Windows.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")
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3. Make sure the Main sheet is displayed.

4. Click the Layout tab to display the Layout sheet.

5. Select the A Page Layout check box.

6. Click Free Layout in the A Page Layout list.
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7. When you attempt to print, the imagePROGRAF Free Layout window is displayed. (At this point, the document will
not be printed yet.)

8. Edit and rearrange the image in the imagePROGRAF Free Layout window as desired.

Note
• Without closing the imagePROGRAF Free Layout window, repeat steps 1–7 to arrange originals

from multiple applications on the same page.
• For instructions on editing and rearranging images, refer to the imagePROGRAF Free Layout help

topic.

9. Print from the imagePROGRAF Free Layout menu.

Note
• For details on imagePROGRAF Free Layout functions, refer to Free Layout →P.261 .

Printing Multiple Originals Next to Each Other (Mac OS X)
This topic describes how to use the Free Layout function to arrange multiple originals next to each other before printing.

1. Choose Print in the application menu.
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2. Access the Page Setup pane.

3. Select the N Free Layout check box.

4. Click M Print.

5. The Canon imagePROGRAF Free Layout window is displayed.
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6. Edit and rearrange the image in the Canon imagePROGRAF Free Layout window as desired.

Note
• Without closing the Canon imagePROGRAF Free Layout window, repeat steps 1 to 4 to arrange

originals from multiple applications on the same page.
• For instructions on editing and rearranging images, refer to the Canon imagePROGRAF Free Lay-

out help topic.

7. Print from the Canon imagePROGRAF Free Layout menu.

Note
• For details on Canon imagePROGRAF Free Layout functions, refer to Free Layout →P.549 .

Printing Multiple Pages Continuously
You can print multiple pages as a single continuous image, without margins between pages.

• Roll paper (banner)

Important
• This feature is only available with rolls. It cannot be used when printing on sheets.
• During banner printing, settings for conserving paper, number of copies, borderless printing, enlarge-

ment or reduction, and other layout-related settings are disregarded.

For instructions on borderless printing of photos and images at actual size, refer to the following topics, as appropriate
for your computer and operating system.

• Printing Multiple Pages Continuously (Windows) →P.145

• Printing Multiple Pages Continuously (Mac OS X) →P.147
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Printing Multiple Pages Continuously (Windows)
This topic describes how to print multiple pages as a single continuous image, without margins between pages.

Important
• This feature is only available with rolls. It cannot be used when printing on sheets.
• During banner printing, settings for conserving paper, number of copies, borderless printing, enlargement or

reduction, and other layout-related settings are disregarded.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, click the type of paper that is loaded.
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5. Click the Page Setup tab to display the Page Setup sheet.

6. Select and click a roll paper in the L Paper Source list.

7. Click N Roll Paper Options to display the Roll Paper Options dialog box.

8. Select the B Banner Printing check box.

9. Click OK.

10. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "
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Printing Multiple Pages Continuously (Mac OS X)
This topic describes how to print multiple pages as a single continuous image, without margins between pages.

Important
• This feature is only available with rolls. It cannot be used when printing on sheets.
• During banner printing, settings for conserving paper, number of copies, borderless printing, enlargement or

reduction, and other layout-related settings are disregarded.
 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. Click the original size in the C Paper Size list.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, click the type of paper that is loaded.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Click Roll Paper (Banner) in the A Paper Source list.
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11. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "

Printing Multiple Pages Per Sheet
To conserve paper, you can print several pages of the original on a single sheet by reducing the original and dividing the
sheet into areas for each page.

• Page Layout
Specify a number of pages of the original to print on a single sheet, in a layout of multiple pages per sheet.

Important
• This function cannot be combined with the following options.

• Borderless Printing
• Scaling Originals (Windows)
• Banner Printing (Windows)

• When printing using this function, the Print Centered setting is disabled.

Note
• You can print up to 16 pages of the original on a single sheet.
• You can also change the page layout order and print page boundary lines, as desired.

For instructions on printing multiple pages per sheet, refer to the following topics, as appropriate for your computer
and operating system.

• Printing Multiple Pages Per Sheet (Windows) →P.149

• Printing Multiple Pages Per Sheet (Mac OS X) →P.152

Printing Multiple Pages Per Sheet (Windows)
This topic describes how to print four pages of originals together on a single sheet based on the following example.

• Document: Any Type
• Page size: A3 (297.0×420.0 mm [11.7×16.5 in])
• Paper: Roll
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• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driver
Dialog Box from Applications (Windows) →P.211 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Make your selection in the E Print Target list.

6. Make your selection in the F Print Quality list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. In A Page Size, click the size of the original as specified in the application software. In this case, click ISO A3 or
Letter (8.5"x11").

9. Select and click a roll paper in the L Paper Source list.

10. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).
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11. Click the Layout tab to display the Layout sheet.

12. Select the A Page Layout check box.

13. Click 4 Pages/Sheet in the A Page Layout list.

Note
• You can select the layout order for placing four pages on a sheet and a frame border in the Page Lay-

out Printing dialog box by clicking B Set.

14. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Printing Multiple Pages Per Sheet (Mac OS X)
This topic describes how to print four pages of an original on a single sheet, based on the following example.

• Document: Any Type
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A3.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Layout pane.

6. Click 4 in the A Pages per Sheet list.

Note
• You can choose the layout order and specify a boundary line for the four pages in B Layout Direc-

tion and C Border.

7. Access the Main pane.

8. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

9. Make your selection in the E Print Target list.

10. Make your selection in the F Print Quality list.
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11. Access the Page Setup pane.

12. Select and click a roll paper in the A Paper Source list.

13. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.
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14. Make sure C Page Size shows the original size as specified in C Paper Size in the Page Attributes dialog box—in
this case, ISO A3.

15. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "

Printing Posters in Sections
You can enlarge an original to print it in sections on several sheets. By assembling the printed sheets, you can create a post-
er larger than the maximum supported paper size of the printer.

• Page Layout
Choose poster printing.

Important
• When printing using this function, the Print Centered, Watermark, No Spaces at Top or Bottom

(Conserve Paper), and Page Options settings are disabled.

For instructions on printing large posters, refer to the following topics, as appropriate for your computer and operating
system.

• Printing Large Posters (Windows) →P.157
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Note
• This method of poster printing is supported in Windows.

Printing Large Posters (Windows)
You can enlarge an original to print it in sections on several sheets. By assembling the printed sheets, you can create a post-
er larger than the maximum supported paper size of the printer. This topic describes how to enlarge an A2 original for print-
ing it in sections on four sheets, based on the following example.

• Document: Poster
• Page size: A2 (420.0×594.0 mm [16.5 × 23.4 in])
• Paper: Sheets
• Paper Size: A2 (420.0 × 594.0 mm [16.5 × 23.4 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.

5. Click Poster in the E Print Target list.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In A Page Size, click the size of the original as specified in the application. In this case, click ISO A2.

8. Click Manual in the L Paper Source list.

9. Click the Layout tab to display the Layout sheet.
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10. Select the A Page Layout check box.

11. Click Poster (2 x 2) in the A Page Layout list.

Note
• Follow the steps below to print only a portion of the poster as divided for printing.

• Click B Set under A Page Layout to display the Pages to Print dialog box.
• On the Pages to Print dialog box, clear the check boxes of the portion you do not want to print.
• Click OK to close the Pages to Print dialog box.

12. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Enhanced Printing Options > Tiling and multiple pages per sheet >

iPF6300S Printing Large Posters (Windows)

2

159



Centering originals
Printing Originals Centered on Rolls ............................................................................................................... 160

Printing Originals Centered on Rolls (Windows) ......................................................................................... 160
Printing Originals Centered on Rolls (Mac OS X) ....................................................................................... 162

 

Printing Originals Centered on Sheets ............................................................................................................ 166
Printing Originals Centered on Sheets (Windows) ...................................................................................... 166
Printing Originals Centered on Sheets (Mac OS X) .................................................................................... 169

Printing Originals Centered on Rolls
You can print originals centered on a page—for example, if the paper is larger than the original, or if you are reducing the
original.

• Centering originals relative to roll paper width
If you use originals smaller than the roll paper width, you can center them relative to the width when printing.
Print Centered
Aligns the center of the original with the center of the roll, relative to the width.

For instructions on centering originals when printing on rolls, refer to the following topics, as appropriate for your
computer and operating system.

• Printing Originals Centered on Rolls (Windows) →P.160

• Printing Originals Centered on Rolls (Mac OS X) →P.162

Printing Originals Centered on Rolls (Windows)
This topic describes how to center originals before printing on rolls based on the following example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll width: A3/A4 roll (297.0 mm [11.7 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

Enhanced Printing Options > Centering originals >

Printing Originals Centered on Rolls iPF6300S

2

160



3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Select the print target in the E Print Target list.

6. Click the Page Setup tab to display the Page Setup sheet.
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7. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

8. Select and click a roll paper in the L Paper Source list.

9. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A3/A4 Roll (297.0mm).

10. Click the Layout tab to display the Layout sheet.

11. Select the E Print Centered check box.

12. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Printing Originals Centered on Rolls (Mac OS X)
This topic describes how to center originals before printing on rolls based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Select and click a roll paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in B Roll Width —in this case, ISO A3/A4 (297.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

13. Select the J Print Centered check box.

14. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "
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Printing Originals Centered on Sheets
You can print originals centered on a page—for example, if the paper is larger than the original, or if you are reducing the
original.

• Centering originals on sheets
If you use paper larger than the original size or print originals after reduction, the printed images may be aligned in the
upper-left corner of the paper. In this case, you can center originals on sheets when printing.
Print Centered
Aligns the center of the original with the center of the sheet.

For instructions on centering originals when printing on sheets, refer to the following topics, as appropriate for your
computer and operating system.

• Printing Originals Centered on Sheets (Windows) →P.166

• Printing Originals Centered on Sheets (Mac OS X) →P.169

Printing Originals Centered on Sheets (Windows)
This topic describes how to reduce an original 50% for printing centered on a sheet.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Make your selection in the E Print Target list.

6. Click the Page Setup tab to display the Page Setup sheet.
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7. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4.

8. Select the C Enlarged/Reduced Printing check box.

9. Click Match Page Size in the G Paper Size list.

10. Click F Scaling and enter 50.

11. Click Manual in the L Paper Source list.

12. Click the Layout tab to display the Layout sheet.

13. Select the E Print Centered check box.

14. Confirm the print settings and print as desired.

Important
• If you have selected Manual as the paper source, follow the instructions on the printer control panel

to enter the paper size.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "
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Printing Originals Centered on Sheets (Mac OS X)
This topic describes how to center originals for printing on sheets, based on the following example.

• Document: Any Type
• Page size: A4
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: Non-standard

 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4 - for Paper Tray (Large Mar-
gins).

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Make your selection in the E Print Target list.

8. Make your selection in the F Print Quality list.

9. Access the Page Setup pane.

10. Click Manual in the A Paper Source list.
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11. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4 - for Paper Tray (Large Margins).

12. Select the J Print Centered check box.

13. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "

Important
• If you have selected Manual as the paper source, follow the instructions on the printer control panel to enter

the paper size.
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Conserving roll paper
Conserving Roll Paper by Rotating Originals 90 Degrees .............................................................................. 172
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Conserving Roll Paper by Rotating Originals 90 Degrees
You can conserve roll paper by specifying particular settings as suitable for your original.

• Rotate Page 90 degrees (Conserve Paper)
When originals are printed in portrait orientation, the original is rotated 90 degrees before printing if it fits within the
roll width. This enables you to conserve paper.

Important
• If the page would exceed the roll paper width after rotation, use this function with Scale to fit Roll Paper

Width to print rotated pages.

For tips on conserving roll paper, refer to the following topics, as appropriate for your computer and operating system.

• Conserving Roll Paper by Rotating Originals 90 Degrees (Windows) →P.172

• Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X) →P.174

Conserving Roll Paper by Rotating Originals 90 Degrees (Windows)
This topic describes how to conserve paper by rotating originals 90 degrees before printing, based on the following exam-
ple.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3×11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

This example illustrates how to rotate an A4 (210.0×297.0 mm)/Letter (8.3×11.7 in) original in portrait orientation 90 de-
grees to fit within the width of A3/A4 roll paper (297.0 mm [11.7 in]), which enables you to conserve paper.

1. Choose Print in the application menu.
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2. Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driver
Dialog Box from Applications (Windows) →P.211 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Click the Page Setup tab to display the Page Setup sheet.
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6. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

7. Select and click a roll paper in the L Paper Source list.

8. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A3/A4 Roll (297.0mm).

9. Select the K Rotate Page 90 degrees (Conserve Paper) check box.

10. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X)
This topic describes how to conserve roll paper by rotating originals 90 degrees before printing, based on the following
example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

This example illustrates how to rotate an A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in) original in portrait orientation 90
degrees to fit within the width of A3/A4 roll (297.0 mm [11.7 in]), which enables you to conserve paper.
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Access the Page Setup pane.

8. Select and click a roll paper in the A Paper Source list.
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9. Make sure the width of the loaded roll is displayed in B Roll Width —in this case, ISO A3/A4 (297.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

10. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

11. Select the L Rotate Page 90 degrees check box.

12. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "
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Conserving Roll Paper by Printing Originals Without Top and Bottom Margins
You can conserve roll paper by specifying particular settings as suitable for your original.

• No Spaces at Top or Bottom (Conserve Paper)
You can print without feeding the paper for blank portions of originals if there are top and bottom margins in originals.
This enables you to conserve as much paper as the size of the margins.

Important
• Printing without the top and bottom margins is not supported in the following cases.

• Banner printing
• If you have chosen poster as the type of page layout

 

Note
• Even during borderless printing, you can print without the top and bottom margins.
• Printing without the top and bottom margins may cause inconsistency in the size of printed documents,

depending on the layout of images or text in your originals.

For tips on conserving roll paper, refer to the following topics, as appropriate for your computer and operating system.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows) →P.178

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS X) →P.180

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins
(Windows)
This topic describes how to conserve roll paper when printing originals that have a top and bottom margin, based on the
following example.

• Document: Any type
• Page size: A4 (210.0×297.0mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Click the Page Setup tab to display the Page Setup sheet.

6. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").
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7. Select and click a roll paper in the L Paper Source list.

8. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A3/A4 Roll (297.0mm).

9. Click the Layout tab to display the Layout sheet.

10. Select the G No Spaces at Top or Bottom (Conserve Paper) check box.

11. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS
X)
This topic describes how to conserve roll paper when printing originals that have a top and bottom margin, based on the
following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

7. Access the Page Setup pane.

8. Select and click a roll paper in the A Paper Source list.
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9. Make sure the width of the loaded roll is displayed in B Roll Width —in this case, ISO A3/A4 (297.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

10. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

11. Select the K No Spaces at Top or Bottom check box.

12. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "
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Checking Images Before Printing
Checking the Layout in a Preview Before Printing .......................................................................................... 184

Checking the Layout in a Preview Before Printing
You can check the print layout on the preview screen.

• Open Preview When Print Job Starts (Windows)
While viewing the preview screen, you can also adjust orientation or other settings, and your changes will be instantly
applied on the preview screen.

Note
• Under some settings and in some environments, PageComposer may be started.
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• Preview (Macintosh)
While viewing the preview screen, you can also adjust layout or size settings, and your changes will be instantly ap-
plied on the preview screen.

For instructions on how to check the layout before printing, refer to the following topics:

• Checking the Layout in a Preview Before Printing (Windows) →P.208

• Checking the Layout in a Preview Before Printing (Mac OS X) →P.492
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Printing With Watermarks
You can add watermarks (background images) to documents that require special handling.

• Watermark
Watermarks are applied to all pages of your document.

Important
• Watermarks are not printed if you select poster as the type of page layout.

The following watermarks are provided:

• CONFIDENTIAL
• COPY
• DRAFT
• FILE COPY
• FINAL
• PRELIMINARY
• PROOF
• TOP SECRET

You can also create your own watermarks. Specify the following options to customize your watermark.

• Watermark string: Specify the font, size, color, and so on. Surround the watermark with a frame, if desired.
• Watermark position: Specify the position on the page, the angle, and so on.
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• Watermark printing method: Specify whether to print the watermark superimposed or under the document image.
You can also print the watermark only on the first page, if desired.

Note
• Watermarks are supported in Windows.
• In addition to the provided watermarks, you can create up to 50 original watermarks in Windows.

For detailed instructions on printing with watermarks, refer to the following topics:

• Printing with Watermarks— COPY, FILE COPY, and so on (Windows) →P.187

Printing with Watermarks— COPY, FILE COPY, and so on (Windows)
This topic describes how to print with watermarks, based on the following example of printing with a FILE COPY water-
mark.

• Document: Any type
• Page size: A2 (420.0×594.0 mm [16.5 × 23.4 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in[)

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

3. Make sure the Main sheet is displayed.
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4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Make your selection in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View Settings.

6. Click the Page Setup tab to display the Page Setup sheet.

7. In A Page Size, click the size of the original as specified in the application software. In this case, click ISO A2.

8. Select and click a roll paper in the L Paper Source list.

9. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).
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10. Click the Layout tab to display the Layout sheet.

11. Select the C Watermark check box.

12. Click FILE COPY in the Watermarks list.

Note
• Click D Edit Watermark to open the Edit Watermark dialog box. In the Edit Watermark dialog

box, you can create custom watermarks and change the position and angle of watermarks.

13. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "
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Making the Original Orientation Match the Paper Orientation
You can specify the original orientation to match the orientation of the paper for printing.

• Orientation
Paper is usually loaded in the printer in portrait orientation. When you have an original in landscape orientation, you
can specify the printing orientation so that the original is printed in landscape orientation.

• Rotate 180 degrees
The original is rotated 180 degrees to print it upside down.

• Mirror
A mirror image of the original is printed.
For instructions on specifying the original orientation before printing, refer to the following topics, as appropriate for
your computer and operating system.

• Making the Original Orientation Match the Paper Orientation (Windows) →P.190

• Making the Original Orientation Match the Paper Orientation (Mac OS X) →P.192

Making the Original Orientation Match the Paper Orientation (Windows)
This topic describes how to print an original in landscape orientation after matching the paper orientation, based on the fol-
lowing example.

• Document: An original in landscape orientation
• Page size: A4 (210.0 × 297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then open the printer driver dialog box.(See "Accessing the Printer Driver
Dialog Box from Applications (Windows) →P.211 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5. Make your selection in the E Print Target list.

6. Make your selection in the F Print Quality list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. In the A Page Size list, click the size of the original as specified in the application. In this case, click ISO A4 or
Letter (8.5"x11").

9. In H Orientation, click J Landscape.

10. Select and click a roll paper in the L Paper Source list.

11. Select the width of the loaded roll in the M Roll Paper Width list—in this case, ISO A2/A3 Roll (420.0mm).

12. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Making the Original Orientation Match the Paper Orientation (Mac OS X)
This topic describes how to print an original in landscape orientation after matching the paper orientation, based on the fol-
lowing example.

• Document: An original in landscape orientation
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])
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1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

4. In D Orientation, click the icon of the document in landscape orientation.

5. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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6. Access the Main pane.

7. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.

8. Make your selection in the E Print Target list.

9. Make your selection in the F Print Quality list.

10. Access the Page Setup pane.

11. Select and click a roll paper in the A Paper Source list.
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12. Make sure the width of the loaded roll is displayed in the B Roll Width list—in this case, ISO A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

13. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the Page Attributes
dialog box—in this case, ISO A4.

14. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "
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Using Favorites
You can register print settings as Favorites to reuse settings from a particular job that met your expectations, or settings for
a particular page size that you will use repeatedly.

• Favorites
Registering a favorite for later use. You can choose the settings you have registered from a list before printing, and you
can check the settings details.

Note
• You can also save the favorite settings as files. Using these files is a convenient way to print under the

same conditions on another computer. (In Windows.)

For instructions on using favorites to print, refer to the following topics, as appropriate for your computer and operat-
ing system.

• Using Favorites (Windows) →P.209

• Using Favorites (Mac OS X) →P.493

Cutting Roll Paper After Printing
Roll paper can be automatically cut after printing.

Note
• It may not be possible to cut certain types of paper, such as adhesive paper. For details on types of paper that

cannot be used with the auto cut feature, see the Paper Reference Guide. (See "Types of Paper →P.773 ")

• Automatic Cutting
Roll paper is cut automatically after printing. If you prefer, you can print continuously without cutting the roll, or you
can print a cut line.
For instructions on cutting roll paper after printing, refer to the following topics, as appropriate for your computer and
operating system.

• Cutting Roll Paper After Printing (Windows) →P.196

• Cutting Roll Paper After Printing (Mac OS X) →P.198

Cutting Roll Paper After Printing (Windows)
This topic describes how to cut roll paper automatically after printing (using the auto cut function), as well as how to print a
cut line for manual cutting.

Note
• The auto cut function is activated on the printer by default and when the printer driver is installed. Follow the

steps below to reactivate the function if it is disabled, or to select the setting for printing a cut line instead.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")
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3. Click the Page Setup tab to display the Page Setup sheet.

4. Select and click a roll paper in the L Paper Source list.

5. Click N Roll Paper Options to display the Roll Paper Options dialog box.

6. To enable automatic cutting, click Yes in the A Automatic Cutting list. If you prefer to cut the paper later yourself,
click Print Cut Guideline.

7. Click OK to close the Roll Paper Options dialog box.

8. Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Windows) →P.207 "

Roll paper will be automatically cut after printing.
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Cutting Roll Paper After Printing (Mac OS X)
This topic describes how to cut roll paper automatically after printing (using the auto cut function), as well as how to print a
cut line for manual cutting.

Note
• The auto cut function is activated on the printer by default and when the printer driver is installed. Follow the

steps below to reactivate the function if it is disabled, or to select the setting for printing a cut line instead.
 

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.

3. Choose the original size in the C Paper Size list.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.
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5. Access the Page Setup pane.

6. Select and click a roll paper in the A Paper Source list.

7. Access the Main pane.

8. In the A Media Type list, select the type of paper that is loaded.
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9. Click C Set to display the Paper Detailed Settings dialog box.

10. To enable automatic cutting, click Printer Default in the H Automatic Cutting list. If you prefer to cut the paper
later yourself, click Print Cut Guideline.

Important
• If the automatic cut function has been deactivated on the printer, change the auto cut setting on the

printer Control Panel.

11. Click OK to close the Paper Detailed Settings dialog box.

12. Confirm the print settings, and then click M Print to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings (Mac OS X) →P.491 "
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Free Layout 261

Color imageRUNNER Enlargement Copy 292

Print Plug-In for Photoshop/Digital Photo Professional 307

Print Plug-In for Office 372

Status Monitor 425

Accounting 428

Digital Photo Front-Access 441

Device Setup Utility 442

Media Configuration Tool 447
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Printer Driver Settings
For instructions on accessing the Windows printer driver, refer to the following topics.

• Accessing the Printer Driver Dialog Box from Applications →P.211

• Accessing the Printer Driver Dialog Box from the Operating System Menu →P.213
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For information on the Windows printer driver settings, refer to the following topics.

• Main Sheet →P.215
You can specify the type of paper, color processing, print quality, print preview, and other settings. Choose Easy Set-
tings to specify basic print settings based on the printing application or Advanced Settings to complete more detailed
settings as desired.

• Paper Detailed Settings Dialog Box →P.220

• View Settings Dialog Box for the Printing Application →P.222

• Color Adjustment Sheet: Color →P.222

• Object Adjustment dialog box: Color →P.224

• Matching Sheet →P.225

• Ambient Light Adjust dialog box →P.227

• Light Source Check Tool →P.229

• Color Adjustment Sheet: Monochrome →P.230

• Object Adjustment dialog box: Monochrome →P.231

• Gray Adjustment Sheet →P.232

• Page Setup Sheet →P.233
You can specify the page size of the original, borderless printing, enlargement or reduction, the orientation, the paper
size and feed source, and automatic cutting.

• Output Method dialog box →P.236

• Paper Size Options Dialog Box →P.237

• Layout Sheet →P.238
You can specify the page layout, watermarks, the orientation, the number of copies, and print processing options.

• Page Options Dialog Box →P.240

• Special Settings Dialog Box →P.241

• Favorites Sheet →P.242
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Groups of print settings you select on each sheet can be saved as a favorite. Favorites you have added can be edited or
used at the time of printing as desired.

• Utility Sheet →P.244
You can specify settings related to maintenance for the Printhead and feed amount, as well as settings for Color im-
ageRUNNER Enlargement Copy.

• Support Sheet →P.245
You can view support information and the user manual.

• Device Settings Sheet →P.247
You can display settings for optional equipment installed on the printer and see the version information for the printer
driver.

imagePROGRAF Free Layout is a feature for freely arranging originals from various source applications on a single page
as desired before printing. For details, see Free Layout →P.261 .
Color imageRUNNER Enlargement Copy is a feature for automatic enlargement and printing of scanned originals from a
Color imageRUNNER. For details, see Color imageRUNNER Enlargement Copy →P.292 .

Note
• Color imageRUNNER Enlargement Copy and imagePROGRAF Free Layout cannot be used on 64-bit

version of Windows.

Specifying Paper in the Printer Driver
If you have replaced the paper, you must complete the following settings in the printer driver.

Important
• Always specify the same type and size of paper in the printer menu and printer driver.

1. Choose Print in the application menu.

Windows Software > Printer Driver >

Specifying Paper in the Printer Driver iPF6300S

3

204



2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications →P.211 ")

3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.

Note
• Click the B Get Information button to display the Paper Information on Printer dialog box. On

the Paper Information on Printer dialog box, you can obtain information on the paper in the printer
and configure printer driver settings for the feed source and type of paper.
This function requires that the Status Monitor be installed.
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5. Click the Page Setup tab to display the Page Setup sheet.

6. In the A Page Size list, select the size of the original as specified in the application.

7. In the L Paper Source list, select how paper is supplied.

8. If you have selected roll paper in L Paper Source, select the width of the loaded roll in M Roll Paper Width.

Note
• A variety of settings are available in the printer driver to suit different printing applications.

For details on available printing conditions, see "Printer Driver Settings →P.202 "
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Confirming Print Settings
There are two ways to confirm the print settings, as follows.

• Checking a preview of the settings
A preview of the settings is displayed on the left side of the Main, Page Setup, and Layout sheets. By checking illus-
trations and numerical values in the preview, you can confirm current settings for the page size, orientation, paper
source, layout, and so on.

Display Area Information Displayed

P Top illustrations Illustrations indicate the orientation, page layout, borderless printing selection, color
mode, and other settings information.

Q Middle, bordered area The page size, paper size, and method and percentage of enlargement or reduction
are indicated.

R Bottom illustrations Illustrations indicate the feed source, orientation, borderless printing selection, and
other settings information.

Note
• To confirm the Print Target specified in Easy Settings, click G View Settings on the Main sheet to

display the View Settings dialog box.

• Checking a print preview
You can check an image of the original just as it will be printed.
When you activate this feature, imagePROGRAF Preview or PageComposer is started before printing. Confirming
how documents will be printed this way helps prevent printing errors.
For details on print previews, see "Checking the Layout in a Preview Before Printing →P.184 "

Windows Software > Printer Driver >

iPF6300S Confirming Print Settings

3

207



Checking the Layout in a Preview Before Printing
This topic describes how to preview images of print jobs before actually printing them.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications →P.211 ")

3. Make sure the Main sheet is displayed.

4. Select the L Open Preview When Print Job Starts check box.
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5. After you click OK, when you print a job, the imagePROGRAF Preview window will be displayed.

Note
• If PageComposer is running, access the Special Settings dialog box from the Layout sheet and clear

Enable Preview Switching.

6. On the main window, you can check the layout and change settings as needed.

7. To print, click Print in the File menu.

Note
• For details on imagePROGRAF Preview functions, see Preview →P.248 .

Using Favorites
This topic describes how to register favorites and print using favorite settings.

Registering a favorite
This section describes the procedure for registering printing settings that have been changed in the driver as Favorites.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box. (Refer to "Accessing the Printer
Driver Dialog Box from Applications →P.211 ")

3. Perform normal printing settings.
The favorite is registered from here.
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4. Click the Favorites tab to display the Favorites sheet.

5. Click H Add to display the Add dialog box.

6. Enter a desired name in Name, such as Photos for Presentations or Monthly Report.

7. Choose a fitting icon for these print settings in the Icon list.

8. In Comment, enter a description of the favorite to be added, as desired.

9. Click OK to close the Add dialog box.
The favorite you have added is now displayed in A Favorites.

Note
• To save a favorite as a file, click J Export and specify the file to save.
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Printing using the favorite
Follow the steps below to print using the favorite you have registered.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications →P.211 ")

3. Click the Favorites tab to display the Favorites sheet.

4. In the A Favorites, choose the favorite you registered.

Note
• To import a favorite, click I Import and specify the favorite file.

5. Click D Apply Favorite to replace the favorite settings with the current print settings.

6. Confirm the print settings and print as desired.

Note
• For instructions on confirming print settings, see "Confirming Print Settings →P.207 "

Accessing the Printer Driver Dialog Box from Applications

1. Choose Print from the File menu to display the dialog box for printing conditions.
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2. Select the printer, and then display the printer driver dialog box.

Note
• The dialog box for specifying printing conditions varies depending on the source application. In some

cases, when you select the printer, a sheet for configuring the printer driver is added to the dialog box.
In the following case, click Preferences.

• Example: Print dialog box displayed by the application software
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Six sheets of print settings are displayed by the printer driver: Main, Page Setup, Layout, Favorites, Utility, and
Support.

Note
• The titles of dialog boxes may vary depending on the application, and sheets other than these six

sheets may be displayed.

Important
• If you access the printer driver dialog box from the source application, changes you make to the settings will

only apply temporarily to that application. Because these are sizes you specify temporarily in the printer driv-
er, the sizes will not be available after you exit the application.

• You can also access the printer driver dialog box from the Windows system menu.
To use the settings continuously in all applications, open the printer driver from the system menu to make the
settings.
See "Accessing the Printer Driver Dialog Box from the Operating System Menu →P.213 ".

Accessing the Printer Driver Dialog Box from the Operating System Menu

1. Click start > Printers and Faxes (or Printers ).
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2. Select the printer, and then display the printer properties dialog box.

3. Click Printing Preferences to display the Printing Preferences dialog box, titled with the name of this printer.

Note
• The Device Settings sheet is also an extension of the printer driver.(See "Device Settings Sheet

→P.247 ")
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Six sheets of print settings are displayed by the printer driver: Main, Page Setup, Layout, Favorites, Utility, and
Support.

Important
• If you access the printer driver dialog box from the operating system menu, changes you make to the settings

will apply to all applications you use for printing.
• You can also access the printer driver dialog box from applications.

See "Accessing the Printer Driver Dialog Box from Applications →P.211 ".

Main Sheet
The following settings are available on the Main sheet. For details on settings items, refer to the printer driver help file.

Note
• On the Main sheet, choose Easy Settings to specify basic print settings based on the particular printing ap-

plication, or switch to Advanced Settings to complete more detailed settings as desired.
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Common Items

• AMedia Type
Select the type of paper.
For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See " Paper Refer-
ence Guide ".)

• BGet Information
Displays Paper Information on Printer. You can update the printer driver settings for the feed source, media type,
and roll width by selecting the feed source.

• Paper Information on Printer Dialog Box →P.219

• CAdvanced Settings
Displays Paper Detailed Settings. You can configure the printing settings to match the type of media, such as the ink
drying time.

• Paper Detailed Settings Dialog Box →P.220

• LOpen Preview When Print Job Starts
If you turn this on, imagePROGRAF Preview starts before printing.
This allows you to check on-screen previews of documents before printing.

• Checking the Layout in a Preview Before Printing →P.184

• MStatus Monitor
Starts imagePROGRAF Status Monitor.
You can check the printer status, job status, and other conditions.
You can also set up email notification if printer errors occur by completing the Email Notice settings.
For details, refer to the Status Monitor help file.

• NAbout
Displays version information for the printer driver.
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• SDefaults
Restores all settings on the sheet to the default values.

Configuration using Easy Settings

• EPrint Target
Choose presets that match the type of document to be printed.

• Printing Photos and Images →P.22

• Printing Line Drawings and Text →P.47

• Printing Office Documents →P.38

Depending on the A Media Type setting, some E Print Target options may not be available.

• FPrint Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.64

• GView Settings
Displays the E Print Target setting values.
You can view and change the order of E Print Target setting values.

• View Settings Dialog Box for the Printing Application →P.222
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Configuration using Advanced Settings

• EPrint Priority
Choose the graphic elements that you want to emphasize for printing.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.64

• FPrint Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.64

• THighest quality
If you select this option, the document will be printed with enhanced quality at the highest resolution. Compared to the
other options, more time and ink are consumed in printing, however you will attain print results with the highest quali-
ty.

Note
• If you set F Print Quality to High, you can select T Highest quality. However, depending on A Me-

dia Type and E Print Priority, you may not be able to select T Highest quality.

• UEconomy Printing
If you select this option, you can print with less ink consumed. However, print quality is lower than in regular printing.
Select this option to save ink, such as when printing to check drawings. Depending on the settings of A Media Type
and F Print Quality, you may not be able to select this option.

Note
• If you set F Print Quality to Fast, you can select U Economy Printing. However, depending on

A Media Type and E Print Priority, you may not be able to select U Economy Printing.
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• GColor Mode
Choose the color mode.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.64

Note
• Depending on the A Media Type setting, some G Color Mode options may not be available.

• HColor Settings
Click to display the Color Settings dialog box for more advanced color settings.

• Adjusting the Color in the Printer Driver →P.55

• IThicken Fine Lines
Activate this option to print fine lines more distinctly.

• JUnidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the printing
speed becomes slower.

Paper Information on Printer Dialog Box
On the Paper Information on Printer dialog box, you can obtain information on the paper in the printer and configure
printer driver settings for the paper source and media type.

Note
• To display the Paper Information on Printer dialog box, on the Main sheet, click Get Information by

Media Type.(See "Main Sheet →P.215 ")

• APaper Source
Shows the paper source supported by the printer, as well as information about the loaded paper. To update the paper
source and media type settings in the printer driver, select the desired Paper Source option and click OK.
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Paper Detailed Settings Dialog Box
In the Paper Detailed Settings dialog box, you can set Drying Time for the paper selected with Media Type of the Main
sheet, etc.
You can display this dialog box by clicking Settings of Media Type on the Main sheet. (Refer to "Main Sheet
→P.215 ".)

As for the items for which you can selectPrinter Default in this dialog box, you also can set them from the control panel of
the printer. (Refer to "Menu Settings →P.914 ".)

ADrying Time
Specify the time that the printer waits for ink to dry, as needed. The Drying Time setting is only valid for rolls.

• BBetween Pages
You can set the time to wait after printing 1 document page until ejecting the paper. Since waiting time is required for
ink to dry before a roll is cut, you can deliver paper in the Output Stacker with the ink dried even if Cutting Mode is
set to Automatic.

Setting Item Details

Printer Default The setting of the control panel of the printer is applied.

Off Paper is ejected immediately after printing completes.

30 sec. / 1 min. / 3 min. / 5 min. /
10 min. / 30 min. / 60 min.

Paper is ejected when the set time elapses after printing completes.

• CBetween Scans
You can set the time to wait after printing 1 line on a page until printing the next line. Set this to avoid bleeding or
color unevenness such as when bleeding occurs on a page or when color unevenness occurs during borderless printing.

Setting Item Details

Printer Default The setting of the control panel of the printer is applied.

Off The next line is printed immediately after a line is printed.

1 sec. / 3 sec. / 5 sec. / 7 sec. / 9
sec.

The next line is printed when the set time elapses after a line is printed.
 

* Increase the time according to the occurrence condition of bleeding or unevenness.
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DRoll Paper Margin for Safety
You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to curling is held firmly
against the Platen.

• ENear End Margin
Specify the length of the Near End Margin (the leading edge margin) of the roll, as needed.

Setting Item Details

Printer Default The setting of the control panel of the printer is applied.

3 mm (0.12 in) The document is printed in the standard size.
 

* Select this when you do not have any problems in printing.

20 mm (0.8 in) Select this when rubbing against the printhead occurs such as when using paper that
tends to curl.

FCut Speed
Select the speed of automatic cutting, as needed. You can adjust this setting if paper is not cut well when automatic cutting
is used.

Setting Item Details

Printer Default The setting of the control panel of the printer is applied.

High Speed When the Standard setting does not result in cutting the surface cleanly, select this.

Standard Select this when you do not have any problems in automatic cutting.

Low Speed This helps prevent adhesive from sticking to the cutter and keeps the cutter sharp if
you select it when using adhesive paper.

HCalibration Value
You can specify whether to apply the results of calibration performed on the printer to image processing.

Setting Item Details

Printer Default The setting of the control panel of the printer is applied.

Enabled Print using the calibration results.

Disabled Print without using the calibration results. Select this to avoid the changing of the
color of images during printing by color calibration.

GMirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image with the
left and right sides inverted.

Windows Software > Printer Driver >

iPF6300S Paper Detailed Settings Dialog Box

3

221



View Settings Dialog Box for the Printing Application
In the View Settings dialog box, you can check details of the selected printing application.

Note
• To display the View Settings dialog box, on the Main sheet, click View Settings by Print Target.(See

"Main Sheet →P.215 ")

• APrint Target
Shows all Print Target options (settings items for the printing application).

• BName
Identifies the item selected in Print Target by its name and an icon.

• CDetails
Here, you can confirm detailed settings values for each listed item for the selected Print Target.

Color Adjustment Sheet: Color
If the color tone as printed is not as you expected, you can adjust it on the Color Adjustment sheet.
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Note
• To display the Color Adjustment sheet, on the Main sheet, click Color Settings by Color Mode in Ad-

vanced Settings.(See "Main Sheet →P.215 ")

• ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

• BView Color Pattern
Select this checkbox to display the color pattern.

• CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

• DCyan / EMagenta / FYellow
Fine-tune color tones by adjusting the levels of each color.

• GGray Tone
Adjust the color tone of grays as desired. Choose Cool Black (tinged with blue) or Warm Black (tinged with red).

• HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or dark-
er than the original image (that is, the original photo that was scanned or the original graphic as it appears on the com-
puter screen).

• IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast makes
images sharper, and reducing the Contrast softens images.

• JSaturation
Adjust the color intensity as desired. Increasing the Saturation setting makes colors more vivid, and reducing the
Saturation makes colors more subdued.
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• KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color ad-
justment.

• Object Adjustment dialog box: Color →P.224

• SDefaults
Click to restore all settings on the sheet to the default values.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.55 "

Object Adjustment dialog box: Color
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment sheet.

• A Image
Select this option to apply color adjustment to image areas, such as photos.

• BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

• CText
Select this option to apply color adjustment to text.
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Matching Sheet
On the Matching sheet, you can specify color matching to compensate for differences in the appearance of colors on vari-
ous devices.

Important
• If No color correction is selected under Color Mode, the Matching sheet is not displayed.

Note
• To display the Matching sheet, on the Main sheet, click Color Settings in Color Mode in Advanced Set-

tings, and then click the Matching sheet. (Refer to "Main Sheet →P.215 ")

Driver Matching Mode
The following options are available when you select Driver Matching Mode in the A Matching Mode list.

• AMatching Mode
Select the color matching mode to use, as desired.
Normally, select Driver Matching Mode. For color matching based on ICC profiles, select ICC Matching Mode,
Driver ICM Mode, or Host ICM Mode, depending on your color matching system.

• BMatching Method
Select the color matching method that suits the document to be printed. Various Matching Method options are availa-
ble depending on your selection in Matching Mode.

• CColor Space
Select the applicable color space as desired.

• DMonitor White Point
Enter the color temperature set on the monitor.
Displayed when the B Matching Method is set to Monitor Matching.
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• EUse ambient light adjustment
Select this option for adjustment of colors to suit the ambient light in the viewing environment.

• FAmbient Light Adjust
Click to display the Ambient Light Adjust dialog box, which enables you to complete settings for printing to match
the ambient light.

• Ambient Light Adjust dialog box →P.227

ICC Matching Mode, Driver ICM Mode and Host ICM Mode
The following options are available when you select ICC Matching Mode, Driver ICM Mode, or Host ICM Mode in the
A Matching Mode list.

• AMatching Mode
Select the color matching mode to use, as desired.

• B Input Profile Settings
You can select Image, Graphics, or Text. You can choose Matching Method and Input Profile.
Various options are available depending on your selected Matching Mode.
To apply the same input profile automatically for Graphics and Text, select Use the Same Profile for All Objects. To
apply separate input profiles to Graphics and Text, clear Use the Same Profile for All Objects and specify the indi-
vidual settings.

• CPrinter Profile Settings
Specify the printer profile as desired. Normally, select Auto Settings.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.55 "
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Ambient Light Adjust dialog box
The Ambient Light Adjust dialog box is used to select the setting method and to enter and select the information required
for the settings.

When you select By selecting a chart number in Setting Method

• ASetting Method
You can choose configuration based on the printed Chart or based on using the i1 colorimeter.

• BPrint Chart
Click to start the Light Source Check Tool, for printing Chart. The Light Source Check Tool must be installed to
use this function.

• Light Source Check Tool →P.229

• CChart Number
In Chart, select the number of the pattern with your desired colors.

• DColor Temperature
Enter the D Color Temperature measured during monitor calibration. Displayed when the A Matching Method is
set to Monitor Matching on the Matching sheet.

• E Illuminance
Enter the E Illuminance measured during monitor calibration. Displayed when the A Matching Method is set to
Monitor Matching on the Matching sheet.
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When you select By entering values directly in Setting Method

• ASetting Method
You can choose configuration based on the printed Chart or based on using the i1 colorimeter.

• BLighting Source Type
Select the light source measured using the i1 colorimeter.

• DColor Temperature
Enter the Color Temperature measured using the i1 colorimeter.

• E Illuminance
Enter the Illuminance measured using the i1 colorimeter.
Displayed when the A Matching Method is set to Monitor Matching on the Matching sheet.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.55 "
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Light Source Check Tool
The Light Source Check Tool enables you to print Chart.

• APrinter Name
The printer name is displayed here.

• BMedia Type
Select the paper type.(See "Types of Paper →P.773 ")

• CPaper Source
Choose the paper source, as desired.
Options displayed in the list vary depending on the selection in B Media Type in the Main sheet.

• DPrint
Click to print the Chart.
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Color Adjustment Sheet: Monochrome
On the Color Adjustment sheet for monochrome printing, you can adjust the brightness and contrast.

Note
• To display the Color Adjustment sheet, on the Main sheet, click Color Settings by Color Mode in Ad-

vanced Settings.(See "Main Sheet →P.215 ")

• ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

• BView Color Pattern
Select this checkbox to display the color pattern.

• CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

• DCyan / EMagenta / FYellow
Not available.

• GGray Tone
Not available.

• HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or dark-
er than the original image (that is, the original photo that was scanned or the original graphic as it appears on the com-
puter screen).

• IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast makes
images sharper, and reducing the Contrast softens images.
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• JSaturation
Not available.

• KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color ad-
justment.

• Object Adjustment dialog box: Monochrome →P.231

• SDefaults
Click to restore all settings on the sheet to the default values.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.55 "

Object Adjustment dialog box: Monochrome
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment sheet.

• A Image
Select this option to apply color adjustment to image areas, such as photos.

• BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

• CText
Select this option to apply color adjustment to text.
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Gray Adjustment Sheet
On the Gray Adjustment sheet, you can adjust the color balance, brightness, contrast, and other image qualities.

Note
• To display the Gray Adjustment sheet, on theMain Sheet →P.215 , select Monochrome (Photo) by Col-

or Mode in Advanced Settings, and then click Color Settings.
• Monochrome (Photo) is not available for all types of paper.

• ASample Type
The image at left is updated to reflect any changes you make to setting items on the sheet, enabling you to check the
results of adjustment.

• BSample List
Select a sample image, as desired.

• CColor Balance
Click the list to select a color balance that suits the printing application.

• DX / EY
Adjust the color balance as you check the color tone in the adjustment area.
You can adjust the square area in the center by clicking or dragging it.
Drag the vertical or horizontal scroll bars for adjustment, as desired.
You can click the arrows by the D X (horizontal) and E Y (vertical) boxes or enter the values directly.

• FBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or dark-
er than the original image (that is, the original photo that was scanned or the original graphic as it appears on the com-
puter screen).
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• GContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the G Contrast
makes images sharper, and reducing the G Contrast softens images.

• HHighlight
Adjust the brightness of the lightest portion.

• IShadow
Adjust the brightness of the darkest portion.

• SDefaults
Click to restore all settings on the sheet to the default values.

Page Setup Sheet
The following settings are available on the Page Setup sheet. For details on settings items, refer to the printer driver help
file.

• APage Size
Select the page size as specified in the source application.
For details on available page sizes, see "Paper Sizes →P.774 "
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• BBorderless Printing

Borderless printing is available if roll paper is selected in the L Paper Source list. Choose from the following options
when this setting is activated.

• Borderless Printing on Paper of Equivalent Size →P.107

• Borderless Printing by Resizing Originals to Fit the Roll Width →P.114

• Borderless Printing at Actual Size →P.99

• DFit Paper Size
Scales the document image to match the paper size.

• EScale to fit Roll Paper Width
Scales the document image to match the roll width.

• FPrint Image with Actual Size
Prints documents at their actual size. This function is available when you have selected the size same as the width of
Roll Paper for either the length or width of the document from the A Page Size list.

• GPaper Size
Available when D Fit Paper Size is selected.
Choose the size of the paper you will print on.
For details on available paper sizes, see "Paper Sizes →P.774 "
Paper sizes compatible with borderless printing are shown in the list.

• CEnlarged/Reduced Printing

Choose from the following options when this setting is activated.

• Resizing Originals to Match the Paper Size →P.73

• Resizing Originals to Fit the Roll Width →P.79

• Resizing Originals by Entering a Scaling Value →P.85

• DFit Paper Size
Scales the document image to match the paper size.

• EFit Roll Paper Width
Scales the document image to match the roll width.
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• FScaling
Resizes the document image based on a specified scaling value. Enter a value in a range of 5–600.

• GPaper Size
Choose the size of the paper you will print on.
For details on available paper sizes, see "Paper Sizes →P.774 "

• HOrientation
Choose the printing orientation.

• Making the Original Orientation Match the Paper Orientation →P.190

• KRotate Page 90 degrees (Conserve Paper)
Activate this setting to rotate the document image by 90 degrees before printing.

• Conserving Roll Paper by Rotating Originals 90 Degrees →P.172

• LPaper Source
Choose the feed source, as desired.
Options displayed in the list vary depending on the selection in Media Type on the Main sheet.

• MRoll Paper Width
Choose the roll width.
For details on available roll widths, see "Paper Sizes →P.774 "

• NRoll Paper Options
Complete optional roll paper settings. Click to display the Roll Paper Options dialog box.

Under A Automatic Cutting, you can specify Yes or No and Print Cut Guideline.

• Cutting Roll Paper After Printing →P.196

Select B Banner Printing when printing multiple pages continuously.

• Printing Multiple Pages Continuously →P.144

• OSize Options
Click to display the Paper Size Options dialog box, which enables you to register additional paper sizes or select the
size system for use.

• Paper Size Options Dialog Box →P.237

• SDefaults
Restores all settings on the sheet to the default values.
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Output Method dialog box
The Output Method dialog box allows you to select the Output Method and set the save settings when saving to the box.

Note
• To display the Output Method dialog box, on the Page Setup sheet, click Output Method. (Refer to "Page

Setup Sheet →P.233 ")

• AOutput Method
If Print is selected, the print job is saved to the printer hard disk after printing has finished.
If Save in mail box is selected, the print job is saved to the printer hard disk. If you choose Save in mail box, also
specify the destination personal box in the Mail box list.
If Print after reception is complete is checked, the print job is first saved completely on the printer hard disk before
printing begins.
These can be selected as Print options.

• BName of data to be saved
To use the file name, choose Use file name.
Otherwise choose Enter name and enter a name in Name.

• CMail box
Displays a list of mail boxes. If you choose Save in mail box, also specify the destination personal box from the list.

• DAcquire Mail Box Name
When this is clicked, the box name acquired from the printer main unit is displayed in Mail box.
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Paper Size Options Dialog Box
In the Paper Size Options dialog box, you can create and register your own Custom Paper Size. The sizes you define are
listed with standard paper sizes for selection later as needed.

Note
• To display the Paper Size Options dialog box, on the Page Setup sheet, click Paper Size Options.(See

"Page Setup Sheet →P.233 ")

• APaper Size List
Shows the names and sizes of paper that can be used with the printer driver.

• BDelete
Custom paper sizes created by users can be deleted from the A Paper Size List, as needed.
However, they cannot be deleted in the following situations.

• If a standard paper size of the printer driver is selected.
• If an oversized paper size is selected.
• If a paper size marked with a red circle is selected.

• CCustom Paper Size Name
You can name Custom Paper Size as desired.

• DUnits
Specify the desired unit of measure for the Custom Paper Size height and width.

• EPaper Size
Specify the desired Width and Height. You can make your selection from sizes that are compatible with Borderless
Printing by selecting Borderless Printing Size. To maintain the aspect ratio of the Width and Height as you resize
the paper, select Fix the Ratio of the Width to Height.

• FAdd
Enables you to register the custom paper size you have specified or overwrite an existing custom paper size.
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• GDisplay Series
You can limit the number of options shown in Page Size, Paper Size, and Paper Size List.

Layout Sheet
The following settings are available on the Layout sheet. For details on settings items, refer to the printer driver help.

• APage Layout
Activate this setting to select a particular page layout.

• Printing Multiple Pages Per Sheet →P.149

• Printing Posters in Sections →P.156

• Printing Multiple Originals Next to Each Other →P.139

• Using PosterArtist to Compose Originals →P.44

• BSet
Click to display one of the following dialog boxes depending on the selection in A Page Layout. In these dialog box-
es, you can specify layout details and which pages to print, as well as other settings.

• Page Layout Printing
• Pages to Print
• Free Layout Settings

• CWatermark
Activating this option makes two settings available, Watermarks and D Edit Watermark.

• Printing With Watermarks →P.186

• Watermarks
Lists the provided watermarks. Choose the watermark to print.
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• DEdit Watermark
Click to display the Edit Watermark dialog box for creating your own, original watermark.

• EPrint Centered
Activate this setting to print document images in the center of the paper.

• Printing Originals Centered on Rolls →P.160

• Printing Originals Centered on Sheets →P.166

• FRotate 180 degrees
Activate this option to rotate document images by 180 degrees before printing.

• GNo Spaces at Top or Bottom (Conserve Paper)
Activate this setting to print the next image skipping blank areas above and below printable data in documents, which
enables you to conserve the paper.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins →P.178

• HCopies
Enter the number of copies to print, in a range of 1–999.

• Reverse Order
Activate this option to print pages in reverse order.

• IPage Options
Click to display the Page Options dialog box, which enables you to complete settings for printing the user name, date,
or page number in the header or footer.

• Page Options Dialog Box →P.240

• JSpecial Settings
If the printing results are not as you expected, click this option to change how printing is processed.

• Special Settings Dialog Box →P.241

• SDefaults
Click to restore all settings on the sheet to the default values.
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Page Options Dialog Box
The Page Options dialog box offers the following settings.

Note
• To display the Page Options dialog box, on the Layout sheet, click Page Options.(See "Layout Sheet

→P.238 ")

• APrint Date
Select where the date is printed, as desired. To print the time as well, select B Print Time Also.

• CPrint User Name
Select where the user name is printed, as desired.

• DPrint Page Number
Select where the page number is printed, as desired.

• EFormat Settings
Click to display the Format Settings dialog box, which enables you to complete format-related settings.

Note
• If you specify the same position for multiple items, the items are printed from left to right in this order:

date, user name, and page number.
• When you print multiple pages per sheet using Page Layout Printing or similar functions, these items

will be printed for each page.
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Special Settings Dialog Box
If the printing results are not as you expected, you can change how printing is processed in the Special Settings dialog box.

Note
• To display the Special Settings dialog box, on the Layout sheet, click Special Settings.(See "Layout Sheet

→P.238 ")

• AFineZoom Settings
This function is used in large-format printing. Normally, choose Auto. If documents are not printed correctly on large-
format paper, it may help to select Yes, and if fine lines are not visible or if images are distorted when printed, it may
help to select No.

• BApplication Color Matching Priority
You can give applications priority in color management.

• CEnable Preview Switching
When this option is selected, PageComposer starts if you print with Open Preview When Print Job Starts selected on
the Main sheet.

• DFast Graphic Process
If image colors are inconsistent in printed documents or if lines are printed in varying thicknesses, clearing this option
may help produce the expected results.

Note
• This function cannot be used on 64-bit version of Windows.

• EExtend print pass
If you are concerned about uneven colors in the print result of Highest quality, selecting this option may improve
printing results. However, printing may take longer.
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Favorites Sheet
The following settings are available on the Favorites sheet. For details on settings items, refer to the printer driver help.

• AFavorites
Printing favorites you have created are listed with Default Settings favorites.

• Using Favorites →P.196

• BSettings Details
Displays details of the favorite selected in the A Favorites.

• CComment
Displays notes registered in the favorite.

• DApply Favorite
Click to change the current print settings to those of the favorite selected in the A Favorites.

• EApplication Settings Priority
Activate this setting to use settings values specified in the source application in preference to favorite settings selected
in the A Favorites, when clicking D Apply Favorite. For details on the settings items used in preference, refer to the
printer driver help.

• FDelete
Click to delete the selected favorite from the A Favorites list.

• GEdit
Click to display the Edit dialog box, which enables you to change the name and icon for the favorite selected in the
A Favorites list.
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• HAdd
Click to display the Add dialog box, which enables you to add the current print settings as a favorite.

• I Import
Click to display the Open dialog box, which enables you to import favorite settings saved as a file.

• JExport
Click to display the Save As dialog box, which enables you to save the favorite settings as a file.

• KUp
Click to move the selected favorite up in the A Favorites list.

• LDown
Click to move the selected favorite down in the A Favorites list.
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Utility Sheet
The following items can be executed on the Utility sheet. For details on the utilities, refer to the relevant utility help.

• AMaintenance
Click to start the imagePROGRAF Status Monitor, which offers the following maintenance for the printer.

• Nozzle (ink ejecting outlet) check
• Nozzle (ink ejecting outlet) cleaning
• Head alignment adjustment
• Feed amount adjustment

• BColor imageRUNNER Enlargement Copy
Click to launch Color imageRUNNER Enlargement Copy (iR enlargement copy), which enables you to create hot fold-
ers used for Color imageRUNNER Enlargement Copy and assign print settings to hot folders.

• Printing Enlargements of Scanned Originals from a Color imageRUNNER →P.304

For details, see Color imageRUNNER Enlargement Copy →P.292 .

Note
• This function is not available on 64-bit version of Windows.
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Support Sheet
On the Support sheet, you can view support information and the user's manual.

• ASupport Information
Click to access the Canon support webpage, where you can find the latest information on the printer and consumables,
check for printer driver updates, and browse other information.

• BUser Manual
Click to view the printer user's manual. This function requires the user's manual to be installed on your computer.

• CSettings Summaries
Click to display the View Settings dialog box, which enables you to confirm the settings for the Main, Page Setup,
Layout, and Favorites sheets.
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Settings Summaries Dialog Box
The Settings Summaries dialog box enables you to confirm the settings for the Main, Page Setup, Layout, and Favorites
sheets.

• ACopy
Click to copy the settings information to the clipboard. You can paste the settings information into a file created with a
text editor or similar application.
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Device Settings Sheet
Many settings items on the printer properties sheets are controlled by Windows applications. However, the Device Settings
sheet is for configuring the printer, and it is an extension of the printer driver.
The following settings are available on the Device Settings sheet.

• AAbout
You can display version information for the printer driver.
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The Features of Preview
The main features of Preview are as follows.

• While viewing this screen, you can adjust layout settings of a document created with application software.
• You can not only adjust layout settings but also your changes will be instantly applied on the preview screen, and you

can print the preview screen as it is seen.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Preview settings.

Operating Environment
You can use the Preview in the following environments.

• Compatible Operating System

• 32 bit edition Windows OS
Windows XP, Windows Server 2003, Windows Server 2003 R2, Windows Vista, Windows Server 2008, Win-
dows 7

• 64 bit edition Windows OS
Windows XP, Windows Server 2003, Windows Server 2003 R2, Windows Vista, Windows Server 2008, Win-
dows Server 2008 R2, Windows 7

Note
• For the Windows OS, use the latest version of Service Pack.

• Software that requires installation
imagePROGRAF Printer Driver
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Starting Preview
Follow the procedure below to start the Preview.

1. Start the apllication software which you use.

2. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

3. On the Main sheet, click on the Open Preview When Print Job Starts check box.
Click the OK button to save the settings.

Note
• Your printer is depicted in the lower-left area of this screen.

4. On the Print dialog box in the apllication software, click the Print button.
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5. Preview main window is displayed.

Preview Main Window
The Preview main window consists of the menu and tool bars, preview and dialog area and status bar.

Note
• You can use the View menu to show or hide the tool bar.
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• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.

• Preview Area
You can check the settings you made in this area.

• Dialog Area
This allows you to set the print conditions and perform a print job.
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For more information about Dialog Area, see "Dialog Area." →P.253

• Status Bar
This shows the message, Pages and Output Size.
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Dialog Area
You can select the layout and print on the center.

• Media Type / Paper Source /Paper Size
You can confirm the information that is set.

• Layout Selection
You can print which conserves paper by selecting the layout.
For more information about Layout Selection, see "Printing with Selecting the Layout." →P.257

• Center Originals Across Roll
You can print on the center of the media loaded in the printer.
For more information about Center Originals Across Roll, see "Print on the Center." →P.259

Note
• Available only if rolls are selected in Paper Source.

• No Spaces at Top or Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or
bottom.
For more information about No Spaces at Top or Bottom, see "Not Print Spaces at the Top/Bottom." →P.260

Windows Software > Preview >

iPF6300S Dialog Area

3

253



Note
• Available only if rolls are selected in Paper Source.

• Print Button
Click the button to start printing.

• Cancel Button
Click the button to stop printing.

• Printer Information
You can confirm the information acquired from the printer.

• Update Printer Information Button
Click the button to update the printer information with connecting to the printer.

• Status Monitor Button
Click the button to start Status Monitor.

Enlarge/Reduce the screen display
You can enlarge or reduce the screen display when you select Zoom from the View menu.

Setting Details

Fit Screen Display all.

Fit to Width Display to the width of the paper.

Reduce Display at half of the standard size.

Standard Display at the standard size.

Enlarge Display with the double of the standard size.

Enlarge More Display with the triple of the standard size.

Note
• This item can be selected even if you have clicked the ▼ button in the toolbar Zoom.

Moving a Page
You can move a page to display when you select Go to Page from the View menu.

Setting Details

First Page Go to the first page.

Previous Page Go to the previous page.

Next Page Go to the next page.

Last Page Go to the last page.

Go To Page Go to the specified page.
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Note

• You can also move a page by clicking  on the tool bar.

Using the ruler
You can confirm the layout with using the ruler.

• Switching the ruler Show/Hide
In the View menu, select Ruler to switch the ruler Show/Hide.
 

• Changing the ruler unit
You can set the ruler unit when you select Units from the View menu.

Setting Details

mm Use mm as the ruler unit.

inch Use inches as the ruler unit.

Priority setting for rotating 90 degrees
You can select Rotate 90 Degrees If Possible or Use Driver Settings from the Options menu.

Setting Details

Rotate 90 Degrees If Possible Rotates pages in portrait orientation 90 degrees before printing. Pages are only rota-
ted if they can fit lengthwise across the roll.

Use Driver Settings Follows printer driver settings when determining whether to rotate pages.
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Selecting Rotate 90 Degrees If Possible or Placing a checkmark for Rotate Page 90 degrees (Conserve Paper) on the
printer driver

Selecting Use Driver Settings
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Printing with Selecting the Layout
You can print which conserves paper by selecting the layout.

1. In Layout Selection, click the layout button to use.

Button Details

Upper Button

Turn at the position of .

Right Button

Turn at the position of .

Left Button

Turn at the position of .
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Button Details

Lower Button

Turn at the position of .

Note
• Right Button or Left Button can be selected only when the rotated pages can fit lengthwise across

the roll.
• By clicking Right Button or Left Button, you can save paper by printing in landscape orientation on

roll paper.
• You can select only Upper Button or Lower Button if Cut Sheet is selected.

Button Details

The button is selected currently.

The button can be selected.

The button can not be selected.

2. Click the Print Button.
 

Printing on the selected layout begins.
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Print on the Center
You can print on the center of the media loaded in the printer.

1. Click the Center Originals Across Roll check box on.

2. Click the Print button
 

Printing on the center begins.

Note
• Available only if rolls are selected in Paper Source.
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Not Print Spaces at the Top/Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or bottom.

1. Click the No Spaces at Top or Bottom check box on.

2. Click the Print button.
 

Printing on the settings with no spaces at top or bottom begins.
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The Features of Free Layout
The main features of Free Layout are as follows.

• Allows you to lay out at will and print a document created with application software.
• You can not only lay out multiple pages on one page but also lay out and print a multiple-file document on one page,

or lay out and print a document created with multiple application programs on one page.
• Any two pages can be arranged and printed in a layout that becomes duplex on folding.

This can be used such as for advertising posters that are suspended from the ceiling.
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Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Free Layout settings.

Operating Environment
You can use the Free Layout in the following environments.

• Compatible Operating System
Windows XP, Windows Server 2003, Windows Server 2003 R2, Windows Vista, Windows Server 2008, Windows 7

Note
• This function is not available on 64-bit version of Windows.
• For the Windows OS, use the latest version of Service Pack.

• Software that requires installation
imagePROGRAF Printer Driver

Starting Free Layout
Follow the procedure below to start the Free Layout.

1. Start the apllication software which you use.

2. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.
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3. From the list, select the printer and select the Layout sheet.

Note
• Your printer is depicted in the lower-left area of this screen.

4. In the Layout sheet, click on the Page Layout check box and select Free Layout from the list.
Click the OK button to save the settings.

Note
• When you select Free Layout, all other setting items will be disabled.
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5. On the Print dialog box in the apllication software, click the Print button.
Free Layout main window is displayed.
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Free Layout Main Window
The Free Layout main window consists of the menu and tool bars, layout area and status bar.

Note
• You can use the View menu to show or hide the tool and status bar.

• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.
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• Layout Area
This allows you to lay out objects and edit the object size and orientation.

• Status Bar
This shows the paper size, unit of length, and number of objects.

Windows Software > Free Layout >
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Detailed Settings
The printer driver opens when you select Detailed Settings from the File menu. The printer driver is used to configure basic
settings to match the type of media loaded in the printer.

Refer to Printer Driver →P.202  for details on the printer driver.

Note
• When you select the Detailed Settings, the only three sheets displayed are the Main sheet, the Page Setup

sheet, and the Layout sheet. Some of the printer driver settings may be disabled.

Windows Software > Free Layout >
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Preferences Dialog Box
This dialog box appears when you select Preferences from the File menu. This allows you to configure the preferences of
Free Layout.

• Units
Set the unit for paper length, margins, and so on.

• Gridlines
You can input a grid line width value in numerical characters so that they serve as a guide to laying out objects.

Note
• You can input between 10.0 and 200.0(mm) (between 0.39 and 7.88(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Divisions
You can change the number of divisions of grid lines so that they serve as a guide to laying out objects.

Note
• You can input between 1 and 10.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Grid Color
Select the grid line color.

• Auto Arrange Spacing
Change the object-to-object spacing to be applied in the operation of laying out objects automatically.

Note
• You can input between 0.0 and 100.0(mm) (between 0.00 and 3.94(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Windows Software > Free Layout >
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• Object Frame Style
You can select the object frame style for printing.
The following settings are available for the object frame style.

Setting Details

None You can print with no frame style.

Solid Line You can print the solid line as the frame style.

Dotted Line You can print the dotted line as the frame style.

Dashed Line You can print the dashed line as the frame style.

Crop Marks You can print with the crop marks.

Page Options Dialog Box
This dialog box appears when you select Page Options from the File menu. This allows you to configure the roll paper
length, object layout order, and margins of Free Layout.

• Roll Paper Length
Set the length of one page to print on roll paper.
The following settings are available for roll paper length.

Setting Details

Auto Settings The one-page length to be printed on roll paper is automatically set so that the laid-
out objects are printed on one page.

Manual Settings You can input the length of one page to print on roll paper in numerical characters.

Windows Software > Free Layout >
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Note
• Available only if rolls are selected in Paper Source.
• You can input between 203.2 and 18000.0(mm) (between 8.00 and 708.66(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Order
Set the object layout order.
The following settings are available for order.

Setting Details

Upper Left to Right The objects are laid out from upper left to right.

Upper Left to Bottom The objects are laid out from upper left to bottom.

Upper Right to Left The objects are laid out from upper right to left.

Lower Left to Top The objects are laid out from lower left to top.

Note
• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Vertical, you

can choose Upper Left to Right or Upper Right to Left.
• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Horizontal,

you can choose Upper Left to Bottom or Lower Left to Top.

• Margins
You can input the paper margins in numerical characters.

Note
• You can input between 0.0 and 50.0(mm) (between 0.00 and 1.97(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Zoom Dialog Box
This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen display.

• Scaling
Set the magnification for enlargement or reduction of the screen display.

Note
• You can input between 25 and 400.
• You can change the numbers by clicking ▼ button.

Windows Software > Free Layout >
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Format Dialog Box
This dialog box appears when you select Format from the Object menu after you select an object.

Size Sheet
You can rotate, enlarge, or reduce an object.

Note
• When the objects are not selected, you can not select Format.

• Rotate
When you place a checkmark here, you can select Rotate Right or Rotate Left.

Setting Details

Rotate Right Rotates the object 90 degrees clockwise.

Rotate Left Rotates the object 90 degrees counterclockwise.

Note
• When several objects are selected, you cannot select Rotate.

• Enl./Red.
When you place a checkmark here, you can select Scaling, Fit Paper Size, or Fit Photo Size.

Setting Details

Scaling Allows you to input the value of the enlargement or reduction ratio of an object.
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Setting Details

Fit Paper Size Prints by enlarging or reducing each object to match the paper size. If you are using
roll paper, objects are enlarged or reduced so that the width of each object matches
the width of the roll paper.

Fit Photo Size Prints all of the objects at the specified photo size.

Note
• You can input between 25 and 600.
• You can change the numbers by clicking either ▲ button or ▼ button.

Position Sheet
You can rotate, enlarge, or reduce an object.

Note
• When the objects are not selected, you can not select Format.

• Object Position
You can move the object position by changing the values.

Setting Details

Vertical Pos You can input the number of the vertical position in numerical characters.

Horizontal Pos You can input the number of the horizontal position in numerical characters.

Page Pos You can input the number of the page position in numerical characters.

• Object Size
You can confirm the object size.
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Note
• When several objects are selected, you cannot display Object Size.

Laying out a Multiple-File Document on One Page
You can lay out and print a multiple-file document on one page.

1. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

2. Click Properties to open the Properties dialog box.

Windows Software > Free Layout >

iPF6300S Laying out a Multiple-File Document on One Page

3

273



3. In the Page Setup sheet, select Paper Source.

Note
• Your printer is depicted in the lower-left area of this screen.

4. In the Layout sheet, click on the Page Layout check box and select Free Layout from the list.

Windows Software > Free Layout >
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Note
• Your printer is depicted in the lower-left area of this screen.
• When you select Free Layout, all other setting items will be disabled.

5. Click the OK button to save the settings.

6. In the Print dialog box, select the pages to print and the number of copies, and click the OK button.

Free Layout starts, laying out the document created with application software in the layout area as an object.

Windows Software > Free Layout >
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7. Leaving Free Layout running, open other files with the application software and repeat the above steps.

Laying out a Document Created with Multiple Application Programs on One Page
You can lay out and print a document created with multiple application programs on one page.

1. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

2. Click Properties to open the Properties dialog box.

Windows Software > Free Layout >

Laying out a Document Created with Multiple Application Programs on One Page iPF6300S

3

276



3. In the Page Setup sheet, select Paper Source.

Note
• Your printer is depicted in the lower-left area of this screen.

4. In the Layout sheet, click on the Page Layout check box and select Free Layout from the list.

Windows Software > Free Layout >
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Note
• Your printer is depicted in the lower-left area of this screen.
• When you select Free Layout, all other setting items will be disabled.

5. Click the OK button to save the settings.

6. In the Print dialog box, select the pages to print and the number of copies, and click the OK button.

Free Layout starts, laying out the document created with application software in the layout area as an object.

Windows Software > Free Layout >
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7. Leaving Free Layout running, open other files with other application software and repeat the above steps.

Selecting an Object
When an object is selected, a select box (blue border) appears around the object.

Note
• To select an object, click that object.
• To select multiple successive objects, click them while holding down the Shift key.
• To select multiple arbitrary objects, click them while holding down the Ctrl key.
• To select all objects, select Select All from the Edit menu.
• When you specify the area with dragging the mouse, the object in the area is selected.

Windows Software > Free Layout >
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Changing the Object Size
You can change the object size by means of mouse operation or by specifying a scaling value.

Note
• The vertical-to-horizontal ratio remains unchanged when the object is enlarged or reduced.

Resizing by means of mouse operation

1. Select an object.

2. Place the pointer at a corner of the selection box around the object to show the arrow handle, and drag this handle to
change the object size.

Resizing by specifying a scaling value

1. Select an object.
Click on the Enl./Red. checkbox in the Format Dialog Box →P.271  and select Scaling.

2. You either enter numbers directly.

Note
• You can input between 25 and 600.
• You can change the numbers by clicking either ▲ button or ▼ button.

3. Click the OK button.

Moving an Object
You can move the object position.

1. Select an object.

Windows Software > Free Layout >
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2. Place the pointer inside the selection box of the object to show the crosshair handle, and drag it to move the object.
Alternatively, you can move the Object Position by changing the values in Vertical Pos, Horizontal Pos and Page
Pos in the Format Dialog Box →P.271 .

Rotating an Object
You can rotate the object.

1. Select an object.

2. Select Rotate Left 90 Degrees or Rotate Right 90 Degrees from the toolbar.
Alternatively, you may click on the Rotate check box in the Format Dialog Box →P.271  then select Rotate Right
or Rotate Left, and click the OK button.

Windows Software > Free Layout >
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Laying out Objects Automatically
Click Auto Arrange Object in the tool bar. This automatically lays out objects. Alternatively, you may select Auto Ar-
range Object from the Object menu.

Note
• The object layout order varies depending on the Order setting in the Page Options Dialog Box →P.269

dialog box.

Aligning Objects
You can align objects systematically.

1. Select multiple objects.

2. Click the align button from the toolbar.
Alternatively, you may select the align menu from the Object menu.

Align Top
Lays out the objects, justifying them to the top.
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Center Vertically
Lays out the objects, justifying them to the vertical center.

Align Bottom
Lays out the objects, justifying them to the bottom.

Align Left
Lays out the objects, justifying them to the left.

Windows Software > Free Layout >
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Center Horizontally
Lays out the objects, justifying them to the horizontal center.

Align Right
Lays out the objects, justifying them to the right.

Changing the Object Overlapping Order
You can change the object overlapping order.

1. Select an object.

2. Select the Overlapping Order menu from the Object menu.

Note
• The order of overlapping affects the order of objects automatically laid out.
• You can also select by clicking the right button of the mouse on an object.
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Bring to Front
Moves the object to the frontmost position.

Send to Back
Moves the object to the backmost position.

Bring Forward
Moves the object one position to the front.

Windows Software > Free Layout >
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Send Backward
Moves the object one position to the back.

Pasting a Copied or Cut Object

1. Click Copy or Cut from the toolbar.
Alternatively, you may select Copy or Cut from the Edit menu.

2. Click Paste from the toolbar.
Alternatively, you may select Paste from the Edit menu.

Note
• The copied or cut object is laid out at the end of the page.
• You can also select by clicking the right button of the mouse on an object.
• In order to paste an object on any position that you like, you can paste the object with Pointed Paste by

clicking the right button of the mouse on any position that you want.
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Folded Duplex Window
This window is displayed if you select Folded Duplex from the Edit menu after selecting an object. Using the Folded Du-
plex function allows you to print with fold lines added.
The Folded Duplex window consists of the menu and tool bars, layout area and status bar.

Note
• The toolbar and status bar can be toggled between hidden and displayed from the View menu.

• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.

Windows Software > Free Layout >
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• Layout Area
This allows you to check the arrangement and orientation of objects.

• Status Bar
This shows the paper source, roll paper width, and output size.

Finished Size Settings Dialog Box
This dialog box is displayed when you select Finished Size Settings from the Edit menu. This allows you to configure
finished size settings.

• Finished Size
Selects the method for setting the finished size.
The following settings are available for the finished size.

Windows Software > Free Layout >
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Setting Details

Fit Roll Paper Width Prints by automatically enlarging or reducing the entire document so that the width
of the document matches the roll paper width.

Specify Folded Size Prints by automatically enlarging or reducing the entire document to match the size
of the paper. Select the actual size of the paper you want to print on in Fit Paper
Size.

Rotate Page 90 degrees (Con-
serve Paper)

Prints by rotating pages by 90 degrees. Pages are automatically rotated if they will fit
within the roll paper width when rotated, and are not rotated if they will not fit with-
in the roll paper width.

Binding Settings Dialog Box
This is displayed when you select Binding Settings from the Edit menu. This allows you to configure the binding edge
settings.

• Binding Edge
Configures the binding edge when folding paper.
The following settings are available for the binding edge.

Setting Details

Bottom Prints by placing the binding margin (gutter) at the bottom of the document.

Top Prints by placing the binding margin (gutter) at the top of the document.

• Binding
Configures the binding margin (gutter).
Prints by creating a binding margin (gutter) of the specified size. Enter the margin size as a number.

Note
• The values that can be entered are 0 to 50 (mm).

• Print Fold Lines
Configures the color and type of fold lines.

Windows Software > Free Layout >
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Note
• To not print fold lines, clear the Print Fold Lines checkbox.

• Fold Line Color
You can select the fold lines.

• Fold Line Type
You can select the fold lines.
The following settings are available for the fold line type.

Setting Details

Solid Line You can print the solid line as the frame style.

Dotted Line You can print the dotted line as the frame style.

Dashed Line You can print the dashed line as the frame style.

• Only Print Center and Edges
To print fold lines at the center and both edges, select the Only Print Center and Edges checkbox.

Prints using Folded Duplex
This prints 2 pages consecutively. Folding back the paper at the fold lines of the center substitutes for duplex printing.

1. Select two objects from the layout area of Free Layout.

2. Select Folded Duplex from the Edit menu of Free Layout.
Open the Folded Duplex window and arrange the selected objects in the layout area.

3. Open the Finished Size Settings dialog box from the Edit menu.

4. Select Fit Roll Paper Width or Specify Folded Size in Finished Size.

Note
• Rotate Page 90 degrees (Conserve Paper) is also available when Specify Folded Size is selected.

5. Click OK to save the settings.

6. Open the Binding Settings dialog box from the Edit menu.

7. Select Bottom or Top in Binding Edge.

8. Specify the Binding width in Binding.

Windows Software > Free Layout >
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9. Configure the Fold Line Color and Fold Line Type from Print Fold Lines.

Note
• When the Only Print Center and Edges checkbox is selected, fold lines are only printed at the three

locations of the center and both edges.

10. Click OK to save the settings.

11. Confirm the print setting and begin printing.

Windows Software > Free Layout >
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The Features of Color imageRUNNER Enlargement Copy
The main features of Color imageRUNNER Enlargement Copy are as follows.

• Allows the document scanned with the Color imageRUNNER to be automatically enlarged and printed.
• You can perform basic printer settings such as printer selection, media type and output profile selection, and matching

methods, in addition to borderless printing and enlargement/reduction process without growing through the printer
driver.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Color imageRUNNER Enlargement Copy settings.

Operating Environment
You can use the Color imageRUNNER Enlargement Copy in the following environments.

• Compatible Operating System
Windows XP, Windows Server 2003, Windows Server 2003 R2, Windows Vista, Windows Server 2008, Windows 7

Note
• This function is not available on 64-bit version of Windows.
• For the Windows OS, use the latest version of Service Pack.

 

• Software that requires installation
imagePROGRAF Printer Driver

Starting Color imageRUNNER Enlargement Copy
Follow the procedure below to start the Color imageRUNNER Enlargement Copy.

To start by selecting Printers and Faxes from the start button

1. Open the folder of the OS you are using for configuring printers.
For example, on Windows XP click the start button on the desktop, and then select Printers and Faxes.

Windows Software > Color imageRUNNER Enlargement Copy >
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2. Right-click the Printers icon and select Printing Preferences to open the Printing Preferences dialog box.
In the Utility sheet, click the Color imageRUNNER Enlargement Copy button.

3. The Color imageRUNNER Enlargement Copy dialog box displays.

Note
• If you click on the Add to Startup folder check box in the Color imageRUNNER Enlargement Copy

dialog box, the icon of Color imageRUNNER Enlargement Copy utility will appear on the task bar when
starting Windows thereafter.

Windows Software > Color imageRUNNER Enlargement Copy >
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To start by selecting Color imageRUNNER Enlargement Copy from the start button

1. From the Windows start button, select Color imageRUNNER Enlargement Copy.

2. The Color imageRUNNER Enlargement Copy dialog box displays.

Color imageRUNNER Enlargement Copy Dialog Box
The explanation below is on the Color imageRUNNER Enlargement Copy dialog box.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color image-

RUNNER Enlargement Copy." →P.292

• Hot Folder
The hot folder list appears.

Windows Software > Color imageRUNNER Enlargement Copy >
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• Add Button
Click the button to open the Easy Setup Wizard dialog box so that you can add a hot folder.

• Edit Button
From the Hot Folder list, select a hot folder and click the button to open the Add/Edit Hot Folder dialog box that
allows you to edit the hot folder.

• Delete Button
From the Hot Folder list, select a hot folder and click the button to delete the hot folder.

• Start Button
Clicking the button changes the status of the selected inactive Hot Folder to active.

• Stop Button
Clicking the button changes the status of the selected active Hot Folder to inactive.

• Add to Startup folder
Register the application in the Windows startup menu.

• Save Printed Data
Automatically saves printed data.

• About Button
Click the button to display the name and the version number of the utility.

• Operation Guide Button
Click the button to display the Color imageRUNNER Enlargement Copy Setup Manual.

Hot Folder
Hot folder refers to a folder used for Color imageRUNNER Enlargement Copy.

• When transferred to the PC's hot folder, the document data scanned with the Color imageRUNNER is printed in en-
larged size from the printer according to the print conditions set in the hot folder.

• You can create a new hot folder, edit or delete an existing one, and set print conditions at will.

Note
• You can create up to 20 hot folders.

Windows Software > Color imageRUNNER Enlargement Copy >
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Creating a New Hot Folder

1. Open the Color imageRUNNER Enlargement Copy dialog box, and then click the Add button.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color

imageRUNNER Enlargement Copy." →P.292

2. The Easy Setup Wizard dialog box displays.
Click the Next button.

Windows Software > Color imageRUNNER Enlargement Copy >
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3. Select the type of printer to use.
Click the Next button.

4. Select the media type to print.

Note
• If the Borderless Printing checkbox is checked, only media types that can be used for borderless

printing are displayed in the list.

Click the Next button.
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5. Select roll paper or cut sheet to print. Also, select the media size to print.
Click the Next button.

6. Select the color matching method.
Click the Next button.

7. To receive a document scanned with the Color imageRUNNER, you need to share a folder. Enter the folder shared
name in Shared Name.
Click the Next button.

Note
• This shared name is used as the name of the hot folder.
• You cannot use the Back button, after clicking the Next button here.
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8. Click Finish button to close the Easy Setup Wizard dialog box.
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The hot folder you have created appears in the Hot Folder list in the Color imageRUNNER Enlargement Copy
dialog box.

Specifying an Existing Shared Folder as a Hot Folder

1. Share the folder you want to specify as a hot folder.

2. Open the Color imageRUNNER Enlargement Copy dialog box, and then click the Add button.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color

imageRUNNER Enlargement Copy." →P.292
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3. The Easy Setup Wizard dialog box displays.
Click the Manual Settings button.

4. The Add/Edit Hot Folder dialog box displays.
Enter the hot folder name in Name.
Click the Browse botton, with selecting Specify a folder, to set the existing shared folder.

Windows Software > Color imageRUNNER Enlargement Copy >
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5. The location of the folders will appear.
Select the folder to specify a hot folder, and click the OK button.

6. As necessary, set the print conditions in the hot folder.  (See "Setting the Print Parameters.") →P.303
Click the OK button to close the Add/Edit Hot Folder dialog box.
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The hot folder you have created appears in the Hot Folder list in the Color imageRUNNER Enlargement Copy
dialog box.

Setting the Print Parameters
The printer driver opens when you click the Properties button in the Add/Edit Hot Folder dialog box. The printer driver is
used to configure basic settings to match the type of media loaded in the printer.

Refer to Printer Driver →P.202  for details on the printer driver.

Note
• The only three sheets displayed are the Main sheet, the Page Setup sheet, and the Layout sheet. Some of the

printer driver settings may be disabled.

Windows Software > Color imageRUNNER Enlargement Copy >
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• Apply Sharpness
Place a checkmark here to set the sharpness.
Drag the slider bar to the left or right to adjust. You can also adjust by directly entering a number in the numeric input
field.

Note
• You can input between 0 and 500.
• You can change the numbers by clicking either ▲ button or ▼ button.
• You cannot be applied to PDF files.

Printing Enlargements of Scanned Originals from a Color imageRUNNER
Scanned originals from a Color imageRUNNER can be enlarged and printed automatically.
Originals you create by scanning with a Color imageRUNNER are transferred to a "hot folder" and printed automatically
after enlargement according to printing conditions you specify for that folder.
This processing sequence is called the Color imageRUNNER Enlargement Copy function.
To use Color imageRUNNER Enlargement Copy, first complete these settings in the following order.

1. Register a hot folder on your computer.
Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER and complete the
settings for enlargement copy.

2. Complete the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder.

After these settings are complete, you can print enlarged copies of scanned originals from the Color imageRUNNER.

Registering a hot folder on your computer
Folders used for Color imageRUNNER Enlargement Copy (iR enlargement copy) are called hot folders. Register a hot
folder on your computer for storing scanned originals from the Color imageRUNNER. You can specify printing conditions
(such as the image quality and paper size), based on which originals transferred to the hot folder will be printed. Follow
these steps to register and modify hot folders.

1. Display the printer driver dialog box. (See "Accessing the Printer Driver Dialog Box from the Operating System
Menu .") →P.213
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2. Click the Utility tab to display the Utility sheet.

3. Click Color imageRUNNER Enlargement Copy to start the Color imageRUNNER Enlargement Copy utility.

4. Use the Color imageRUNNER Enlargement Copy utility to register or modify hot folders.
For instructions on registering and modifying hot folders, refer to the help file for the Color imageRUNNER En-
largement Copy utility.

Completing the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder. It is easy to send scanned originals to the
hot folder if you assign the scanning settings and destination to a Favorites button on the Color imageRUNNER.
For instructions on assigning scanning settings and destinations to a Favorites button, refer to the setting manual, displayed
by clicking Color imageRUNNER Enlargement Copy Setup Manual button of Color imageRUNNER Enlargement Copy
utility, or refer to the Color imageRUNNER manual.

Scanning the original and print an enlargement
Follow the steps below to scan an original on the Color imageRUNNER for enlarged printing on the printer. For detailed
instructions, refer to the Color imageRUNNER manual.

1. Load the original on the platen glass or document feeder of the Color imageRUNNER.

2. Press Send to display the screen for transmission.

3. Press Favorites, and then press the Favorites button assigned to the hot folder.
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4. Press Start on the control panel. If you scan originals on the platen glass, after scanning all originals, press Done on
the touch-panel display.
Scanned originals are sent to the hot folder and automatically enlarged and printed following the conditions you
specified for the folder.
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The Features of Print Plug-In
The main features of Print Plug-In are as follows.

• You can automatically detect the color space of Adobe RGB or sRGB-use images, etc., and automatically set optimal
profiles. Thus, you can print without the trouble of configuring settings.

• You can directly process image data on Photoshop, and forward the image data to a printer. In this way, you can proc-
ess 16-bit image data in addition to 8-bit image data.

• By using the preview function for images based on real images, and the preview function for layouts based on image
positioning by media size, you can use this software to make color adjustments and confirm print layout.

• You can perform basic printer settings such as printer selection, media type and output profile selection, and matching
methods, in addition to borderless printing and enlargement/reduction process without growing through the printer
driver.

• By using the print history management function, you can import past print settings parameters. Additionally, you can
save preferences as a file.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Print Plug-In settings (the arrangement of the image in the layout preview, the print start
position, and the media size).

• Loss of gradation in dark areas can be reduced by performing black point compensation.

Note
• Adobe CMM is required in order to use the black point compensation function.

• You can perform printing press simulation printing by specifying the printing press profile.

Operating Environment
The Print Plug-In operating environment is as follows.

• Compatible Operating System
Windows XP, Windows Vista, Windows 7

• Compatible Photoshop Version
Photoshop CS5, Photoshop CS4, Photoshop CS3

• Compatible Digital Photo Professional Version
Digital Photo Professional 3.8x or later

• Software needed for Print Plug-In Installation
Photoshop or Digital Photo Professional, imagePROGRAF Printer Driver

Note
• For the Windows OS, use the latest version of Service Pack.
• The version of supporting OS differs for each version of Photoshop, For details, consult Adobe Incorporated.
• 32-bit Print Plug-In in 32-bit Photoshop and 64-bit Print Plug-In in 64-bit Photoshop must be installed.
• The supported OS version differs for each version of Digital Photo Professional.
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Installation Procedures
The procedures to install Print Plug-In are as follows.

1. Insert the User Software CD-ROM into the CD-ROM drive to start the installer.

Note
• If the installer screen does not appear, open the CD-ROM icon in My Computer and click on set-

up.exe to open the icon.

2. Click imagePROGRAF Print Plug-in button.

3. Click the appropriate Install button for your Print Plug-In.

• For 32-bit Windows
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• For 64-bit Windows

Note
• If a version of Photoshop that is not compatible with Print Plug-In is installed, the message No

target software exists. is displayed. Install Print Plug-In in a computer with a compatible Photo-
shop installed.  (See "Operating Environment.") →P.308

• If the folder for the Photoshop Plug-In to install Print Plug-In cannot be found, Specify the des-
tination for installation of the plug-in? will appear. In this case, refer to the Photoshop manual
then specify a folder for the Plug-In.

• The Print Plug-In cannot be installed in Photoshop until after Photoshop has been installed and
then opened at least once on a PC. Install the Print Plug-In after installing, opening and quitting
Photoshop.

4. Click Next button.
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5. After you have read the Licensing Agreement, select I accept the terms of the license agreement and click the
Next button.

6. Click Install button.
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7. Click Finish button.

Print Plug-In installation is complete.

Uninstall Procedures
The procedures for uninstalling the Print Plug-In are as follows.

• Uninstall the Print Plug-In for Photoshop
 

1. Select start in Control Panel menu.

2. Open Add or Remove Programs (For Windows 7 and Windows Vista, Programs and Features).

3. Select Canon iPFxxxx Print Plug-In for Photoshop xx, then click Change/Remove.
 

• Uninstall the Print Plug-In for Digital Photo Professional
 

1. Select start in Control Panel menu.

2. Open Add or Remove Programs (For Windows 7 and Windows Vista, Programs and Features).

3. Select Canon iPFxxxx Print Plug-In for Digital Photo Professional, then click Change/Remove.

Note
• iPFxxxx is the name of your printer.

Starting from Photoshop
Follow the procedure below to start the Print Plug-In from Photoshop.

1. Start Photoshop.
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2. Open the image that you wish to print.

3. If required, select the print range.

Note
• Images for use with Print Plug-In are less than 60,000 pixels in width and height. Reduce the selec-

tion range or reduce the image with processing for images more than 60,000 pixels in width and
height, and then attempt step 3.

4. Select Export(or Data Export) from the File menu and then select the output plug-in that matches your printer.
The imagePROGRAF Print Plug-In for Photoshop window (known below as the Print Plug-In window) is displayed.

Important
• When a profile is created with a commercially available profile creation tool, it may be created in

ICCv4 format. When an image source profile is ICCv4, you must install AdobeCMM or use Print
Plug-In in a Windows Vista or later environment.
When Adobe CMM is not installed in a Windows XP environment, a message is displayed, and the
source profile changes to Adobe RGB. To use an ICCv4 profile in a Windows XP environment, exit
Plug-In and then install Adobe CMM. For details on installing Adobe CMM, refer to Using Adobe
CMM →P.348 .

Note
• If the message below is displayed but the Print Plug-In window is not displayed, install the newest

imagePROGRAF printer driver and then attempt step 3.
The imagePROGRAF Printer Driver for iPFxxxx is either not installed correctly or not instal-
led at all. Please install.
(The iPFxxxx portion of the above message will reflect your printer name.)

• If the message below is displayed but the Print Plug-In window is not displayed, convert the color
space of the image to either RGB color, grayscale, or CMYK color and then attempt step 3.
Set the color space of the image to either RGB color, grayscale, or CMYK color.

• When the color space of the entry screen is CMYK, it changes to AdobeRGB due to processing with
Print Plug-In. Also, [Relative Colorimetric] is used for the matching method.
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Starting from Digital Photo Professional
Follow the procedure below to start the Print Plug-In from Digital Photo Professional.

1. Start Digital Photo Professional.

2. Open the RGB color image that you want to print.

3. If required, select the print range.

Note
• Images for use with Print Plug-In are less than 6,000 pixels in width and height. Reduce the selection

range or reduce the image with processing for images more than 6,000 pixels in width and height, and
then attempt step 3.

4. Select File from the Plug-in printing menu and then select the output plug-in that matches your printer.
The imagePROGRAF Print Plug-In for Digital Photo Professional window (hereinafter referred to as the Print Plug-
In window) is displayed.

Important
• When a profile is created with a commercially available profile creation tool, it may be created in

ICCv4 format. When an image source profile is ICCv4, you must install AdobeCMM or use Print
Plug-In in a Windows Vista or later environment.
When Adobe CMM is not installed in a Windows XP environment, a message is displayed, and the
source profile changes to Adobe RGB. To use an ICCv4 profile in a Windows XP environment, exit
Plug-In and then install Adobe CMM. For details on installing Adobe CMM, refer to Using Adobe
CMM →P.348 .
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Print Plug-In Main Window
The Print Plug-In main window consists of the sheet selection area, and the preview and button area.

• Sheet Selection Area
The tabs used to switch between each sheet on the Print Plug-In window are displayed.

When you select a tab, a sheet is displayed. The settings available on each sheet are as follows.

• Main Sheet →P.318

• Page Setup Sheet →P.322

• Color Settings Sheet →P.325

• Print History Sheet →P.326

• Support Sheet →P.327
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• Preview Area
You can check the settings you made on the image in this area.

About the settings available on the preview area, see "Preview Area." →P.317
 

• Button Area
This contains the buttons Print, Quit and Help

• PrintButton
Click this button to begin printing.

• QuitButton
Click this button to close the Print Plug-In window and return to application software.

• HelpButton
Click this button to display the Print Plug-In Help file.

Windows Software > Print Plug-In for Photoshop/Digital Photo Professional >

Print Plug-In Main Window iPF6300S

3

316



Preview Area
You can check the settings you made on the image in this area.

• Preview
Select the preview display method.
For more information about preview, see "Utilize Three Types of Previews." →P.336

Setting Details

Print Area Layout Displays the print range and the area out of the print range in the layout matching the
Paper Size set.
 

*You can change the image print position when you drag the image while the cursor

is displayed as .

Image The entire image is displayed.
 

*You can select the print range when you drag the image while the cursor is dis-

played as .

*When you click the image while the cursor is displayed as , the selected area is
deselected.

Roll Paper Preview Display the media size and roll paper information on the top in the layout printing on
roll paper.
 

*To select Roll Paper Preview, select Roll Paper in Paper Source.

• Print Selected Range
Place a checkmark here to only print the selected range.

Note
• When you select Preview in the Image, then select a portion of the image on the preview display, this

becomes valid.

• Perform Proof in Preview
Place a checkmark here to simulate the colors of the output product in the preview.
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Note
• If Auto (Color) is selected under Output Profile, some media types are enabled.
• If ICC profile is selected under Output Profile, this is always enabled.
• The actual color balance of the print product and the simulation product may differ with some environ-

ments and conditions. In addition, when you have selected an ICC Profile with Output Profile and it is
not compatible with the printer or media that you are using, the color balance of the actual print product
will differ.

• Image Properties button

When you click the  button to open the Image Properties dialog box, where Image Size, Resolution, Bit and
Color Space information of the image imported to Print Plug-In are displayed.
Click the Close button to return to Print Plug-In.

Main Sheet
You can use this sheet to perform basic settings such as selecting a printer, setting the media type, or adjusting image quali-
ty.

• Printer
The printer types are displayed.
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• Select button
Click this button to display the Select Printer dialog box.
When you click the OK button after selecting the printer in the Select Printer dialog box, you can change the printer
that corresponds with Print Plug-In.
 

• Media Type
This allows you to select the media type.
For more information about Media Type, see "Customize Media Settings." →P.357

Note
• Always select media type that is actually set in the printer. When the media you chose is different from

the media set in the printer, you may not receive the desired print results.

• Advanced Settings button
Click the button to display the Paper Detailed Settings dialog box.
For more information about the media detailed settings, see "Paper Detailed Settings Dialog Box." →P.328
 

• Input Resolution to Plug-in
You can select the resolution to process the image with Print Plug-In.
The following settings are available for resolution.

Setting Details

Accuracy 300ppi This processes images at an accurate resolution. This can control print speed and
memory capacity.

High Accuracy 600ppi This processes images at a more accurate resolution. This setting results in the best
print quality, but this takes more time to print than Accuracy 300ppi while also re-
quiring more memory capacity.
 

*This may not be displayed depending on how you set Media Type

• Input Bit to Plug-in
You can select the bit number to process with Print Plug-In.
The following settings are available for the input bit number.

Setting Details

High Gradation 8bit This processes images with at 8bit/channel (24 bit).

Highest Gradation 16bit This processes images with at 16bit/channel (48 bit).
 

*This may not be displayed depending on how you set Media Type and Input Res-
olution to Plug-in.

• Print Mode
Selecting the printing mode strikes the balance between the quality of the printed image and printing speed.
The following settings are available for the print mode.

Setting Details

Highest A setting for printing at the highest resolution when quality is most important. Print-
ing takes longer and consumes more ink than in other modes, but this mode offers
superior printing quality.
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Setting Details

High Choose this setting to print at high resolution when quality is most important. Print-
ing takes longer and consumes more ink than in Standard or Fast modes, but this
mode offers exceptional printing quality.

Standard Choose this setting to print at standard resolution when quality and speed are both
important. Printing takes less time than in Highest or High mode.

Fast Choose this setting to print faster. Printing in fast mode can help you work more effi-
ciently when checking layouts.

Highest (Max. No. of Passes) If you are concerned about uneven colors in the print result of Highest quality, se-
lecting this option may improve printing results. However, printing may take longer.

Note
• The selectable fields may vary according to the Media Type, Input Resolution to Plug-in and Input

Bit to Plug-in settings.

• Output Profile
You can select the output profile.
The following settings are available for the output profile.

Setting Details

Auto (Color) Performs the optimum color conversion from the input image data color space infor-
mation (sRGB, Adobe RGB), media settings etc. You should normally select these
settings.

Auto (Monochrome Photo) Performs the best color conversion to monochrome from the input image data color
space information (sRGB, Adobe RGB), media settings etc.

None (No Color Correction) You cannot perform color conversion with a plug-in. This is useful for creating an
original ICC profile.

External ICC Profiles This selects printer ICC profiles to be output to ICC profiles saved in the OS stand-
ard folder. Use the color space of the input data as well as the select ICC profile to
perform color conversion.

Important
• To use an ICCv4 profile, you must install AdobeCMM or use Print Plug-In in a Windows Vista or later

environment. For details on installing Adobe CMM, refer to Using Adobe CMM →P.348 .

Note
• Auto (Monochrome Photo) can only be selected for the corresponding media types.

• Proof
This is displayed when an ICC profile is selected as the Output Profile.
When this is checked, you can perform printing press simulation prints.
Refer to Perform Printing Press Simulation Print →P.351  for details on printing press simulation prints.

• Matching Method
You can select the processing method when performing color conversion.
The following settings are available for the matching method.
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Setting Details

Perceptual This converts the image to an image with natural color balance and gradation. This is
useful for pictures.

Saturation This converts the image to an image with heightened color saturation. The color bal-
ance of pictures and drawings may change.

Relative Colorimetric This converts the image with emphasis on color balance before the conversion or on
visual color balance. This is useful for pictures and drawings.

Note
• When the Output Profile you have set is Auto (Monochrome Photo) or None (No Color Correction),

you cannot select a matching method.

• ICC Conversion Options button
This is displayed when an ICC profile is selected as the Output Profile.
When this button is clicked, the ICC Conversion Options dialog box is displayed allowing you to configure color
conversion related settings.
Refer to ICC Conversion Options dialog box →P.331  for details on ICC Conversion Options.
 

• Copies
You can input the number of print copies in numerical characters.

Note
• The maximum value is 99.
• You can change the numbers by clicking either ▲ or ▼.

• Set Configuration button
Clicking the button opens the Set Configuration dialog box that provides settings for the adjustment of image sharp-
ness and image enlargement method.
For more information about Set Configuration, see "Set Configuration Dialog Box." →P.330
 

• Defaults button
Click the button to return all of the settings on the Main sheet to their defaults.
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Page Setup Sheet
You can use this sheet to set the size of the image to be printed, the media size, and whether to enlarge/reduce the image.

• Input Image Size
The size of the image imported to Print Plug-In is displayed.
 

• Borderless Printing
When you place a checkmark here, the Specify Roll Paper Width dialog box is displayed and you can print an image
without borders.
For more information about Borderless Printing, see "Print with No Borders." →P.356

Note
• Available only if rolls are selected in Paper Source.

• Enlarged/Reduced Printing
When you place a checkmark here, you can print enlarged/reduced images.
When printing an enlarged/reduced image, select the method for enlargement/reduction. The image size sent to the
printer is displayed matching the selected method in Output Image Size.
The following settings are available for enlarged/reduced printing.

Setting Details

Fit Paper Size This automatically enlarges/reduces the entire image imported to Print Plug-In to
match the export media size when printing.

Fit Roll Paper Width This automatically enlarges/reduces the entire image imported to Print Plug-In to
match the width of the roll paper with the width of the image when printing.
 

*Displayed only if rolls are selected in Paper Source.

Scaling This enlarges/reduces the entire image by the specified scaling value. Input the scal-
ing value in numerical characters. You can specify a range between 5-600%.
 

*You can change the numbers by clicking either ▲ or ▼.
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Note
• This is not displayed when a checkmark is placed in Borderless Printing.

• Output Image Size
The output image size is displayed up to one place after the decimal point in millimeters.

Note
• When Paper Size is smaller than Output Image Size, part of the image may not print.

• Paper Size
You can select the size of the print media.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.
• This is not displayed when Fit Roll Paper Width is set in Enlarged/Reduced Printing.

• Orientation
This selects the print orientation.
The following settings are available for orientation.

Setting Details

Portrait Prints the image on the media as it appears on the screen.

Landscape Prints the image on the media rotated 90 degrees.

• Layout
You can select the print position of an image on the media.
The following settings are available for layout.
 

Layout

Setting Details

Upper-Left of Output Paper
Size

Prints the image with fitting the top left of the active print area for Paper Size.

Center of Output Paper Size Prints the center of the image on the center of the selected Paper Size.

Specify Print Start Position You can print with specifying the top and left printing start positions in From Top
Margin and From Left Margin for Paper Size.

From Top Margin Input the margin from the top of the media in numbers.
 

*You can input between -9999 and 9999 mm.

From Left Margin Input the margin from the left of the media in numbers.
 

*You can input between -9999 and 9999 mm.

Note
• Select Print Area Layout or Image in Preview when you select Layout.

 

Roll Paper Layout
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Setting Details

Upper-Left of Roll Paper Prints the top left of Media Size on the top left of the selected roll paper.

Center of Roll Paper Prints the center of Media Size on the center of the selected roll paper.

Note
• Select Roll Paper Preview in Preview when you select Roll Paper Layout.

• Paper Source
You can select the media source.
The following settings are available for media source.

Setting Details

Manual Select for manual paper feed printing.

Manual (3mm margins) Select for manual paper feed printing when you want to minimize the margin at the
far end edge of paper.

Roll Paper Select to print on roll paper.

Note
• When you select Manual (3mm margins) for Paper Source, the far end edge of printed image may

become defective depending on the paper used. If this happens, select another media source.

• Roll Paper Options button
Click this button to open the Roll Paper Options dialog box, where you can set roll paper width and perform auto cut
settings.
For more information about the roll paper options, see "Roll Paper Options Dialog Box." →P.332
 

• Size Options
Click the Size Options button to open the Size Options dialog box and you can select a media name, size and other
settings.
For more information about the size options, see "Size Options Dialog Box." →P.332
 

• Defaults button
Click the button to return all of the settings on the Page Setup sheet to their defaults.
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Color Settings Sheet
You can use this sheet to adjust image Color, Brightness, [Contrast, Saturation, and you can set the color balance of print
product more to your liking.

• Cyan / Magenta / Yellow
You can adjust the strength or weakness of a color by either inputting a numerical value or dragging the slide bar.

Note
• You can check the adjustments in the preview display.

• Gray Tone
You can adjust gray tone from cool black (cool tones) to warm black (red tones) by either inputting a numerical value
or dragging the slide bar.

Note
• You can check the adjustments in the preview display.

• Brightness
You can adjust the brightness of the printed image without losing the brightest and darkest areas by either inputting a
numerical value or dragging the slide bar.

Note
• You can check the adjustments in the preview display.

• Contrast
You can relatively adjust the brightness of the brightest and darkness areas by either inputting a numerical value or
dragging the slide bar.

Note
• You can check the adjustments in the preview display.
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• Saturation
You can adjust the saturation of vivid color balance to dark color balance by either inputting a numerical value or drag-
ging the slide bar.

Note
• You can check the adjustments in the preview display.

• Curves button
Click the button to open the Curves dialog box then set the Channel and other settings.
For more information about Curves, see "Curves Dialog Box." →P.333
 

• Defaults button
Click the button to return all of the settings on the Color Settings sheet to their defaults.
 

Print History Sheet
You can use this sheet to apply settings history used in printing, and to print information, such as the image file name, with
the image.

• Print History and Favorites
This displays a list of print preferences.
Select Restore Defaults and click the Apply button to restore all settings to their initial settings.

Note
• You can check the 3 print preferences in the preview display.

• Apply button
When you click the button, the print setting content applies to the current image selected with Print History and Fa-
vorites.
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• Details button
Click the Details button to open the Print History Details dialog box, where you can manage print history.
For more information about the print history details, see "Print History Details Dialog Box." →P.334
 

• Print Information
When you place a checkmark here, you can print the file name and print time and date on the image. The following
settings are available for the print position and content.
For more information about Print Information, see "Set Information to Print with Image." →P.370

Setting Details

Information Print Position Selects the information print position.

Top (Header) Information is printed on the top of the image.

Bottom (Footer) Information is printed on the bottom of the image.

Print History Number Place a checkmark here to print the print history number.

File Name Place a checkmark here to print the file name.

Printed at Place a checkmark here to print the time and date.

Color Adjustment Value Place a checkmark here to print the color adjustment value.

Printer Name Place a checkmark here to print the printer name.

Comment Place a checkmark here to print the comment details.

Comment Details Place a checkmark here to display the comment details.

• Edit Comment button
Click the button to display the Edit Comment dialog box, where you can edit the comment.
 

Support Sheet
You can display product support information and the electronic manual.
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• Support Information button
Click the button to display websites that contain the latest product information.

Note
• An Internet connection is needed to view the websites.

• User Manual button
Click the button to display the printer manuals installed on the computer.

Note
• You must have User Manual installed on your computer.

• About button
Click the button to open the version information window of the Print Plug-In. Click the OK button in the version infor-
mation window to return to the Print Plug-In window.
 

Paper Detailed Settings Dialog Box
This dialog box appears when you click the Advanced Settings button on the Main Sheet. You can set Drying Time and
Roll Paper Margin for Safety by media type.

• Drying Time
Between Pages
This sets the wait time for the ink to dry between each completely printed sheet and the output of the sheet.

Setting Details

Printer Default The settings of the printer operating panel are applied.

None The paper is ejected immediately after printing.

30sec. / 1min. / 3min. / 5min. /
10min. / 30min. / 60min.

The sheet is ejected when the specified time after printing has elapsed.

Between Scans
This sets the wait time between line scans during printing.
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Setting Details

Printer Default The settings of the printer operating panel are applied.

None The printing continues to the next line immediately after the last line.

1sec. / 3sec. / 5sec. / 7sec. / 9sec. The printing continues to the next line after the set time.
 

*For the media type that has problems, such as ink smears on the page or colors that
seem uneven during borderless printing etc., increase the value for this setting.

• Roll Paper Margin for Safety
Near End Margin
This sets the length of the near end margin of the roll paper.

Setting Details

Printer Default The settings of the printer operating panel are applied.

3mm Print at a standard size.
 

*Select for Media Type that has no problem when printing with a standard size mar-
gin.

20mm Select this when rubbing against the printhead occurs such as when using paper that
tends to curl.

• Cut Speed
This selects the auto cut speed.

Setting Details

Printer Default The settings of the printer operating panel are applied.

Fast Select this setting if cutting with the Standard setting is not clean.

Standard Select this setting when you are not experiencing problems.

Slow This helps prevent adhesive from sticking to the cutter and keeps the cutter sharp if
you select it when using adhesive paper.

• Calibration Value
When calibration has been carried out on the printer, use this setting to choose whether or not to use the results.

Setting Details

Printer Default The settings of the printer operating panel are applied.

Use Value The calibration results are used for printing.

Disregard Value The calibration results are not used for printing. Select this option to avoid changes
to image color tones during printing due to color calibration.

• Mirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image with
the left and right sides inverted.
 

• Unidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the printing
speed becomes slower.
 

• High-Precision Text and Fine Lines
Print increasing ink impact accuracy, particularly for sharper text and fine lines. However, this takes more time than
regular printing.
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Note
• When Highest (Max. No. of Passes) is selected as the print mode, High-Precision Text and Fine

Lines cannot be selected.
 

Set Configuration Dialog Box
This dialog box appears when you click the Set Configuration button on the Main Sheet. You can set the adjustment of
image sharpness and image enlargement method.

• Sharpen
Performs adjustment of the sharpness (outline) settings.
 

• Image Enlargement Method
You can select the image enlargement method.
The following settings are available for the image enlargement method.

Setting Details

Nearest Neighbor Performs simple enlargement.

Bilinear Performs line vector enlargement.

Bicubic Adjust pixels with calculation of elements such as a color or brightness of neighbor-
ing pixels.

• Close Plug-in After Printing
When you place a checkmark here, the plug-in closes after printing finishes.

Note
• If printing does not finish correctly because it was canceled or an error occurred, the plug-in does not

close.

• Initialize all warning dialog boxes
When this is checked, all of the warning dialog boxes that have been set to "Do not show this screen again" become
displayed.
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ICC Conversion Options dialog box
This is displayed when an ICC profile is selected in the Output Profile list in the Main sheet and the ICC Conversion
Options button is clicked. This allows you to configure detailed color matching related settings.

• Conversion Engine
Selects the conversion engine to use when converting colors.

Note
• Adobe CMM needs to be installed in order to use Adobe CMM. Refer to Using Adobe

CMM →P.348  for details on how to install Adobe CMM.
 

• Black Point Compensation
Check this check box to perform black point compensation. Loss of gradation in dark areas can be improved by per-
forming black point compensation.

Note
• This can be used if Adobe CMM is selected as the Conversion Engine.

 

• Proof Options
Configures settings related to printing press simulation.
The proof options consist of the following settings.

Setting Details

Simulate Paper Color Select this when performing paper color simulation. When this is on, Simulate
Black Ink is automatically turned on and becomes grayed out.

Simulate Black Ink Select this when performing simulation of black ink. In order to enable this setting,
Adobe CMM needs to be selected under Conversion Engine.
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Roll Paper Options Dialog Box
This dialog box appears when you click the Roll Paper Options button on the Page Setup Sheet. You can set the roll paper
width and perform the auto cut settings.

• Roll Paper Width
This selects the width of the roll media set to the printer.
 

• Automatic Cutting
You can set the printer to cut roll paper automatically or print a guideline for cutting.
The following settings are available for automatic cutting.

Setting Details

Available Each page is automatically cut after it is printed.

None Each page is not cut after it is printed and printing continues without interruption.

Print Cut Guideline A print cut guideline is printed after each page and printing continues without inter-
ruption.

• No Spaces at Top or Bottom (Conserve Paper)
When you place a checkmark here, the print data is printed without margins.
 

Size Options Dialog Box
This dialog box appears when you click the Size Options button on the Page Setup Sheet. You can select a media name,
size and other settings.

• Paper Size List
Displays all the standard sizes and custom media sizes.
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• Custom Paper Size Name
You can enter any name up to 63 characters.
 

• Units
You can select the units of measure to use when you define custom media size. Switching this setting resets the units of
measure for the entire Plug-In.
 

• Paper Size
Width
Enter the width of the media size.
 

Height
Enter the height of the media size.

• Add button
Click the button to register the contents of the settings.
 

Curves Dialog Box
This dialog box appears when you click the Curves button on the Color Settings Sheet. You can set Channel and other
settings.

• Channel
Select from among RGB, Red, Green, or Blue.

Note
• Gray is displayed for monochrome printing and this selection cannot be changed.

• Input
Enter an input value.
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Note
• The allowed entry range is 0 to 255.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Output
Enter an output value.

Note
• The allowed entry range is 0 to 255.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Load Curves button
Click the button to load stored data for a tone curve.
 

• Save Curves button
Click the button to stores the current tone curve settings.
 

Print History Details Dialog Box
This dialog box appears when you click the Details button on the Print History Sheet. This controls print history. For more
information about Print History Details, see "Utilize Print History." →P.358

• Print History
Print History appears in list format.

Display Items Details

Print History Number Displays the print history number.

File Name Displays image file name.

Printed at Displays time and date of printing.
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Display Items Details

Comment Displays comment details.

Note
• Up to 200 print history items can be displayed. All items above 200 are deleted.

• When you cannot print properly because you canceled the printing or an error occurred, appears  to
the left of the print history number.

• Delete button
Click the button to delete the selected print history.
 

• Add button

Click the  button to add the selected print history to preferences.

Note
• Up to 200 print preference items can be added.

• Favorites
The print history stored in print preferences displays in list format.

Note
• You can change the order by selecting an item and dragging it to another place.

• Import button
Click the button to import print history saved as a file.
 

• Export button
Click the button to save print history as a file that is stored in print preferences.
 

• Delete button
Click the button to delete print history stored in print preferences.
 

• Settings
Displays the print history settings selected from the Print History or Favorites.

Setting Details

Main When you select this the Main sheet settings are displayed.

Page Setup When you select this the Page Setup sheet settings are displayed.

Color Settings When you select this the Color Settings sheet settings are displayed.
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Utilize Three Types of Previews
You can use Print Plug-In to check an image in three types of previews.
The preview types are as follows.

• Check Image with Print Area Layout →P.336

• Check the original image with Image →P.337

• Check Image with Roll Paper Preview →P.338

Check Image with Print Area Layout
Displays the print range and the area out of the print range in the layout matching the media size set in the print area layout.
Select Print Area Layout in Preview.

Note

• When the cursor on the preview is displayed as  on the preview, you can specify the print position by
dragging the image.

• When the cursor is displayed as  on the preview, the below conditions on the Page Setup sheet have all
been met.

• There is no checkmark in Borderless Printing.
• There is no checkmark in Enlarged/Reduced Printing or Scaling has been selected.
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Check the original image with Image
In the image preview you can check the entire image that you have input.
Select Image in Preview.

Note

• When the cursor appears as a small magnifying glass  while there is an Image in the Preview area,
the Selected Range feature is enabled and you an drag the cursor on the image and select an area for print-
ing.

• When you click the image while the cursor is displayed as  on the preview, the selected area is deselec-
ted.
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Check Image with Roll Paper Preview
Display the media size and roll paper information on the top in the layout printing on roll paper in Roll Paper Preview
Select Roll Paper Preview in Preview.

Note
• To select Roll Paper Preview in Preview, select Roll Paper in Paper Source.

Print with a Desired Picture Quality
You can specify and print at the resolution you desire.

1. Display the Main sheet.
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2. Select the media set to the printer in Media Type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different

from the media set in the printer, you may not receive the desired print results.

3. Choose either Accuracy 300ppi or High Accuracy 600ppi for the resolution to process images in Input Resolution
to Plug-in.

Note
• When you select Accuracy 300ppi images are processed at an accurate resolution. This can control

print speed and memory capacity.
• When you select High Accuracy 600ppi images are processed at a more accurate resolution. This

setting results in the best print quality, but this takes more time to print than Accuracy 300ppi while
also requiring more memory capacity.

• High Accuracy 600ppi will not display with some Media Type settings.

4. Choose either High Gradation 8bit or Highest Gradation 16bit for the bit number when processing images in
Input Bit to Plug-in.

Note
• When you select High Gradation 8bit, images are processed at 8 bit/channel (24 bit).
• When you select Highest Gradation 16bit, images are processed at 16bit/channel (48 bit).
• Highest Gradation 16bit will not display with some Media Type or Input Resolution to Plug-in

settings.

5. Select the mode to be printed when processing images in Print Mode.

Note
• The settings that can be selected differ by Media Type,Input Resolution to Plug-in, and Input Bit

to Plug-in selected.

6. Click the Print button.
 

Printing begins.

Adjust the Colors and Print
You can adjust the colors to your liking and print images.
The explanation below is on 6 ways to adjust the colors using Print Plug-In.

• Adjust the Colors while Checking the Preview (for Color) →P.340

• Adjust the Colors while Checking the Preview (for Monochrome) →P.341

• Adjust the Colors by Color Matching →P.345

• Print High-Quality Adobe RGB16bit Images →P.346

• Prints monochrome photographs with high quality →P.348

• Using Adobe CMM →P.348
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Adjust the Colors while Checking the Preview (for Color)
You can adjust the colors while checking the adjustments in the preview.
The following explanation is on the procedures for adjusting example image below.

• Low for Cyan
• High for Yellow
• Low for Saturation
• Warm Black for Gray Tone
• Enhance brightness for the curves

The above image adjustments are reflected in the before and after images below.

Before Application After Application

1. Display the Color Settings sheet.

2. Drag the slide bar in the direction of Low in Cyan.
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3. Drag the slide bar in the direction of High in Yellow.

4. Drag the slide bar in the direction of Low in Saturation.

5. Drag the slide bar in the direction of Warm Black in Gray Tone.

Note
• You can change the numbers by inputting in numerical characters.
• You can change the numbers by clicking either ▲ button or ▼ button.

6. Click the Curves button then click near the center of the curve.

7. Enter 120 in Input and 135 in Output then click the OK button.

8. Click the Print button.
 

The adjustments are reflected in the image and printing begins.

Adjust the Colors while Checking the Preview (for Monochrome)
You can adjust the colors while checking the adjustments in the preview.
The following explanation is about the procedures for adjusting example image below.

• Low for Contrast
• Light for Highlight
• Light for Shadow
• Enhance brightness for the curves

The unapplied and the applied images of the above image adjustments are as below.
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Before Application After Application

1. Open the Main sheet.

2. Select Auto (Monochrome Photo) in Output Profile.
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3. Open the Color Settings sheet.

4. In Contrast, drag the slide bar toward Low.

5. In Highlight, drag the slide bar toward Light.

6. In Shadow, drag the slide bar toward Light.

Note
• You can change the numbers by inputting in numerical characters.
• You can change the numbers by clicking either ▲ button or ▼ button.

7. Click the Curves button then click near the center of the curve.
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8. Enter 120 in Input and 135 in Output then click the OK button.

9. Click the Print button.
 

This applies the image adjustments and starts the print job.
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Adjust the Colors by Color Matching
When you print a color image imported from a scanner or a digital camera, the image may appear different from the image
on the screen. That is due to the differences in color on the screen and in the printer. In Print Plug-In, you can get the color
balance of the print product closer to the color balance displayed on the screen through performing ICC (International Color
Consortium) color profile settings, matching method settings, and settings for the internal profile, which performs optimum
color conversion in response to media and resolution settings.

1. Display the Main sheet.

2. Select the profile in Output Profile.

Note
• When you place a checkmark in Perform Proof in Preview, you can check the color matching in the

preview. This may not be displayed depending on how you set Media Type.
• The details of Output Profile you have set is saved even when you close the Print Plug-In, but when

the specified profile cannot be located it is set to Auto (Color).
• If an ICC profile is selected as the Output Profile, Adobe CMM can be selected as the color conver-

sion engine. Refer to Using Adobe CMM →P.348  for details.

3. Select the profile matching method in Matching Method.

4. Click the Print button.
 

Printing begins with the output profile and matching method that you have set.
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Print High-Quality Adobe RGB16bit Images
This prints a high-quality Adobe RGB16bit image taken with a high-end digital camera. Print Plug-In allows you to print
high color gamut and high tone images, when the Adobe RGB16bit image data has been retouched in Photoshop, without
compromising the level of tone in the image.

1. Select the Adobe RGB16bit image data in Photoshop and start Print Plug-In.  (See "Starting from Photoshop.")
→P.312

2. Click button.

3. Check that Adobe RGB is displayed in Color Space, and 16bit/channel is displayed in Bit in the Image Properties
dialog box, and click the Close button.
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4. Display the Main sheet.

5. Select High Accuracy 600ppi in Input Resolution to Plug-in.

6. Select Highest Gradation 16bit in Input Bit to Plug-in.

7. Select the highest quality possible in Print Mode.

8. If required, adjust the colors using color matching.

Note
• For more information about the color matching, see "Adjust the Colors by Color Matching."

→P.345

9. Click the Print button.
 

Printing of the Adobe RGB16bit image begins.
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Prints monochrome photographs with high quality
Prints images captured with a scanner or digital camera in monochrome with high quality. Provides stable monochrome
photo images without color casts and minimizes the influences of the difference of the light source.

1. Display the Main sheet.

2. Select Auto (Monochrome Photo) in Output Profile.

Note
• Auto (Monochrome Photo) can be selected only after a compatible Media Type has been selected.

3. Click the Print button.
 

Performs conversion to the most suitable monochrome and printing begins.

Using Adobe CMM
Adobe CMM is a color conversion engine made by Adobe. Using Adobe CMM makes it possible to obtain uniform color
conversion results and to use the black point compensation function.

• How to Obtain Adobe CMM
Adobe CMM can be obtained using the following procedure.

1. Open the Adobe website (http://www.adobe.com).

2. Enter "Adobe CMM" in the search input box on the screen.

3. Search for the "Adobe Color Management Module (CMM)" item and select the Windows version.

4. Download the file by following the on-screen directions.
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5. Start the installer in the downloaded file to perform the installation.

Important
• Use version 1.1 or higher of Adobe CMM.

• Adobe CMM System Requirements
The system requirements for Adobe CMM are as follows.

• Supported OS
Windows XP SP2, Windows Vista
 

• Supported CPU
Intel Xeon, Xeon Dual, Intel Centrino, Pentium 4 processor

Note
• Check with Adobe for details.

• How to Use Adobe CMM
The procedure for using Adobe CMM is as follows.

1. Display the Main sheet.

2. Select one of the ICC profiles as the Output Profile.

3. Click the ICC Conversion Options button.
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4. In the ICC Conversion Options dialog box, select Adobe CMM from Conversion Engine.

5. Click the OK button to close the ICC Conversion Options dialog box.

Perform Black Point Compensation
Black point compensation that is equivalent to Photoshop can be performed using the following procedure. Use this to avoid
saturation in the black areas of images.

Important
• Adobe CMM needs to be installed in order to use black point compensation. Refer to Using Adobe

CMM →P.348  for details on how to install Adobe CMM.

1. Display the Main sheet.

2. Select one of the ICC profiles as the Output Profile.

3. Click the ICC Conversion Options button to open the ICC Conversion Options dialog box.
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4. Select Adobe CMM as the Conversion Engine.

5. Check the Black Point Compensation check box.

6. Click the OK button to close the ICC Conversion Options dialog box.

Perform Printing Press Simulation Print
You can perform printing press simulation prints by specifying ICC profiles such as Japan Color or SWOP, and specifying
an ICC profile for the printing press.

1. Display the Main sheet.

2. Select one of the ICC profiles as the Output Profile.

3. Check the Proof check box and select the profile for the printing press you want to target from the list on the right.
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4. Click the ICC Conversion Options button to open the ICC Conversion Options dialog box.

5. Configure the Proof Options as needed.

Note
• The proof options are Simulate Paper Color and Simulate Black Ink. The settings that can be selec-

ted vary depending on the Conversion Engine settings.

6. Click the OK button to close the ICC Conversion Options dialog box.

7. Click the Print button.
Printing begins.

Enlarge/Reduce and Print
You can enlarge or reduce an image in Print Plug-In.
Three methods to enlarge/reduce and print are as follows.

• Enlarge/Reduce and Print Matching Output Media Size →P.352

• Enlarge/Reduce and Print Matching Width of Roll Paper →P.354

• Specify Scaling, Enlarge/Reduce and Print →P.355

Enlarge/Reduce and Print Matching Output Media Size
By specifying the media type loaded in the printer, the image can be enlarged or reduced to fit the size of the image area of
the media. This feature is useful when you need to print on the full width of Media that you have selected.

Note
• When you need to print on the full width of roll media, see "Enlarge/Reduce and Print Matching Width of

Roll Paper." →P.354

• When you do the procedure below to print on roll media, the print job will match the size of the output with
the media selected with the Paper Size setting.
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1. Display the Page Setup sheet.

2. Select the size of the media that you want to print in Paper Size.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.
• This is not displayed when Fit Roll Paper Widthis set in Enlarged/Reduced Printing.

3. Select either Portrait or Landscape as the media orientation for the image in Orientation.

Note
• When you select Portrait, the image on the media prints as it appears on the screen.
• When you select Landscape, the image on the media prints rotated 90 degrees.

4. Click the Enlarged/Reduced Printing check box on.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.

5. Select Fit Paper Size.

6. Click the Print button.
 

The image prints filling the entire output media surface.
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Enlarge/Reduce and Print Matching Width of Roll Paper
You can enlarge/reduce and print an image matching the width of the roll paper set in the printer. This is useful when you
wish to print an image that covers the entire width of the roll paper.

Note
• Printing will not occur properly when a print roll is not set to the printer.

1. Display the Page Setup sheet.

2. Select Roll Paper in Paper Source.

3. Click the Roll Paper Options button.

4. Set the roll paper options and click the OK button.

Note
• For more information about the Roll Paper Options dialog box, see "Roll Paper Options Dialog

Box." →P.332

• Click the Defaults button to return all of the roll paper option settings to their defaults.

5. Select either Portrait or Landscape as the media orientation for the image in Orientation.

Note
• When you select Portrait, the image on the media prints as it appears on the screen.
• When you select Landscape, the image on the media prints rotated 90 degrees.

6. Click the Enlarged/Reduced Printing check box on.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.
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7. Select Fit Roll Paper Width.

8. Click the Print button.
 

The image prints covering the entire width of the roll paper.

Specify Scaling, Enlarge/Reduce and Print
You can specify scaling to enlarge/reduce an image and print. This is useful when you wish to print an image at a specific
size.

1. Display the Page Setup sheet.

2. Select the size of the media that you want to print in Paper Size.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.
• Fit Roll Paper Widthis set in Enlarged/Reduced Printing.

3. Select either Portrait or Landscape as the media orientation for the image in Orientation.

Note
• When you select Portrait, the image on the media prints as it appears on the screen.
• When you select Landscape, the image on the media prints rotated 90 degrees.

4. Click the Enlarged/Reduced Printing check box on.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.
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5. Select Scaling and input the scaling factor or drag the four corners of the image in the Preview display.

Note
• You can specify scaling rate in intervals of 0.01%.
• You can specify a range between 5.00-600.00%.
• The size of the width and height proportionally grow when the image is enlarged/reduced.

6. Either drag the image on the Print Area Layout preview, or set the print position Layout.

7. Click the Print button.
 

Printing begins at the set scaling rate.

Print with No Borders
You can use the borderless printing function to print without margins surrounding the image.

Note
• With some media borderless printing can be performed only between two edges.
• To use the borderless printing function, the specified media must be set to the printer.

1. Display the Page Setup sheet.

2. Select Roll Paper in Paper Source.

3. Click the Borderless Printing check box on.

Note
• Select the width for roll paper set in the printer in Roll Paper Width in the Specify Roll Paper

Width dialog box, and click OK.
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4. Click the Print button.
 

Borderless printing begins.

Customize Media Settings
You can customize media settings.

1. Display the Main sheet.

2. Select the media type that you wish to customize in Media Type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different

from the media set in the printer, you may not receive the desired print results.

3. Click the Advanced Settings button.

4. Perform the settings in the Paper Detailed Settings Dialog Box →P.328  and click the OK button.
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Utilize Print History
When you perform various settings and print in Print Plug-In, those settings are saved as print history. Also, you can export
and import as files. You can store often-used print history under a specified name in print preferences.

Note
• You can save up to 200 print history items. All items over 200 are deleted in chronological order.

You can do the following things using print history.

• Confirm Print History Details →P.358

• Apply Print History to an Image →P.360

• Store Print History to Print Preferences →P.360

• Delete Print History →P.363

• Export Print History from Print Preferences →P.365

• Import Print History to Print Preferences →P.366

• Delete Print History from Print Preferences →P.368

• Set Information to Print with Image →P.370

Confirm Print History Details
You can confirm the print history details.

1. Display Print History sheet.
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2. Click the Details button.

Note
• Select the print history you wish to check the details of, from either Print History or Favorites in the

Print History Details dialog box.

3. Check the print history details in Settings, and click the OK button.

Note
• You can display the print history details by switching the sheets.
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Apply Print History to an Image
You can use previous print history, and apply it to an image.

1. Display the Print History sheet.

2. If required, check the print history details.  (See "Confirm Print History Details.") →P.358

3. Select the print history you wish to apply from Print History and Favorites, and click the Apply button.

Store Print History to Print Preferences
You can store often-used print history to print preferences. Not only can you store the print history stored under a different
name in print preferences, you can also find it with ease.

Note
• You can store up to 200 print history items to print preferences.
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1. Display the Print History sheet.

2. Click the Details button.

3. Select the print history you wish to store in print preferences from Print History in the Print History Details dialog
box, and check the print history details in Settings.
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4. Select the print history you wish to store in print preferences from Print History and click the  button.

5. In the Add Favorites dialog box input the name of the print history in Name, input a comment in Comment, and
click the OK button.
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6. Click the OK button to close the Print History Details dialog box.

Delete Print History
You can delete print history.

Important
• Be aware that you cannot undo deletions of print history.

1. Display the Print History sheet.

2. Click the Details button.
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3. Select the print history you wish to delete from Print History in the Print History Details dialog box, and click the
Delete button.

4. Click the OK button.

5. Click the OKbutton to close the Print History Details dialog box.
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Export Print History from Print Preferences
You can export print history stored in print preferences as a file.

1. Display the Print History sheet.

2. Click the Details button.

3. Select the print history you wish to export from Favorites in the Print History Details dialog box, and click the
Export button.
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4. Input the name of the print history in File Name in the Save As dialog box, and click the Save button.

 

The print history is exported under the specified file name.

5. Click the OK button to close the Print History Details dialog box.

Import Print History to Print Preferences
You can import print history in file format and store it to print preferences.

1. Display the Print History sheet.

2. Click the Details button.
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3. Click the Import button in the Print History Details dialog box.

4. Select the print history you wish to import in the Open dialog box, and click the Open button.

The print history is imported.

Note
• The print history file name suffix is *.pjb.
• You cannot import a print history file exported from a different OS in Print Plug-In.
• You cannot import a print history file exported from a different printer in Print Plug-In.
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5. Click the OK button to close the Print History Details dialog box.

Delete Print History from Print Preferences
You can delete print history store to print preferences. You cannot store more than 200 print history items in print preferen-
ces.

1. Display the Print History sheet.

2. Click the Details button.

Windows Software > Print Plug-In for Photoshop/Digital Photo Professional >

Delete Print History from Print Preferences iPF6300S

3

368



3. Select the print history you wish to delete from Favorites in the Print History Details dialog box, and click the
Delete button.

4. Click the OK button.

5. Click the OK button to close the Print History Details dialog box.
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Set Information to Print with Image
You can print information with an image that is related, such as the file name and the time and date.

Note
• When you use the borderless printing function to print, the information will not be printed.  (See "Print with

No Borders.") →P.356

• When the printed information is too long as does not fit on the media, a break will appear in the printed infor-
mation.

• The information may print on the image data with some media sizes, enlargement rates and print position
values.

• When Keep Media Size is set to On on the printer, a portion of bottom of the print data is not printed.

1. Display the Print History sheet.

2. Click the Print Information check box on.

3. Select the position where you wish to print the information in Information Print Position.

4. Click the information check box you wish to print on.

5. When you wish to edit the comment, click the Edit Comment button.

Note
• When you do not wish to edit the comment, move to step 7.
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6. Input the comment in the Edit Comment dialog box, and click OK button.

7. Click the Print button.

Comments are printed with images.
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Print Plug-In for Office features
Print Plug-In for Office is a Plug-In that enables easy printing from Microsoft Office.

• It is displayed on the toolbar/ribbon, so it is easily accessible.
• It can be set by just selecting from the Wizard.
• Large-Format Printing custom size can also be set in the Wizard from Microsoft Word or Microsoft PowerPoint.
• Custom size can be set automatically from Microsoft Excel.
• The layout can be checked before printing by starting the preview screen.

Important
• The Print Plug-In for Office toolbar/ribbon might not be displayed in Microsoft Office after installing im-

agePROGRAF Print Plug-In for Office.
Refer to the following topic for details on how to display the imagePROGRAF Print Plug-In for Office
toolbar/ribbon.

• When Print Plug-In for Office is not displayed →P.377
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Operating Environment
Print Plug-In for Office 's operating environment is as below.

• Compatible Operating System

• 32 bit edition Windows OS
Windows XP, Windows Server 2003, Windows Server 2003 R2, Windows Vista, Windows Server 2008, Win-
dows 7

• 64 bit edition Windows OS
Windows Vista, Windows Server 2008, Windows Server 2008 R2, Windows 7

Note
• 64 bit edition Windows OS operates only on WOW64 (32 bit emulator).
• For the Windows OS, use the latest version of Service Pack.

 

• Software that requires installation
Microsoft Office XP/2003/2007/2010
imagePROGRAF Printer Driver Ver. 3.95 or later
 

• Hardware
CPU 2.8 GHz Pentium 4 or better
RAM 1GB or more(512MB or more for Windows XP and Windows Server 2003)
HDD (free space) 20GB or more

Important
• If you opened the Office document from Internet Explorer, the software will not run correctly.
• If you are editing an embedded object or link object, the software will not run correctly.
• If you added the imagePROGRAF Print Plug-In ribbon to the Microsoft Office 2007/2010 Quick Access

toolbar, the software will not run correctly.

Steps to install
Below are the steps to install Print Plug-In for Office.

Note
• You must log into Windows as an Administrator before the installation.

1. Insert "User Software CD-ROM" into the CD-ROM drive and start the installer.

Note
• If the installer screen does not display, open the CD-ROM icon from My Computer, click setup.exe,

and open the icon.
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2. Click the Install Individual Software button.

3. Click Install in imagePROGRAF Print Plug-In for Office.
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4. Click the Next button.

5. Read the License Agreement, and click the Yes button.
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6. Click the Start button.

7. Click the Yes button.

8. Click the Exit button.

The installation for Print Plug-In for Office is complete.
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Important
• When you install this software, the virtual printer Canon imagePROGRAF PrintPlugIn may be installed. If

you want to use this software, do not uninstall the virtual printer Canon imagePROGRAF PrintPlugIn.
• The Print Plug-In for Office toolbar/ribbon might not be displayed in Microsoft Office after installing im-

agePROGRAF Print Plug-In for Office.
Refer to the following topic for details on how to display the imagePROGRAF Print Plug-In for Office
toolbar/ribbon.

• When Print Plug-In for Office is not displayed →P.377

Steps to uninstall
Below are the steps to uninstall Print Plug-In for Office.

1. If Microsoft Office is open, close it.

2. Select Control Panel from the start menu.

3. Open Add or Remove Programs.

4. Select imagePROGRAF Print Plug-In, and click the Remove button.

Note
• You cannot uninstall Print Plug-In for Office if an Office application is running. When a message appears,

select Cancel and close all Office applications that are running.

When Print Plug-In for Office is not displayed
Buttons such as Start imagePROGRAF Print Plug-In sometimes do not appear in the Word, PowerPoint and Excel
Office applications, and the Print Plug-In for Office functions are not available.
In this event, re-install Print Plug-In for Office.
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If you are using Microsoft Office 2003 or later, you can also enable add-ins to display Print Plug-In for Office.
See below for the procedure for re-installing the plug-in or enabling add-ins.

Re-installing Print Plug-In for Office

• If a problem occurs, such as the system or an application terminating abnormally, the Microsoft Office application
disables add-ins as a safety precaution.

In this event, you will need to re-install Print Plug-In for Office to display the imagePROGRAF Print Plug-In toolbar/
ribbon.

Note
• You cannot re-install Print Plug-In for Office once an Office application is running. When the message ap-

pears, select Cancel and close the active Office application.

Re-install Print Plug-In for Office as follows:

1. Close Microsoft Office if it is open.

2. Install Print Plug-In for Office.
For information about instsalling, see "Steps to install." →P.373

Enabling Print Plug-In for Office for items disabled in Office applications

• If a problem occurs, such as the system or an application terminating abnormally, the Microsoft Office application
disables add-ins as a safety precaution.

In this event, you will need to restore the disabled add-ins in order to display the imagePROGRAF Print Plug-In toolbar/
ribbon.
Use the procedure below to restore the add-ins disabled by Microsoft Office.
 

For Microsoft Office 2010

1. Select Options from the File menu.

2. From the list on the left side of the <application name> options dialog box, select Add-ins.
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3. Select Disabled Items in the Manage combo box and click the Go button.

4. If Addin imageprograf print plug-in (ipfaddinif.dll) is displayed in the Disabled Items dialog box, select it and
click the Enable button.

5. Close all the dialog boxes and restart the Office application.
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For Microsoft Office 2007

1. Click the Office button and then click the <application name> options button.

2. From the list on the left side of the <application name> options dialog box, select Add-ins.

3. Select Disabled Items in the Manage combo box and click the Go button.
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4. If Addin imageprograf print plug-in (ipfaddinif.dll) is displayed in the Disabled Items dialog box, select it and
click the Enable button.

5. Close all the dialog boxes and restart the Office application.

For Microsoft Office 2003

1. Click About <application name> in the Help menu of application.
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2. Click the Disabled Items button in the About <application name> dialog box.

3. If Addin imageprograf print plug-in (ipfaddinif.dll) is displayed in the Disabled Items dialog box, select it and
click the Enable button.

4. Close all the dialog boxes and restart the Office application.

To start from Microsoft Word
Below are the steps to start Print Plug-In for Office from Microsoft Word.

1. Start Microsoft Word.

Windows Software > Print Plug-In for Office >

To start from Microsoft Word iPF6300S

3

382



2. If Start imagePROGRAF Print Plug-In is displayed on the toolbar/ribbon, click it.

Important
• If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.

• When Print Plug-In for Office is not displayed →P.377

3. Check that the imagePROGRAF Print Plug-In toolbar/ribbon is displayed.

4. Click the buttons on the toolbar/ribbon according to the items you want to set.

Icon Contents

Menu

Displays the About, Help, and Special Settings dialog boxes.
You can change the settings using the Special Settings dialog box.
Refer to Configuring Special Settings →P.423  for details.

Printer list

Select Printer.
If you select Show All Printers, the imagePROGRAF printers will be displayed
again. Select this when you want to display all printer drivers or update the display.

Print Button

The print Wizard is displayed.
The settings Print Matching Roll Width, Borderless Printing, Multi-Page Print-
ing, and Print Using Registered Settings can be set.

Paper Settings Button

Large-Format Wizard is displayed.
Settings for Portrait or Landscape Orientation can be set.
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Printing Wizard dialog box

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close the

Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar.

Large-Format Printing Wizard dialog box
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Important
• If you want to change the display to another file or application while the Large-Format Printing Wizard is

open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to change dis-
plays or operate the toolbar/ribbon.

• The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

Print Matching Roll Width (Word)
Prints to the edge of the roll width. You can print large exhibits and posters, and also print Portrait and Landscape orienta-
tions made in Large-Format Printing Wizard.

1. Start Microsoft Word.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.
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4. Click Print Matching Roll Width.

5. Select Roll Paper Width that is set in the printer.

6. Select image size.

7. Select layout.

8. Select Next.
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9. Select Media Type.

10. Select Print Range from All Pages, Current Page, and Pages.
If Pages is selected, enter the number of pages.

11. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• When Saturation is selected, you can print posters, etc., vividly.
• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to

need print multiple times using the same setting.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• When you print to the edge of the roll width, the maximum length will be the lesser of 5.587 times the

roll paper width, or 18.0m.

12. Press Print to start printing.

Borderless Printing (Word)
Prints up to the border of the media. Photos and posters can be printed without worrying about margins.

1. Start Microsoft Word.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.
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3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4. Click Borderless Printing.
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5. A confirmation dialog box is displayed. If the data fills up the page, confirm that Continue using the plug-in is
selected in Choose how to proceed and press OK.

Note
• To adjust the data, select Return to application and press OK. Exit Print Plug-In for Office and

return to the application.

6. Select Roll Paper Width that is set in the printer.

7. Select Layout.
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8. Select Next.

9. Select Media Type.

10. Select Print Range from All Pages, Current Page, and Pages.
For Pages, insert the page number.

11. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• When Saturation is selected, you can print posters, etc., vividly.
• Press the One-Touch Registration button to register the settings. This is useful for multiple printing

using the same settings.
• Press the Print Preview button to display the preview screen. You can confirm and make changes to

the layout in the preview screen.
• The maximum length for Borderless Printing is the lesser of 5.587 times the roll paper width, or

18.0m.

12. Press Print to start printing.

Multi-Page Printing (Word)
Prints multiple pages as one page. You can print handouts into a single page, or print matter with many pages.

1. Start Microsoft Word.
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2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.
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4. Click Multi-Page Printing.

5. Select the Roll Paper Width that is set in the printer.

6. Select layout from Layout Selection.

7. Select Next.

8. Select Media Type.
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9. Select Print Range from All Pages, Current Page, and Pages.
If Pages is selected, enter the number of pages.

10. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• When Saturation is selected, you can print posters, etc., vividly.
• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to

need print multiple times using the same setting.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• The maximum length for Multi-Page Printing is the lesser of 5.587 times the roll paper width, or

18.0m.

11. Press Print to start printing.

Register the settings(Word)
If you are going to print multiple times using the same setting, you can select One-Touch Registration. Registered settings
can be recalled from Print Using Registered Settings.

1. Set up to the Print screen from Print Matching Roll Width, Borderless Printing or Multi-Page Printing of
Printing Menu.

Note
• Up to 20 items can be registered.
• The available settings are as follows.

• Print Matching Roll Width (Word) →P.385

• Borderless Printing (Word) →P.387

• Multi-Page Printing (Word) →P.390

2. Click the One-Touch Registration button.
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3. Enter name in Name.
Up to 31 characters can be entered.

4. Click . The name you entered is displayed in Registered Settings.

5. Click OK, and return to the Print screen.

6. Click Print to print, and click Cancel to cancel the print.

Note
• Clicking Cancel in the Print screen will not delete the registered settings.

Print Using Registered Settings (Word)
Prints using the registered settings.

1. Start Microsoft Word.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.
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Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4. Click Print Using Registered Settings.

5. Click the Next button.

6. Select Media Type.
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7. Select Print Range from All Pages, Current Page, or Pages.
If Pages is selected, enter the number of pages.

8. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• When Saturation is selected, you can print posters, etc., vividly.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• The maximum print length when printing with the registered settings is the lesser of 5.587 times the

roll paper width, or 18.0m.

9. Press Print to start printing.

Portrait Orientation / Landscape Orientation (Word)
Print to the edge of the roll width. You can print large exhibits and posters, or print the Landscape or Portrait Orientation
Page Sizes made in the Large-Format Printing Wizard.

Create Page Size in Portrait or Landscape Orientation.
Use the Large-Format Printing Wizard to create portrait page sizes for Potrait Orientation, and landscape page sizes for
Landscape Orientation.

1. Start Microsoft Word.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Paper Settings from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Large-Format Printing Wizard dialog box is displayed.

Note
• If you want to change the display to another file or application while the Large-Format Printing

Wizard is open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be
able to change displays or operate the toolbar/ribbon.
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4. Click Portrait Orientation or Landscape Orientation.

Note
• The steps taken to create a Portrait Page Size will be used as an example to explain the procedure.

5. Adjust Length from the list-box or slide-bar.

6. Click the Create Page button.
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7. Click OK if the message is displayed.

8. Edit and create the document.

Note
• Printing is done in Print Matching Roll Width of the Printing Wizard. For details on Print Match-

ing Roll Width, refer to see "Print Matching Roll Width (Word)." →P.385 .

Important
• The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

To start from Microsoft PowerPoint
Below are the steps to start Print Plug-In for Office from Microsoft PowerPoint.

1. Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed on the toolbar/ribbon, click it.

Important
• If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.

• When Print Plug-In for Office is not displayed →P.377

3. Check that the imagePROGRAF Print Plug-In toolbar/ribbon is displayed.
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4. Click the buttons on the toolbar/ribbon according to the items you want to set.

Icon Contents

Menu

Displays the About, Help, and Special Settings dialog boxes.  (See "Configuring
Special Settings .") →P.423

Printer list

Select Printer.
If you select Show All Printers, the imagePROGRAF printers will be displayed
again. Select this when you want to display all printer drivers or update the display.

Print Button

The print Wizard is displayed.
The settings Print Matching Roll Width, Borderless Printing, Multi-Page Print-
ing, and Print Using Registered Settings can be set.

Paper Settings Button

Large-Format Wizard is displayed.
Settings for Portrait or Landscape Orientation can be set.

Printing Wizard dialog box

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close the

Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/rib-
bon.

Note
• If you open a password protected document as read-only, the Printing Wizard cannot be run.
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Large-Format Printing Wizard dialog box

Important
• If you want to change the display to another file or application while the Large-Format Printing Wizard is

open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to change dis-
plays or operate the toolbar/ribbon.

• The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

Note
• If you open a password protected document as read-only, the Large-Format Printing Wizard cannot be

run. Remove the password protection.

Print Matching Roll Width (PowerPoint)
Prints to the edge of the roll width. You can print large exhibits and posters, and also print Portrait and Landscape orienta-
tions made in Large-Format Printing Wizard.

1. Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.
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3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4. Click Print Matching Roll Width.

5. Select Roll Paper Width that is set in the printer.
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6. Select image size.

7. Select layout.

8. Select Next.

9. Select Media Type.

10. Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

11. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• When Saturation is selected, you can print posters, etc., vividly.
• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to

need print multiple times using the same setting.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• When you print to the edge of the roll width, the maximum length will be the lesser of 14.22 times the

roll paper width, or 18.0m.

12. Press Print to start printing.
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Borderless Printing (PowerPoint)
Prints up to the border of the media. Photos and posters can be printed without worrying about margins.

1. Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.
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4. Click Borderless Printing.

5. A confirmation dialog box is displayed. If the data fills up the page, confirm that Continue using the plug-in is
selected in Choose how to proceed and press OK.

Note
• To adjust the data, select Return to application and press OK. Exit Print Plug-In for Office and

return to the application.

6. Select Roll Paper Width that is set in the printer.

7. Select Layout.
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8. Select Next.

9. Select Media Type.

10. Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

11. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• When Saturation is selected, you can print posters, etc., vividly.
• Press the One-Touch Registration button to register the settings. This is useful for multiple printing

using the same settings.
• Press the Print Preview button to display the preview screen. You can confirm and make changes to

the layout in the preview screen.
• The maximum length for Borderless Printing is the lesser of 14.22 times the roll paper width, or

18.0m.

12. Press Print to start printing.

Multi-Page Printing (PowerPoint)
Prints multiple pages as one page. You can print handouts into a single page, or print matter with many pages.

1. Start Microsoft PowerPoint.
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2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.
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4. Click Multi-Page Printing.

5. Select the Roll Paper Width that is set in the printer.

6. Select layout from Layout Selection.

7. Select Next.

8. Select Media Type.
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9. Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

10. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• When Saturation is selected, you can print posters, etc., vividly.
• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to

need print multiple times using the same setting.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• The maximum length for Multi-Page Printing is the lesser of 14.22 times the roll paper width, or

18.0m.

11. Press Print to start printing.

Register the settings(PowerPoint)
If you are going to print multiple times using the same setting, you can select One-Touch Registration. Registered settings
can be recalled from Print Using Registered Settings.

1. Set up to the Print screen from Print Matching Roll Width, Borderless Printing or Multi-Page Printing of
Printing Menu.

Note
• Up to 20 items can be registered.
• The available settings are as follows.

• Print Matching Roll Width (PowerPoint) →P.400

• Borderless Printing (PowerPoint) →P.403

• Multi-Page Printing (PowerPoint) →P.405

2. Click the One-Touch Registration button.
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3. Enter name in Name.
Up to 31 characters can be entered.

4. Click . The name you entered is displayed in Registered Settings.

5. Click OK, and return to the Print screen.

6. Click Print to print, and click Cancel to cancel the print.

Note
• Clicking Cancel in the Print screen will not delete the registered settings.

Print Using Registered Settings (PowerPoint)
Prints using the registered settings.

1. Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Printing Wizard dialog box is displayed.
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Important
• If you want to change the display to another file or application while the Printing Wizard is open,

close the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate
the toolbar/ribbon.

4. Click Print Using Registered Settings.

5. Click the Next button.

6. Select Media Type.
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7. Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

8. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• When Saturation is selected, you can print posters, etc., vividly.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• The maximum print length when printing with the registered settings is the lesser of 14.22 times the

roll paper width, or 18.0m.

9. Press Print to start printing.

Portrait Orientation / Landscape Orientation (PowerPoint)
Print to the edge of the roll width. You can print large exhibits and posters, or print the Landscape or Portrait Orientation
Page Sizes made in the Large-Format Printing Wizard.

Create Page Size in Portrait or Landscape Orientation.
Use the Large-Format Printing Wizard to create portrait page sizes for Potrait Orientation, and landscape page sizes for
Landscape Orientation.

1. Start Microsoft PowerPoint.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.
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3. Click Paper Settings from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Large-Format Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Large-Format Printing

Wizard is open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be
able to change displays or operate the toolbar/ribbon.

4. Click Portrait Orientation or Landscape Orientation.

Note
• The steps taken to create a Portrait Page Size will be used as an example to explain the procedure.
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5. Adjust Length from the list-box or slide-bar.

6. Click the Create Page button.

7. Click OK if the message is displayed.

8. Edit and create the document.

Important
• The layout may collapse if you create a form using existing data. If that is the case, modify the data

again.

Note
• Printing is done in Print Matching Roll Width of the Printing Wizard. For details on Print Match-

ing Roll Width, refer to see "Print Matching Roll Width (PowerPoint)." →P.400 .
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To start from Microsoft Excel
Below are the steps to start Print Plug-In for Office from Microsoft Excel.

1. Start Microsoft Excel.

2. If Start imagePROGRAF Print Plug-In is displayed on the toolbar/ribbon, click it.

Important
• If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.

• When Print Plug-In for Office is not displayed →P.377

3. Check that the imagePROGRAF Print Plug-In toolbar/ribbon is displayed.

4. Click the buttons on the toolbar/ribbon according to the items you want to set.

Icon Contents

Menu

Displays the About, Help, and Special Settings dialog boxes.  (See "Configuring
Special Settings .") →P.423

Printer list

Select Printer.
If you select Show All Printers, the imagePROGRAF printers will be displayed
again. Select this when you want to display all printer drivers or update the display.

Print Button

The print Wizard is displayed.
The settings Print Entire Sheet and Print Selected Area can be set.
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Printing Wizard dialog box

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close the

Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the toolbar/rib-
bon.

• The Printing Wizard will not start if you click the Print button on the toolbar/ribbon while editing a cell.
• When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one worksheet

and click Print again.
• When an object is selected, the Printing Wizard is not started if you click the Print button on the toolbar/

ribbon.
• If the paper size in Excel is blank, the Printing Wizard cannot be run. From the File menu in Excel, select

Page Setup and check Paper size.

Note
• If you click the Print button with a graph selected, a message dialog box will appear asking if you want to

continue printing. If you click No, you will return to the application.
• If you click the Print button with a page break set, a message dialog box will appear asking if you want to

continue printing. If you click No, you will return to the application. If you do not use the set page break,
check the page break preview and change the setting.

• If you click the Print button with a page range set, a message dialog box will appear asking if you want to
continue printing. If you click No, you will return to the application. If you do not use the set page range,
check the page break preview and change the setting.

• If you click the Print button with a worksheet or cell protected, a message dialog box will appear asking if
you want to continue printing. If you click No, you will return to the application. If you want to change the
setting, remove the protection from the worksheet or cell.
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Print Entire Sheet (Excel)
For resizing the entire sheet to fit the roll width. Choose this option to enlarge the currently displayed sheet before printing.

1. Start Microsoft Excel.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.

Important
• When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one

worksheet and click Print again.

If a print area is set, a confirmation message dialog box will appear.
To print the entire sheet, cancel the setting of the print area.

The Printing Wizard dialog box is displayed.
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4. Click Print Entire Sheet.
A message will appear informing you that analysis is in progress.

The Layout menu will appear automatically.

Note
• If data analysis requires time, a message dialog will appear. If you select No, you will return to the

application.

5. Select Roll Paper Width that is set in the printer.

Windows Software > Print Plug-In for Office >

iPF6300S Print Entire Sheet (Excel)

3

417



6. Select image size.

7. Select layout.

8. To configure Binding, click the Binding Settings button.
Refer to Configuring Binding (Excel) →P.422  for details on the procedure for configuring Binding.

9. Select Next.

10. Select Media Type.

11. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• When Saturation is selected, you can print posters, etc., vividly.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• When you print to the edge of the roll width, the maximum print length is 18.0m.

12. If the upper and lower margins are too wide, check No Spaces at Top or Bottom (Conserve Paper).
The upper and lower margins can be checked in Print Preview.

13. Press Print to start printing.

Important
• If divided into plural pages, try reducing the data size or the range you select.
• You cannot run Print or Print Preview if you select it for a worksheet with no data displayed.
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Print Selected Area (Excel)
For resizing the selected range of cells to fit the roll width. Choose this option to enlarge a particular part of the sheet before
printing.

1. Start Microsoft Excel.

2. If Start imagePROGRAF Print Plug-In is displayed, click it.

3. Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.

Important
• When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one

worksheet and click Print again.

If a print area is set, a confirmation message dialog box will appear.
To print the selected area, cancel the setting of the print area.

The Printing Wizard dialog box is displayed.
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4. Click Print Selected Area.

Important
• If only one cell is selected, Print Selected Area cannot be selected.

A message will appear informing you that analysis is in progress.

The Layout menu will appear automatically.

Important
• If the range selected in Excel 2007/2010 is too large, it will not be possible to analyze the data. Select

a smaller range and then run the analysis.
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Note
• If data analysis requires time, a message dialog will appear. If you select No, you will return to the

application.

5. Select Roll Paper Width that is set in the printer.

6. Select image size.

7. Select layout.

8. To configure Binding, click the Binding Settings button.
Refer to Configuring Binding (Excel) →P.422  for details on the procedure for configuring Binding.

9. Select Next.

10. Select Media Type.

11. Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.
• When Saturation is selected, you can print posters, etc., vividly.
• Press the Print Preview button to display the preview screen. You can check and make changes to

the layout in the preview screen.
• When you print to the edge of the roll width, the maximum print length is 18.0m.

12. If the upper and lower margins are too wide, check No Spaces at Top or Bottom (Conserve Paper).
The upper and lower margins can be checked in Print Preview.
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13. Press Print to start printing.

Important
• If divided into plural pages, try reducing the data size or the range you select.
• You cannot run Print or Print Preview if you select it for a worksheet with no data displayed.

Configuring Binding (Excel)
You can configure Binding margins for binding printouts.

1. Configure the settings up to Layout Selection in the Layout screen in Print Entire Sheet or Print Selected Area.
Refer to Print Entire Sheet (Excel) →P.416  and Print Selected Area (Excel) →P.419  for the configuration
methods.

2. Click the Binding Settings button.

Important
• You cannot click the Binding Settings button in the following situations.

• When the Image Size is set to 100%
• When a graph is selected
• When page breaks have been set
• When a sheet or cell is protected

Open the Binding Settings dialog box.

3. If the Binding checkbox is not checked, select it to turn binding on.

4. Select Binding Edge.

5. Select Binding Margin.
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6. Click the OK button.
Return to the Layout screen.

Check that the Binding settings are applied in the preview screen.

7. Configure the settings in the Printing Wizard dialog box.

Configuring Special Settings
You can configure Special Settings from the imagePROGRAF Print Plug-In toolbar.

1. Click imagePROGRAF in the toolbar, and select Special Settings.

2. Turn the checkbox for the item you want to change on or off.

Item Details

Show progress indicator during plug-in
startup

When this setting is off, hides the progress indicator that appears while
the plug-in is starting up.

Center sheets and print areas When this setting is off, printing is performed without changing the po-
sition. When this setting is on, printing is performed with the top, bot-
tom, left, and right margins layed out equally. When this setting is off,
printing is performed without changing the position.
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Item Details
Center sheets and print areas This function is only valid in Microsoft Excel.

Ensure image quality when creating page
sizes

When this setting is on, documents are created at the maximum size.
This reduces the enlargement ratio during actual printing, which mini-
mizes degradation of the quality of photos, etc.
This function is only valid in [ Microsoft PowerPoint.

Correct the print area when analyzing For data that cannot be processed with usual data analysis, the print area
is corrected and then the data is processed. When data analysis fails, you
may be able to print by turning on this checkbox.
This function is only valid in Microsoft Excel.

3. Click OK to close the Special Settings dialog box.
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Status Monitor
The Features of imagePROGRAF Status Monitor .......................................................................................... 425
Job Management Using imagePROGRAF Status Monitor .............................................................................. 426

The Features of imagePROGRAF Status Monitor
imagePROGRAF Status Monitor is a utility for checking the printer status and managing print jobs.
Two screens are available in imagePROGRAF Status Monitor : Printer List shows a list of printers, and Status Monitor
shows details for each printer.

• You can view a list of the printers for which printer drivers have been installed on your computer, printers connected to
your computer, and printers found on the network.
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• If a printer error occurs, you can investigate the corrective action immediately.
• Printer status can be checked in real time on a computer monitor.
• Displays the ink level of every color in the printer. An icon and warning message will notify you when ink levels are

low.
• The type of paper loaded in each media source is identified. You can also check to see if paper has run out.
• This way, the utility enables you to check printer information and take care of printer maintenance for optimal printing

results.
• You can also set up automatic email notification of any printer problems or errors to email addresses you designate in

advance.
• You can check the status of the hard disk and the documents saved on the hard disk.
• You can use the Accounting Manager to collect the print job logs for the printers and check information such as the

printing costs.
For details of the Accounting Manager, see Accounting Manager →P.428 .

Note
• For details, refer to the imagePROGRAF Status Monitor help.

Job Management Using imagePROGRAF Status Monitor
You can use the Job sheet in imagePROGRAF Status Monitor for operations such as pausing and canceling print jobs.

• Preempting Other Jobs
If you select a print job and click the Preempt Other Jobs button, the selected job is printed ahead of the job that
currently precedes it in the print queue.

• Pausing/Resuming Print Jobs
Selecting a print job and clicking the Pause button pauses printing of the selected job.
To resume printing of a paused print job, select the print job and click the Resume button.
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Note
• Once all the print data for a print job has been sent to the printer, the job can no longer be paused/re-

sumed.

• Canceling Print Jobs
Selecting a print job and clicking the Cancel Job button cancels printing of the selected job.

Note
• You cannot cancel other users' print jobs.

• Printing Held Jobs
Printing of the job with a Status of Holding is paused because the paper specified by the driver does not match the
paper currently loaded in the printer.
Use the procedure below to print the held job.

1. Select the held job and click the Replace Paper button.

2. Replace the paper in the printer with the correct paper.

Note
• To continue printing without changing the paper in the printer, select the held job and click Continue to

print button.
• The printing behavior when the paper specified by the driver does not match the paper currently loaded in the

printer can be changed by using Detect Mismatch in the operation panel menu. Refer to Menu Set-
tings →P.914  for details.
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Accounting Manager
The Accounting Manager stores the printer's print job logs so that you can use the information for checking printing costs,
etc.
The benefits of using the Accounting Manager are outlined below.

• Print Job Log Collection
This allows you to check which documents were printed from each printer, who printed them and when.

• Calculation of the Total Pages Used and the Total Cost
This allows you to use the collected print job logs to calculate totals for items such as the number of pages printed, the
amount of paper used and the printing costs incurred.

• Regular Data Acquisition for Print Jobs
Job logs can be automatically collected periodically.

• Exporting Print Job Data
This allows you to export collected print job data as a CSV file.

Important
• The Accounting Manager in Status Monitor displays approximate estimates of the amount of paper con-

sumed and the ink consumed per job. Canon cannot guarantee the accuracy of these estimates. These esti-
mates will also vary depending on the conditions of printer use.

• Print job log collection is not performed when Set./Adj. Menu -> Printer Info -> Show Job Log of the
control panel is Off. However,

• even if Show Job Log is set to Off, regularly acquired jobs that already have been retrieved at that time are
displayed.

• When Show Job Log has been set to On again, all jobs within the printer at that time are displayed.
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Launching the Accounting Manager
The procedure for launching the Accounting Manager is shown below.

1. Open the imagePROGRAF Status Monitor window.

2. Select Accounting in the Accounting menu.
Or, open the Accounting sheet and click the Accounting button.

Accounting Manager Main Window
The Accounting Manager main window consists of a title bar, menu bar, toolbars, listed job selection area, job list area,
totals area and status bar.
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• Title Bar
This displays the printer model, its serial number and the port number it is using.

• Menu Bar
Allows you to select the menu options required for operation.

• Toolbars
Provide tool buttons and pull-down menus for the main operations.

Note
• You can opt to either show or hide the toolbars in the View menu.

• Listed Job Selection Area
You can use this area to select which job log is displayed.
If you are using regular data acquisition, this area allows you to view the collective job logs for each specified period.

For more information on how to select the job logs displayed, see Switching Between Displaying Jobs on Printer
and Regularly Acquired Jobs →P.438 .

• Job List Area
This area lists the details of acquired jobs.
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Display a list of jobs within the printer or of jobs collected periodically. For details, refer to Job List Area →P.432 .

• Totals Area
Displays the total costs for the selected job and the amounts of paper and ink consumed.

Note
• If you are viewing regularly acquired print jobs, selecting a period on the left side of the window dis-

plays the total costs for that period and the amounts of paper and ink consumed.
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• Status Bar
Displays messages and other information.

Job List Area
The content and items of the jobs displayed in the job list area are as follows.

• Job Cost
This is the cost incurred in printing.

Note
• If the Unit Cost of Ink or Paper have not been set, **** is displayed in the Job Cost field.

• Document Name
This is the name of the printed document.

• Printing Results
Displays OK when printing is executed, and Cancel when it is not executed

• Media Type
This is the type of paper used in printing.

• Paper Consumed
This is the area of paper used in printing.

Note
• Paper Consumed may differ from the value derived by multiplying Paper Width by Paper Length.

• Output Image Size
This is the size of the document used in printing.

Note
• When the job is multiple pages, the size of the last page is displayed.
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• Paper Width
This is the width of paper used in printing.

Note
• When the job is multiple pages, the width of the last page is displayed.

• Paper Length
This is the length of paper used in printing.

Accounting Manager Basic Procedures
The first time you use the Accounting Manager, use the following procedures to configure the settings.

1. Configure unit costs, including the costs of ink and paper.
For details of the unit cost settings, see Configuring Unit Costs in Accounting Manager →P.433 .

2. Set options such as the units displayed.
For details of the unit settings, see Configuring Units and Display Settings in Accounting Manager →P.437 .

3. If you are using Regular Data Acquisition, configure the Regular Data Acquisition settings.
For details of the Regular Data Acquisition settings, see Automatically Acquiring Print Job Logs at Regular Inter-
vals →P.438 .

4. Specify the jobs to be listed.
For details of how to select the job logs displayed, see Switching Between Displaying Jobs on Printer and Regu-
larly Acquired Jobs →P.438 .

This displays the required print job logs and lists the details.

Configuring Unit Costs in Accounting Manager
Select Unit Costs in the Settings menu to open the Unit Costs dialog box. Configure the unit cost settings in this dialog
box.

Note
• When you select a job and then open the Unit Costs dialog box, items with unit costs that have not yet been

configured for that job are shown highlighted.

• Setting the Unit Cost for Ink →P.434

• Setting the Unit Cost for Paper →P.435

• Setting the Unit Cost for Items Other Than Ink and Paper →P.436
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Setting the Unit Cost for Ink
Open the Ink sheet. Set the unit cost for ink in this sheet.

To set the same unit cost for all the inks

1. Select the Use same price for all ink checkbox.

2. Enter the Tank Capacity and corresponding Price.

3. Click the OK button.

Important
• Your settings are not applied until you click the OK button.

To set different unit costs for each ink color

1. Select the ink color to be costed.

2. Enter the Tank Capacity and corresponding Price.
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3. Click the Overwrite button.

4. Repeat steps 1 to 3 for all the inks.

5. Click the OK button.

Important
• Your settings are not applied until you click the OK button.

Setting the Unit Cost for Paper
Open the Paper sheet. Set the unit cost for paper in this sheet.

1. Select a media type from the Media Type list.

2. Enter the Width and Length of the paper, and the Price per area for the configured width x height.

3. Click the Add button. To change the unit cost for a media type you have already set, click the Overwrite button.

4. Click the OK button.
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Important
• Your settings are not applied until you click the OK button.

Setting the Unit Cost for Items Other Than Ink and Paper
Open the Other sheet. Use this sheet to set any price for items other than inks and paper.

1. Enter any name in the Name field.

2. Enter a value in Unit Cost.

3. Use Allocated to specify whether the costs are allocated as being incurred by the print job.

4. Click the Add button. To change the unit cost for a media type you have already set, click the Overwrite button.

5. Click the OK button.

Important
• Your settings are not applied until you click the OK button.
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Note
• You can set unit costs for up to 5 items.

Configuring Units and Display Settings in Accounting Manager
Select Units and Display in the Settings menu to open the Units and Display dialog box. Use this dialog box to configure
the display settings.

• Date Display Format
Use this option to select the display format for dates. "YYYY" indicates the year, "MM" the month and "DD" the day.

• Currency Unit
Enter the currency unit. Enter a text string up to 3 characters long.

• 1000 Separator
Use this option to select the symbol used as a separator in numbers. The symbol is inserted every 3 digits.

• Decimal Symbol
Use this option to select the symbol used as a decimal point.

• Ink Consumed
Use this option to select the unit used for ink consumption.

• Paper Width
Use this to select the unit used for paper width.

• Paper Length
Use this to select the unit used for paper length.

• Area Display Format
Use this to select the unit used for paper area.
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Automatically Acquiring Print Job Logs at Regular Intervals
This feature collects print job logs from the printer at regular intervals and saves the logs on your computer.

1. Select Regular Data Acquisition in the Settings menu.

2. Select Acquire print job logs regularly.

3. Click the OK button to close the dialog box.

Important
• Print job log collection is not performed when Set./Adj. Menu -> Printer Info -> Show Job Log of the

control panel is Off. However, even if Show Job Log is set to Off, regularly acquired jobs that already have
been retrieved at that time are displayed.

Note
• Immediately after you configure Regular Data Acquisition, no print jobs are displayed. Wait a few moments

and then select Refresh in the View menu to display the print jobs.
• A maximum of 10,000 records are saved in a print job log. If this number is exceeded, jobs are deleted from

the log starting from the oldest record. To save old data, it is recommended that you export the data as a CSV
file.
For details of how to export print job logs as CSV files, see Exporting Print Job Data as a CSV
File →P.439 .

Canceling Regular Print Job Log Acquisition
You can use this procedure to cancel the regular acquisition of print job logs from printers.

1. Select Regular Data Acquisition in the Settings menu.

2. Uncheck the Acquire print job logs regularly option.

3. Click the OK button to close the dialog box.

Switching Between Displaying Jobs on Printer and Regularly Acquired Jobs
The print job logs displayed by the Status Monitor Accounting Manager contain two types of job: Jobs on Printer and Regu-
larly Acquired Jobs.
You can select whether to display Jobs on Printer or Regularly Acquired Jobs in the Listed Job Selection Area on the left
side of the window.

• Jobs on Printer
This shows a list of the print jobs currently held on printers.
You can change the number of jobs displayed per page using the Print Jobs Shown Per Page setting in the View
menu or the toolbar.
You can skip to a particular page using the Go to option in the View menu or the toolbar.
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Note
• For printers with built-in hard disks, you can view up to 500 print jobs per printer.
• For printers without built-in hard disks, you can view up to 32 print jobs per printer. However, only 10

jobs can be displayed if the printer is switched off.

• Regularly Acquired Jobs
This shows a list of regularly acquired print jobs.
To view all the jobs in a set period, specify the period using Period and then Starting Date (or Starting Day of Week
or Starting Month) in the View menu or the toolbar.
For example, to view monthly job logs starting on the 1st of each month, set Period to Monthly and set Starting Date
to 1.

Note
• Up to 10,000 regularly acquired jobs are displayed for each printer.

Exporting Print Job Data as a CSV File
You can export the collected print job data in the form of a CSV file by selecting Export Job Cost Data in the File menu.

Note
• You can also select Export Job Cost Data using the icon in the toolbar.

• Selected Jobs
Exports the data for the selected print jobs in the job list as a CSV file.

Note
• You can select multiple jobs by holding down the Shift key or Ctrl key as you click the job names.

• Listed Jobs
Exports the data for the print jobs currently displayed in the list as a CSV file.

Showing Job Properties
If you select a job in the job list and then select Show Job Properties in the File menu, the Job Properties dialog box
appears, allowing you to check information such as detailed cost data.
You can copy text-based information in this dialog box to the clipboard by clicking the Copy button.

Note
• You can also open this dialog box by right-clicking the selected job and selecting Show Job Properties. Or

you can also use the toolbar icon to open the dialog box.
• If you select multiple jobs and open the Job Properties dialog box, the total costs for the selected jobs are

displayed.
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Showing, Saving and Loading Selected Unit Cost Data

• Show Unit Cost Data
Select Show Unit Cost Data in the File menu to open the Unit Cost Data dialog box. This lists the unit costs for items
such as the selected ink and paper.
You can copy text-based information in this dialog box to the clipboard by clicking the Copy button.

• Save Unit Cost Data
Select a destination folder using Save Unit Cost Data in the File menu. The unit cost data for items such as the selec-
ted ink and paper is saved as a file.

• Load Unit Cost Data
Selecting Load Unit Cost Data in the File menu loads saved unit cost data.

Showing the Total Amount of Ink and Paper Consumed
Select Show Ink and Paper Consumed in the File menu to open the Show Ink and Paper Consumed dialog box.
This lists the total amounts of ink and paper consumed by the printer so far.
You can copy text-based information in this dialog box to the clipboard by clicking the Copy button.

Note
• Up to 7 types of media are listed in order of the amount consumed. The total consumption for other media

types is shown as Other.
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Digital Photo Front-Access
Digital Photo Front-Access .............................................................................................................................. 441

Digital Photo Front-Access
Digital Photo Front-Access is an application that links photos from Canon digital cameras and other image files on your
computer with various other applications.

• Simply select an image and click the icon of the application you want to start to launch the application.
• You can also print from Digital Photo Front-Access. In short, Digital Photo Front-Access can help you manage images

in many ways from editing to printing as an effective way to work with other applications.
• Digital Photo Front-Access also enables image retouching. For automatic retouching, select an image for retouching

and click Image Adjustment.
• Because this application automates the workflow from retouching to display for all of your images, it can save time

and work in retouching.

Note
• For details, refer to the Digital Photo Front-Access help.
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Device Setup Utility
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imagePROGRAF Device Setup Utility
imagePROGRAF Device Setup Utility is a utility to establish communication between the printer and your computer by
completing relevant settings. After the printer is installed, for example, you can use imagePROGRAF Device Setup Utility
to complete the network settings initially.

• Starting imagePROGRAF Device Setup Utility will show a list of printers found on the network. In this list, select the
printer (specifically, the printer's MAC address) that you want to set up, and then configure the basic settings from
your computer, such as the printer's IP address and the network frame type.

• You can see which printers are online in the network by checking the printer list. Communication between your com-
puter and these printers is possible.

Note
• We recommend that your network or printer administrator complete the setup work using imagePROGRAF

Device Setup Utility.
• For details, refer to the imagePROGRAF Device Setup Utility help.

Installing imagePROGRAF Device Setup Utility
Install imagePROGRAF Device Setup Utility from the User Software CD-ROM provided with the printer as follows:

1. Insert the User Software CD-ROM in the CD-ROM drive.

2. On the Setup Menu window, click Install Individual Software.

3. Click Install in imagePROGRAF Device Setup Utility.

4. Follow the instructions on the screen to proceed with the installation.

Configuring the IP Address Using imagePROGRAF Device Setup Utility
On a computer running Windows, you can use imagePROGRAF Device Setup Utility provided with the printer to configure
the printer's IP address. This topic describes how to configure the IP address using imagePROGRAF Device Setup Utility.
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Important
• To configure network settings, you must be logged in with administrative rights such as Administrator ac-

count. We recommend that your network administrator configure the network settings.

Note
• For instructions on installing imagePROGRAF Device Setup Utility, see "Installing imagePROGRAF De-

vice Setup Utility." →P.442

When specifying an IPv4 IP address

1. Start imagePROGRAF Device Setup Utility from the start menu.

2. In the Device Name list displayed, select the printer to configure.

3. Choose Protocol Settings from the Printer menu.
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4. Select the IPv4 tab.

5. In the Setting IP Address list, choose Manual.

6. Enter the IP address assigned to the printer and click the Set button.

7. Click OK after the Confirmation message is displayed.

8. Exit imagePROGRAF Device Setup Utility.

Note
• To configure the IP address automatically, choose Auto in the Setting IP Address list and select DHCP,

BOOTP, or RARP.
• You can also specify the subnet mask and default gateway.
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When specifying an IPv6 IP address

1. Start imagePROGRAF Device Setup Utility from the start menu.

2. In the Device Name list displayed, select the printer to configure.

3. Choose Protocol Settings from the Printer menu.

4. Select the IPv6 tab.

5. In IPv6, select On.
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6. When there is an IPv6-compatible router in the network environment, select On in Stateless Address.
Additionally, when there is an DHCPv6-compatible server in the network environment, select On in DHCPv6.

Note
• When there is no IPv6-compatible router or DHCPv6-compatible server, select On in Manual and

enter the IPv6 Address and Prefix Length.

7. Click Set.

8. Click OK after the Confirmation message is displayed.

9. Exit imagePROGRAF Device Setup Utility.
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The Features of Media Configuration Tool
The Media Configuration Tool offers the following features.

• Enables information about additional media (types of paper) supported by the printer to be added to the printer control
panel and to the printer driver, through the use of relevant media information files.

• You can rearrange lists of the types of paper on the printer control panel and in printer driver dialog boxes and rename
them, in addition to other functions.

• You can add custom paper (paper that is not Canon genuine paper or Canon feed confirmed paper) to the printer con-
trol panel and printer driver.

Important
• Normally, the Media Configuration Tool is installed and the media information is configured when you in-

stall the printer driver from the User Software CD-ROM. Use this software if you want to add new media
information or edit existing media information.

• Administration of paper information using the Media Configuration Tool should be performed by the printer
administrator.

• Canon offers absolutely no guarantees regarding the print quality or paper feed properties of customer paper
(paper that is not Canon genuine paper or Canon output confirmed paper).

• The paper feed properties cannot be guaranteed if Add Custom Paper is used on Canon genuine paper in the
Media Configuration Tool.

• The print quality and paper feed properties cannot be guaranteed if Add Custom Paper is used on Canon
feed confirmed paper in the Media Configuration Tool. Furthermore, Canon does not guarantee the print
quality of Canon feed confirmed paper.
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Note
• Canon genuine paper and Canon feed confirmed paper are detailed in the Paper Reference Guide. Any other

paper is called custom paper.

Operating Environment
You can use Media Configuration Tool in the following environments.

• Compatible Operating System

• 32 bit edition Windows OS
Windows XP, Windows Server 2003, Windows Server 2003 R2, Windows Vista, Windows Server 2008, Win-
dows 7

• 64 bit edition Windows OS
Windows XP, Windows Server 2003, Windows Server 2003 R2, Windows Vista, Windows Server 2008, Win-
dows Server 2008 R2, Windows 7

Note
• For the Windows OS, use the latest version of Service Pack.

• Software that requires installation
imagePROGRAF Printer Driver

Installation Procedures
The Media Configuration Tool installation screen appears when you start the installation of a new version of the Media
Configuration Tool. The installation procedure started from this screen is described below.

Important
• If the printer driver is installed from the User Software CD-ROM, the Media Configuration Tool is also in-

stalled and the media information is also configured. Therefore, the following procedure does not normally
need to be performed. To install the Media Configuration Tool without using the User Software CD-ROM,
such as when you have downloaded a new version of the Media Configuration Tool from the Canon website,
use the following procedure.

• You must be logged in as Administrator when installing software in Windows.
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1. Start the Media Configuration Tool installer.
Click the Next button.

2. The next screen presents selections for the country or area where the printer is used.
Select a country or territory then click the Next button.
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3. The License Agreement is displayed.
Select I accept the terms of the license agreement and click the Next button.

4. The Choose Destination Location screen appears.
Select the destination folder then click the Next button.
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5. The Ready to Install the Program screen appears.
Click the Install button.

6. All the required files are copied to your computer and InstallShield Wizard Complete screen appears.
Click the Finish button.

 

This completes the installation of Media Configuration Tool.

Starting the Media Configuration Tool
Follow the procedure below to start Media Configuration Tool.
From the start menu go to All Programs > iPFxxxx Media Configuration Tool > iPFxxxx Media Configuration Tool.
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Media Configuration Tool main window is displayed.

Media Configuration Tool Main Window
The explanation below is on the Media Configuration Tool main window.

Note
• For the step to open the Media Configuration Tool main window, see "Starting the Media Configuration

Tool." →P.451
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• Add Genuine Paper button
When this button is clicked, the Edit Media Types dialog box is displayed, which allows you to add media informa-
tion files released by Canon to the printer control panel and printer driver. You can also change names, toggle between
displaying and hiding, and delete added media types.
You can also change the display order of Canon genuine paper and custom paper.
Refer to Editing Media Type Information →P.453  for details on Add Genuine Paper.

• Add Custom Paper button
When this button is clicked, the Add Custom Paper dialog box is displayed, which allows you to added custom paper
(paper that is not Canon genuine paper or Canon feed confirmed paper) to the printer control panel and printer driver.
Refer to Using Paper Other Than Genuine Paper/Feed Confirmed Paper →P.466  for details on Add Custom
Paper.

• Link to Support Information button
Opens imagePROGRAF Support Information. You can check information such as the latest information for the
product and software version upgrade information.

• Link to User Manual Button
Click this button to display the User's Guide. This function requires that the User's Guide be installed on your comput-
er.

Editing Media Type Information
Click the Add Genuine Paper button in the Media Configuration Tool main window to display the Edit Media Types
dialog box.

This dialog box presents functions for the following tasks.

• Adding Media Types →P.454

• Changing Media Names →P.457

• Deleting Media Types You Have Added →P.459

• Switching Media Types Display Show/Hide →P.460

• Changing the Display Order of Media Types →P.462

Windows Software > Media Configuration Tool >

iPF6300S Editing Media Type Information

3

453



Important
• When you update the media type information, perform the same update on all of the PCs that are using that

printer.
• Adding, deleting, toggling display/non-display, and changing the paper name of a media type can only be

performed for Canon genuine paper and feed confirmed paper. Refer to "Using Paper Other Than Genuine
Paper/Feed Confirmed Paper →P.466 " for details on adding, editing, and deleting custom paper. Cus-
tom paper displays Custom as the Status in the Media Type list.

• To add media types, download the media information file (.amf file) in advance from the Canon website.

Note
• It may not be possible to deleting, showing/hiding, and changing the display order under some conditions.

Adding Media Types
Media information files (.amf files) released by Canon are registered in the printer control panel and printer driver.

Important
• Do not perform printing on the target printer while adding the media types.
• Reinstalling Media Configuration Tool after registering a media information file may delete the registered

media information file.In this case, first download and install latest Media Configuration Tool, then down-
load and register the required media information file.

1. Open the Edit Media Types dialog box, and then click the Add button.
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2. The Add Media Type dialog box displays.
Click the Browse button.

3. The Browse for Folder dialog box opens.
Select the folder that contains the media information files (.amf files), and then click the OK button.
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4. The names of media information files in the folder you selected in the Browse for Folder dialog box are displayed
under Media Information File in the Add Media Type dialog box. Select the check boxes of paper to add and click
the OK button.

Important
• If Master Media Information File is displayed as the Type of the Media Information File, the me-

dia type display order and media type display/non-display settings are initialized. Reconfigure these
after added the master media information file.

5. Click OK when the confirmation message is displayed.

6. In the Edit Media Types dialog box, click the Update button.
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The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.464

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.

Changing Media Names

1. Open the Edit Media Types dialog box.

2. In the Media Type list, select the name to change.
Click the Rename button.

Windows Software > Media Configuration Tool >

iPF6300S Changing Media Names

3

457



3. The Rename Media dialog box is displayed.
Edit the names in Name in Printer Driver and Name on Control Panel and click the OK button.

Note
• To restore the original names, click the Restore button.

4. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.464

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.
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Deleting Media Types You Have Added

1. Open the Edit Media Types dialog box.

2. In the Media Type list, select the name of the media to delete.
Click the Delete button.

Note
• Only paper for which Status in the Media Type is Add can be deleted.
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3. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.464

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.

Switching Media Types Display Show/Hide

1. Open the Edit Media Types dialog box.
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2. In the Media Type list, select the name of the media to switch off or on for display.
Click the Show/Hide button.
The selected paper is alternately shown or hidden.

Note
• The names of media switched for non-display appear grayed out in the Media Type list.
• Each time you click the Show/Hide button, the display mode cycles from showing both the printer

driver and printer panel, to hiding both the printer driver and printer panel, and then to showing only
the printer panel.

3. In the Edit Media Types dialog box, click the Update button.
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The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.464

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.

Changing the Display Order of Media Types

1. Open the Edit Media Types dialog box.
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2. Select the paper in the Media Type list for which to change the display order, and then click the buttons to move the

item (  or ).
The selected item moves one line up or down for every button click.

3. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.464

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.
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Updating Media Types
Clicking the Update button on the Edit Media Types dialog box opens the Update Media Types wizard. You can use this
wizard to apply new information about print media in the printer and in the printer driver.
The procedures for updating the media information with the Update Media Types wizard are as follows.

Important
• When you update the media type information, perform the same update on all of the PCs that are using that

printer.

1. Confirm the printer, where media type information is to be updated, to be displayed in Printer in the Update Media
Types - Select Printer dialog box, and then click the Next button.

Note
• If the printer driver is not installed, the following dialog box is displayed. Select how the printer to

update is connected.

2. Communication with the printer starts and the following dialog box is displayed.
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Important
• Do not attempt to print or turn the printer off while the program is communicating with the printer.
• When the program cannot communicate with the printer, the following warning message is displayed.

3. When the program has finished communicating with the printer, the screen moves to display Update Media Types -
Confirm Update. Confirm the information received from the printer.
To update click the Execute button.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

4. Communication with the printer starts and the following dialog box is displayed.
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Important
• Do not attempt to print or turn the printer off while the program is communicating with the printer.
• When the program cannot communicate with the printer, the following warning message is displayed.

5. Click the OK button.

Note
• To apply the same updates to other printers of the same model, click the Add Genuine Paper button

in the main window to open the Edit Media Types dialog box and then click the Update button.
Select the printer that you want to update in Step 1, and update the media information by following
the Update Media Types wizard.

Using Paper Other Than Genuine Paper/Feed Confirmed Paper
When the Add Custom Paper button is clicked in the Media Configuration Tool main window, the Add Custom Paper
dialog box is displayed.
Adding custom paper to the printer control panel and printer driver is performed from this screen.

Note
• Custom paper is paper other than Canon genuine paper and feed confirmed paper (paper that is detailed in the

Paper Reference Guide).
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The following operations can be performed from this screen.

• Add Custom Paper →P.468

• Edit Custom Paper →P.478

• Delete Custom Paper →P.477

• Export Custom Media Information →P.479

• Import Custom Media Information →P.480

Important
• When adding, editing, or deleting custom paper, make the same changes on all of the other PCs that use the

target printer. The changes can be made easily by creating a Custom Media Information File (.am1 file) using
the custom paper export function and importing the file on the other PCs.

• When using custom paper in another printer, always add the custom paper to that printer before use.
• Canon genuine paper and feed confirmed paper cannot be changed from this dialog box. Refer to "Editing

Media Type Information →P.453 ".
• Changing the display order of media types displayed in the printer control panel and printer driver is per-

formed from the Edit Media Types dialog box regardless of whether it is Canon genuine paper or custom
paper. Refer to "Editing Media Type Information →P.453 ".

Compatible Paper

Paper specifications
Refer to "Specifications" and "Paper" for specifications such as thickness and size of paper that can be added as custom
paper  (See "Specifications.") →P.1078

Notes on the operating environment
In low humidity environments (below 40%), your printer may develop the following problems.

• Paper becomes curled or wrinkled.
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• Paper and the printhead are more likely to touch each other, resulting in a scratched print surface or damaged print-
head.

• The cut printed matter sticks to the printer and will not fall down (film media).
• Paper sticks to the printer, making its transfer impossible and preventing its normal ejection (film media).
• Uneven printing (film media)

In high humidity environments (over 60%), your printer may develop the following problems.

• Printed matter will not dry.
• Wavy paper surface
• Cut edges are ragged (fabric media).
• Margins remain due to borderless printing.

Important
• Canon offers absolutely no guarantees regarding the print quality or paper feed properties of customer paper

(paper that is not Canon genuine paper or Canon feed confirmed paper).

Add Custom Paper
In order to add new custom paper to the printer control panel and printer driver, first select the media type to use as the basis
from among the Canon genuine paper and feed confirmed paper.. Add this as custom paper after making various changes to
the standard paper as necessary.

Important
• Do not execute printing on the target printer while adding custom paper.
• When adding custom paper, check the specifications of paper that can be added using "Compatible Pa-

per →P.467 ".
• Custom paper added using the add custom paper function can only be used by the printer driver. It cannot be

used by other software.

1. Open the Add Custom Paper dialog box and click the Add button.
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2. Check that the printer on which you are updating the media information is displayed in Printer in the Update Me-
dia Types - Select Printer dialog box and click the Next button.

3. The Step 1: Select the standard paper dialog box is displayed. In Paper Category, select the category of media
type to use as the basis of the custom paper you are adding.

Important
• Select the category that you think is the closest to the custom paper you are adding.
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4. The media type names of the Canon genuine paper and feed confirmed paper within the selected category are shown
in Media Type Name. Select the media type to use as the basis of the custom paper, and click the Next button.

Note
• If you do not know which media type to use as the basis of the custom paper, click the Assist button

to open the Media Type Selection Assistance dialog box, and then set either the Weight (gram-
mage) or the Thickness. The Media Configuration Tool automatically selects the appropriate paper
from the selected paper category. Alternatively, select the media type called General from among the
displayed Media Type Name.

• Depending on the selected category, there might not be a media type called General.
• Depending on the selected category, the Assist button may be disabled.

5. The Step 2: Set the custom paper name dialog box is displayed.
Enter an arbitrary name to display in the printer control panel and printer driver, and then click the Next button.

Note
• Paper Name (English) is used in keeping track of the amount of roll paper left, in status print, etc.

6. Load the custom paper in the printer and then click the OK button.

Important
• Do not load paper that is curled or that has already been printed on.

Windows Software > Media Configuration Tool >

Add Custom Paper iPF6300S

3

470



7. The Step 3: Paper Source Settings dialog box is displayed. Select the paper source where the custom paper is loa-
ded and then click the OK button.

8. The Step 4: Paper feed adjustment dialog box is displayed. Click the Execute button to execute paper feed adjust-
ment.
The adjustment pattern is printed, and the paper feed is automatically adjusted based on the printing result.
Once the paper feed adjustment is complete, click the Next button.

Important
• Check that there is no paper left on the ejection guide.
• If Paper Feed Adjustment is not executed, horizontal stripes with different color tones may appear

in the printed material. Paper feed adjustment does not need to be executed more than once. Execute
paper feed adjustment only once each time you add a custom paper.

9. The Roll Paper Settings dialog box is displayed.

Note
• If a paper source other than Roll Paper is selected in the Step 3: Paper Source Settings dialog box,

this screen is not displayed.
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Configure the following settings as necessary, and then click the Next button.

Setting Details

Automatic Cutting Settings Configures the method for cutting roll paper when it is ejected after printing.

• Automatic Cut :Roll paper is automatically cut by the cutter unit.

• Eject Cut :When the Cut key is pressed on the printer control panel, the roll pa-
per is cut by the cutter unit. Select this if you do not want the printed material to
drop immediately after printing, such as to wait for the ink to dry.

• User Cut :Cutting is not performed by the cutter unit. Cut the roll paper using
scissors after each sheet. Select this for paper that cannot be cut by the cutter unit.

Drying Time Specify the time that the printer waits for ink to dry, as needed.

• Off :Ejects immediately after printing finishes.

• 30 sec./1 min./3 min./5 min./10 min./30 min./60 min. :Ejects after the specified
time has elapsed after printing finishes.

Borderless Printing Configures whether or not to permit borderless printing.

• Permit : Borderless printing is permitted.

• Deny : Borderless printing is denied.
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Important
• Depending on the paper, there are types that cannot be cut by the cutter unit, and types that speed

deterioration of the blade and cause damage to the cutter. For thick paper, hard paper, etc. do not use
the cutter unit, and instead cut the roll paper using scissors, etc. after printing. In this case, select User
Cut as the Automatic Cutting Settings.

• If borderless printing is performed on paper where the ink drying is poor, the cutter unit may leave
scratches where it touches the printed surface, or may not cut correctly. In this kind of situation, con-
figure the amount of time to wait for the ink to dry after printing using Drying Time. Alternatively, if
the paper cannot be cut well by the cutter, set the Automatic Cutting Settings to User Cut and cut
the roll paper using scissors, etc.

• Paper where borderless printing can be performed is limited by the media type and roll paper width.
Refer to "Compatible Paper →P.467 ".

• For custom paper where there is a need to set the Automatic Cutting Settings to User Cut, set the
Borderless Printing to Deny.

10. The Step 5: Configure the amount of ink used dialog box is displayed.
The upper limit on the amount of ink used to print to the custom paper is set on this screen by selecting from among
several levels.
First, click the Test Print button to perform a test print of each level.

Important
• If Newsprint for Proofing was selected as the standard paper for the custom paper, you cannot per-

form the test print or configure the maximum ink usage.
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11. The Test Print Settings dialog box is displayed.
Select the print priority and print quality of the test print using Print Priority and Print Quality.
Set the level to test print using Maximum ink usage and the image to use using Image used in test print, and then
click the Start Print button.

12. Determine and set the ink level that is thought to give the best visual test print results with no bleeding or scraping of
ink.

Note
• Select the optimal ink level by referring to the help.
• If you cannot obtain sufficiently high quality printing no matter which maximum ink usage level you

select, use the Step 1: Select the standard paper dialog box to change the paper that is the basis of
the custom paper to another paper.

Windows Software > Media Configuration Tool >

Add Custom Paper iPF6300S

3

474



Important
• Because this settings imposes an upper limit on the amount of ink used during printing, the printing

result might not change even if the level is changed depending on the image.
• The color tone cannot be configured using the Media Configuration Tool. Although the color tone

may change when the maximum ink usage is changed, at this point you should select the optimal lev-
el by only focusing on bleeding and scraping of ink. If the color tone needs to be adjusted, provide an
ICC color profile that matches the paper you are using, and select that ICC color profile in your soft-
ware.

• Depending on the maximum ink usage setting, some of the print qualities in the printer driver may
become unselectable.

13. Configure Head Height and Vacuum Strength as required and click the Next button.
Usually, these do not need to be set.

Important
• If you set the Head Height lower than the automatically set height in parentheses ( ), check that the

printhead does not rub against the paper. (If the printhead rubs against the paper, there will be
scratches in the printing results.) If the printhead rubs against the paper, this can cause damage to the
printhead.

• If you change the Vacuum Strength, check that the printhead is not rubbing against the paper. (If the
printhead rubs against the paper, there will be scratches in the printing results.) If the printhead rubs
against the paper, this can cause damage to the printhead.

• For details on the Head Height and Vacuum Strength, refer to the help.
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14. The Step 6: Confirm the settings dialog box is displayed.
Configure the settings of the custom paper, and then click the Next button.

15. The Confirm Update dialog box is displayed.
Confirm the updates and then click the Execute button.

The custom paper is added to the control panel of the printer and to the printer driver of the PC you are using.

Important
• If you have added custom paper with the POP Board / Cardboard category as the Standard Paper,

remove the loaded custom paper from the printer.
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Note
• When the custom paper is correctly added to the printer driver, the name of the added custom paper is

displayed in the Edit Media Types dialog box that is opened by Add Genuine Paper in the Media
Configuration Tool window.

Delete Custom Paper
You can delete custom paper that you have already added from printer control panel and from the printer driver of the PC
you are using.

1. Open the Add Custom Paper dialog box.

2. Select the paper you want to delete from the Added Custom Paper list and then click the Delete button.
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3. Select the custom paper you want to delete, and then click the Next button.

4. The Confirm Update dialog box is displayed.
Confirm the updates and then click the Execute button.

The custom paper is deleted from the control panel of the printer and from the printer driver of the PC you are using.

Edit Custom Paper
You can change the settings of custom paper you have already added.

1. Open the Add Custom Paper dialog box.
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2. Select the paper you want to edit from the Added Custom Paper list and then click the Edit button.

3. The Update Media Types - Select Printer dialog box is displayed.
Follow the on-screen directions and change the settings as required.

Note
• Refer to Steps 5 to 15 of the "Add Custom Paper →P.468 " for details on how to configure each

setting.

Export Custom Media Information
You can export to file and save media information about custom paper that you have added.
The saved Custom Media Information File can be used by importing it into another printer or PC. Refer to "Import Custom
Media Information →P.480 " for details on "importing custom media information".

1. Open the Add Custom Paper dialog box.
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2. Select the paper you want to export to media information file from the Added Custom Paper list and then click the
Export button.

3. Specify the location to save the Custom Media Information File.

A Custom Media Information File (.am1 file) is saved.

Import Custom Media Information
You can import a Custom Media Information File that has been saved in a folder, and add the file to the printer control
panel and to the printer driver of the PC you are using.

1. Open the Add Custom Paper dialog box.
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2. Click the Import button.

3. Select the printer to add the custom paper to.

Note
• Double-click Custom Media Information File to start the Media Configuration Tool and display this

screen.
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4. Select the Custom Media Information File (.am1 file) to import.

5. The Confirm Update dialog box opens.
Click the Execute button.

The custom paper is added to the control panel of the printer and to the printer driver of the PC you are using.

Note
• When the custom paper is correctly added to the printer driver, the name of the added custom paper is

displayed in the Edit Media Types dialog box that is opened by Add Genuine Paper in the Media
Configuration Tool window.

Windows Software > Media Configuration Tool >

Import Custom Media Information iPF6300S

3

482



Warnings
Take note of the following warnings when added custom paper other than Canon genuine paper and feed confirmed paper to
the printer driver and the printer itself.

About the Cutter

• Depending on the paper, there are types that cannot be cut by the cutter unit, and types that speed deterioration of the
blade and cause damage to the cutter. For thick paper, hard paper, etc. do not use the cutter unit, and instead cut the roll
paper using scissors, etc. after printing. In this case, select User Cut as the Automatic Cutting Settings in the Roll
Paper Settings dialog box.

Note
• If the cutter is damaged, contact your Canon dealer for assistance.
• Refer to "Specifying the Cutting Method for Rolls" for details on the methods for cutting roll paper.  (See

"Specifying the Cutting Method for Rolls.") →P.797

About the Printhead

• If the printhead rubs against the paper during printing, this may cause damage to the printhead. If the printhead is rub-
bing against the paper, configure the Vacuum Strength in the Step 5: Configure the amount of ink used dialog box
as follows.

• For paper-based media such as Heavyweight Coated Paper: Set to Strong or Strongest
• For film-based media such as CAD Tracing Paper: Set to Standard, Strong, or Strongest
• For thin paper of thickness 0.1mm or less: Set to Weakest

Note
• If the printhead still rubs even after changing the Vacuum Strength, set the Head Height to be higher in the

Step 5: Configure the amount of ink used dialog box.
• Refer to "Paper rubs against the Printhead" for details on how to handle the printhead rubbing against the

paper.  (See "Paper rubs against the printhead.") →P.1027

About Borderless Printing

• When performing borderless printing on paper where the ink does not dry well, the cutter unit may leave scratches
where it touches the printed surface, or may not cut correctly. In this kind of situation, configure the amount of time to
wait for the ink to dry after printing using Drying Time in the Roll Paper Settings dialog box.
Alternatively, if the paper cannot be cut well by the cutter, set the Automatic Cutting Settings to User Cut in the Roll
Paper Settings dialog box, and cut the roll paper using scissors, etc.

About the Print Quality

• If the edges of images are blurry, set the Vacuum Strength to be weaker in the Step 5: Configure the amount of ink
used dialog box.

• If lines are warped or scratched, set the Head Height to be lower in the Step 5: Configure the amount of ink used
dialog box.

• If the amount of ink used is too much, wrinkles may appear and the ink may bleed in the printed material. Furthermore,
if the amount of ink used is too little, color production may be poor and lines may become scratched. In this kind of
situation, change the amount of ink used in the Step 5: Configure the amount of ink used dialog box.
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• If horizontal bands with different color tone appear in the printed material, execute Paper Feed Adjustment in the
Step 4: Paper feed adjustment dialog box. If you have already executed Paper Feed Adjustment, execute Adj. Fine
Feed from the printer control panel and fine tune the amount of paper feed.

Note
• Refer to "Fine-Tuning the Paper Feed Amount (Adj. Fine Feed)" for details on Adj. Fine Feed.  (See

"Fine-Tuning the Paper Feed Amount (Adj. Fine Feed).") →P.838

• If horizontal bands appear even after executing Adj. Fine Feed, refer to "Banding in different colors
occurs" in "Troubleshooting".  (See "Banding in different colors occurs.") →P.1030

• If printed sheets are affected by banding in different colors toward the end of the sheet (about 20–30 mm from the
edge), try adjusting the feed amount of the trailing edge of sheets.  (See "Adjusting Color on the Trailing Edge of
Sheets.") →P.840

• If you cannot obtain sufficiently high print quality, change the maximum ink usage, or change the media type used as
the basis for the custom paper in the Step 1: Select the standard paper dialog box.

• If there is no luster in printed material, set the paper used as the basis for the custom paper to a paper that uses photo
ink as the Black ink.
The types of Black ink used are displayed on the right side of each media type in the Step 1: Select the standard
paper dialog box.

Note
• Refer to "Problems with the printing quality" for details on problems with printing quality. (Refer to " Prob-

lems with the printing quality →P.1026 ")

About the Color Tone

• The color tone cannot be configured using the Media Configuration Tool. If the color tone needs to be adjusted, pro-
vide an ICC color profile that matches the paper you are using, and select that ICC color profile in your software.

• Custom paper cannot be used with the ambient light adjustment function or Monitor Matching in Color-Matching
Method.
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Mac OS X Software

Printer Driver 486

Preview 518

Free Layout 549

Color imageRUNNER Enlargement Copy 583

Print Plug-In for Photoshop/Digital Photo Professional 607

Printmonitor 673

Media Configuration Tool 676
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Printer Driver Settings
For instructions on accessing the Mac OS X printer driver, refer to the following topics.

• Accessing the Printer Driver Dialog Box from Applications →P.493
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For information on the Mac OS X printer driver settings, refer to the following topics.

• Main Pane →P.494
You can specify the media type, color processing, print quality, print preview, and other settings. Choose Easy Set-
tings to specify basic print settings based on the printing application or Advanced Settings to complete more detailed
settings as desired.

• Paper Detailed Settings Dialog Box →P.500

• View settings Dialog Box for the Printing Application →P.502

• Color Settings Pane: Color →P.508

• Object Adjustment dialog box: Color →P.509

• Matching pane →P.503

• Ambient Light Adjust dialog box →P.505

• Light Source Check Tool →P.507

• Color Settings Pane: Monochrome →P.510

• Object Adjustment dialog box: Monochrome →P.511

• Gray Adjustment Pane →P.512

• Page Setup Pane →P.513
You can specify the page size of the original, borderless printing, enlargement or reduction, the orientation, the paper
size and source, and automatic cutting.

• Utility Pane →P.515
You can specify settings related to maintenance for the Printhead and feed amount, as well as settings for Color im-
ageRUNNER Enlargement Copy.
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• Additional Settings Pane →P.516
You can specify settings for how print jobs are sent to the printer.

• Support Pane →P.517
You can view support information and the user's manual.

With the imagePROGRAF Free Layout feature, you can arrange originals from various source applications on a single
page before printing. For details, see Free Layout →P.549 .
With the imagePROGRAF Preview feature, you can check the layout before printing and adjust layout or size settings
while viewing a preview screen. For details, see Preview →P.518 .
With the Color imageRUNNER Enlargement Copy feature, you can automatically enlarge and print scanned originals
from a Color imageRUNNER. For details, see Color imageRUNNER Enlargement Copy →P.583 .

Specifying Paper in the Printer Driver
If you have replaced the paper, you must complete the following settings in the printer driver.

1. This sets the B Format for and C Paper Size.

Note
• The configuration method varies depending on the OS and application software you are using.

If Page Setup is displayed in the application menu, the settings are configured by opening the Page
Attributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
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3. Choose the original size in the F Paper Size list.

4. If you configured the settings using the Page Attributes dialog box, click F OK to close the dialog box, and then
select Print from the application software menu.

5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded.

7. Access the Page Setup pane.
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8. In the A Paper Source list, select how paper is supplied.

9. If you have selected Manual in A Paper Source, make sure the size as selected in Page Setup is displayed in
C Page Size. If you have selected Roll Paper in A Paper Source, make sure the width of the loaded roll is dis-
played in B Roll Width.

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Informa-

tion on the Main pane to update the printer information.

Note
• A variety of settings are available in the printer driver to suit different printing applications.

For details on available printing conditions, see "Printer Driver Settings →P.486 "
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Confirming Print Settings
There are two ways to confirm what printing conditions have been specified, as follows.

• Checking a preview of the settings
A preview of the settings is displayed on the left side of the Main, Page Setup, Utility, and Additional Settings
panes.By checking images and numerical values in the preview, you can confirm current settings for the page size,
orientation, paper source, and so on.

Display Area Information Displayed

Pane displayed when the H Im-
ages tab is clicked

On top, illustrations indicate the page size of the original, the paper size, orientation,
layout, borderless printing selection, color mode, and other settings information.
Under this, the page size, paper size, and method and percentage of enlargement or
reduction is displayed.

Pane displayed when the I Size
tab is clicked

Paper size details are indicated numerically.

Pane with printer and paper illus-
trations

Illustrations indicate the paper source, orientation, borderless printing selection, and
other settings information.

Note
• To confirm the Print Target specified in Easy Settings, click G View set. on the Main pane to display

the View settings dialog box.

• Checking a print preview
You can check an image of the original just as it will be printed.
Confirming the image of print jobs beforehand helps prevent printing errors.
For details on print previews, see "Checking the Layout in a Preview Before Printing →P.184 "
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Checking the Layout in a Preview Before Printing
This topic describes how to check the layout before printing using the Canon imagePROGRAF Preview function.

1. Choose Print in the application menu.

2. Access the Main pane.

3. Select the O Print Preview check box.

4. Click M Print.
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5. The Canon imagePROGRAF Preview window is displayed.

6. Check the layout and adjust settings in the Canon imagePROGRAF Preview window as desired.

7. Print from the Canon imagePROGRAF Preview menu.

Note
• For details on imagePROGRAF Preview functions, refer to Preview →P.518 .

Using Favorites
You can use the Presets function in Mac OS X for favorite-based printing.

Note
• In the printing dialog box, click Save As in the Presets list to save the current print settings. This is a stand-

ard feature of the operating system. For details, refer to the Mac OS documentation.

Accessing the Printer Driver Dialog Box from Applications

1. In the application software, select Print from the File menu to display the dialog box for printing conditions.

Note
• This dialog box includes basic printing options and enables you to choose the printer, specify the

range of pages, number of copies, and so on.
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2. Select the printer in the Printer list.

3. Click Print to start printing.
As shown in the following illustration, you can switch to other panes in this dialog box to complete settings for vari-
ous methods of printing, including enlarged and reduced printing, borderless printing, and so on.

Main Pane
The following settings are available on the Main pane. For details on settings items, refer to the printer driver help.

Note
• On the Main pane, choose Easy Settings to specify basic print settings based on the print target, or switch to

Advanced Settings to complete more detailed settings as desired.
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Common Items

• AMedia Type
Select the paper type.
For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See " Paper Refer-
ence Guide ".)

• BGet Information
Displays Paper Information on Printer. You can update the printer driver settings for the feed source, media type,
and roll width by selecting the feed source.

• Paper Information on Printer Dialog Box →P.499

• CSet
Displays Paper Detailed Settings. You can configure the printing settings to match the type of media, such as the ink
drying time.

• Paper Detailed Settings Dialog Box →P.500

• OPrint Preview
If you turn this on, imagePROGRAF Preview starts before printing.
This allows you to check on-screen previews of documents before printing.

Important
• When Free Layout is selected on the Page Setup panel, Free Layout is disabled.

• Checking the Layout in a Preview Before Printing →P.184

• LPrinter Information
Display the Printer Information dialog box. You can display information of the printer such as the remaining ink.
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Configuration using Easy Settings

• EPrint Target
Choose presets that match the type of document to be printed.

• Printing Photos and Images →P.22

• Printing Office Documents →P.38

• Printing Line Drawings and Text →P.47

• FPrint Quality
Choose the level of print quality.

• GView set.
Click to display the View settings dialog box, which enables you to confirm the settings for the selected item from the
E Print Target list or change the order of items listed in E Print Target.

• View settings Dialog Box for the Printing Application →P.502
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Configuration using Advanced Settings

• EPrint Priority
Choose the graphic elements that you want to emphasize for printing.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.64

• FPrint Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.64

• NHighest quality
If you select this option, the document will be printed with enhanced quality at the highest resolution. Compared to the
other options, more time and ink are consumed in printing, however you will attain print results with the highest quali-
ty.

Note
• If you set F Print Quality to High, you can select N Highest quality. However, depending on A Me-

dia Type, you may not be able to select N Highest quality.

• KEconomy Printing
When this mode is selected, you can print with less ink consumed. However, print quality is lower than in regular
printing. Select this option to save ink, such as when printing to check drawings. Depending on the A Media Type and
F Print Quality settings, this mode may not be available.

Note
• If you set F Print Quality to Fast, you can select K Economy Printing. However, depending on

A Media Type, you may not be able to select K Economy Printing.
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• G Input Bit Depth
Choose the levels of gradation in print data, either 8-bit or 16-bit. Optimal results when printing data with rich grada-
tion are possible by choosing 16-bit. For example, this option is particularly suited to printing images created after
specifying 16 bits per channel in Photoshop.
(Mac OS X 10.4 or later)

• RFast Graphic Process
Select this option to print faster than usual, when possible.

• HColor Mode
Choose the color mode.

• Giving Priority to Particular Graphic Elements and Colors for Printing →P.64

• ISet
Click to display the Color Settings dialog box for more advanced color settings.

• Adjusting the Color in the Printer Driver →P.55

• JUnidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the printing
speed becomes slower.

• QThicken Fine Lines
Activate this option to print fine lines more distinctly.

Mac OS X Software > Printer Driver >

Main Pane iPF6300S

4

498



Paper Information on Printer Dialog Box
On the Paper Information on Printer dialog box, you can obtain information on the paper in the printer and configure
printer driver media type setting.

Note
• To display the Paper Information on Printer dialog box, on the Main pane, click Get Information by

Media Type.(See "Main Pane →P.494 ")

• APaper Source
Shows the Paper Source supported by the printer, as well as the type of paper loaded. To update the media type setting
in the printer driver, select the desired Paper Source option and click OK.
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Paper Detailed Settings Dialog Box
In the Paper Detailed Settings dialog box, you can set Drying Time for the paper selected with Media Type of the Main
panel, etc.
You can display this dialog box by clicking Set of Media Type on the Main panel. (Refer to "Main Pane →P.494 ".)
You also can select from the control panel of the printer the items for which you can select Printer Default in this dialog
box. (Refer to "Menu Settings →P.914 ".)

AMedia Type
The paper selected with Media Type of the Main panel is displayed.
For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See " Paper Reference
Guide ".)

BDrying Time
Specify the time that the printer waits for ink to dry, as needed. The Drying Time setting is only valid for rolls.

• CBetween Pages
You can set the time to wait after printing 1 document page until ejecting the paper. Since waiting time is required for
ink to dry before a roll is cut, you can deliver paper in the Output Stacker with the ink dried even if Cutting Mode is
set to Automatic.

Setting Item Details

Printer Default The setting of the control panel of the printer is applied.

None Paper is ejected immediately after printing completes.

30 sec. / 1 min. / 3 min. / 5 min. /
10 min. / 30 min. / 60 min.

Paper is ejected when the set time elapses after printing completes.
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• DBetween Scans
You can set the time to wait after printing 1 line on a page until printing the next line. Set this to avoid bleeding or
color unevenness such as when bleeding occurs on a page or when color unevenness occurs during borderless printing.

Setting Item Details

Printer Default The setting of the control panel of the printer is applied.

None The next line is printed immediately after a line is printed.

1 sec. / 3 sec. / 5 sec. / 7 sec. / 9
sec.

The next line is printed when the set time elapses after a line is printed.
 

* Increase the time according to the occurrence condition of bleeding or unevenness.

ERoll Paper Margin for Safety
You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to curling is held firmly
against the Platen.

• FNear End Margin
Specify the length of the Near End Margin (the leading edge margin) of the roll, as needed.

Setting Item Details

Printer Default The setting of the control panel of the printer is applied.

3 mm (0.12 in) The document is printed in the standard size.
 

* Select this when you do not have any problems in printing.

20 mm (0.8 in) Select this when rubbing against the printhead occurs such as when using paper that
tends to curl.

GCut Speed
Select the speed of automatic cutting, as needed. You can adjust this setting if paper is not cut well when automatic cutting
is used.

Setting Item Details

Printer Default The setting of the control panel of the printer is applied.

High Speed When the Standard setting does not result in a clean cut surface, select this.

Standard Select this when you do not have any problems in automatic cutting.

Low Speed This helps prevent adhesive from sticking to the cutter and keeps the cutter sharp if
you select it when using adhesive paper.

HAutomatic Cutting
Set whether to perform roll cutting automatically or print a cut line.
The following settings are available for automatic cutting.

Setting Item Details

Printer Default The setting of the control panel of the printer is applied.

None After printing completes, the roll is not cut per page, and the next page of data is
printed successively.

Print Cut Guideline After printing completes, a line is printed per page, and the next page of data is prin-
ted successively.
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ICalibration Value
You can specify whether to apply the results of calibration performed on the printer to image processing.

Setting Item Details

Printer Default The setting of the control panel of the printer is applied.

Enabled Print using the calibration results.

Disabled Print without using the calibration results. Select this to avoid the changing of the
color of images during printing by color calibration.

JMirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image with the
left and right sides inverted.

KExtend print pass
If you are concerned about uneven colors in the print result of Highest quality, selecting this option may improve printing
results. However, printing may take longer.

View settings Dialog Box for the Printing Application
In the View settings dialog box, you can check details of the selected printing application.

Note
• To display the View settings dialog box, on the Main pane, click View settings by Print Target.(See "Main

Pane →P.494 ")

• APrint Target
Shows all Print Target options (settings items for the printing application).
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• BName
Identifies the item selected in Print Target by its name and an icon.

• CDetails
Here, you can confirm detailed settings values for each item selected in the Print Target list.

Matching pane
On the Matching pane, you can specify color matching to compensate for differences in the appearance of colors on various
devices.

Important
• If No color correction is selected under Color Mode, the Matching pane is not displayed.

Note
• To display the Matching pane, on the Main pane click Color Settings in Color Mode in Advanced Set-

tings, and then click the Matching tab. (Refer to "Main Pane →P.494 ")

• Driver Matching Mode
The following options are available when you select Driver Matching Mode in the A Matching Mode list.

• AMatching Mode
Select the color matching mode to use, as desired.
Normally, select Driver Matching Mode. For color matching based on ICC profiles, select ICC Matching Mode
depending on your color matching system.

• BMatching Method
Select the color matching method that suits the document to be printed. Various B Matching Method options are
available depending on your selection in A Matching Mode.
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• CColor Space
Select the applicable color space as desired.

• DMonitor White Point
Enter the color temperature set on the monitor.
Displayed when the B Matching Method is set to Monitor Matching.

• EUse ambient light adjustment
Select this option for adjustment of colors to suit the ambient light in the viewing environment.

• FAmbient Light Adjust
Click to display the Ambient Light Adjust dialog box, which enables you to complete settings for printing to match
the ambient light.

• Ambient Light Adjust dialog box →P.505

ICC Matching Mode
The following options are available when you select ICC Matching Mode, in the A Matching Mode list.

Note
• To display the Matching pane, on the Main pane, click Color Settings by Color Mode in Advanced Set-

tings, and then click the Matching tab.(See "Main Pane →P.494 ")

• AMatching Mode
Select the color matching mode to use, as desired.

• B Input Profile Settings
You can choose Input Profile.
Various options are available depending on your selected A Matching Mode.
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• CMatching Method
You can choose C Matching Method.
Various options are available depending on your selected A Matching Mode.

• DPrinter Profile Settings
Specify the printer profile as desired.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.55 "

Ambient Light Adjust dialog box
The Ambient Light Adjust dialog box is used to select the setting method and to enter and select the information required
for the settings.

When you select By selecting a chart number in Setting Method

• ASetting Method
You can choose configuration based on the printed Chart or based on using the i1 colorimeter.

• BPrint Chart
Click to start the Light Source Check Tool, for printing Chart.

• Light Source Check Tool →P.507

• CChart Number
In Chart, select the number of the pattern with your desired colors.

• DColor Temperature
Enter the D Color Temperature measured during monitor calibration. Displayed when the B Matching Method is
set to Monitor Matching on the Matching pane.

• E Illuminance
Enter the E Illuminance measured during monitor calibration. Displayed when the B Matching Method is set to
Monitor Matching on the Matching pane.
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When you select By entering values directly in Setting Method

• ASetting Method
You can choose configuration based on the printed Chart or based on using the i1 colorimeter.

• BLighting Source Type
Select the light source measured using the i1 colorimeter.

• DColor Temperature
Enter the D Color Temperature measured using the i1 colorimeter.

• E Illuminance
Enter the E Illuminance measured using the i1 colorimeter.
Displayed when the B Matching Method is set to Monitor Matching on the Matching pane.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.55 "
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Light Source Check Tool
The Light Source Check Tool enables you to print Chart.

• APrinter Name
The printer name is displayed here.

• BMedia Type
Select the type of paper. For details on paper types supported by Driver Matching Mode, refer to the Paper Reference
Guide. (See " Paper Reference Guide ".)

• CPaper Source
Choose the paper source, as desired.
Options displayed in the list vary depending on the selection in B Media Type in the Main pane.

• DPrint
Click to print the Chart.
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Color Settings Pane: Color
In general, make any needed adjustments to the color of documents in the application used to create them. However, if the
color tone as printed is not as you expected, you can also adjust the color in the printer driver.
If the color tone as printed is not as you expected, you can adjust it on the Color Adjustment pane.

Note
• To display the Color Adjustment pane, on the Main pane click Color Settings by Color Mode in Ad-

vanced Settings.(See "Main Pane →P.494 ")

• ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

• BView Color Pattern
Select this checkbox to display the color pattern.

• CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

• DCyan / EMagenta / FYellow
Correct color tones by adjusting the levels of each color.

• GGray Tone
Adjust the color tone of grays as desired. Choose Cool (tinged with blue) or Warm (tinged with red).

• HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or dark-
er than the original image (that is, the original photo that was scanned or the original graphic as it appears on the com-
puter screen).

Mac OS X Software > Printer Driver >
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• IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Contrast makes
images sharper, and reducing the Contrast softens images.

• JSaturation
Adjust the color intensity as desired. Increasing the Saturation setting makes colors more vivid, and reducing the
Saturation makes colors more subdued.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.55 "

• KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color ad-
justment.

• Object Adjustment dialog box: Color →P.509

Object Adjustment dialog box: Color
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment panel.

• A Images
Select this option to apply color adjustment to image areas, such as photos.

• BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

• CText
Select this option to apply color adjustment to text.
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iPF6300S Object Adjustment dialog box: Color

4

509



Color Settings Pane: Monochrome
On the Color Adjustment pane for monochrome printing, you can adjust the brightness and contrast.

Note
• To display the Color Adjustment pane, on the Main pane, click Color Settings in Advanced Settings.(See

"Main Pane →P.494 ")

• ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

• BView Color Pattern
Select this checkbox to display the color pattern.

• CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

• DCyan / EMagenta / FYellow
Not available.

• GGray Tone
Not available.

• HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or dark-
er than the original image (that is, the original photo that was scanned or the original graphic as it appears on the com-
puter screen).

• IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the I Contrast
makes images sharper, and reducing the I Contrast softens images.
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• JSaturation
Not available.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver →P.55 "

• KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to color ad-
justment.

• Object Adjustment dialog box: Monochrome →P.511

Object Adjustment dialog box: Monochrome
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an original
comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment panel.

• A Images
Select this option to apply color adjustment to image areas, such as photos.

• BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

• CText
Select this option to apply color adjustment to text.
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Gray Adjustment Pane
On the Gray Adjustment pane, you can adjust the color balance, brightness, contrast, and other image qualities.

Note
• To display the Gray Adjustment pane, on theMain Pane →P.494 , select Monochrome (Photo) by Color

Mode in Advanced Settings, and then click Color Settings.
• Monochrome (Photo) is not available for all types of paper.

• ASample
The image at left is updated to reflect any changes you make to setting items on the sheet, enabling you to check the
results of adjustment.

• BSample List
Select a sample image, as desired.

• CColor Balance
Click the list to select a color balance that suits the printing application.

• DX / EY
Adjust the color balance as you check the color tone in the adjustment area.
You can adjust the square area in the center by clicking or dragging it.
Drag the vertical or horizontal scroll bars for adjustment, as desired.
You can click the arrows by the D X (horizontal) and E Y (vertical) boxes or enter the values directly.

• FBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter or dark-
er than the original image (that is, the original photo that was scanned or the original graphic as it appears on the com-
puter screen).

Mac OS X Software > Printer Driver >
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• GContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the G Contrast
makes images sharper, and reducing the G Contrast softens images.

• HHighlight
Adjust the brightness of the lightest portion.

• IShadow
Adjust the brightness of the darkest portion.

Page Setup Pane
The following settings are available on the Page Setup pane. For details on settings items, refer to the printer driver help.

• APaper Source
Choose how paper is supplied.
Options displayed in the list vary depending on the selection in A Media Type in the Main pane.

• BRoll Width
Displays the paper width of the roll loaded in the printer. Unknown is displayed if the printer cannot detect the roll
paper width.

• CPage Size
Displays the size of the original, as specified in the page settings of the application.
For details on page sizes available in the application. see "Paper Sizes →P.774 "

• DEnlarged/Reduced Printing
Select this checkbox to choose the following options.

• Resizing Originals to Match the Paper Size →P.73

• Resizing Originals to Fit the Roll Width →P.79

• Resizing Originals by Entering a Scaling Value →P.85

Mac OS X Software > Printer Driver >
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• EFit Paper Size
Resizes the document image to match the paper size.

• FFit Roll Paper Width
Resizes the document image to match the roll width.

• GScaling
Resizes the document image based on a specified scaling value. Enter a value in a range of 5–600.

• HBorderless Printing
Borderless printing is available if roll paper is selected in the A Paper Source list.
Activate this setting for borderless printing to match the size and width of the paper.

• Borderless Printing on Paper of Equivalent Size →P.107

• Borderless Printing by Resizing Originals to Fit the Roll Width →P.114

• Borderless Printing at Actual Size →P.99

• IPaper Size
Choose the size of the paper you will print on.
Click Display all selections for Paper Size to list available sizes.
For details on available paper sizes, see "Paper Sizes →P.774 "

• JPrint Centered
Select this checkbox to print document images in the center of the paper.

• Printing Originals Centered on Rolls →P.160

• Printing Originals Centered on Sheets →P.166

• KNo Spaces at Top or Bottom
Select this checkbox to print the next image skipping blank areas above and below printable data in documents, which
enables you to conserve the paper.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins →P.178

• LRotate Page 90 degrees
Select this checkbox to rotate the document image by 90 degrees before printing.

• Conserving Roll Paper by Rotating Originals 90 Degrees →P.172

• NFree Layout
Select this checkbox to start imagePROGRAF Free Layout before printing.
This allows you to print multiple documents next to each other.

Important
• When Print Preview is selected on the Main panel, Print Preview is disabled.

• Printing Multiple Originals Next to Each Other →P.139
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Utility Pane
The following settings are available on the Utility pane.

• ASet
Click to display the Printer Information dialog box, which offers the following maintenance for the printer.

• Nozzle (ink ejecting outlet) cleaning
• Head alignment adjustment
• Feed amount adjustment

• BView
Click to start imagePROGRAF Printmonitor, which enables you to view the status of print jobs.

• CSet
Click to complete the settings for Color imageRUNNER Enlargement Copy (iR enlargement copy).
For details, see Color imageRUNNER Enlargement Copy →P.583 .
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Additional Settings Pane
The following settings are available on the Additional Settings pane.

• DSend job to
You can configure the method for saving print jobs to the printer hard disk.

• E Print

• F Save in mail box

• GPrint after reception is complete
Jobs are printed after they are saved on the hard disk.

Mac OS X Software > Printer Driver >
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Support Pane
On the Support pane, you can view support information and the user's manual.

• ASupport Information
Click to access the Canon support webpage, where you can find the latest information on the printer and consumables,
check for printer driver updates, and browse other information.

• BUser Manual
Click to view the printer user's manual. This function requires the user's manual to be installed on your computer.

• CSettings
The settings can be saved as a file. Click to display the Export dialog box, which enables you to specify where to save
the file.

• DAbout
You can display version information for the printer driver.

Mac OS X Software > Printer Driver >
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The Features of Preview
The main features of Preview are as follows.

• While viewing this screen, you can adjust layout settings of a document created with application software.
• You can not only adjust layout settings but also your changes will be instantly applied on the preview screen, and you

can print the preview screen as it is seen.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Preview settings.

Operating Environment
You can use the Preview in the following environments.

• Compatible Operating System
Mac OS X (10.4.11 to 10.6)
 

• Software that requires installation
imagePROGRAF Printer Driver

Mac OS X Software > Preview >
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Starting Preview
Follow the procedure below to start the Preview.

1. Start the apllication software which you use.

2. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

3. Click Print Preview in the Main panel to attach a checkmark.

4. Click the Print button in the Print dialog box.

Note
• Your printer is depicted in the lower-left area of this screen.

Mac OS X Software > Preview >

iPF6300S Starting Preview
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5. Preview main window is displayed.

Preview Main Window
The Preview main window consists of the menu and tool bars, and preview, dialog , drawer and status area.

Note
• You can use the View menu to show or hide the tool bar.

Mac OS X Software > Preview >

Preview Main Window iPF6300S
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• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.

• Preview Area
You can check the settings you made in this area.

Mac OS X Software > Preview >
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• Dialog Area
This allows you to set the print conditions and perform a print job.

• Drawer Area
This allows you to display the thumbnails of a document.

This area appears when you click  Drawer from the tool bar.
Alternatively, you may select Drawer from the View menu.

Mac OS X Software > Preview >
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• Status Area
This shows Input Size and Output Size.

Paper Settings Panel
This panel appears when you select Paper Settings in the dialog area.

• Media Type
This allows you to select the media type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different from

the media set in the printer, you may not receive the desired print results.

• Easy Settings / Advanced Settings
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings →P.525

• Advanced Settings →P.527

Mac OS X Software > Preview >
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• Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details

Manual Select for manual paper feed printing.

Manual (3mm margins) Select for manual paper feed printing when you want to minimize the margin at the
far end edge of paper.

Roll Paper Select to print on roll paper.

Note
• When you select Manual (3mm margins) for Paper Source, the far end edge of printed image may

become defective depending on the paper used. If this happens, select another paper source.

• Roll Paper Width
This selects the width of the roll media set to the printer.

Note
• Available only if rolls are selected in Paper Source.

• Copies
You can input the number of print copies in numerical characters.

Note
• The maximum value is 999.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Restore Defaults Button
Click the button to reset to the setting when starting Preview.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.

Mac OS X Software > Preview >
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Easy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that matches the
content of the document.

• Print Target
You can easily select the best settings for the print job simply.
If you select each Print Target item the corresponding comment for that item is displayed below the list.

Setting Details

Default Settings Suitable for printing normal documents that contain a mixture of text, photographs,
and graphics.

Photo (Color) Suitable for printing photographic images captured with a digital camera.

Photo (Monochrome) Suitable for optimized printing of monochrome photos.

Poster The best setting for posters.Prints using vivid and high impact colors.

Faithful Color Reproduction Prints by faithfully reproducing the colors of the original image.

Photo (Adobe RGB) Achieves the best color when printing an image created with the Adobe RGB color
space feature.

CAD (Color Line Drawing) Prints the fine lines of CAD drawings and other such documents sharp and clear.

Perspective, GIS Suitable for attractive printing of 3D-CAD drawings, perspective drawings, and GIS
drawings including maps.

Office Document Suitable for printing handouts as well as general office documents for which print
clarity is key.

Mac OS X Software > Preview >
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Setting Details

Custom Settings Suitable for printing documents for which Advanced Settings have been specified.

Note
• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality Highest quality / High / Standard / Fast

Resolution 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is

higher.
• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is

lower.
• For Highest quality, the resolution is not displayed.

Mac OS X Software > Preview >
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Advanced Settings
Presents detailed settings for the print quality, the color mode, and other items so you can select the values for these settings
yourself.

• Print Priority
Select a print quality mode that is appropriate for the print job.

Setting Details

Image This mode achieves the best results for printing photographic images and illustra-
tions.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or
other documents that contain large amounts of text. However, you may not achieve
the quality you expect with printing photographs or other images with many filled
areas. For these types of jobs, select Image.

Proof This is a setting for enhancing the reproducibility of characters, illustrations, and
photos with print proofing.However, this takes more time than regular printing.

Office Document Prints common office documents, such as proposals, memos for distribution, etc., so
they are easy to read.

Note
• The number of settings available for selection depends on the media type.

Mac OS X Software > Preview >
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• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality Highest quality / High / Standard / Fast

Resolution 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is

higher.
• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is

lower.
• For Highest quality, the resolution is not displayed.

Output Settings Panel
This panel appears when you select Output Settings in the dialog area.

• Enlarged/Reduced Printing
Select the method for enlarged/reduced printing.
The following settings are available for enlarged/reduced printing.

Mac OS X Software > Preview >
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Setting Details

Fit Paper Size Enlarges/reduces the whole page automatically to fit the media size selected for out-
put. Select the media size to print from Paper Size.

Fit Roll Paper Width Enlarges/reduces the whole page automatically to fit the width of the roll paper with
the page width.
 

*Make sure that the width of the roll paper in the printer is set correctly for Roll Pa-
per Width in the Paper Settings panel.
*Displayed only if rolls are selected in Paper Source.

Scaling Enlarges/reduces the whole page by the scaling rate as specified. Input the scaling
value in numerical characters. You can specify a range between 5 and 600%.
 

*You can change the numbers by clicking either ▲ button or ▼ button.
*Although Scaling can be set to make the image larger than the media size, the part
that does not fit in the media cannot be printed.
*This is not displayed when a checkmark is placed in Borderless Printing.

• Borderless Printing
You can print the media without margins on all sides when the roll paper with the specific width and the specific media
type is used.
For more information about Borderless Printing, see "Print with No Borders." →P.542

Note
• Available only if rolls are selected in Paper Source.
• This is not displayed when a checkmark is placed in Print Centered.

• Paper Size
You can select the size of the print media.

Note
• This is not displayed when Fit Roll Paper Width is set in Enlarged/Reduced Printing.

• Print Centered
You can print on the center of the media loaded in the printer.
For more information about Print Centered, see "Print on the Center." →P.542

Note
• This is not displayed when a checkmark is placed in Borderless Printing.

• No Spaces at Top or Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or
bottom.
For more information about No Spaces at Top or Bottom, see "Not Print Spaces at the Top/Bottom." →P.543

Note
• Available only if rolls are selected in Paper Source.

• Rotate Page
Select the method for rotating page.
The following settings are available for rotating page.

Mac OS X Software > Preview >
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Setting Details

Rotate Right 90 Degrees Rotates the portrait page right 90 degrees and print in landscape orientation. When
the rotated page can fit in the width of roll paper, the page is rotated automatically,
and when it can not fit in the width of roll paper, the page is not rotated.

Rotate Left 90 Degrees Rotates the portrait page left 90 degrees and print in landscape orientation. When the
rotated page can fit in the width of roll paper, the page is rotated automatically, and
when it can not fit in the width of roll paper, the page is not rotated.

Rotate 180 degrees Allows you to rotate the image 180 degrees from the vertical to the right.

• Restore Defaults Button
Click the button to reset to the setting when starting Preview.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.

Color Settings Panel
This panel appears when you select Color Settings in the dialog area.

• Color Mode
You can select a color mode to suit the print job.

Mac OS X Software > Preview >
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Setting Details

Color Enables color printing.

Monochrome (Photo) Prints monochrome photo image data in a gray scale that is free of color casting
(phenomenon of grays that appear tinted).

Monochrome Disables color printing and converts image from continuous color to grayscaled
monochrome.

No color correction Prints without performing color matching in the printer driver. Select this when color
matching is performed by the application such as Adobe Photoshop or when you
want to print color charts using the profile creation tool.

Note
• The availability of settings depends on the print priority and media type selections.

• Color Adjustment / Gray Adjustment / Matching
You can set the color adjustment and matching.

• Color Adjustment →P.531

• Gray Adjustment →P.534

• Matching →P.535

Note
• You can select Gray Adjustment only after Monochrome (Photo) has been selected in Color Mode.
• Matching is not displayed if No color correction has been selected in Color Mode.

• Restore Defaults Button
Click the button to reset to the setting when starting Preview.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.

Color Adjustment
You can set the color adjustment.

Adjusting Color
Normally colors should be adjusted in the software application, but if you see colors in the printout that do not match colors
on the screen, you can perform color adjustments.

1. Select Color or Color (Economy) on Color Mode in the Color Settings panel.
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2. Select Color Adjustment.

3. Drag each slider to the left or right to adjust.

Setting Details

Cyan Adjusts the strength of colors to compensate the hues.

Magenta Adjusts the strength of colors to compensate the hues.

Yellow Adjusts the strength of colors to compensate the hues.

Brightness Adjusts the brightness of the entire image. When the results of the printout are
brighter than the original images such as the original photo before scanning and
graphics created on the display, or when you want to print in different degrees of
brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the im-
age.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjusts the hues for vivid color or dark color.

Gray Adjustment Adjusts gray from cool black (bluish tones) to warm black (reddish tones).

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the

value.
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Adjusting Monochrome
Use the monochrome setting to print monochrome images of color photographs captured with a scanner or digital camera or
other color images.

1. Select Monochrome on Color Mode in the Color Settings panel.

2. Select Color Adjustment.

3. Drag each slider to the left or right to adjust.

Setting Details

Brightness Adjusts the brightness of the entire image. When the results of the printout are
brighter than the original images such as the original photo before scanning and
graphics created on the display, or when you want to print in different degrees of
brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the im-
age.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the

value.
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Gray Adjustment
You can set the gray adjustment.

Adjusting Monochrome (Photo)
Sets monochrome printing for black-and-white photo image data captured with a scanner or digital camera.

1. Select Monochrome (Photo) on Color Mode in the Color Settings panel.

2. Select Gray Adjustment.

3. Click the Color Balance list and select the color settings.

Setting Details

Cool Black Adjusts cool black (blue tones) to gray.

Pure Neutral Black Adjusts to neutral gray.

Warm Black Adjusts warm black (red tones) to gray.

Note
• To perform the adjustments, drag the X or Y slide bar left and right.
• You can also click the up or down arrow, or enter the number directly to increase or decrease the

value by X and Y.
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4. Drag each slider to the left or right to adjust.

Setting Details

Brightness Adjusts the brightness of the entire image. When the results of the printout are
brighter than the original images such as the original photo before scanning and
graphics created on the display, or when you want to print in different degrees of
brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the im-
age.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Highlight Adjusts the brightness of the brightest areas.

Shadow Adjusts the brightness of the darkest areas.

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the

value.
• The availability of settings depends on the selected the media type.

Matching
You can set the matching.

Important
• If No color correction is selected under Color Mode, the Matching is not displayed.
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• Matching Mode
You can select a matching mode to suit the print job.

Setting Details

Driver Matching Mode
→P.538

Enables printing of optimal color tones using a driver specific color profile. You
should normally select this mode.

ICC Matching Mode →P.539 Enables color matching using ICC profiles. Select this if you want to print by speci-
fying the input profile, printer profile, and matching method in detail. This allows
you to use ICC profiles for digital cameras and scanners, ICC profiles created using
the profile creation tool, etc.

ColorSync →P.540 Enables color matching by using the ColorSync function of Mac OS. Select this if
you want to perform soft proofing using ColorSync before printing.

Note
• You need to set each correction on the printer driver.
• Using Mac OS X 10.5 or later, ColorSync needs to be selected in the Color Matching panel of the

driver in order to select ColorSync.

• Matching Method
You can select a matching method to suit the print job.

• Color Space
Select the color space.
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Note
• You can select only after Driver Matching Mode has been selected in Matching Mode.

• Input Profile
Select the input profile.

Note
• You can select only after ICC Matching Mode has been selected in Matching Mode.

• Printer Profile
Select the printer profile.

Note
• (Using Mac OS X 10.4)You can select only after ICC Matching Mode or ColorSync has been selected

in Matching Mode.
• (Using Mac OS X 10.5 or later)You can select only after ICC Matching Mode has been selected in

Matching Mode.

• Soft Proof
When you place a checkmark here, ColorSync applies to the preview area.

Note
• You can select only after ColorSync has been selected in Matching Mode.
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Driver Matching Mode

1. Under Matching Mode, select Driver Matching Mode.

2. Click the Matching Method list, and then select a setting.

Setting Details

Auto Automatically selects the best color matching method for each Image, Graphics,
Text.

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation
is a feature. This is also an easy-to-use mode when performing color adjustment us-
ing application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color
space. This is the easiest-to-use mode when you want to adjust the color and print.
However, gradation may be lost for colors of wider range than the color reproduction
range of the printer. Generally, this is also called relative colorimetric.

3. Select Color Space for the print output.

Setting Details

sRGB Uses color space for a standard monitor. This selection is ideal for most software ap-
plications.
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Setting Details

Adobe RGB Uses wide color space. Use this setting to print images created with Adobe RGB col-
or space.

ICC Matching Mode

1. Under Matching Mode, select ICC Matching Mode.

2. Click the Matching Method list, and then select a setting.

Setting Details

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation
is a feature. This is also an easy-to-use mode when performing color adjustment us-
ing application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color
space. This is the easiest-to-use mode when you want to adjust the color and print.
However, gradation may be lost for colors of wider range than the color reproduction
range of the printer. Generally, this is also called relative colorimetric.

Colorimetric (No White-Point
Correction)

The processing method of color-matching is identical to Colorimetric. Use this
when you want to further reproduce the target paper material color of the image data.
Generally, this also is called absolute colorimetric.
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3. Click the Input Profile list and select an input profile.

4. Click the Printer Profile list and select a printer profile.

ColorSync

1. Check that ColorSync is selected in Matching Mode.

2. To apply ColorSync to previews, check the Soft Proof check box.

Preferences Dialog Box
This dialog box appears when you select Preferences from the imagePROGRAF Advanced Preview menu. You can set
the preferences for Preview.
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• Units
Set the unit for paper length, margins, and so on.
 

Zoom Dialog Box
This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen display.

• Scaling
Set the magnification for enlargement or reduction of the screen display.

Note
• You can input between 10 and 400.
• You can change the numbers by clicking ▼ button.

Go to Page Dialog Box
This dialog box appears when you select Go to Page from the View menu.

Note
• You can not select Go to Page if the document is only one page.

• Page
Input the page number in numerical characters to display in the preview area.

Note
• You can change the numbers in the range of the page of the documents.
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Print with No Borders
You can use the borderless printing function to print without margins surrounding the image.

Note
• With some media borderless printing can be performed only between two edges.
• To use the borderless printing function, the specified media must be set to the printer.

1. On the Paper Settings Panel →P.523 , select Roll Paper in Paper Source.

2. On the Output Settings panel, click the Enlarged/Reduced Printing check box on.

3. Select Fit Roll Paper Width.

4. Click the Borderless Printing check box on.

5. Click the Print button.
 

Borderless printing begins.

Print on the Center
You can print on the center of the media loaded in the printer.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.
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1. On the Output Settings panel, click the Print Centered check box on.

2. Click the Print button.
 

Printing on the center begins.

Not Print Spaces at the Top/Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top or bottom.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.

1. On the Paper Settings Panel →P.523 , select Roll Paper in Paper Source.
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2. On the Output Settings panel, click the No Spaces at Top or Bottom check box on.

3. Click the Print button.
 

Printing on the settings with no spaces at top or bottom begins.

Print Page Rotated 90 Degrees
You can save paper by printing in landscape orientation on roll paper.

1. On the Paper Settings Panel →P.523 , select Roll Paper in Paper Source.

2. On the Output Settings panel, click the Rotate Page check box on.
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3. Select Rotate Right 90 Degrees or Rotate Left 90 Degrees.

4. Click the Print button.
 

Printing on rotating 90 degrees begins.

Display with Fitting to the Width of the Paper
In the preview area, you can display to the width of the paper.

1. Select  Fit Roll Paper Width from the tool bar.
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2. Fitting to the width of the paper, it is displayed.

Display with All
In the preview area, you can display all.

1. Select  Fit Screen from the tool bar.

2. All is displayed.
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Display with Actual Size
In the preview area, you can display the actual size.

1. Select  Actual Size from the tool bar.

2. Actual size is displayed.

Moving a Page
You can move a page to display in the preview area.

1. Select each button in Go to Page on the tool bar.

Setting Details

Go to the first page.

Go to the previous page.

Go to the next page.

Go to the last page.
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2. The target page appears.

Note
• You can also move a page by clicking the page on the thumbnails.
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The Features of Free Layout
The main features of Free Layout are as follows.

• Allows you to lay out at will and print a document created with application software.
• You can not only lay out multiple pages on one page but also lay out and print a multiple-file document on one page,

or lay out and print a document created with multiple application programs on one page.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Free Layout settings.

Operating Environment
You can use the Free Layout in the following environments.

• Compatible Operating System
Mac OS X (10.4.11 to 10.6)

• Software that requires installation

Mac OS X Software > Free Layout >
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imagePROGRAF Printer Driver

Starting Free Layout
Follow the procedure below to start the Free Layout.

1. Start the apllication software which you use.

2. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

3. Click on Free Layout in the Page Setup panel to attach a checkmark.

4. Click the Print button in the Print dialog box.

Note
• Your printer is depicted in the lower-left area of this screen.

Mac OS X Software > Free Layout >
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5. Free Layout main window is displayed.

Free Layout Main Window
The Free Layout main window consists of the menu and tool bars, layout area and dialog areas.

Note
• You can use the View menu to show or hide the tool.
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• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.

• Layout Area
This allows you to lay out objects and edit the object size and orientation.
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• Dialog Area
This allows you to set the print conditions and perform a print job.
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Paper Settings Panel
This panel appears when you select Paper Settings in the dialog area.

• Media Type
This allows you to select the media type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different from

the media set in the printer, you may not receive the desired print results.

• Easy Settings / Advanced Settings
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings →P.556

• Advanced Settings →P.558

• Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details

Roll Paper Select to print on roll paper.

Manual Select for manual paper feed printing.
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Setting Details

Manual (3mm margins) Select for manual paper feed printing when you want to minimize the margin at the
far end edge of paper.

Note
• When you select Manual (3mm margins) for Paper Source, the far end edge of printed image may

become defective depending on the paper used. If this happens, select another media source.

• Roll Paper Width
This selects the width of the roll media set to the printer.

Note
• Available only if rolls are selected in Paper Source.

• Copies
You can input the number of print copies in numerical characters.

Note
• The maximum value is 999.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Restore Defaults Button
Click the button to reset to the setting when starting Free Layout.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.
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Easy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that matches the
content of the document.

• Print Target
You can easily select the best settings for the print job simply.
If you select each Print Target item the corresponding comment for that item is displayed below the list.

Setting Details

Default Settings Suitable for printing normal documents that contain a mixture of text, photographs,
and graphics.

Photo (Color) Suitable for printing photographic images captured with a digital camera.

Photo (Monochrome) Suitable for optimized printing of monochrome photos.

Poster The best setting for posters.Prints using vivid and high impact colors.

Faithful Color Reproduction Prints by faithfully reproducing the colors of the original image.

Photo (Adobe RGB) Achieves the best color when printing an image created with the Adobe RGB color
space feature.

CAD (Color Line Drawing) Prints the fine lines of CAD drawings and other such documents sharp and clear.

Perspective, GIS Suitable for attractive printing of 3D-CAD drawings, perspective drawings, and GIS
drawings including maps.

Office Document Suitable for printing handouts as well as general office documents for which print
clarity is key.
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Setting Details

Custom Settings Suitable for printing documents for which Advanced Settings have been specified.

Note
• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality Highest quality / High / Standard / Fast

Resolution 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is

higher.
• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is

lower.
• For Highest quality, the resolution is not displayed.
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Advanced Settings
Presents detailed settings for the print priority, the print quality, and other items so you can select the values for these set-
tings yourself.

• Print Priority
Select a print quality mode that is appropriate for the print job.

Setting Details

Image This mode achieves the best results for printing photographic images and illustra-
tions.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or
other documents that contain large amounts of text. However, you may not achieve
the quality you expect with printing photographs or other images with many filled
areas. For these types of jobs, select Image.

Proof This is a setting for enhancing the reproducibility of characters, illustrations, and
photos with print proofing.However, this takes more time than regular printing.

Office Document Prints common office documents, such as proposals, memos for distribution, etc., so
they are easy to read.

Note
• The number of settings available for selection depends on the media type.
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• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality Highest quality / High / Standard / Fast

Resolution 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is

higher.
• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is

lower.
• For Highest quality, the resolution is not displayed.

Color Settings Panel
This panel appears when you select Color Settings in the dialog area.

• Color Mode
You can select a color mode to suit the print job.
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Setting Details

Color Enables color printing.

Monochrome (Photo) Prints monochrome photo image data in a gray scale that is free of color casting
(phenomenon of grays that appear tinted).

Monochrome Disables color printing and converts image from continuous color to grayscaled
monochrome.

No color correction Prints without performing color matching in the printer driver. Select this when color
matching is performed by the application such as Adobe Photoshop or when you
want to print color charts using the profile creation tool.

Note
• The availability of settings depends on the print priority and media type selections.

• Color Adjustment / Gray Adjustment / Matching
You can set the color adjustment and matching.

• Color Adjustment →P.560

• Gray Adjustment →P.563

• Matching →P.564

Note
• You can select Gray Adjustment only after Monochrome (Photo) has been selected in Color Mode.
• Matching is not displayed if No color correction has been selected in Color Mode.

• Restore Defaults Button
Click the button to reset to the setting when starting Free Layout.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.

Color Adjustment
You can set the color adjustment.

Adjusting Color
Normally colors should be adjusted in the software application, but if you see colors in the printout that do not match colors
on the screen, you can perform color adjustments.

1. Select Color or Color (Economy) on Color Mode in the Color Settings panel.
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2. Select Color Adjustment.

3. Drag each slider to the left or right to adjust.

Setting Details

Cyan Adjusts the strength of colors to compensate the hues.

Magenta Adjusts the strength of colors to compensate the hues.

Yellow Adjusts the strength of colors to compensate the hues.

Brightness Adjusts the brightness of the entire image. When the results of the printout are
brighter than the original images such as the original photo before scanning and
graphics created on the display, or when you want to print in different degrees of
brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the im-
age.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjusts the hues for vivid color or dark color.

Gray Tone Adjusts gray from cool black (bluish tones) to warm black (reddish tones).

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the

value.
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Adjusting Monochrome
Use the monochrome setting to print monochrome images of color photographs captured with a scanner or digital camera or
other color images.

1. Select Monochrome on Color Mode in the Color Settings panel.

2. Select Color Adjustment.

3. Drag each slider to the left or right to adjust.

Setting Details

Brightness Adjusts the brightness of the entire image. When the results of the printout are
brighter than the original images such as the original photo before scanning and
graphics created on the display, or when you want to print in different degrees of
brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the im-
age.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the

value.
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Gray Adjustment
You can set the gray adjustment.

Adjusting Monochrome (Photo)
Sets monochrome printing for black-and-white photo image data captured with a scanner or digital camera.

1. Select Monochrome (Photo) on Color Mode in the Color Settings panel.

2. Select Gray Adjustment.

3. Click the Color Balance list and select the color settings.

Setting Details

Cool Black Adjusts cool black (blue tones) to gray.

Pure Neutral Black Adjusts to neutral gray.

Warm Black Adjusts warm black (red tones) to gray.

Note
• To perform the adjustments, drag the X or Y slide bar left and right.
• You can also click the up or down arrow, or enter the number directly to increase or decrease the

value by X and Y.
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4. Drag each slider to the left or right to adjust.

Setting Details

Brightness Adjusts the brightness of the entire image. When the results of the printout are
brighter than the original images such as the original photo before scanning and
graphics created on the display, or when you want to print in different degrees of
brightness, use this feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the im-
age.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Highlight Adjusts the brightness of the brightest areas.

Shadow Adjusts the brightness of the darkest areas.

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the

value.
• The availability of settings depends on the selected the media type.

Matching
You can set the matching.

Important
• If No color correction is selected under Color Mode, the Matching is not displayed.
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• Matching Mode
You can select a matching mode to suit the print job.

Setting Details

Driver Matching Mode
→P.567

Enables printing of optimal color tones using a driver specific color profile. You
should normally select this mode.

ICC Matching Mode →P.568 Enables color matching using ICC profiles. Select this if you want to print by speci-
fying the input profile, printer profile, and matching method in detail. This allows
you to use ICC profiles for digital cameras and scanners, ICC profiles created using
the profile creation tool, etc.

ColorSync →P.569 Enables color matching by using the ColorSync function of Mac OS. Select this if
you want to perform soft proofing using ColorSync before printing.

Note
• You need to set each correction on the printer driver.
• Using Mac OS X 10.5 or later, ColorSync needs to be selected in the Color Matching panel of the

driver in order to select ColorSync.

• Matching Method
You can select a matching method to suit the print job.

• Color Space
Select the color space.
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Note
• You can select only after Driver Matching Mode has been selected in Matching Mode.

• Input Profile
Select the input profile.

Note
• You can select only after ICC Matching Mode has been selected in Matching Mode.

• Printer Profile
Select the printer profile.

Note
• (Using Mac OS X 10.4)You can select only after ICC Matching Mode or ColorSync has been selected

in Matching Mode.
• (Using Mac OS X 10.5 or later)You can select only after ICC Matching Mode has been selected in

Matching Mode.

• Soft Proof
When you place a checkmark here, ColorSync applies to the layout area.

Note
• You can select only after ColorSync has been selected in Matching Mode.
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Driver Matching Mode

1. Under Matching Mode, select Driver Matching Mode.

2. Click the Matching Method list, and then select a setting.

Setting Details

Auto Automatically selects the best color matching method for each Image, Graphics,
Text.

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation
is a feature. This is also an easy-to-use mode when performing color adjustment us-
ing application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color
space. This is the easiest-to-use mode when you want to adjust the color and print.
However, gradation may be lost for colors of wider range than the color reproduction
range of the printer. Generally, this is also called relative colorimetric.

3. Select Color Space for the print output.

Setting Details

sRGB Uses color space for a standard monitor. This selection is ideal for most software ap-
plications.
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Setting Details

Adobe RGB Uses wide color space. Use this setting to print images created with Adobe RGB col-
or space.

ICC Matching Mode

1. Under Matching Mode, select ICC Matching Mode.

2. Click the Matching Method list, and then select a setting.

Setting Details

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation
is a feature. This is also an easy-to-use mode when performing color adjustment us-
ing application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color
space. This is the easiest-to-use mode when you want to adjust the color and print.
However, gradation may be lost for colors of wider range than the color reproduction
range of the printer. Generally, this is also called relative colorimetric.

Colorimetric (No White-Point
Correction)

The processing method of color-matching is identical to Colorimetric. Use this
when you want to further reproduce the target paper material color of the image data.
Generally, this also is called absolute colorimetric.
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3. Click the Input Profile list and select an input profile.

4. Click the Printer Profile list and select a printer profile.

ColorSync

1. Check that ColorSync is selected in Matching Mode.

2. Place a checkmark on Soft Proof to simulate the output product in Layout Area.
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Preferences Dialog Box
This dialog box appears when you select Preferences from the imagePROGRAF Advanced Preview menu. You can set the
preferences for Free Layout.

• Units
Set the unit for paper length, margins, and so on.

• Gridlines
You can input a grid line width value in numerical characters so that they serve as a guide to laying out objects.

Note
• You can input between 10.0 and 200.0(mm) (between 0.39 and 7.87(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Divisions
You can change the number of divisions of grid lines so that they serve as a guide to laying out objects.

Note
• You can input between 1 and 10.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Grid Color
Select the grid line color.

• Print Object Frames
You can print the object border.

Note
• If you do not want to print the object border, deselect the Print Object Frames check box.
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• Object Frame Style
You can select the object frame style for printing.
The following settings are available for the object frame style.

Setting Details

Solid Line You can print the solid line as the frame style.

Dotted Line You can print the dotted line as the frame style.

Dashed Line You can print the dashed line as the frame style.

• Auto Arrange Spacing
Change the object-to-object spacing to be applied in the operation of laying out objects automatically.

Note
• You can input between 0.0 and 100.0(mm) (between 0.00 and 3.94(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Page Setup Dialog Box
This dialog box appears when you select Page Setup from the File menu.This dialog box provides selections for setting the
media size, orientation and other important features.

• Paper Orientation
This selects the paper orientation.
The following settings are available for orientation.

Setting Details

Vertical Prints the image and text created with the application software in the orientation as it
is.

Horizontal Prints the image and text by rotating sideways 90 degrees from the orientation as
specified in the application.
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• Roll Paper Length
Set the length of one page to print on roll paper.
When you place a checkmark on Auto Settings, the one-page length to be printed on roll paper is automatically set so
that the laid-out objects are printed on one page.

Note
• Available only if rolls are selected in Paper Source.
• You can input between 203.2 and 18000.0(mm) (between 8.00 and 708.66(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Order
Set the object layout order.
The following settings are available for order.

Setting Details

Upper Left to Right The objects are laid out from upper left to right.

Upper Left to Bottom The objects are laid out from upper left to bottom.

Note
• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Vertical, you

can choose only Upper Left to Right.
• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Horizontal,

you can choose only Upper Left to Bottom.

• Paper Size
You can select the size of the print media.

Note
• You cannot display this if Roll Paper is selected in Paper Source.

Zoom Dialog Box
This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen display.

• Scaling
Set the magnification for enlargement or reduction of the screen display.

Note
• You can input between 10 and 400.
• You can change the numbers by clicking ▼ button.
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Format Dialog Box
This dialog box appears when you select Format from the Object menu after you select an object. You can rotate, enlarge,
or reduce an object.

Note
• When the objects are not selected, you can not select Format.

• Rotate
When you place a checkmark here, you can select Rotate Right or Rotate Left.

Setting Details

Rotate Right Rotates the object 90 degrees clockwise.

Rotate Left Rotates the object 90 degrees counterclockwise.

Note
• When several objects are selected, you cannot select Rotate.

• Scaling
You can input the value for enlargement or reduction of the obeject in numerical characters.

Note
• You can input between 25 and 400.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Object Size
You can confirm the object size.

Note
• When several objects are selected, you cannot display Object Size.
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Laying out a Multiple-File Document on One Page
You can lay out and print a multiple-file document on one page.

1. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

2. Click on Free Layout in the Page Setup panel to attach a checkmark.

3. In the Print dialog box, select the pages to print and the number of copies, and click the Print button.
Free Layout starts, laying out the document created with application software in the layout area as an object.

4. Leaving Free Layout running, open other files with the application software and repeat the above steps.

Laying out a Document Created with Multiple Application Programs on One Page
You can lay out and print a document created with multiple application programs on one page.

1. From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

2. Click on Free Layout in the Page Setup panel to attach a checkmark.

3. In the Print dialog box, select the pages to print and the number of copies, and click the Print button.
Free Layout starts, laying out the document created with application software in the layout area as an object.

4. Leaving Free Layout running, open the files with other application software and repeat the above steps.
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Selecting an Object
When an object is selected, a select box (blue border) appears around the object.

Note
• To select an object, click that object.
• To select multiple successive objects, click them while holding down the shift key.
• To select multiple arbitrary objects, click them while holding down the command key.
• To select all objects, select Select All from the Edit menu.

Changing the Object Size
You can change the object size by means of mouse operation or by specifying a scaling value.

Note
• The vertical-to-horizontal ratio remains unchanged when the object is enlarged or reduced.

Resizing by means of mouse operation

1. Select an object.
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2. Place the pointer at a corner of the selection box around the object to show the arrow handle, and drag this handle to
change the object size.

Resizing by specifying a scaling value

1. Select an object.

2. Open the Format Dialog Box →P.573 .

3. Use Scaling to set the magnification for enlargement or reduction. You either enter numbers directly.

Note
• You can input between 25 and 400.
• You can change the numbers by clicking either ▲ button or ▼ button.

4. Click the OK button.

Moving an Object
You can move the object position.

1. Select an object.
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2. Place the pointer inside the selection box of the object to show the crosshair handle, and drag it to move the object.

Rotating an Object
You can rotate the object.

1. Select an object.

2. Select Rotate Left or Rotate Right from the toolbar.
Alternatively, you may click on the Rotate check box in the Format Dialog Box →P.573  then select Rotate Right
or Rotate Left, and click the OK button.

Note
• When several objects are selected, you cannot select Rotate.
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Laying out Objects Automatically
Click Auto Arrange in the tool bar. This automatically lays out objects. Alternatively, you may select Auto Arrange Ob-
ject from the Object menu.

Note
• The object layout order varies depending on the Order setting on the Page Setup Dialog Box →P.571 .

Aligning Objects
You can align objects systematically.

1. Select multiple objects.

2. Select the align menu from the Object menu.

Align Top
Lays out the objects, justifying them to the top.
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Center Vertically
Lays out the objects, justifying them to the vertical center.

Align Bottom
Lays out the objects, justifying them to the bottom.

Align Left
Lays out the objects, justifying them to the left.
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Center Horizontally
Lays out the objects, justifying them to the horizontal center.

Align Right
Lays out the objects, justifying them to the right.

Changing the Object Overlapping Order
You can change the object overlapping order.

1. Select an object.

2. Select the overlapping order menu from the Object menu.
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Bring to Front
Moves the object to the frontmost position.

Send to Back
Moves the object to the backmost position.

Bring Forward
Moves the object one position to the front.

Mac OS X Software > Free Layout >

iPF6300S Changing the Object Overlapping Order

4

581



Send Backward
Moves the object one position to the back.

Pasting a Copied or Cut Object

1. Click Copy or Cut from the toolbar.
Alternatively, you may select Copy or Cut from the Edit menu.

2. Click Paste from the toolbar.
Alternatively, you may select Paste from the Edit menu.

Note
• The copied or cut object is laid out at the end of the page.
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The Features of Color imageRUNNER Enlargement Copy
The main features of Color imageRUNNER Enlargement Copy are as follows.

• Allows the document scanned with the Color imageRUNNER to be automatically enlarged and printed.
• You can perform basic printer settings such as printer selection, media type and output profile selection, and matching

methods, in addition to borderless printing and enlargement/reduction process without growing through the printer
driver.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Color imageRUNNER Enlargement Copy settings.

Operating Environment
You can use the Color imageRUNNER Enlargement Copy in the following environments.

• Compatible Operating System
Mac OS X (10.4.11 to 10.6)
 

• Software that requires installation
imagePROGRAF Printer Driver
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Starting Color imageRUNNER Enlargement Copy
Follow the procedure below to start the Color imageRUNNER Enlargement Copy.

1. Open the Utility panel of the Print dialog box.

Note
• Your printer is depicted in the lower-left area of this screen.
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2. Click the Set button in Configure Color imageRUNNER Enlargement Copy. to open the Color imageRUNNER
Enlargement Copy dialog box.

Note
• You can also start the utility directly by clicking on the Color imageRUNNER Enlargement Copy.app

icon in Applications > Canon Utilities > iR Enlargement Copy.

Color imageRUNNER Enlargement Copy Dialog Box
The explanation below is on the Color imageRUNNER Enlargement Copy dialog box.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color image-

RUNNER Enlargement Copy." →P.584
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• Delete files in the folder
From the Hot Folder list, select a hot folder and click the Delete button to delete only files in the hot folder.

• Delete the entire folder, as well as items in the list above
From the Hot Folder list, select a hot folder and click the Delete button to delete the hot folder.

• Delete Button
Select Delete files in the folder or Delete the entire folder, as well as items in the list above and click this button to
delete the hot folder or only files in the hot folder.

• Add Button
Click the button to open the Destination Selection dialog box so that you can add a hot folder.

• Edit Button
From the Hot Folder list, select a hot folder and click this button to open the Add/Edit Hot Folder dialog box that
allows you to edit the hot folder.

• Monitor Hot Folder Constantly
If you click on the check box, the icon of Color imageRUNNER Enlargement Copy utility will appear on the Dock
when starting OS X thereafter.

Hot Folder
Hot folder refers to a folder used for Color imageRUNNER Enlargement Copy.

• When transferred to the PC's hot folder, the document data scanned with the Color imageRUNNER is printed in en-
larged size from the printer according to the print conditions set in the hot folder.

• You can create a new hot folder, edit or delete an existing one, and set print conditions at will.

Note
• You can create up to 10 hot folders.
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Creating a New Hot Folder

1. Open the Color imageRUNNER Enlargement Copy dialog box.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color

imageRUNNER Enlargement Copy." →P.584

2. Click the Add button in Enlarged Copy Settings to open the Destination Selection dialog box.

3. From the printer list in Destination, select the printer of destination.
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4. Click the OK button to open the Add/Edit Hot Folder dialog box.

5. In Name, enter the name to display in the Hot Folder list.

6. In Hot Folder, enter the Hot Folder name.

7. Click the OK button. The created Hot Folder is listed in the Color imageRUNNER Enlargement Copy dialog box.
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8. Click the Close button to close the Color imageRUNNER Enlargement Copy dialog box.

9. From the Apple Menu, open the Sharing dialog box for System Preferences.

10. Select the check box labeled File Sharing, and click the Options button.

11. Select the check box labeled Share files and folders using FTP and Share files and folders using SMB to make
shared settings.

Note
• You can create up to 10 hot folders.

Editing a Hot Folder (Setting Print Conditions)

1. Open the Color imageRUNNER Enlargement Copy dialog box.

2. Select the Hot Folder from the Hot Folder list.

3. From Enlarged Copy Settings, click Edit button to open the Add/Edit Hot Folder dialog box.
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4. Make the necessary settings in the Paper Settings Panel →P.594 .
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5. Make the necessary settings in the Output Settings Panel →P.599 .
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6. Make the necessary settings in the Color Settings Panel →P.601 .

7. Click the OK button to close the Add/Edit Hot Folder dialog box.

8. From the Apple Menu, open the Sharing dialog box for System Preferences.

9. Select the check box labeled File Sharing, and click the Options button.

10. Select the check box labeled Share files and folders using FTP and Share files and folders using SMB to make
shared settings.

Note
• If you've made shared settings when you created a new Hot Folder, you do not need to execute steps 8

to 10.

Mac OS X Software > Color imageRUNNER Enlargement Copy >

Editing a Hot Folder (Setting Print Conditions) iPF6300S

4

592



Deleting a Hot Folder

1. Open the Color imageRUNNER Enlargement Copy dialog box.

2. Select the Hot Folder you want to delete from the Hot Folder list.

3. Select Delete the entire folder, as well as items in the list above, and then click the Delete button.

4. Read the messag,e and then click the OK button.

Note
• Select Delete files in the folder to delete only files in the hot folder.

Setting the Print Parameters
You can set the print conditions in the setting panels within the Add/Edit Hot Folder dialog box.
The settings available on each panel are as follows.

• Paper Settings Panel →P.594

• Output Settings Panel →P.599

• Color Settings Panel →P.601
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Paper Settings Panel

• Easy Settings / Advanced Settings
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings →P.596

• Advanced Settings →P.597

• Media Type
This allows you to select the media type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different from

the media set in the printer, you may not receive the desired print results.

• Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details

Manual Select for manual paper feed printing.

Manual (3mm margins) Select for manual paper feed printing when you want to minimize the margin at the
far end edge of paper.

Roll Paper Select to print on roll paper.
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Note
• When you select Manual (3mm margins) for Paper Source, the far end edge of printed image may

become defective depending on the paper used. If this happens, select another paper source.

• Roll Paper Width
This selects the width of the roll media set to the printer.

Note
• Available only if rolls are selected in Paper Source.

• Automatic Cutting
You can set the printer to cut roll paper automatically or print a guideline for cutting.
The following settings are available for automatic cutting.

Setting Details

Printer Default The value set on the printer operation panel takes priority.

None Each page is not cut after it is printed and printing continues without interruption.

Print Cut Guideline A print cut guideline is printed after each page and printing continues without inter-
ruption.

Note
• Available only if rolls are selected in Paper Source.

• Copies
You can input the number of print copies in numerical characters.

Note
• The maximum value is 999.
• You can change the numbers by clicking either ▲ button or ▼ button.
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Easy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that matches the
content of the document.

• Print Target
You can easily select the best settings for the print job simply.
If you select each Print Target item the corresponding comment for that item is displayed below the list.

Setting Details

Default Settings Suitable for printing normal documents that contain a mixture of text, photographs,
and graphics.

Photo (Color) Suitable for printing photographic images captured with a digital camera.

Photo (Monochrome) Suitable for optimized printing of monochrome photos.

Poster The best setting for posters.Prints using vivid and high impact colors.

Faithful Color Reproduction Prints by faithfully reproducing the colors of the original image.

Photo (Adobe RGB) Achieves the best color when printing an image created with the Adobe RGB color
space feature.

CAD (Color Line Drawing) Prints the fine lines of CAD drawings and other such documents sharp and clear.

Perspective, GIS Suitable for attractive printing of 3D-CAD drawings, perspective drawings, and GIS
drawings including maps.

Office Document Suitable for printing handouts as well as general office documents for which print
clarity is key.

Custom Settings Suitable for printing documents for which Advanced Settings have been specified.
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Note
• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality High / Standard / Fast

Resolution 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is

higher.
• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is

lower.

Advanced Settings
Presents detailed settings for the print priority, the print quality, and other items so you can select the values for these set-
tings yourself.
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• Print Priority
Select a print quality mode that is appropriate for the print job.

Setting Details

Image This mode achieves the best results for printing photographic images and illustra-
tions.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or
other documents that contain large amounts of text. However, you may not achieve
the quality you expect with printing photographs or other images with many filled
areas. For these types of jobs, select Image.

Proof This is a setting for enhancing the reproducibility of characters, illustrations, and
photos with print proofing.However, this takes more time than regular printing.

Office Document Prints common office documents, such as proposals, memos for distribution, etc., so
they are easy to read.

Note
• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality High / Standard / Fast

Resolution 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is

higher.
• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is

lower.
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Output Settings Panel

• Enlarged/Reduced Printing
Select the method for enlarged/reduced printing.
The following settings are available for enlarged/reduced printing.

Setting Details

Fit Paper Size Enlarges/reduces the whole page automatically to fit the media size selected for out-
put. Select the media size to print from Paper Size.

Fit Roll Paper Width Enlarges/reduces the whole page automatically to fit the width of the roll paper with
the page width.
 

*Make sure that the width of the roll paper in the printer is set correctly for Roll Pa-
per Width in the Paper Settings panel.
*Displayed only if rolls are selected in Paper Source.

Scaling Enlarges/reduces the whole page by the scaling rate as specified. Input the scaling
value in numerical characters. You can specify a range between 5 and 600%.
 

*You can change the numbers by clicking either ▲ button or ▼ button.
*Although Scaling can be set to make the image larger than the media size, the part
that does not fit in the media cannot be printed.
*This is not displayed when a checkmark is placed in Borderless Printing.

• Borderless Printing
You can print the media without margins on all sides when the roll paper with the specific width and the specific media
type is used.
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Note
• Available only if rolls are selected in Paper Source.

• Paper Size
You can select the size of the print media.

Note
• This is not displayed when Fit Roll Paper Width is set in Enlarged/Reduced Printing.

• Print Centered
Select this feature to print the image in the center of a cut sheet or to print left and right margins evenly from the edges
of roll paper.

Note
• This feature is useful when you print the document enlarged or reduced with Scaling as well. When an

image is scaled, it is always enlarged or reduced in reference to a starting point in the upper left corner
of the page. If the image is reduced, the bottom and right margins are enlarged and the top and left mar-
gins remain unchanged. At that point, you can set all margins evenly with this feature.

• No Spaces at Top or Bottom
You can set the printer to print without any empty area when the print data contains empty area at the top or bottom.
Since the printer does not feed paper over the empty area, you can save paper.

Note
• Available only if rolls are selected in Paper Source.

• Rotate Page
Select the method for rotating page.
The following settings are available for rotating page.

Setting Details

Rotate Right 90 Degrees Rotates the portrait page right 90 degrees and print in landscape orientation. When
the rotated page can fit in the width of roll paper, the page is rotated automatically,
and when it can not fit in the width of roll paper, the page is not rotated.
 

*When Fit Roll Paper Width is selected under Enlarged/Reduced Printing, then
the image is enlarged or reduced after rotating to fit the width of the roll paper.

Rotate Left 90 Degrees Rotates the portrait page left 90 degrees and print in landscape orientation. When the
rotated page can fit in the width of roll paper, the page is rotated automatically, and
when it can not fit in the width of roll paper, the page is not rotated.
 

*When Fit Roll Paper Width is selected under Enlarged/Reduced Printing, then
the image is enlarged or reduced after rotating to fit the width of the roll paper.

Rotate 180 degrees Allows you to rotate the image 180 degrees from the vertical to the right.

Note
• Available only if rolls are selected in Paper Source.
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Color Settings Panel

• Color Mode
You can select a color mode to suit the print job.

Setting Details

Color Enables color printing.

Monochrome (Photo) Prints monochrome photo image data in a gray scale that is free of color casting
(phenomenon of grays that appear tinted).

Monochrome Disables color printing and converts image from continuous color to grayscaled
monochrome.

Note
• The availability of settings depends on the print priority and media type selections.

• Matching Mode
Under Matching Mode, select the matching mode.

Setting Details

Driver Matching Mode
→P.602

Enables printing of optimal color tones using a driver specific color profile. You
should normally select this mode.

ICC Matching Mode →P.603 Enables color matching using ICC profiles. Select this if you want to print by speci-
fying the input profile, printer profile, and matching method in detail. This allows
you to use ICC profiles for digital cameras and scanners, ICC profiles created using
the profile creation tool, etc.
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Setting Details

ColorSync →P.604 Enables color matching by using the ColorSync function of Mac OS. Select this if
you want to perform soft proofing using ColorSync before printing.

No Correction No color matching is performed. Select this option when you want to perform color
matching in the software application.

Driver Matching Mode

1. Under Matching Mode, select Driver Matching Mode.

2. Click Matching Method list, and then select a setting.

Setting Details

Auto Automatically selects the best color matching method for each Image, Graphics,
Text.

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation
is a feature. This is also an easy-to-use mode when performing color adjustment us-
ing application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color
space. This is the easiest-to-use mode when you want to adjust the color and print.
However, gradation may be lost for colors of wider range than the color reproduction
range of the printer. Generally, this is also called relative colorimetric.
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ICC Matching Mode

1. Under Matching Mode, select ICC Matching Mode.

2. Click Matching Method list, and then select a setting.

Setting Details

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation
is a feature. This is also an easy-to-use mode when performing color adjustment us-
ing application software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color
space. This is the easiest-to-use mode when you want to adjust the color and print.
However, gradation may be lost for colors of wider range than the color reproduction
range of the printer. Generally, this is also called relative colorimetric.

Colorimetric (No White-Point
Correction)

The processing method of color-matching is identical to Colorimetric. Use this
when you want to further reproduce the target paper material color of the image data.
Generally, this also is called absolute colorimetric.

3. Click the Input Profile list, and then select an input profile.

Note
• To match the color on the printing, select the input profile for Color imageRUNNER Enlargement

Copy of the Color imageRUNNER type in use.
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4. Click the Printer Profile list, and then select a printer profile.

ColorSync

1. Under Matching Mode, select ColorSync.

2. Click the Printer Profile list, and then select a printer profile.

Note
• Available when using Mac OS X 10.4.

Printing Enlargements of Scanned Originals from a Color imageRUNNER
Scanned originals from a Color imageRUNNER can be enlarged and printed automatically.
Originals you create by scanning with a Color imageRUNNER are transferred to a "hot folder" and printed automatically
after enlargement according to printing conditions you specify for that folder.
This processing sequence is called the Color imageRUNNER Enlargement Copy function.
To use Color imageRUNNER Enlargement Copy, first complete these settings in the following order.

1. Register a hot folder on your computer.
Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER and complete the
settings for enlargement copy.

2. Complete the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder.
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After these settings are complete, you can print enlarged copies of scanned originals from the Color imageRUNNER.

Registering a hot folder on your computer
Folders used for Color imageRUNNER Enlargement Copy (iR enlargement copy) are called hot folders. Register a hot
folder on your computer for storing scanned originals from the Color imageRUNNER. You can specify printing conditions
(such as the image quality and paper size), based on which originals transferred to the hot folder will be printed. Follow
these steps to register and modify hot folders.

1. To display the Color imageRUNNER Enlargement Copy dialog box, either double-click the Color imageRUN-
NER Enlargement Copy.app icon after navigating to Canon Utilities — iR Enlargement Copy in the Applica-
tions folder or click Set in the Utility pane

Note
• Your printer is depicted in the lower-left area of this screen.

2. In Enlarged Copy Settings, click Add or Edit and either create or modify the hot folder.
For instructions on registering and modifying hot folders, refer to the help file for Color imageRUNNER Enlarge-
ment Copy.

Completing the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder. It is easy to send scanned originals to the
hot folder if you assign the scanning settings and destination to a Favorites button on the Color imageRUNNER.
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For instructions on assigning scanning and sending settings to the Favorites button, refer to the Color imageRUNNER man-
ual.

Scanning the original and print an enlargement
Follow the steps below to scan an original on the Color imageRUNNER for enlarged printing on the printer. For detailed
instructions, refer to the Color imageRUNNER manual.

1. Load the original on the platen glass or document feeder of the Color imageRUNNER.

2. Press Send to display the screen for transmission.

3. Press Favorites, and then press the Favorites button assigned to the hot folder.

4. Press Start on the control panel. If you scan originals on the platen glass, after scanning all originals, press Done on
the touch-panel display.
Scanned originals are sent to the hot folder and automatically enlarged and printed following the conditions you
specified for the folder.
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The Features of Print Plug-In
The main features of Print Plug-In are as follows.

• You can automatically detect the color space of Adobe RGB or sRGB-use images, etc., and automatically set optimal
profiles. Thus, you can print without the trouble of configuring settings.

• You can directly process image data on Photoshop, and forward the image data to a printer. In this way, you can proc-
ess 16-bit image data in addition to 8-bit image data.

• By using the preview function for images based on real images, and the preview function for layouts based on image
positioning by media size, you can use this software to make color adjustments and confirm print layout.

• You can perform basic printer settings such as printer selection, media type and output profile selection, and matching
methods, in addition to borderless printing and enlargement/reduction process without growing through the printer
driver.

• By using the print history management function, you can import past print settings parameters. Additionally, you can
save preferences as a file.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output

to differ from the Print Plug-In settings (the arrangement of the image in the layout preview, the print start
position, and the media size).

• Loss of gradation in dark areas can be reduced by performing black point compensation.

Note
• Adobe CMM is required in order to use the black point compensation function.

• You can perform printing press simulation printing by specifying the printing press profile.

Operating Environment
The Print Plug-In operating environment is as follows.

• Compatible Operating System
Mac OS X (10.4.8 or later)

• Compatible Photoshop Version
Photoshop CS5, Photoshop CS4, Photoshop CS3

• Compatible Digital Photo Professional Version
Digital Photo Professional Version 3.8x or later

• Software needed for Print Plug-In Installation
Photoshop or Digital Photo Professional, imagePROGRAF Printer Driver

Note
• The supported OS version differs for each version of Photoshop. Check with Adobe for details.
• The supported OS version differs for each version of Digital Photo Professional.
• Operation in Mac OS X Classic is not guaranteed.
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Installation Procedures
The procedures to install Print Plug-In are as follows.

Note
• Always install the printer driver before installing the Print Plug-In.

1. Insert the User Software CD-ROM into the CD-ROM drive to start the installer.

2. Click on the iPFxxxx PlugIn InstallerX icon in the Plug-in folder in the User Software CD-ROM.

Note
• The iPFxxxx icon is the name of the printer you are using.

3. Input the Administrator name and password and click the OK button.
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4. After you have read the software User's Licensing Agreement, click the Continue button.

5. Click the Agree button.

6. Select Custom Install to put a checkmark on your Print Plug-In, then click the Install button.
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7. To quit another application, click the Continue button.

8. Click the Quit button.

The Print Plug-In installation is complete.

Uninstall Procedures
The procedures for uninstalling the Print Plug-In are as follows.

• Uninstall Print Plug-In for Photoshop
 

1. Close Photoshop.

2. In Finder, display the Print Plugin for iPFxxxx folder.

3. Delete the Print Plugin for iPFxxxx folder.

Note
• iPFxxxx is the name of your printer.

 

• Uninstall Print Plug-In for Digital Photo Professional
 

1. Perform the installation procedures 1 through 5.
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2. Select Uninstall.

3. Click the Uninstall button.

4. To quit another application, click on the Continue button.
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5. Click the Quit button.

Starting from Photoshop
Follow the procedure below to start the Print Plug-In from Photoshop.

1. Start Photoshop.

2. Open the image that you wish to print.

3. If required, select the print range.

Note
• Images for use with Print Plug-In are less than 60,000 pixels in width and height. Reduce the selec-

tion range or reduce the image with processing for images more than 60,000 pixels in width and
height, and then attempt step 3.
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4. Select Export (or Data Export) from the File menu and then select the output plug-in that matches your printer.
The imagePROGRAF Print Plug-In for Photoshop window (known below as the Print Plug-In window) is displayed.

Note
• When the color space of the input image is CMYK, it is changed to AdobeRGB for processing with

Print Plug-In. Also, Relative Colorimetric is used for the matching method.
• If the message below is displayed but the Print Plug-In window is not displayed, install the newest

imagePROGRAF printer driver and then attempt step 3.
To install imagePROGRAF Print Plug-In, the latest version of the imagePROGRAF printer
driver must be installed.

• If the following message is displayed, but the Print Plug-In window is not displayed, open only one
Photoshop.
When Photoshop is running in multiple windows, the plug-in may not start.

• If the message below is displayed but the Print Plug-In window is not displayed, convert the color
space of the image to either RGB color, grayscale, or CMYK color and then attempt step 3.
Set the color space of the image to either RGB color, grayscale, or CMYK color.

Starting from Digital Photo Professional
Follow the procedure below to start the Print Plug-In from Digital Photo Professional.

1. Start Digital Photo Professional.

2. Open the RGB color image that you want to print.

3. If required, select the print range.

Note
• Images for use with Print Plug-In are less than 6,000 pixels in width and height. Reduce the selection

range or reduce the image with processing for images more than 6,000 pixels in width and height, and
then attempt step 3.
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4. Select File from the Plug-in printing menu and then select the output plug-in that matches your printer.
The imagePROGRAF Print Plug-In for Digital Photo Professional window (hereinafter referred to as the Print Plug-
In window) is displayed.

Print Plug-In Main Window
The Print Plug-In main window consists of the sheet selection area, and the preview and button area.
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• Sheet Selection Area
The tabs used to switch between each sheet on the Print Plug-In window are displayed.

When you select a tab, a sheet is displayed. The settings available on each sheet are as follows.

• Main Sheet →P.619

• Page Setup Sheet →P.622

• Color Settings Sheet →P.625

• Print History Sheet →P.626

• Support Sheet →P.628

• Preview Area
You can check the settings you made on the image in this area.

About the settings available on the preview area, see "Preview Area." →P.617
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• Button Area
This contains the buttons Print, Quit and Help

• PrintButton
Click this button to begin printing.
 

• QuitButton
Click this button to close the Print Plug-In window and return to application software.
 

•  Button
Click this button to display the Print Plug-In Help file.

Preview Area
You can check the settings you made on the image in this area.
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• Preview
Select the preview display method.
For more information about preview, see "Utilize Three Types of Previews." →P.637

Setting Details

Print Area Layout Displays the print range and the area out of the print range in the layout matching the
Paper Size set.
 

*You can change the image print position when you drag the image while the cursor

is displayed as .

Image The entire image is displayed.
 

*You can select the print range when you drag the image while the cursor is dis-

played as .

*When you click the image while the cursor is displayed as , the selected area is
deselected.

Roll Paper Preview Display the media size and roll paper information on the top in the layout printing on
roll paper.
 

*To select Roll Paper Preview, select Roll Paper in Paper Source.

• Print Selected Range
Place a checkmark here to only print the selected range.

Note
• When you select Preview in the Image, then select a portion of the image on the preview display, this

becomes valid.

• Perform Proof in Preview
Place a checkmark here to simulate the colors of the output product in the preview.

Note
• If Auto (Color) is selected under Output Profile, some media types are enabled.
• If ICC profile is selected under Output Profile, this is always enabled.
• The actual color balance of the print product and the simulation product may differ with some environ-

ments and conditions. In addition, when you have selected an ICC Profile with Output Profile and it is
not compatible with the printer or media that you are using, the color balance of the actual print product
will differ.

• Image Properties button

When you click the  button to open the Image Properties dialog box, where Image Size, Resolution, Bit and
Color Space information of the image imported to Print Plug-In are displayed.
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Click the Close button to return to Print Plug-In.

Main Sheet
You can use this sheet to perform basic settings such as selecting a printer, setting the media type, or adjusting image quali-
ty.

• Printer
The printer types are displayed.
 

• Select button
Click this button to display the Select Printer dialog box.
When you click the OK button after selecting the printer in the Select Printer dialog box, you can change the printer
that corresponds with Print Plug-In.
 

• Media Type
This allows you to select the media type.
For more information about Media Type, see "Customize Media Settings." →P.659

Note
• Always select media type that is actually set in the printer. When the media you chose is different from

the media set in the printer, you may not receive the desired print results.
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• Advanced Settings button
Click the button to display the Paper Detailed Settings dialog box.
For more information about the media detailed settings, see "Paper Detailed Settings Dialog Box." →P.629
 

• Input Resolution to Plug-in
You can select the resolution to process the image with Print Plug-In.
The following settings are available for resolution.

Setting Details

Accuracy 300ppi This processes images at an accurate resolution. This can control print speed and
memory capacity.

High Accuracy 600ppi This processes images at a more accurate resolution. This setting results in the best
print quality, but this takes more time to print than Accuracy 300ppi while also re-
quiring more memory capacity.
 

*This may not be displayed depending on how you set Media Type

• Input Bit to Plug-in
You can select the bit number to process with Print Plug-In.
The following settings are available for the input bit number.

Setting Details

High Gradation 8bit This processes images with at 8bit/channel (24 bit).

Highest Gradation 16bit This processes images with at 16bit/channel (48 bit).
 

*This may not be displayed depending on how you set Media Type and Input Res-
olution to Plug-in.

• Print Mode
Selecting the printing mode strikes the balance between the quality of the printed image and printing speed.
The following settings are available for the print mode.

Setting Details

Highest A setting for printing at the highest resolution when quality is most important. Print-
ing takes longer and consumes more ink than in other modes, but this mode offers
superior printing quality.

High Choose this setting to print at high resolution when quality is most important. Print-
ing takes longer and consumes more ink than in Standard or Fast modes, but this
mode offers exceptional printing quality.

Standard Choose this setting to print at standard resolution when quality and speed are both
important. Printing takes less time than in Highest or High mode.

Fast Choose this setting to print faster. Printing in fast mode can help you work more effi-
ciently when checking layouts.

Highest (Max. No. of Passes) If you are concerned about uneven colors in the print result of Highest quality, se-
lecting this option may improve printing results. However, printing may take longer.

Note
• The selectable fields may vary according to the Media Type, Input Resolution to Plug-in and Input

Bit to Plug-in settings.
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• Output Profile
You can select the output profile.
The following settings are available for the output profile.

Setting Details

Auto (Color) Performs the optimum color conversion from the input image data color space infor-
mation (sRGB, Adobe RGB), media settings etc. You should normally select these
settings.

Auto (Monochrome Photo) Performs the best color conversion to monochrome from the input image data color
space information (sRGB, Adobe RGB), media settings etc.

None (No Color Correction) You cannot perform color conversion with a plug-in. This is useful for creating an
original ICC profile.

External ICC Profiles This selects printer ICC profiles to be output to ICC profiles saved in the OS stand-
ard folder. Use the color space of the input data as well as the select ICC profile to
perform color conversion.

Note
• Auto (Monochrome Photo) can only be selected for the corresponding media types.

• Proof
This is displayed when an ICC profile is selected as the Output Profile.
When this is checked, you can perform printing press simulation prints.
Refer to Perform Printing Press Simulation Print →P.653  for details on printing press simulation prints.

• Matching Method
You can select the processing method when performing color conversion.
The following settings are available for the matching method.

Setting Details

Perceptual This converts the image to an image with natural color balance and gradation. This is
useful for pictures.

Saturation This converts the image to an image with heightened color saturation. The color bal-
ance of pictures and drawings may change.

Relative Colorimetric This converts the image with emphasis on color balance before the conversion or on
visual color balance. This is useful for pictures and drawings.

Note
• When the Output Profile you have set is Auto (Monochrome Photo) or None (No Color Correction),

you cannot select a matching method.

• ICC Conversion Options button
This is displayed when an ICC profile is selected as the Output Profile.
When this button is clicked, the ICC Conversion Options dialog box is displayed allowing you to configure color
conversion related settings.
Refer to ICC Conversion Options dialog box →P.632  for details on ICC Conversion Options.
 

• Copies
You can input the number of print copies in numerical characters.
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Note
• The maximum value is 99.
• You can change the numbers by clicking either ▲ or ▼.

• Set Configuration button
Clicking the button opens the Set Configuration dialog box that provides settings for the adjustment of image sharp-
ness and image enlargement method.
For more information about Set Configuration, see "Set Configuration Dialog Box." →P.631
 

• Defaults button
Click the button to return all of the settings on the Main sheet to their defaults.
 

Page Setup Sheet
You can use this sheet to set the size of the image to be printed, the media size, and whether to enlarge/reduce the image.

• Input Image Size
The size of the image imported to Print Plug-In is displayed.
 

• Borderless Printing
When you place a checkmark here, the Specify Roll Paper Width dialog box is displayed and you can print an image
without borders.
For more information about Borderless Printing, see "Print with No Borders." →P.658

Note
• Available only if rolls are selected in Paper Source.

• Enlarged/Reduced Printing
When you place a checkmark here, you can print enlarged/reduced images.
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When printing an enlarged/reduced image, select the method for enlargement/reduction. The image size sent to the
printer is displayed matching the selected method in Output Image Size.
The following settings are available for enlarged/reduced printing.

Setting Details

Fit Paper Size This automatically enlarges/reduces the entire image imported to Print Plug-In to
match the export media size when printing.

Fit Roll Paper Width This automatically enlarges/reduces the entire image imported to Print Plug-In to
match the width of the roll paper with the width of the image when printing.
 

*Displayed only if rolls are selected in Paper Source.

Scaling This enlarges/reduces the entire image by the specified scaling value. Input the scal-
ing value in numerical characters. You can specify a range between 5-600%.
 

*You can change the numbers by clicking either ▲ or ▼.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.

• Output Image Size
The output image size is displayed up to one place after the decimal point in millimeters.

Note
• When Paper Size is smaller than Output Image Size, part of the image may not print.

• Paper Size
You can select the size of the print media.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.
• This is not displayed when Fit Roll Paper Width is set in Enlarged/Reduced Printing.

• Orientation
This selects the print orientation.
The following settings are available for orientation.

Setting Details

Portrait Prints the image on the media as it appears on the screen.

Landscape Prints the image on the media rotated 90 degrees.

• Layout
You can select the print position of an image on the media.
The following settings are available for layout.
 

Layout

Setting Details

Upper-Left of Output Paper
Size

Prints the image with fitting the top left of the active print area for Paper Size.
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Setting Details

Center of Output Paper Size Prints the center of the image on the center of the selected Paper Size.

Specify Print Start Position You can print with specifying the top and left printing start positions in From Top
Margin and From Left Margin for Paper Size.

From Top Margin Input the margin from the top of the media in numbers.
 

*You can input between -9999 and 9999 mm.

From Left Margin Input the margin from the left of the media in numbers.
 

*You can input between -9999 and 9999 mm.

Note
• Select Print Area Layout or Image in Preview when you select Layout.

 

Roll Paper Layout

Setting Details

Upper-Left of Roll Paper Prints the top left of Media Size on the top left of the selected roll paper.

Center of Roll Paper Prints the center of Media Size on the center of the selected roll paper.

Note
• Select Roll Paper Preview in Preview when you select Roll Paper Layout.

• Paper Source
You can select the media source.
The following settings are available for media source.

Setting Details

Manual Select for manual paper feed printing.

Manual (3mm margins) Select for manual paper feed printing when you want to minimize the margin at the
far end edge of paper.

Roll Paper Select to print on roll paper.

Note
• When you select Manual (3mm margins) for Paper Source, the far end edge of printed image may

become defective depending on the paper used. If this happens, select another media source.

• Roll Paper Options button
Click this button to open the Roll Paper Options dialog box, where you can set roll paper width and perform auto cut
settings.
For more information about the roll paper options, see "Roll Paper Options Dialog Box." →P.633
 

• Size Options
Click the Size Options button to open the Size Options dialog box and you can select a media name, size and other
settings.
For more information about the size options, see "Size Options Dialog Box." →P.634
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• Defaults button
Click the button to return all of the settings on the Page Setup sheet to their defaults.
 

Color Settings Sheet
You can use this sheet to adjust image Color, Brightness, Contrast, Saturation, and you can set the color balance of print
product more to your liking.

• Cyan / Magenta / Yellow
You can adjust the strength or weakness of a color by either inputting a numerical value or dragging the slide bar.

Note
• You can check the adjustments in the preview display.

• Gray Tone
You can adjust gray tone from cool black (cool tones) to warm black (red tones) by either inputting a numerical value
or dragging the slide bar.

Note
• You can check the adjustments in the preview display.

• Brightness
You can adjust the brightness of the printed image without losing the brightest and darkest areas by either inputting a
numerical value or dragging the slide bar.

Note
• You can check the adjustments in the preview display.

• Contrast
You can relatively adjust the brightness of the brightest and darkness areas by either inputting a numerical value or
dragging the slide bar.
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Note
• You can check the adjustments in the preview display.

• Saturation
You can adjust the saturation of vivid color balance to dark color balance by either inputting a numerical value or drag-
ging the slide bar.

Note
• You can check the adjustments in the preview display.

• Curves button
Click the button to open the Curves dialog box then set the Channel and other settings.
For more information about Curves, see "Curves Dialog Box." →P.635
 

• Defaults button
Click the button to return all of the settings on the Color Settings sheet to their defaults.
 

Print History Sheet
You can use this sheet to apply settings history used in printing, and to print information, such as the image file name, with
the image.

• Print History and Favorites
This displays a list of print preferences.
Select Restore Defaults and click the Apply button to restore all settings to their initial settings.

Note
• You can check the 3 print preferences in the preview display.
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• Apply button
When you click the button, the print setting content applies to the current image selected with Print History and Fa-
vorites.
 

• Details button
Click the Details button to open the Print History Details dialog box, where you can manage print history.
For more information about the print history details, see "Print History Details Dialog Box." →P.636
 

• Print Information
When you place a checkmark here, you can print the file name and print time and date on the image. The following
settings are available for the print position and content.
For more information about Print Information, see "Set Information to Print with Image." →P.671

Setting Details

Information Print Position Selects the information print position.

Top (Header) Information is printed on the top of the image.

Bottom (Footer) Information is printed on the bottom of the image.

Print History Number Place a checkmark here to print the print history number.

File Name Place a checkmark here to print the file name.

Printed at Place a checkmark here to print the time and date.

Color Adjustment Value Place a checkmark here to print the color adjustment value.

Printer Name Place a checkmark here to print the printer name.

Comment Place a checkmark here to print the comment details.

Comment Details Place a checkmark here to display the comment details.

• Edit Comment button
Click the button to display the Edit Comment dialog box, where you can edit the comment.
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Support Sheet
You can display product support information and the electronic manual.

• Support Information button
Click the button to display websites that contain the latest product information.

Note
• An Internet connection is needed to view the websites.

• User Manual button
Click the button to display the printer manuals installed on the computer.

Note
• You must have User Manual installed on your computer.

• About button
Click the button to open the version information window of the Print Plug-In. Click the OK button in the version infor-
mation window to return to the Print Plug-In window.
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Paper Detailed Settings Dialog Box
This dialog box appears when you click the Advanced Settings button on the Main Sheet. You can set Drying Time and
Roll Paper Margin for Safety by media type.

• Drying Time
Between Pages
This sets the wait time for the ink to dry between each completely printed sheet and the output of the sheet.

Setting Details

Printer Default The settings of the printer operating panel are applied.

None The paper is ejected immediately after printing.

30sec. / 1min. / 3min. / 5min. /
10min. / 30min. / 60min.

The sheet is ejected when the specified time after printing has elapsed.

Between Scans
This sets the wait time between line scans during printing.

Setting Details

Printer Default The settings of the printer operating panel are applied.

None The printing continues to the next line immediately after the last line.

1sec. / 3sec. / 5sec. / 7sec. / 9sec. The printing continues to the next line after the set time.
 

*For the media type that has problems, such as ink smears on the page or colors that
seem uneven during borderless printing etc., increase the value for this setting.
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• Roll Paper Margin for Safety
Near End Margin
This sets the length of the near end margin of the roll paper.

Setting Details

Printer Default The settings of the printer operating panel are applied.

3mm Print at a standard size.
 

*Select for Media Type that has no problem when printing with a standard size mar-
gin.

20mm Select this when rubbing against the printhead occurs such as when using paper that
tends to curl.

• Cut Speed
This selects the auto cut speed.

Setting Details

Printer Default The settings of the printer operating panel are applied.

Fast Select this setting if cutting with the Standard setting is not clean.

Standard Select this setting when you are not experiencing problems.

Slow This helps prevent adhesive from sticking to the cutter and keeps the cutter sharp if
you select it when using adhesive paper.

• Calibration Value
When calibration has been carried out on the printer, use this setting to choose whether or not to use the results.

Setting Details

Printer Default The settings of the printer operating panel are applied.

Use Value The calibration results are used for printing.

Disregard Value The calibration results are not used for printing. Select this option to avoid changes
to image color tones during printing due to color calibration.

• Mirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image with
the left and right sides inverted.
 

• Unidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the printing
speed becomes slower.
 

• High-Precision Text and Fine Lines
Print increasing ink impact accuracy, particularly for sharper text and fine lines. However, this takes more time than
regular printing.

Note
• When Highest (Max. No. of Passes) is selected as the print mode, High-Precision Text and Fine

Lines cannot be selected.
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Set Configuration Dialog Box
This dialog box appears when you click the Set Configuration button on the Main Sheet. You can set the adjustment of
image sharpness and image enlargement method.

• Sharpen
Performs adjustment of the sharpness (outline) settings.
 

• Image Enlargement Method
You can select the image enlargement method.
The following settings are available for the image enlargement method.

Setting Details

Nearest Neighbor Performs simple enlargement.

Bilinear Performs line vector enlargement.

Bicubic Adjust pixels with calculation of elements such as a color or brightness of neighbor-
ing pixels.

• Perform printing in the background
When you place a checkmark here, the plug-in performs printing with the Plug-In in the background.
 

• Close Plug-in After Printing
When you place a checkmark here, the plug-in closes after printing finishes.

Note
• If printing does not finish correctly because it was canceled or an error occurred, the plug-in does not

close.
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• Output Method
You can select the output method.
The following settings are available for the output method.

Setting Details

Print Normal printing. The print job data is stored temporarily in the box as the job prints.

Save in mail box Saves the print data in the mail box.
If you select Save in mail box, you must specify Name of data to be saved.

Print after reception is complete When you place a checkmark here, you can print after saving jobs in the temporary
storage space. This cannot be used when Save in mail box is selected.

• Initialize all warning dialog boxes
When this is checked, all of the warning dialog boxes that have been set to "Do not show this screen again" become
displayed.
 

ICC Conversion Options dialog box
This is displayed when an ICC profile is selected in the Output Profile list in the Main sheet and the ICC Conversion
Options button is clicked. This allows you to configure detailed color matching related settings.

• Conversion Engine
Selects the conversion engine to use when converting colors.

Note
• Adobe CMM needs to be installed in order to use Adobe CMM. Refer to Using Adobe

CMM →P.650  for details on how to install Adobe CMM.
 

• Black Point Compensation
Check this check box to perform black point compensation. Loss of gradation in dark areas can be improved by per-
forming black point compensation.

Note
• This can be used if Adobe CMM is selected as the Conversion Engine.

 

• Proof Options
Configures settings related to printing press simulation.
The proof options consist of the following settings.
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Setting Details

Simulate Paper Color Select this when performing paper color simulation.

Roll Paper Options Dialog Box
This dialog box appears when you click the Roll Paper Options button on the Page Setup Sheet. You can set the roll paper
width and perform the auto cut settings.

• Roll Paper Width
This selects the width of the roll media set to the printer.
 

• Automatic Cutting
You can set the printer to cut roll paper automatically or print a guideline for cutting.
The following settings are available for automatic cutting.

Setting Details

Available Each page is automatically cut after it is printed.

None Each page is not cut after it is printed and printing continues without interruption.

Print Cut Guideline A print cut guideline is printed after each page and printing continues without inter-
ruption.

• No Spaces at Top or Bottom (Conserve Paper)
When you place a checkmark here, the print data is printed without margins.
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Size Options Dialog Box
This dialog box appears when you click the Size Options button on the Page Setup Sheet. You can select a media name,
size and other settings.

• Paper Size List
Displays all the standard sizes and custom media sizes.
 

• Custom Paper Size Name
You can enter any name up to 63 characters.
 

• Units
You can select the units of measure to use when you define custom media size. Switching this setting resets the units of
measure for the entire Plug-In.
 

• Paper Size
Width
Enter the width of the media size.
 

Height
Enter the height of the media size.

• Add button
Click the button to register the contents of the settings.
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Curves Dialog Box
This dialog box appears when you click the Curves button on the Color Settings Sheet. You can set Channel and other
settings.

• Channel
Select from among RGB, Red, Green, or Blue.

Note
• Gray is displayed for monochrome printing and this selection cannot be changed.

• Input
Enter an input value.

Note
• The allowed entry range is 0 to 255.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Output
Enter an output value.

Note
• The allowed entry range is 0 to 255.
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• Load Curves button
Click the button to load stored data for a tone curve.
 

• Save Curves button
Click the button to stores the current tone curve settings.
 

Print History Details Dialog Box
This dialog box appears when you click the Details button on the Print History Sheet. This controls print history. For more
information about Print History Details, see "Utilize Print History." →P.660

• Print History
Print History appears in list format.

Display Items Details

Print History Number Displays the print history number.

File Name Displays image file name.

Printed at Displays time and date of printing.

Comment Displays comment details.

Note
• Up to 200 print history items can be displayed. All items above 200 are deleted.

• When you cannot print properly because you canceled the printing or an error occurred, appears  to
the left of the print history number.

• Delete button
Click the button to delete the selected print history.
 

• Add button

Click the  button to add the selected print history to preferences.
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Note
• Up to 200 print preference items can be added.

• Favorites
The print history stored in print preferences displays in list format.

Note
• You can change the order by selecting an item and dragging it to another place.

• Import button
Click the button to import print history saved as a file.
 

• Export button
Click the button to save print history as a file that is stored in print preferences.
 

• Delete button
Click the button to delete print history stored in print preferences.
 

• Settings
Displays the print history settings selected from the Print History or Favorites.

Setting Details

Main When you select this the Main sheet settings are displayed.

Page Setup When you select this the Page Setup sheet settings are displayed.

Color Settings When you select this the Color Settings sheet settings are displayed.

Utilize Three Types of Previews
You can use Print Plug-In to check an image in three types of previews.
The preview types are as follows.

• Check Image with Print Area Layout →P.638

• Check the original image with Image →P.639

• Check Image with Roll Paper Preview →P.640
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Check Image with Print Area Layout
Displays the print range and the area out of the print range in the layout matching the media size set in the print area layout.
Select Print Area Layout in Preview.

Note

• When the cursor on the preview is displayed as  on the preview, you can specify the print position by
dragging the image.

• When the cursor is displayed as  on the preview, the below conditions on the Page Setup sheet have all
been met.

• There is no checkmark in Borderless Printing.
• There is no checkmark in Enlarged/Reduced Printing or Scaling has been selected.
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Check the original image with Image
In the image preview you can check the entire image that you have input.
Select Image in Preview.

Note

• When the cursor appears as a small magnifying glass  while there is an Image in the Preview area, the
Selected Range feature is enabled and you an drag the cursor on the image and select an area for printing.

• When you click the image while the cursor is displayed as  on the preview, the selected area is deselec-
ted.
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Check Image with Roll Paper Preview
Display the media size and roll paper information on the top in the layout printing on roll paper in Roll Paper Preview
Select Roll Paper Preview in Preview.

Note
• To select Roll Paper Preview in Preview, select Roll Paper in Paper Source.

Print with a Desired Picture Quality
You can specify and print at the resolution you desire.

1. Display the Main sheet.
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2. Select the media set to the printer in Media Type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different

from the media set in the printer, you may not receive the desired print results.

3. Choose either Accuracy 300ppi or High Accuracy 600ppi for the resolution to process images in Input Resolution
to Plug-in.

Note
• When you select Accuracy 300ppi images are processed at an accurate resolution. This can control

print speed and memory capacity.
• When you select High Accuracy 600ppi images are processed at a more accurate resolution. This

setting results in the best print quality, but this takes more time to print than Accuracy 300ppi while
also requiring more memory capacity.

• High Accuracy 600ppi will not display with some Media Type settings.

4. Choose either High Gradation 8bit or Highest Gradation 16bit for the bit number when processing images in
Input Bit to Plug-in.

Note
• When you select High Gradation 8bit, images are processed at 8 bit/channel (24 bit).
• When you select Highest Gradation 16bit, images are processed at 16bit/channel (48 bit).
• Highest Gradation 16bit will not display with some Media Type or Input Resolution to Plug-in

settings.

5. Select the mode to be printed when processing images in Print Mode.

Note
• The settings that can be selected differ by Media Type,Input Resolution to Plug-in, and Input Bit

to Plug-in selected.

6. Click the Print button.
 

Printing begins.

Adjust the Colors and Print
You can adjust the colors to your liking and print images.
The explanation below is on 5 ways to adjust the colors using Print Plug-In.

• Adjust the Colors while Checking the Preview (for Color) →P.642

• Adjust the Colors while Checking the Preview (for Monochrome) →P.643

• Adjust the Colors by Color Matching →P.647

• Print High-Quality Adobe RGB16bit Images →P.648

• Prints monochrome photographs with high quality →P.650

• Using Adobe CMM →P.650
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Adjust the Colors while Checking the Preview (for Color)
You can adjust the colors while checking the adjustments in the preview.
The following explanation is on the procedures for adjusting example image below.

• Low for Cyan
• High for Yellow
• Low for Saturation
• Warm Black for Gray Tone
• Enhance brightness for the curves

The above image adjustments are reflected in the before and after images below.

Before Application After Application

1. Display the Color Settings sheet.

2. Drag the slide bar in the direction of Low in Cyan.
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3. Drag the slide bar in the direction of High in Yellow.

4. Drag the slide bar in the direction of Low in Saturation.

5. Drag the slide bar in the direction of Warm Black in Gray Tone.

Note
• You can change the numbers by inputting in numerical characters.
• You can change the numbers by clicking either ▲ button or ▼ button.

6. Click the Curves button then click near the center of the curve.

7. Enter 120 in Input and 135 in Output then click the OK button.

8. Click the Print button.
 

The adjustments are reflected in the image and printing begins.

Adjust the Colors while Checking the Preview (for Monochrome)
You can adjust the colors while checking the adjustments in the preview.
The following explanation is about the procedures for adjusting example image below.

• Low for Contrast
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• Light for Highlight
• Light for Shadow
• Enhance brightness for the curves

The unapplied and the applied images of the above image adjustments are as below.

Before Application After Application

1. Open the Main sheet.

2. Select Auto (Monochrome Photo) in Output Profile.
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3. Open the Color Settings sheet.

4. In Contrast, drag the slide bar toward Low.

5. In Highlight, drag the slide bar toward Light.

6. In Shadow, drag the slide bar toward Light.

Note
• You can change the numbers by inputting in numerical characters.
• You can change the numbers by clicking either ▲ button or ▼ button.

7. Click the Curves button then click near the center of the curve.
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8. Enter 120 in Input and 135 in Output then click the OK button.

9. Click the Print button.
 

This applies the image adjustments and starts the print job.
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Adjust the Colors by Color Matching
When you print a color image imported from a scanner or a digital camera, the image may appear different from the image
on the screen. That is due to the differences in color on the screen and in the printer. In Print Plug-In, you can get the color
balance of the print product closer to the color balance displayed on the screen through performing ICC (International Color
Consortium) color profile settings, matching method settings, and settings for the internal profile, which performs optimum
color conversion in response to media and resolution settings.

1. Display the Main sheet.

2. Select the profile in Output Profile.

Note
• When you place a checkmark in Perform Proof in Preview, you can check the color matching in the

preview. This may not be displayed depending on how you set Media Type.
• The details of Output Profile you have set is saved even when you close the Print Plug-In, but when

the specified profile cannot be located it is set to Auto (Color).
• If an ICC profile is selected as the Output Profile, Adobe CMM can be selected as the color conver-

sion engine. Refer to Using Adobe CMM →P.650  for details.

3. Select the profile matching method in Matching Method.

4. Click the Print button.
 

Printing begins with the output profile and matching method that you have set.
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Print High-Quality Adobe RGB16bit Images
This prints a high-quality Adobe RGB16bit image taken with a high-end digital camera. Print Plug-In allows you to print
high color gamut and high tone images, when the Adobe RGB16bit image data has been retouched in Photoshop, without
compromising the level of tone in the image.

1. Select the Adobe RGB16bit image data in Photoshop and start Print Plug-In.  (See "Starting from Photoshop.")
→P.613

2. Click button.

3. Check that Adobe RGB is displayed in Color Space, and 16bit/channel is displayed in Bit in the Image Properties
dialog box, and click the Close button.
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4. Display the Main sheet.

5. Select High Accuracy 600ppi in Input Resolution to Plug-in.

6. Select Highest Gradation 16bit in Input Bit to Plug-in.

7. Select the highest quality possible in Print Mode.

8. If required, adjust the colors using color matching.

Note
• For more information about the color matching, see "Adjust the Colors by Color Matching."

→P.647

9. Click the Print button.
 

Printing of the Adobe RGB16bit image begins.
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Prints monochrome photographs with high quality
Prints images captured with a scanner or digital camera in monochrome with high quality. Provides stable monochrome
photo images without color casts and minimizes the influences of the difference of the light source.

1. Display the Main sheet.

2. Select Auto (Monochrome Photo) in Output Profile.

Note
• Auto (Monochrome Photo) can be selected only after a compatible Media Type has been selected.

3. Click the Print button.
 

Performs conversion to the most suitable monochrome and printing begins.

Using Adobe CMM
Adobe CMM is a color conversion engine made by Adobe. Using Adobe CMM makes it possible to obtain uniform color
conversion results and to use the black point compensation function.

Important
• Use version 1.1 or higher of Adobe CMM.

• How to Obtain Adobe CMM
Adobe CMM can be obtained using the following procedure.

1. Open the Adobe website (http://www.adobe.com).

2. Enter "Adobe CMM" in the search input box on the screen.
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3. Search for the "Adobe Color Management Module (CMM)" item and select the Macintosh version.

4. Download the file by following the on-screen directions.

5. Start the installer in the downloaded file to perform the installation.

• Adobe CMM System Requirements
The system requirements for Adobe CMM are as follows.

• Supported OS
Mac OS X 10.4.8 or later
 

• Supported CPU
PowerPC G4 or G5
Intel Core Duo, Intel Core 2 Duo, Intel Xeon processor

Note
• Check with Adobe for details.

• How to Use Adobe CMM
The procedure for using Adobe CMM is as follows.

1. Display the Main sheet.

2. Select one of the ICC profiles as the Output Profile.

3. Click the ICC Conversion Options button.
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4. In the ICC Conversion Options dialog box, select Adobe CMM from Conversion Engine.

5. Click the OK button to close the ICC Conversion Options dialog box.

Perform Black Point Compensation
Black point compensation that is equivalent to Photoshop can be performed using the following procedure. Use this to avoid
saturation in the black areas of images.

Important
• In order to make the black point compensation settings effective, close down and restart Photoshop or Digital

Photo Professional.
• Adobe CMM needs to be installed in order to use black point compensation. Refer to Using Adobe

CMM →P.650  for details on how to install Adobe CMM.

1. Display the Main sheet.

2. Select one of the ICC profiles as the Output Profile.

3. Click the ICC Conversion Options button to open the ICC Conversion Options dialog box.
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4. Select Adobe CMM as the Conversion Engine.

5. Check the Black Point Compensation check box.

6. Click the OK button to close the ICC Conversion Options dialog box.

Perform Printing Press Simulation Print
You can perform printing press simulation prints by specifying ICC profiles such as Japan Color or SWOP, and specifying
an ICC profile for the printing press.

1. Display the Main sheet.

2. Select one of the ICC profiles as the Output Profile.

3. Check the Proof check box and select the profile for the printing press you want to target from the list on the right.
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4. Click the ICC Conversion Options button to open the ICC Conversion Options dialog box.

5. Configure the Proof Options as needed.

Note
• The proof option is Simulate Paper Color.

6. Click the OK button to close the ICC Conversion Options dialog box.

7. Click the Print button.
Printing begins.

Enlarge/Reduce and Print
You can enlarge or reduce an image in Print Plug-In.
Three methods to enlarge/reduce and print are as follows.

• Enlarge/Reduce and Print Matching Output Media Size →P.654

• Enlarge/Reduce and Print Matching Width of Roll Paper →P.656

• Specify Scaling, Enlarge/Reduce and Print →P.657

Enlarge/Reduce and Print Matching Output Media Size
By specifying the media type loaded in the printer, the image can be enlarged or reduced to fit the size of the image area of
the media. This feature is useful when you need to print on the full width of Media that you have selected.

Note
• When you need to print on the full width of roll media, see "Enlarge/Reduce and Print Matching Width of

Roll Paper." →P.656

• When you do the procedure below to print on roll media, the print job will match the size of the output with
the media selected with the Paper Size setting.
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1. Display the Page Setup sheet.

2. Select the size of the media that you want to print in Paper Size.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.
• This is not displayed when Fit Roll Paper Widthis set in Enlarged/Reduced Printing.

3. Select either Portrait or Landscape as the media orientation for the image in Orientation.

Note
• When you select Portrait, the image on the media prints as it appears on the screen.
• When you select Landscape, the image on the media prints rotated 90 degrees.

4. Click the Enlarged/Reduced Printing check box on.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.

5. Select Fit Paper Size.

6. Click the Print button.
 

The image prints filling the entire output media surface.
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Enlarge/Reduce and Print Matching Width of Roll Paper
You can enlarge/reduce and print an image matching the width of the roll paper set in the printer. This is useful when you
wish to print an image that covers the entire width of the roll paper.

Note
• Printing will not occur properly when a print roll is not set to the printer.

1. Display the Page Setup sheet.

2. Select Roll Paper in Paper Source.

3. Click the Roll Paper Options button.

4. Set the roll paper options and click the OK button.

Note
• For more information about the Roll Paper Options dialog box, see "Roll Paper Options Dialog

Box." →P.633

• Click the Defaults button to return all of the roll paper option settings to their defaults.

5. Select either Portrait or Landscape as the media orientation for the image in Orientation.

Note
• When you select Portrait, the image on the media prints as it appears on the screen.
• When you select Landscape, the image on the media prints rotated 90 degrees.

6. Click the Enlarged/Reduced Printing check box on.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.
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7. Select Fit Roll Paper Width.

8. Click the Print button.
 

The image prints covering the entire width of the roll paper.

Specify Scaling, Enlarge/Reduce and Print
You can specify scaling to enlarge/reduce an image and print. This is useful when you wish to print an image at a specific
size.

1. Display the Page Setup sheet.

2. Select the size of the media that you want to print in Paper Size.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.
• Fit Roll Paper Widthis set in Enlarged/Reduced Printing.

3. Select either Portrait or Landscape as the media orientation for the image in Orientation.

Note
• When you select Portrait, the image on the media prints as it appears on the screen.
• When you select Landscape, the image on the media prints rotated 90 degrees.

4. Click the Enlarged/Reduced Printing check box on.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.
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5. Select Scaling and input the scaling factor or drag the four corners of the image in the Preview display.

Note
• You can specify scaling rate in intervals of 0.01%.
• You can specify a range between 5.00-600.00%.
• The size of the width and height proportionally grow when the image is enlarged/reduced.

6. Either drag the image on the Print Area Layout preview, or set the print position Layout.

7. Click the Print button.
 

Printing begins at the set scaling rate.

Print with No Borders
You can use the borderless printing function to print without margins surrounding the image.

Note
• With some media borderless printing can be performed only between two edges.
• To use the borderless printing function, the specified media must be set to the printer.

1. Display the Page Setup sheet.

2. Select Roll Paper in Paper Source.

3. Click the Borderless Printing check box on.

Note
• Select the width for roll paper set in the printer in Roll Paper Width in the Specify Roll Paper

Width dialog box, and click OK.
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4. Click the Print button.
 

Borderless printing begins.

Customize Media Settings
You can customize media settings.

1. Display the Main sheet.

2. Select the media type that you wish to customize in Media Type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different

from the media set in the printer, you may not receive the desired print results.

3. Click the Advanced Settings button.

4. Perform the settings in the Paper Detailed Settings Dialog Box →P.629  and click the OK button.
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Utilize Print History
When you perform various settings and print in Print Plug-In, those settings are saved as print history. Also, you can export
and import as files. You can store often-used print history under a specified name in print preferences.

Note
• You can save up to 200 print history items. All items over 200 are deleted in chronological order.

You can do the following things using print history.

• Confirm Print History Details →P.660

• Apply Print History to an Image →P.661

• Store Print History to Print Preferences →P.662

• Delete Print History →P.664

• Export Print History from Print Preferences →P.666

• Import Print History to Print Preferences →P.667

• Delete Print History from Print Preferences →P.669

• Set Information to Print with Image →P.671

Confirm Print History Details
You can confirm the print history details.

1. Display Print History sheet.

2. Click the Details button.

Note
• Select the print history you wish to check the details of, from either Print History or Favorites in the

Print History Details dialog box.

Mac OS X Software > Print Plug-In for Photoshop/Digital Photo Professional >

Utilize Print History iPF6300S

4

660



3. Check the print history details in Settings, and click the OK button.

Note
• You can display the print history details by switching the sheets.

Apply Print History to an Image
You can use previous print history, and apply it to an image.

1. Display the Print History sheet.

2. If required, check the print history details.  (See "Confirm Print History Details.") →P.660

3. Select the print history you wish to apply from Print History and Favorites, and click the Apply button.
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Store Print History to Print Preferences
You can store often-used print history to print preferences. Not only can you store the print history stored under a different
name in print preferences, you can also find it with ease.

Note
• You can store up to 200 print history items to print preferences.

1. Display the Print History sheet.

2. Click the Details button.

3. Select the print history you wish to store in print preferences from Print History in the Print History Details dialog
box, and check the print history details in Settings.
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4. Select the print history you wish to store in print preferences from Print History and click the  button.

5. In the Add Favorites dialog box input the name of the print history in Name, input a comment in Comment, and
click the OK button.
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6. Click the OK button to close the Print History Details dialog box.

Delete Print History
You can delete print history.

Important
• Be aware that you cannot undo deletions of print history.

1. Display the Print History sheet.

2. Click the Details button.
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3. Select the print history you wish to delete from Print History in the Print History Details dialog box, and click the
Delete button.

4. Click the OK button.

5. Click the OKbutton to close the Print History Details dialog box.
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Export Print History from Print Preferences
You can export print history stored in print preferences as a file.

1. Display the Print History sheet.

2. Click the Details button.

3. Select the print history you wish to export from Favorites in the Print History Details dialog box, and click the
Export button.
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4. Input the name of the print history in Save As in the Save dialog box, and click the Save button.

 

The print history is exported under the specified file name.

5. Click the OK button to close the Print History Details dialog box.

Import Print History to Print Preferences
You can import print history in file format and store it to print preferences.

1. Display the Print History sheet.

2. Click the Details button.
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3. Click the Import button in the Print History Details dialog box.

4. Select the print history you wish to import in the Open dialog box, and click the Open button.

The print history is imported.

Note
• The print history file name suffix is *.pjb/*.pjb2.
• You cannot import a print history file exported from a different OS in Print Plug-In.
• You cannot import a print history file exported from a different printer in Print Plug-In.

Mac OS X Software > Print Plug-In for Photoshop/Digital Photo Professional >

Import Print History to Print Preferences iPF6300S

4

668



5. Click the OK button to close the Print History Details dialog box.

Delete Print History from Print Preferences
You can delete print history store to print preferences. You cannot store more than 200 print history items in print preferen-
ces.

1. Display the Print History sheet.

2. Click the Details button.

Mac OS X Software > Print Plug-In for Photoshop/Digital Photo Professional >

iPF6300S Delete Print History from Print Preferences

4

669



3. Select the print history you wish to delete from Favorites in the Print History Details dialog box, and click the
Delete button.

4. Click the OK button.

5. Click the OK button to close the Print History Details dialog box.
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Set Information to Print with Image
You can print information with an image that is related, such as the file name and the time and date.

Note
• When you use the borderless printing function to print, the information will not be printed.  (See "Print with

No Borders.") →P.658

• When the printed information is too long as does not fit on the media, a break will appear in the printed infor-
mation.

• The information may print on the image data with some media sizes, enlargement rates and print position
values.

• When Keep Media Size is set to On on the printer, a portion of bottom of the print data is not printed.

1. Display the Print History sheet.

2. Click the Print Information check box on.

3. Select the position where you wish to print the information in Information Print Position.

4. Click the information check box you wish to print on.

5. When you wish to edit the comment, click the Edit Comment button.

Note
• When you do not wish to edit the comment, move to step 7.
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6. Input the comment in the Edit Comment dialog box, and click OK button.

7. Click the Print button.

Comments are printed with images.
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The Features of imagePROGRAF Printmonitor
imagePROGRAF Printmonitor is a utility for checking the printer status and managing print jobs.

• Printer status can be checked in real time on a computer monitor.
• You can check the status of print jobs, cancel jobs, and manage them as needed.
• If a printer error occurs, you can investigate the corrective action immediately.
• You can also set up automatic email notification of any printer problems or errors to email addresses you designate in

advance.
• You can check the status of the hard disk and the documents saved on the hard disk.

Note
• If the status of the desired printer is not shown in imagePROGRAF Printmonitor, select the printer again as

follows.

1. Make sure the printer is on and connected to the network or to a local port.
2. In the Printer menu, select the name of the desired printer. After the printer is detected, the printer status is

shown.
3. If information about the printer is not shown in step 2, choose Search Printer in the Printer menu. Printer

names listed in the Printer menu are updated with the printers that are now detected.
4. In the Printer menu, select the name of the desired printer. After the printer is detected, the printer status is

shown.
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Job Management Using imagePROGRAF Printmonitor
You can use the Driver Panel in imagePROGRAF Printmonitor for operations such as pausing and canceling print jobs.

• Preempting Other Jobs

If you select a print job and click the  button, the selected job is printed ahead of the job that currently precedes
it in the print queue.

• Pausing/Resuming Print Jobs

Selecting a print job and clicking the  button pauses printing of the selected job.

To resume printing of a paused print job, select the print job and click the  button.

Note
• Once all the print data for a print job has been sent to the printer, the job can no longer be paused/re-

sumed.

• Canceling Print Jobs

Selecting a print job and clicking the  button cancels printing of the selected job.

Note
• You cannot cancel other users' print jobs.

• Printing Held Jobs
Printing of the job with a Status of Holding is paused because the paper specified by the driver does not match the
paper currently loaded in the printer.
Use the procedure below to print the held job.
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1. Select the held job and click the Replace Paper button.

2. Replace the paper in the printer with the correct paper.

Note
• To continue printing without changing the paper in the printer, select the held job and click Continue to

print button.
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The Features of Media Configuration Tool
The Media Configuration Tool offers the following features.

• Enables information about additional media (types of paper) supported by the printer to be added to the printer control
panel and to the printer driver, through the use of relevant media information files.

• You can rearrange lists of the types of paper on the printer control panel and in printer driver dialog boxes and rename
them, in addition to other functions.

• You can add custom paper (paper that is not Canon genuine paper or Canon feed confirmed paper) to the printer con-
trol panel and printer driver.

Important
• Normally, the Media Configuration Tool is installed and the media information is configured when you in-

stall the printer driver from the User Software CD-ROM. Use this software if you want to add new media
information or edit existing media information.

• Administration of paper information using the Media Configuration Tool should be performed by the printer
administrator.

• Canon offers absolutely no guarantees regarding the print quality or paper feed properties of customer paper
(paper that is not Canon genuine paper or Canon output confirmed paper).

• The paper feed properties cannot be guaranteed if Add Custom Paper is used on Canon genuine paper in the
Media Configuration Tool.

• The print quality and paper feed properties cannot be guaranteed if Add Custom Paper is used on Canon
feed confirmed paper in the Media Configuration Tool. Furthermore, Canon does not guarantee the print
quality of Canon feed confirmed paper.
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Note
• Canon genuine paper and Canon feed confirmed paper are detailed in the Paper Reference Guide. Any other

paper is called custom paper.

Operating Environment
You can use Media Configuration Tool in the following environments.

• Compatible Operating System
Mac OS X (10.4.11 to 10.6)

• Software that requires installation
imagePROGRAF Printer Driver

Procedures for Installing
Start the installer in the new version of Media Configuration Tool, and follow procedures below to install the Media Config-
uration Tool.

Important
• If the printer driver is installed from the User Software CD-ROM, the Media Configuration Tool is also in-

stalled and the media information is also configured. Therefore, the following procedure does not normally
need to be performed. To install the Media Configuration Tool without using the User Software CD-ROM,
such as when you have downloaded a new version of the Media Configuration Tool from the Canon website,
use the following procedure.

1. Double click the MCT Installer iPFxxxx for X icon to start the Media Configuration Tool installer.

Note
• The iPFxxxx in the icon will be the printer name in use.

2. Input the administrator name and password, and click the OK button.
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3. The next screen presents selections for the country or area where the printer is used.
Select a country or territory then click the OK button.

4. The License is displayed.
After you have read Canon Software License Agreement, click the Continue button.

5. Click the Agree button.
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6. Select Easy Install then click the Install button.

7. Click the Continue button to quit another application.

8. When the following message is displayed, click the Quit button.
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The installation of Media Configuration Tool is complete.

Note
• When the installation is completed properly, the Media Configuration Tool folder is saved in the

following folder.
Applications > Canon Utilities > iPFxxxx Media Configuration Tool

• The iPFxxxx in the folder above will be the printer name in use.

Procedures for Uninstalling

1. Double click the MCT Installer iPFxxxx for X icon to start the Media Configuration Tool installer.

Note
• The iPFxxxx in the icon will be the printer name in use.

2. Input the administrator name and password, and click the OK button.
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3. The next screen presents selections for the country or area where the printer is used.
Select a country or territory then click the OK button.

4. The License is displayed.
After you have read Canon Software License Agreement, click the Continue button.

5. Click the Agree button.
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6. Select Uninstall.

7. Click the Uninstall button.

8. Press the Continue button when another application is running.
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9. When the following message is displayed, click the Quit button.

 

Media Configuration Tool has been uninstalled.

Starting the Media Configuration Tool
Follow the procedure below to start the Media Configuration Tool.
From the Applications menu > Canon Utilities >iPFxxxx Media Configuration Tool > MCTxxxx.app.
Media Configuration Tool main window is displayed.
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Note
• If a compatible printer driver is not installed, the Media Configuration Tool will not start. If you attempt to

start the Media Configuration Tool when a printer driver is not installed, the warning message below is dis-
played.

Media Configuration Tool main window
The explanation below is on the Media Configuration Tool main window.

Note
• For the step to open the Media Configuration Tool main window, see "Starting the Media Configuration

Tool." →P.683

• Add Genuine Paper button
When this button is clicked, the Edit Media Types dialog box is displayed, which allows you to add media informa-
tion files released by Canon to the printer control panel and printer driver. You can also change names, toggle between
displaying and hiding, and delete added media types.
You can also change the display order of Canon genuine paper and custom paper.
Refer to Editing Media Type Information →P.685  for details on Add Genuine Paper.

• Add Custom Paper button
When this button is clicked, the Add Custom Paper dialog box is displayed, which allows you to added custom paper
(paper that is not Canon genuine paper or Canon feed confirmed paper) to the printer control panel and printer driver.
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Refer to Using Paper Other Than Genuine Paper/Feed Confirmed Paper →P.699  for details on Add Custom
Paper.

• Link to Support Information button
Opens imagePROGRAF Support Information. You can check information such as the latest information for the
product and software version upgrade information.

• Link to User Manual Button
Click this button to display the User's Guide. This function requires that the User's Guide be installed on your comput-
er.

Editing Media Type Information
Click the Add Genuine Paper button in the Media Configuration Tool main window to display the Edit Media Types
dialog box.

This dialog box presents functions for the following tasks.

• Adding Media Types →P.686

• Changing Media Names →P.689

• Deleting Media Types You Have Added →P.691

• Switching Media Types Display Show/Hide →P.693

• Changing the Display Order of Media Types →P.695

Important
• When you update the media type information, perform the same update on all of the PCs that are using that

printer.
• Adding, deleting, toggling display/non-display, and changing the paper name of a media type can only be

performed for Canon genuine paper and feed confirmed paper. Refer to "Using Paper Other Than Genuine
Paper/Feed Confirmed Paper →P.699 " for details on adding, editing, and deleting custom paper. Cus-
tom paper displays Custom as the Status in the Media Type list.

• To add media types, download the media information file (.amf file) in advance from the Canon website.
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Note
• It may not be possible to deleting, showing/hiding, and changing the display order under some conditions.

Adding Media Types
Media information files (.amf files) released by Canon are registered in the printer control panel and printer driver.

Important
• Do not perform printing on the target printer while adding the media types.
• Reinstalling Media Configuration Tool after registering a media information file may delete the registered

media information file.In this case, first download and install latest Media Configuration Tool, then down-
load and register the required media information file.

1. Open the Edit Media Types dialog box, and then click the Add button.
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2. The Add Media Type dialog box displays.
Click the Browse button.

3. Select the folder that contains the media information files (.amf files), and then click the Open button.
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4. The names of media information files in the folder you selected in the Open dialog box are displayed under Media
Information File in the Add Media Type dialog box. Select the check boxes of paper to add and click the OK
button.

Important
• If Master Media Information File is displayed as the Type of the Media Information File, the me-

dia type display order and media type display/non-display settings are initialized. Reconfigure these
after added the master media information file.

5. Click OK when the confirmation message is displayed.

6. In the Edit Media Types dialog box, click the Update button.
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The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.697

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.

Changing Media Names

1. Open the Edit Media Types dialog box.
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2. In the Media Type list, select the name to change.
Click the Rename button.

3. The Rename Media dialog box is displayed.
Edit the names in Name in Printer Driver and Name on Control Panel and click the OK button.

Note
• To restore the original names, click the Restore button.
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4. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.697

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.

Deleting Media Types You Have Added

1. Open the Edit Media Types dialog box.
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2. In the Media Type list, select the name of the media to delete.
Click the Delete button.

Note
• Only paper for which Status in the Media Type is Add can be deleted.

3. In the Edit Media Types dialog box, click the Update button.
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The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.697

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.

Switching Media Types Display Show/Hide

1. Open the Edit Media Types dialog box.
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2. In the Media Type list, select the name of the media to switch off or on for display.
Click the Show/Hide button.
The selected paper is alternately shown or hidden.

Note
• The names of media switched for non-display appear grayed out in the Media Type list.
• Each time you click the Show/Hide button, the display mode cycles from showing both the printer

driver and printer panel, to hiding both the printer driver and printer panel, and then to showing only
the printer panel.

3. In the Edit Media Types dialog box, click the Update button.
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The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.697

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.

Changing the Display Order of Media Types

1. Open the Edit Media Types dialog box.
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2. Select the paper in the Media Type list for which to change the display order, and then click the buttons to move the

item (  or ).
The selected item moves one line up or down for every button click.

3. In the Edit Media Types dialog box, click the Update button.

The Update Media Types wizard is started at this point. For details on the procedure to update paper information
using the Update Media Types wizard, see "Updating Media Types." →P.697

Important
• Be sure to click the Update button. If you do not, your changes will not be applied to the printer and

printer driver.
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Updating Media Types
Clicking the Update button on the Edit Media Types dialog box opens the Update Media Types wizard. You can use this
wizard to apply new information about print media in the printer and in the printer driver.
The procedures for updating the media information with the Update Media Types wizard are as follows.

Important
• When you update the media type information, perform the same update on all of the PCs that are using that

printer.

1. Confirm the printer, where media type information is to be updated, to be displayed in Printer in the Update Media
Types - Select Printer dialog box, and then click the Next button.

2. Communication with the printer starts and the following dialog box is displayed.
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Important
• Do not attempt to print or turn the printer off while the program is communicating with the printer.
• When the program cannot communicate with the printer, the following warning message is displayed.

3. When the program has finished communicating with the printer, the screen moves to display Update Media Types -
Confirm Update. Confirm the information received from the printer.
To update click the Execute button.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

4. Communication with the printer starts and the following dialog box is displayed.
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Important
• Do not attempt to print or turn the printer off while the program is communicating with the printer.
• When the program cannot communicate with the printer, the following warning message is displayed.

Note
• If the authentication screen is displayed, input the administrator name and passowrd and click the OK

button.

5. Click the OK button.

Note
• To apply the same updates to other printers of the same model, click the Add Genuine Paper button

in the main window to open the Edit Media Types dialog box and then click the Update button.
Select the printer that you want to update in Step 1, and update the media information by following
the Update Media Types wizard.

Using Paper Other Than Genuine Paper/Feed Confirmed Paper
When the Add Custom Paper button is clicked in the Media Configuration Tool main window, the Add Custom Paper
dialog box is displayed.
Adding custom paper to the printer control panel and printer driver is performed from this screen.

Note
• Custom paper is paper other than Canon genuine paper and feed confirmed paper (paper that is detailed in the

Paper Reference Guide).
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The following operations can be performed from this screen.

• Add Custom Paper →P.701

• Edit Custom Paper →P.712

• Delete Custom Paper →P.710

• Export Custom Media Information →P.712

• Import Custom Media Information →P.714

Important
• When adding, editing, or deleting custom paper, make the same changes on all of the other PCs that use the

target printer. The changes can be made easily by creating a Custom Media Information File (.am1 file) using
the custom paper export function and importing the file on the other PCs.

• When using custom paper in another printer, always add the custom paper to that printer before use.
• Canon genuine paper and feed confirmed paper cannot be changed from this dialog box. Refer to "Editing

Media Type Information →P.685 ".
• Changing the display order of media types displayed in the printer control panel and printer driver is per-

formed from the Edit Media Types dialog box regardless of whether it is Canon genuine paper or custom
paper. Refer to "Editing Media Type Information →P.685 ".

Compatible Paper

Paper specifications
Refer to "Specifications" and "Paper" for specifications such as thickness and size of paper that can be added as custom
paper  (See "Specifications.") →P.1078

Notes on the operating environment
In low humidity environments (below 40%), your printer may develop the following problems.

• Paper becomes curled or wrinkled.
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• Paper and the printhead are more likely to touch each other, resulting in a scratched print surface or damaged print-
head.

• The cut printed matter sticks to the printer and will not fall down (film media).
• Paper sticks to the printer, making its transfer impossible and preventing its normal ejection (film media).
• Uneven printing (film media)

In high humidity environments (over 60%), your printer may develop the following problems.

• Printed matter will not dry.
• Wavy paper surface
• Cut edges are ragged (fabric media).
• Margins remain due to borderless printing.

Important
• Canon offers absolutely no guarantees regarding the print quality or paper feed properties of customer paper

(paper that is not Canon genuine paper or Canon feed confirmed paper).

Add Custom Paper
In order to add new custom paper to the printer control panel and printer driver, first select the media type to use as the basis
from among the Canon genuine paper and feed confirmed paper. Add this as custom paper after making various changes to
the standard paper as necessary.

Important
• Do not execute printing on the target printer while adding custom paper.
• When adding custom paper, check the specifications of paper that can be added using "Compatible Pa-

per →P.700 ".
• Custom paper added using the add custom paper function can only be used by the printer driver. It cannot be

used by other software.

1. Open the Add Custom Paper dialog box and click the Add button.
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2. Check that the printer on which you are updating the media information is displayed in Printer in the Update Me-
dia Types - Select Printer dialog box and click the Next button.

3. The Step 1: Select the standard paper dialog box is displayed. In Paper Category, select the category of media
type to use as the basis of the custom paper you are adding.

Important
• Select the category that you think is the closest to the custom paper you are adding.
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4. The media type names of the Canon genuine paper and feed confirmed paper within the selected category are shown
in Media Type Name. Select the media type to use as the basis of the custom paper, and click the Next button.

Note
• If you do not know which media type to use as the basis of the custom paper, click the Assist button

to open the Media Type Selection Assistance dialog box, and then set either the Weight (gram-
mage) or the Thickness. The Media Configuration Tool automatically selects the appropriate paper
from the selected paper category. Alternatively, select the media type called General from among the
displayed Media Type Name.

• Depending on the selected category, there might not be a media type called General.
• Depending on the selected category, the Assist button may be disabled.

5. The Step 2: Set the custom paper name dialog box is displayed.
Enter an arbitrary name to display in the printer control panel and printer driver, and then click the Next button.

Note
• Paper Name (English) is used in keeping track of the amount of roll paper left, in status print, etc.

6. Load the custom paper in the printer and then click the OK button.

Important
• Do not load paper that is curled or that has already been printed on.
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7. The Step 3: Paper Source Settings dialog box is displayed. Select the paper source where the custom paper is loa-
ded and then click the OK button.

8. The Step 4: Paper feed adjustment dialog box is displayed. Click the Execute button to execute paper feed adjust-
ment.
The adjustment pattern is printed, and the paper feed is automatically adjusted based on the printing result.
Once the paper feed adjustment is complete, click the Next button.

Important
• Check that there is no paper left on the ejection guide.
• If Paper Feed Adjustment is not executed, horizontal stripes with different color tones may appear

in the printed material. Paper feed adjustment does not need to be executed more than once. Execute
paper feed adjustment only once each time you add a custom paper.

9. The Roll Paper Settings dialog box is displayed.

Note
• If a paper source other than Roll Paper is selected in the Step 3: Paper Source Settings dialog box,

this screen is not displayed.
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Configure the following settings as necessary, and then click the Next button.

Setting Details

Automatic Cutting Settings Configures the method for cutting roll paper when it is ejected after printing.

• Automatic Cut :Roll paper is automatically cut by the cutter unit.

• Eject Cut :When the Cut key is pressed on the printer control panel, the roll pa-
per is cut by the cutter unit. Select this if you do not want the printed material to
drop immediately after printing, such as to wait for the ink to dry.

• User Cut :Cutting is not performed by the cutter unit. Cut the roll paper using
scissors after each sheet. Select this for paper that cannot be cut by the cutter unit.

Drying Time Specify the time that the printer waits for ink to dry, as needed.

• Off :Ejects immediately after printing finishes.

• 30 sec./1 min./3 min./5 min./10 min./30 min./60 min. :Ejects after the specified
time has elapsed after printing finishes.

Borderless Printing Configures whether or not to permit borderless printing.

• Permit : Borderless printing is permitted.

• Deny : Borderless printing is denied.
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Important
• Depending on the paper, there are types that cannot be cut by the cutter unit, and types that speed

deterioration of the blade and cause damage to the cutter. For thick paper, hard paper, etc. do not use
the cutter unit, and instead cut the roll paper using scissors, etc. after printing. In this case, select User
Cut as the Automatic Cutting Settings.

• If borderless printing is performed on paper where the ink drying is poor, the cutter unit may leave
scratches where it touches the printed surface, or may not cut correctly. In this kind of situation, con-
figure the amount of time to wait for the ink to dry after printing using Drying Time. Alternatively, if
the paper cannot be cut well by the cutter, set the Automatic Cutting Settings to User Cut and cut
the roll paper using scissors, etc.

• Paper where borderless printing can be performed is limited by the media type and roll paper width.
Refer to "Compatible Paper →P.700 ".

• For custom paper where there is a need to set the Automatic Cutting Settings to User Cut, set the
Borderless Printing to Deny.

10. The Step 5: Configure the amount of ink used dialog box is displayed.
The upper limit on the amount of ink used to print to the custom paper is set on this screen by selecting from among
several levels.
First, click the Test Print button to perform a test print of each level.

Important
• If Newsprint for Proofing was selected as the standard paper for the custom paper, you cannot per-

form the test print or configure the maximum ink usage.
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11. The Test Print Settings dialog box is displayed.
Select the print priority and print quality of the test print using Print Priority and Print Quality.
Set the level to test print using Maximum ink usage and the image to use using Image used in test print, and then
click the Start Print button.

12. Determine and set the ink level that is thought to give the best visual test print results with no bleeding or scraping of
ink.
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Note
• Select the optimal ink level by referring to the help.
• If you cannot obtain sufficiently high quality printing no matter which maximum ink usage level you

select, use the Step 1: Select the standard paper dialog box to change the paper that is the basis of
the custom paper to another paper.

Important
• Because this settings imposes an upper limit on the amount of ink used during printing, the printing

result might not change even if the level is changed depending on the image.
• The color tone cannot be configured using the Media Configuration Tool. Although the color tone

may change when the maximum ink usage is changed, at this point you should select the optimal lev-
el by only focusing on bleeding and scraping of ink. If the color tone needs to be adjusted, provide an
ICC color profile that matches the paper you are using, and select that ICC color profile in your soft-
ware.

• Depending on the maximum ink usage setting, some of the print qualities in the printer driver may
become unselectable.

13. Configure Head Height and Vacuum Strength as required and click the Next button.
Usually, these do not need to be set.

Important
• If you set the Head Height lower than the automatically set height in parentheses ( ), check that the

printhead does not rub against the paper. (If the printhead rubs against the paper, there will be
scratches in the printing results.) If the printhead rubs against the paper, this can cause damage to the
printhead.

• If you change the Vacuum Strength, check that the printhead is not rubbing against the paper. (If the
printhead rubs against the paper, there will be scratches in the printing results.) If the printhead rubs
against the paper, this can cause damage to the printhead.

• For details on the Head Height and Vacuum Strength, refer to the help.
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14. The Step 6: Confirm the settings dialog box is displayed.
Configure the settings of the custom paper, and then click the Next button.

15. The Confirm Update dialog box is displayed.
Confirm the updates and then click the Execute button.

Note
• If the authentication screen is displayed, input the administrator name and passowrd and click the OK

button.
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The custom paper is added to the control panel of the printer and to the printer driver of the PC you are using.

Important
• If you have added custom paper with the POP Board / Cardboard category as the Standard Paper,

remove the loaded custom paper from the printer.

Note
• When the custom paper is correctly added to the printer driver, the name of the added custom paper is

displayed in the Edit Media Types dialog box that is opened by Add Genuine Paper in the Media
Configuration Tool window.

Delete Custom Paper
You can delete custom paper that you have already added from printer control panel and from the printer driver of the PC
you are using.

1. Open the Add Custom Paper dialog box.

2. Select the paper you want to delete from the Added Custom Paper list and then click the Delete button.
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3. Select the custom paper you want to delete, and then click the Next button.

4. The Confirm Update dialog box is displayed.
Confirm the updates and then click the Execute button.

Note
• If the authentication screen is displayed, input the administrator name and passowrd and click the OK

button.

The custom paper is deleted from the control panel of the printer and from the printer driver of the PC you are using.
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Edit Custom Paper
You can change the settings of custom paper you have already added.

1. Open the Add Custom Paper dialog box.

2. Select the paper you want to edit from the Added Custom Paper list and then click the Edit button.

3. The Update Media Types - Select Printer dialog box is displayed.
Follow the on-screen directions and change the settings as required.

Note
• Refer to Steps 5 to 15 of the "Add Custom Paper →P.701 " for details on how to configure each

setting.

Export Custom Media Information
You can export to file and save media information about custom paper that you have added.
The saved Custom Media Information File can be used by importing it into another printer or PC. Refer to "Import Custom
Media Information →P.714 " for details on "importing custom media information".

1. Open the Add Custom Paper dialog box.
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2. Select the paper you want to export to media information file from the Added Custom Paper list and then click the
Export button.

3. Specify the location to save the Custom Media Information File.

A Custom Media Information File (.am1 file) is saved.
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Import Custom Media Information
You can import a Custom Media Information File that has been saved in a folder, and add the file to the printer control
panel and to the printer driver of the PC you are using.

1. Open the Add Custom Paper dialog box.

2. Click the Import button.

3. Select the printer to add the custom paper to.
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Note
• Double-click Custom Media Information File to start the Media Configuration Tool and display this

screen.

4. Select the Custom Media Information File (.am1 file) to import.

5. The Confirm Update dialog box opens.
Click the Execute button.

Note
• If the authentication screen is displayed, input the administrator name and passowrd and click the OK

button.
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The custom paper is added to the control panel of the printer and to the printer driver of the PC you are using.

Note
• When the custom paper is correctly added to the printer driver, the name of the added custom paper is

displayed in the Edit Media Types dialog box that is opened by Add Genuine Paper in the Media
Configuration Tool window.

Warnings
Take note of the following warnings when added custom paper other than Canon genuine paper and feed confirmed paper to
the printer driver and the printer itself.

About the Cutter

• Depending on the paper, there are types that cannot be cut by the cutter unit, and types that speed deterioration of the
blade and cause damage to the cutter. For thick paper, hard paper, etc. do not use the cutter unit, and instead cut the roll
paper using scissors, etc. after printing. In this case, select User Cut as the Automatic Cutting Settings in the Roll
Paper Settings dialog box.

Note
• If the cutter is damaged, contact your Canon dealer for assistance.
• Refer to "Specifying the Cutting Method for Rolls" for details on the methods for cutting roll paper.  (See

"Specifying the Cutting Method for Rolls.") →P.797

About the Printhead

• If the printhead rubs against the paper during printing, this may cause damage to the printhead. If the printhead is rub-
bing against the paper, configure the Vacuum Strength in the Step 5: Configure the amount of ink used dialog box
as follows.

• For paper-based media such as Heavyweight Coated Paper: Set to Strong or Strongest
• For film-based media such as CAD Tracing Paper: Set to Standard, Strong, or Strongest
• For thin paper of thickness 0.1mm or less: Set to Weakest

Note
• If the printhead still rubs even after changing the Vacuum Strength, set the Head Height to be higher in the

Step 5: Configure the amount of ink used dialog box.
• Refer to "Paper rubs against the Printhead" for details on how to handle the printhead rubbing against the

paper.  (See "Paper rubs against the printhead.") →P.1027

About Borderless Printing

• When performing borderless printing on paper where the ink does not dry well, the cutter unit may leave scratches
where it touches the printed surface, or may not cut correctly. In this kind of situation, configure the amount of time to
wait for the ink to dry after printing using Drying Time in the Roll Paper Settings dialog box.
Alternatively, if the paper cannot be cut well by the cutter, set the Automatic Cutting Settings to User Cut in the Roll
Paper Settings dialog box, and cut the roll paper using scissors, etc.

About the Print Quality

• If the edges of images are blurry, set the Vacuum Strength to be weaker in the Step 5: Configure the amount of ink
used dialog box.
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• If lines are warped or scratched, set the Head Height to be lower in the Step 5: Configure the amount of ink used
dialog box.

• If the amount of ink used is too much, wrinkles may appear and the ink may bleed in the printed material. Furthermore,
if the amount of ink used is too little, color production may be poor and lines may become scratched. In this kind of
situation, change the amount of ink used in the Step 5: Configure the amount of ink used dialog box.

• If horizontal bands with different color tone appear in the printed material, execute Paper Feed Adjustment in the
Step 4: Paper feed adjustment dialog box. If you have already executed Paper Feed Adjustment, execute Adj. Fine
Feed from the printer control panel and fine tune the amount of paper feed.

Note
• Refer to "Fine-Tuning the Paper Feed Amount (Adj. Fine Feed)" for details on Adj. Fine Feed.  (See

"Fine-Tuning the Paper Feed Amount (Adj. Fine Feed).") →P.838

• If horizontal bands appear even after executing Adj. Fine Feed, refer to "Banding in different colors
occurs" in "Troubleshooting".  (See "Banding in different colors occurs.") →P.1030

• If printed sheets are affected by banding in different colors toward the end of the sheet (about 20–30 mm from the
edge), try adjusting the feed amount of the trailing edge of sheets.  (See "Adjusting Color on the Trailing Edge of
Sheets.") →P.840

• If you cannot obtain sufficiently high print quality, change the maximum ink usage, or change the media type used as
the basis for the custom paper in the Step 1: Select the standard paper dialog box.

• If there is no luster in printed material, set the paper used as the basis for the custom paper to a paper that uses photo
ink as the Black ink.
The types of Black ink used are displayed on the right side of each media type in the Step 1: Select the standard
paper dialog box.

Note
• Refer to "Problems with the printing quality" for details on problems with printing quality. (Refer to " Prob-

lems with the printing quality →P.1026 ")

About the Color Tone

• The color tone cannot be configured using the Media Configuration Tool. If the color tone needs to be adjusted, pro-
vide an ICC color profile that matches the paper you are using, and select that ICC color profile in your software.

• Custom paper cannot be used with the ambient light adjustment function or Monitor Matching in Color-Matching
Method.
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Using the Printer Hard Disk
The printer can save print jobs on the built-in hard disk.
Using print jobs stored on the printer enables you to print the jobs again as needed without using a computer.

Saving print jobs offers the following benefits.

• Save the time spent using a computer
When you send a print job to the printer, you can save it on the printer after printing or simply save it on the printer
without printing it yet. Saved print jobs can be printed in the required quantity later without the need to use a computer
again.

• Simplify reprinting, if any errors occur
If errors occur in the middle of printing (as when paper runs out), you can resume printing after clearing the error with-
out resending the print job from a computer.

• Streamline printing work
Without using a computer, you can select print jobs and print in the desired quantity. You can also select multiple print
jobs to print during the same period. This enables unattended operation at night, for example.

Output Method
To save print jobs on the printer's hard disk, choose Output Method (in Windows) or Send job to (in Mac OS X).

• Print
Save print jobs on the printer's hard disk after printing.

• Save in mail box
Save print jobs on the printer's hard disk.

• Print after reception is complete
This option is available in combination with Print. Print jobs are saved on the printer's hard disk before printing.
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Storage destination
The storage area on the printer's hard disk is divided into a temporary storage area and a permanent storage area. The tem-
porary storage area stores print jobs in the job queue or shared mailbox. The permanent storage area stores jobs in personal
boxes.

• Job queue
The job queue refers to print jobs that are being processed by the printer (saved, received, prepared for processing,
printed, deleted, or held). Up to 64 jobs can be stored in the temporary storage area.
When the job queue is full, additional jobs sent from a computer are treated as "standby" jobs, to be processed when
possible.
However, if all queued jobs are simply being held, the oldest job is deleted and the print job sent from the computer is
processed.

• Shared mailbox
Jobs for which you have specified Print in Output Method (in Windows) or Send job to (in Mac OS X) are saved in
the shared mailbox and classified as saved jobs.
There is one shared mailbox, numbered 00. A password cannot be set for the shared mailbox.
Up to 100 print jobs can be saved here, but they will be deleted one after another starting with the oldest job in the
following situations.

• If there are more than 100 jobs queued and saved in the shared mailbox combined
• If no more temporary storage space is available when jobs for which you have selected Print in Output Method

(in Windows) or Send job to (in Mac OS X) are received
• If there is not enough space in the temporary or permanent storage area when jobs for which you have selected

Save in mail box in Output Method (in Windows) or Send job to (in Mac OS X) are received

• Personal boxes
Jobs are classified as saved jobs and saved in personal boxes in the following situations.

• When a saved job stored in the shared mailbox is moved to a personal box
• When you have selected Save in mail box as the option in Output Method (in Windows) or Send job to (in Mac

OS X)

There are 29 personal boxes, numbered 01 to 29. You can specify a name and password for each personal box.
Up to 100 print jobs can be saved in all personal boxes combined.
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Saving Print Jobs on the Printer Hard Disk
To save print jobs on the printer's hard disk, configure the printer driver.

Note
• Printing from the following software also enables you to save print jobs on the printer's hard disk.

Windows

• Print Plug-In for Photoshop/Digital Photo Professional →P.307

• Free Layout →P.261

• Color imageRUNNER Enlargement Copy →P.292

• Preview →P.248
Mac OS

• Print Plug-In for Photoshop/Digital Photo Professional →P.607

• Free Layout →P.549

• Color imageRUNNER Enlargement Copy →P.583

• Preview →P.518
The document title will be "imagePROGRAF" when you print from imagePROGRAF Preview.

Configuring the Printer Driver in Windows

1. Access the Page Setup sheet.

Print Job Operations > Basic Print Job Operations >

iPF6300S Saving Print Jobs on the Printer Hard Disk

5

721



2. Click Output Method to display the Output Method dialog box.

3. Make your selection in Output Method.

• Print
Save print jobs on the printer's hard disk after printing.

• Save in mail box
Save print jobs on the printer's hard disk.
If you choose Save in mail box, also specify the destination personal box in the Mail box list.

• Print after reception is complete
This option is available in combination with Print. Print jobs are saved on the printer's hard disk before print-
ing.

Note
• Click Acquire Mail Box Name to display personal box names in the Mail box list, as acquired from

the printer.

4. In Name of data to be saved, specify how to name saved print jobs.

• To use the file name, choose Use file name.
• Otherwise choose Enter name and enter a name in Name.

5. Click OK to close the Output Method dialog box.
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Configuring the printer driver in Mac OS

1. Access the Additional Settings pane.

2. Make your selection in Send job to.

• Print
Save print jobs on the printer's hard disk after printing.

• Save in mail box
Save print jobs on the printer's hard disk.
The Destination dialog box is displayed if you select Save in mail box. Here, specify the name and personal
box number for saved print jobs.
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1. In Document title, enter a name to identify saved print jobs.

2. Select the personal box number in the Mail box list.

3. Click OK to close the Destination dialog box.

• Print after reception is complete
This option is available in combination with Print. Print jobs are saved on the printer's hard disk before print-
ing.

Managing the Job Queue (Deleting or Preempting Other Jobs)
Print jobs being processed by the printer are collectively called the job queue. You can delete or preempt jobs in the job
queue as needed.
These operations are available from the Control Panel or in RemoteUI, imagePROGRAF Status Monitor, and imagePROG-
RAF Printmonitor.

• Delete
Note that only jobs that are not currently being deleted can be deleted from the job queue.

• Preempting other jobs
You can preempt other jobs by printing jobs that are currently being received or prepared for processing first.

Note
• For information on managing jobs being held, see "Managing Pending Jobs (Printing or Deleting Jobs on

Hold)." →P.727
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Using the Control Panel

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Job Menu is displayed.

3. Manage the job queue as needed.

• Deleting jobs

1. Press ▲ or ▼ to select Print Job, and then press the OK button.

2. Press ▲ or ▼ to select the print job to delete, and then press the OK button.

3. Press ▲ or ▼ to select Delete, and then press the OK button.

• Preempting other jobs

1. Press ▲ or ▼ to select Print Job, and then press the OK button.

2. Press ▲ or ▼ to select the job to print first, and then press the OK button.

3. Press ▲ or ▼ to select Preempt Jobs, and then press the OK button.

Using RemoteUI
Manage jobs as needed on the Print Job page. For details, refer to the RemoteUI help.
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Using imagePROGRAF Status Monitor (Windows)
Manage jobs as needed on the Job sheet. For details, refer to the imagePROGRAF Status Monitor help file.

 

Using imagePROGRAF Printmonitor (Mac OS)
Manage jobs as needed on the Driver sheet. For details, refer to the imagePROGRAF Printmonitor help file.
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Managing Pending Jobs (Printing or Deleting Jobs on Hold)
If the type or size of paper loaded does not match the settings in the print job received when you have set Detect Mismatch
to Hold Job in the Control Panel menu, the print job is held on the printer as a pending job in the job queue.
Manage held jobs such as these as follows.
These operations are available from the Control Panel or in RemoteUI, imagePROGRAF Status Monitor, and imagePROG-
RAF Printmonitor.

Note
• As long as you do not manage held jobs from the Control Panel, imagePROGRAF Status Monitor, or image-

PROGRAF Printmonitor, they will remain in the job queue. In this case, the printer processes the next job in
the queue without pausing.

• To print held jobs, replace the loaded paper with the paper specified in the print job.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

Using the Control Panel

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Job tab ( ).
"There are held jobs." is displayed if jobs are being held.

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Job Menu menu is displayed.

3. Press ▲ or ▼ to select Print Job, and then press the OK button.

4. Press ▲ or ▼ to select the print job to manage, and then press the OK button.
Held jobs are labeled with an icon.

5. Press ▲ or ▼ to select Print Anyway or Delete, and then press the OK button.

• If you choose Print Anyway
Press ▲ or ▼ to select Yes or No, and then press the OK button.

• If you choose Delete
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Press ▲ or ▼ to select Yes or No, and then press the OK button.

Using RemoteUI
Manage jobs as needed on the Print Job page. For details, refer to the RemoteUI help file.

Using imagePROGRAF Status Monitor
Manage jobs as needed on the Job sheet. For details, see "Job Management Using imagePROGRAF Status Monitor."
→P.426

Print Job Operations > Basic Print Job Operations >

Managing Pending Jobs (Printing or Deleting Jobs on Hold) iPF6300S

5

728



Using imagePROGRAF Printmonitor
Manage jobs as needed on the Driver sheet. For details, see "Job Management Using imagePROGRAF Printmonitor."
→P.674

Printing Saved Jobs
Print saved print jobs stored on the printer's hard disk as follows.
These operations are available from the Control Panel or in RemoteUI, imagePROGRAF Status Monitor, and imagePROG-
RAF Printmonitor.

Using the Control Panel

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Job tab ( ).
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Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Job Menu menu is displayed.

3. Press ▲ or ▼ to select Stored Job, and then press the OK button.

4. Press ▲ or ▼ to select the box number (in the range 00–29), and then press the OK button.

Note
• Enter a password if one has been set, and then press the OK button.

5. Press ▲ or ▼ to select Job List, and then press the OK button.

6. Press ▲ or ▼ to select the saved job, and then press the OK button.

7. Press ▲ or ▼ to select Print, and then press the OK button.

8. Specify the number of copies and press the OK button.

Using RemoteUI

1. On the Stored Job page, choose the box.
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Note
• Enter a password if one has been set.

2. Select the print job and click Resume.

3. On the Print Saved Document page, enter the quantity to print in Copies and click OK.

For details, refer to the RemoteUI help.
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Using imagePROGRAF Status Monitor

1. On the Hard Disk sheet, select a box and click Open.

Note
• Enter a password if one has been set.
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2. In the Documents dialog box, select the print job and click Print.

3. In the Print dialog box, enter the quantity to print in Copies and click OK.

Note
• The printing time initially indicates how long it took to finish printing one copy during the previous

print job.
If you change the value in Copies, the printing time indicates the time it took to print one copy during
the previous print job multiplied by the number of copies.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor

1. On the Hard Disk pane, click ▶ by Inbox No./Name.

Note
• Enter a password if one has been set.

The password is a four-digit number.
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2. Select the saved job and click Resume Printing.

3. In the Resume Printing dialog box, enter the quantity to print and click OK.

For details, refer to the imagePROGRAF Printmonitor help file.
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Deleting Saved Jobs
Delete saved print jobs stored on the printer's hard disk as follows.
This operation is available from the Control Panel, in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF
Printmonitor.

Using the Control Panel

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Job Menu is displayed.

3. Press ▲ or ▼ to select Stored Job, and then press the OK button.

4. Press ▲ or ▼ to select the box number (in the range 00–29), and then press the OK button.

Note
• Enter a password if one has been set, and then press the OK button.

5. Press ▲ or ▼ to select Job List, and then press the OK button.

6. Press ▲ or ▼ to select the saved job, and then press the OK button.

7. Press ▲ or ▼ to select Delete, and then press the OK button.

8. Press ▲ or ▼ to select "Yes", and then press the OK button.
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Using RemoteUI

1. On the Stored Job page, choose the mail box.

Note
• Enter a password if one has been set.

2. Select the print job and click Delete.

For details, refer to the RemoteUI help file.
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Using imagePROGRAF Status Monitor

1. On the Hard Disk sheet, select a box and click Open.

Note
• Enter a password if one has been set.
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2. In the Documents dialog box, select the print job and click Delete.

For details, refer to the imagePROGRAF Status Monitor help file.
 
 

Using imagePROGRAF Printmonitor

1. In the Hard Disk pane, click ▶ next to Inbox No./Name.
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Note
• Enter a password if one has been set.

The password is a four-digit number.

2. Select the print job and click the Delete button.

For details, refer to the imagePROGRAF Printmonitor help file.

Moving Saved Jobs
Print jobs stored on the printer's hard disk (saved jobs) can be moved from the current box to another box as follows.
However, jobs saved in personal boxes cannot be moved to the shared mailbox.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.
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Important
• Jobs stored in the shared mailbox may be automatically deleted under some conditions. To prevent jobs from

being deleted, move them from the shared mailbox to personal boxes.  (See "Using the Printer Hard Disk.")
→P.719

Using RemoteUI

1. On the Stored Job page, choose the box.

Note
• Enter a password if one has been set.

2. Select the print job and click Move Document.
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3. On the Move Document page, select the name or number of the destination personal box in the Destination mail
box list and click OK.

For details, refer to the RemoteUI help file.
 

Using imagePROGRAF Status Monitor (Windows)

1. On the Hard Disk sheet, select a box and click Open.
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Note
• Enter a password if one has been set.

2. In the Documents dialog box, select the print job and click Move.

3. In the Move dialog box, select the destination personal box and click OK.
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For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Macintosh)

1. In the Hard Disk pane, click ▶ next to Inbox No./Name.

Note
• Enter a password if one has been set.

The password is a four-digit number.
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2. Select the print job and click Move.

3. In the Move Document dialog box, select the destination personal box and click OK.

For details, refer to the imagePROGRAF Printmonitor help file.
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Saving Print Jobs Sent from Sources Other than the Printer Driver
To save print jobs sent from software or systems other than the printer driver or applications provided with the printer, com-
plete the Output Method and Print After Recv settings in the Control Panel menu.

Note
• Contact the software or system developer for information about support for this printer function.

Specifying Output Method
In Output Method, specify how to manage jobs, regarding printing and saving them.

• Print
Save print jobs automatically at the same time they are printed. (This is the default format.)

• Print (Auto Del)
Save print jobs temporarily at the same time they are printed and delete them after printing.

• Save: Box 01 (Here, the number represents a box number)
Save print jobs on the printer.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.
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2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select System Setup, and then press the OK button.

4. Press ▲ or ▼ to select Output Method, and then press the OK button.

5. Press ▲ or ▼ to select Print, Print (Auto Del), or Save: Box 01.
Follow these steps only when you select Save: Box 01.

6. Press ▲ or ▼ to select the box, and then press the OK button.

Specify Print After Recv
To save print jobs on the hard disk before printing, specify Print After Recv.
Printing will start when Print After Recv is set to On, even if you have selected Save: Box 01 in Output Method.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select System Setup, and then press the OK button.

4. Press ▲ or ▼ to select Print After Recv, and then press the OK button.

5. Press ▲ or ▼ to select On or Off, and then press the OK button.
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Printing Without Saving Jobs in the Common Box
Jobs sent from a computer for which you have selected Print in Output Method (in Windows) or Send job to (in Mac OS
X) in the printer driver are saved in the shared mailbox.  (See "Using the Printer Hard Disk.") →P.719
When Common Box Set. is Print (Auto Del) in the Control Panel menu, print jobs for which you have selected Print in
the Output Method dialog box of the printer driver are deleted from the shared mailbox after printing.
Use this function when printing highly confidential documents.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select System Setup, and then press the OK button.

4. Press ▲ or ▼ to select Common Box Set., and then press the OK button.

Note
• If a password has been set on the printer, the Logon screen is displayed.

To change the setting, select Administrator and press the OK button. Enter the password when Ad-
min.Pswd is displayed and press the OK button before going to the next procedure.
If you select User and press the OK button, you can check settings values but cannot change them.

5. Press ▲ or ▼ to select Print (Auto Del), and then press the OK button.

Setting Passwords for Personal Boxes
For greater security, you can specify a password for personal boxes. After you set a password, it will be required to modify
the personal box settings, as well as to display, print, delete, move, and modify jobs saved in the personal box.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.
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Note
• By default, no passwords are set for personal boxes.
• A password cannot be set for the shared mailbox.
• Enter a four-digit number as the password, in the range 0001–9999.
• Even if you have set passwords, they are not required to access personal boxes in Administrator Mode in

RemoteUI.

Using RemoteUI

1. On the Stored Job page, choose the personal box.

2. Click Edit.

3. In the Set/Register User's Inbox dialog box, specify the password and click OK.

• Set Password
Select the check box.

• Password
Enter the password. (This field is limited to four digits in the range 0001–9999.)

• Confirmation Number
Re-enter the password to confirm it.

For details, refer to the RemoteUI help.
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Using imagePROGRAF Status Monitor (Windows)

1. On the Hard Disk sheet, select the personal box and click Open.

2. In the Documents dialog box, click Settings.

3. In the Settings dialog box, specify the password and click OK.

• Set password
Select the check box.

• Password
Enter the password. (This field is limited to four digits in the range 0001–9999.)

• Re-enter to confirm
Re-enter the password to confirm it.
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For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Macintosh)

1. On the Hard Disk pane, click ▶ by Inbox No./Name. Select a saved job in the list and click Set.

2. In the Settings dialog box, specify the password and click OK.

• Set password
Select the check box.

• Password
Enter the password. (This field is limited to four digits in the range 0001–9999.)

• Verify
Re-enter the password to confirm it.
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For details, refer to the imagePROGRAF Printmonitor help file.

Naming Personal Boxes
For easier identification, you can assign names to personal boxes.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Using RemoteUI

1. On the Stored Job page, choose the personal box.
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Note
• Enter a password if one has been set for the personal box.

2. Click Edit.

3. In the Set/Register User's Inbox dialog box, enter the name in Inbox Name and click OK.

For details, refer to the RemoteUI help file.
 

Print Job Operations > Advanced Print Job Operations >

iPF6300S Naming Personal Boxes

5

753



Using imagePROGRAF Status Monitor (Windows)

1. On the Hard Disk sheet, select the personal box and click Open.

Note
• Enter a password if one has been set for the personal box.
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2. In the Documents dialog box, click Settings.

3. In the Settings dialog box, enter the name and click OK.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Macintosh)

1. In the Hard Disk pane, click ▶ next to Inbox No./Name. Select a saved job in the list and click Set.

Note
• Enter a password if one has been set.

The password is a four-digit number.
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2. In the Settings dialog box, enter the name and click OK.

For details, refer to the imagePROGRAF Printmonitor help file.

Displaying a List of Saved Jobs
Print jobs stored on the printer's hard disk (saved jobs) can be listed by box as follows.
These operations are available from the Control Panel or in RemoteUI, imagePROGRAF Status Monitor, and imagePROG-
RAF Printmonitor.

Using the Control Panel

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Job Menu is displayed.

3. Press ▲ or ▼ to select Stored Job, and then press the OK button.
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4. Press ▲ or ▼ to select the box number (in the range 00–29), and then press the OK button.

Note
• Enter a password if one has been set, and then press the OK button.

5. Press ▲ or ▼ to select Job List, and then press the OK button.

Using RemoteUI
On the Stored Job page, choose the box.

Note
• Enter a password if one has been set.

Jobs saved in the box are listed.
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For details, refer to the RemoteUI help.
 

Using imagePROGRAF Status Monitor (Windows)
On the Hard Disk sheet, select a box and click Open.

Note
• Enter a password if one has been set.
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Jobs saved in that box are displayed in the Documents dialog box.

For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Macintosh)
On the Hard Disk pane, click ▶ by Inbox No./Name.
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Note
• Enter a password if one has been set.

The password is a four-digit number.

For details, refer to the imagePROGRAF Printmonitor help file.

Printing a List of Saved Jobs
The list of print jobs stored on the printer's hard disk (saved jobs) can be printed by box as follows.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Job Menu is displayed.

3. Press ▲ or ▼ to select Stored Job, and then press the OK button.

4. Press ▲ or ▼ to select the box number (in the range 00–29), and then press the OK button.

Note
• Enter a password if one has been set, and then press the OK button.

5. Press ▲ or ▼ to select Print Job List, and then press the OK button.
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Displaying Details of Saved Jobs
Details of print jobs stored on the printer's hard disk (saved jobs) can be displayed as follows.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Using RemoteUI

1. On the Stored Job page, choose the box.

Note
• Enter a password if one has been set.

2. Select the print job and click Details.
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The Details of the saved document page is displayed.

For details, refer to the RemoteUI help file.
 

Using imagePROGRAF Status Monitor (Windows)

1. On the Hard Disk sheet, select a box and click Open.
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Note
• Enter a password if one has been set.

2. In the Documents dialog box, select the print job and click Properties.

The Properties dialog box is displayed.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Macintosh)

1. In the Hard Disk pane, click ▶ next to Inbox No./Name.

Note
• Enter a password if one has been set.

The password is a four-digit number.

For details, refer to the imagePROGRAF Printmonitor help file.
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Renaming Saved Jobs
Print jobs stored on the printer's hard disk (saved jobs) can be renamed as follows.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Using RemoteUI

1. On the Stored Job page, choose the box.

Note
• Enter a password if one has been set.

2. Select the print job and click Details.
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3. On the Details of the saved document page, click Change Document.

4. In the Rename Saved Document dialog box, enter the name and click OK.

For details, refer to the RemoteUI help file.
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Using imagePROGRAF Status Monitor (Windows)

1. On the Hard Disk sheet, select a box and click Open.

Note
• Enter a password if one has been set.
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2. In the Documents dialog box, select the print job and click Properties.

3. In the Properties dialog box, enter the new name and click OK.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Macintosh)

1. In the Hard Disk pane, click ▶ next to Inbox No./Name.

Note
• Enter a password if one has been set.

The password is a four-digit number.
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2. Select the print job and click Set.

3. In the Settings dialog box, enter the new name and click OK.

For details, refer to the imagePROGRAF Printmonitor help file.
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Types of Paper
The following types of paper are supported by the printer. For details on the paper supported by the printer, refer to the
Paper Reference Guide. (See Paper Reference Guide .)

• Plain Paper
• Coated Paper
• Photo Paper
• Glossy Paper
• Proofing Paper
• CAD-dedicated Paper Etc.

The following content is described in the Paper Reference Guide.

• Types of paper
• Paper handling
• Paper product specifications
• Use precautions
• Setting of printer driver, control panel etc.

• Paper Reference Guide display method
You can display the Paper Reference Guide from [imagePROGRAF Support Information].  (See "Displaying the Pa-
per Reference Guide .") →P.776

• Method of Updating Supported Paper
Paper supported by the printer may be newly released on the imagePROGRAF website.
To use newly released paper, register the latest paper information on the printer with the Media Configuration Tool.
 (See "Updating paper information.") →P.778

Important
• To install the Paper Reference Guide and register paper types applicable to your region on your printer

even when not using the printer driver, install the Media Configuration Tool.
For information about the Media Configuration Tool, see Media Configuration Tool →P.447  or Me-
dia Configuration Tool →P.676 .

Note
• To use paper not described in the Paper Reference Guide, configure the custom paper setting.  (See

"Adding Custom Paper.") →P.779
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Paper Sizes

Rolls
Rolls that meet the following conditions are supported.

• Outer diameter: Up to 150 mm (6 in)
• Inner diameter of paper core: 2 or 3 inches
• Printing side out

Roll Width Roll Paper Width Setting in Printer Driver (*1 →P.774 ) Borderless Printing
(*1 →P.774 )

609.6 mm (24.00 in) 24-in. Roll (609.6mm) Yes

594.0 mm (23.39 in) ISO A1/A2 Roll (594.0mm) Yes (*2 →P.774 )

515.0 mm (20.28 in) JIS B2/B3 Roll (515.0mm) Yes

431.8 mm (17.00 in) 17-in. Roll (431.8mm) Yes

420.0 mm (16.54 in) ISO A2/A3 Roll (420.0mm) Yes (*2 →P.774 )

406.4 mm (16.00 in) 16-in. Roll (406.4mm) Yes

355.6 mm (14.00 in) 14-in. Roll (355.6mm) Yes

329.0 mm (12.95 in) A3+ Roll (329.0mm) No

300.0 mm (11.81 in) 300mm Roll (300.0mm) No

297.0 mm (11.69 in) ISO A3/A4 Roll (297.0mm) No

257.0 mm (10.12 in) JIS B4 Roll (257.0mm) Yes

254.0 mm (10.00 in) 10-in. Roll (254.0mm) Yes

203.2 mm (8.00 in) 8-in. Roll (203.2mm) No

Custom Paper Size 203.2 mm (8.00 in) – 610.0 mm (24.02 in)

*1: For information on types of paper compatible with borderless printing, refer to the Paper Reference Guide.  (See
"Types of Paper.") →P.773

*2: Requires the Spacer for Borderless Printing.

Sheets
Sheets of the following sizes are supported.

Paper Sizes Dimensions

ISO A1 594.0 × 841.0 mm (23.39 × 33.11 in)

ISO A2 420.0 × 594.0 mm (16.54 × 23.39 in)

ISO A2+ 431.8 × 609.6 mm (17.00 × 24.00 in)

ISO A3 297.0 × 420.0 mm (11.69 × 16.54 in)

ISO A3+ 329.0 × 483.0 mm (12.95 × 19.02 in)

ISO A4 210.0 × 297.0 mm (8.27 × 11.69 in)

ISO B2 500.0 × 707.0 mm (19.69 × 27.83 in)

ISO B3 353.0 × 500.0 mm (13.90 × 19.69 in)

ISO B4 250.0 × 353.0 mm (9.84 × 13.90 in)
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Paper Sizes Dimensions

JIS B2 515.0 × 728.0 mm (20.28 × 28.66 in)

JIS B3 364.0 × 515.0 mm (14.33 × 20.28 in)

JIS B4 257.0 × 364.0 mm (10.12 × 14.33 in)

22"x34"(ANSI D) 558.8 × 863.6 mm (22.00 × 34.00 in)

17"x22"(ANSI C) 431.8 × 558.8 mm (17.00 × 22.00 in)

11"x17"(Ledger) 279.4 × 431.8 mm (11.00 × 17.00 in)

13"x19"(Super B) 330.2 × 482.6 mm (13.00 × 19.00 in)

Letter(8.5"x11") 215.9 × 279.4 mm (8.50 × 11.00 in)

Legal(8.5"x14") 215.9 × 355.6 mm (8.50 × 14.00 in)

24"x36"(ARCH D) 609.6 × 914.4 mm (24.00 × 36.00 in)

18"x24"(ARCH C) 457.2 × 609.6 mm (18.00 × 24.00 in)

12"x18"(ARCH B) 304.8 × 457.2 mm (12.00 × 18.00 in)

9"x12"(ARCH A) 228.6 × 304.8 mm (9.00 × 12.00 in)

DIN C2 458.0 × 648.0 mm (18.03 × 25.51 in)

DIN C3 324.0 × 458.0 mm (12.76 × 18.03 in)

DIN C4 229.0 × 324.0 mm (9.02 × 12.76 in)

20"x24" 508.0 × 609.6 mm (20.00 × 24.00 in)

18"x22" 457.2 × 558.8 mm (18.00 × 22.00 in)

14"x17" 355.6 × 431.8 mm (14.00 × 17.00 in)

12"x16" 304.8 × 406.4 mm (12.00 × 16.00 in)

10"x12" 254.0 × 304.8 mm (10.00 × 12.00 in)

10"x15" 254.0 × 381.0 mm (10.00 × 15.00 in)

US Photo 16"x20" 406.4 × 508.0 mm (16.00 × 20.00 in)

Poster 20"x30" 508.0 × 762.0 mm (20.00 × 30.00 in)

13"x22" 329.0 × 558.0 mm (12.95 × 21.97 in)

Poster 300x900mm 300.0 × 900.0 mm (11.81 × 35.43 in)

Custom Paper Size Top Paper Feed Slot 203.2 × 279.0 mm (8.00 × 10.98 in) to 610.0 × 1600.0 mm (24.02 ×
62.99 in)

Front Paper Feed Slot 250.0 × 350.0 mm (9.84 × 13.78 in) to 610.0 × 914.0 mm (24.02 ×
35.98 in)
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Note
• In the Windows printer driver, some sizes are not available by default. Follow these steps to make them

available.

1. Display the printer driver dialog box.
2. Click the Page Setup tab to display the Page Setup sheet.
3. Click Size Options to display the Paper Size Options dialog box.
4. Select the Oversize check box for the size system.

• For details on non-standard Custom Paper Size, see "Printing on Non-Standard Paper Sizes." →P.131

• Borderless printing is not supported on sheets.

Displaying the Paper Reference Guide
The Paper Reference Guide can be accessed from imagePROGRAF Support Information. Follow these instructions, as
appropriate for your operating system.

• Windows

1. Double-click the iPFxxxx Support desktop icon. (iPFxxxx indicates the printer model.)

The imagePROGRAF Support Information window is displayed.

2. Click the Paper Reference Guide button.
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The Paper Reference Guide is displayed.

• Mac OS X

1. Click the iPF Support icon in the Dock.

The imagePROGRAF Support Information window is displayed.

2. Click the Paper Reference Guide button.
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The Paper Reference Guide is displayed.

Updating paper information
As for paper information of the Paper Reference Guide, printer Control Panel, and printer driver, you can update it to the
latest information by downloading and installing the latest version of Media Information File (Media Information File)
from the imagePROGRAF website.
Download the latest Media Information File (Media Information File) after accessing the imagePROGRAF-dedicated site
from imagePROGRAF Support Information. If you cannot download it, contact your Canon dealer.
For details on Media Information File (Media Information File), refer as follows.

• Media Configuration Tool →P.447  (Windows)
• Media Configuration Tool →P.676  (Macintosh)

Important
• When your version of Media Configuration Tool is older than the version released on the imagePROG-

RAF website, download and install the latest version of Media Configuration Tool before installing Me-
dia Information File. If you do not install the latest version of Media Configuration Tool before instal-
ling Media Information File, the latest paper information cannot be updated.

• Windows

1. Double-click the iPFxxxx Support desktop icon. (iPFxxxx indicates the printer model.)

The imagePROGRAF Support Information window is displayed.
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2. Click Visit the imagePROGRAF webpage.

The default browser on your computer is started and the imagePROGRAF webpage is displayed.

• Mac OS X

1. Click the iPF Support icon in the Dock.

The imagePROGRAF Support Information window is displayed.

2. Click Visit the imagePROGRAF webpage.

The default browser on your computer is started and the imagePROGRAF webpage is displayed.

Adding Custom Paper
Using Media Configuration Tool, you can add custom paper (paper not listed in the Paper Reference Guide ) to the printer
driver and control panel of the printer.
For details on Media Configuration Tool, refer as follows.

• Media Configuration Tool →P.447  (Windows)
• Media Configuration Tool →P.676  (Macintosh)
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Important
• If a malfunction occurs in the printer resulting from the use of custom paper (paper not listed in the

Paper Reference Guide ), it is not guaranteed even within the warranty period.
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Loading Rolls on the Roll Holder
When printing on rolls, attach the Roll Holder to the roll.
Rolls have a two- or three-inch paper core. Use the correct attachment for the paper core. The printer comes equipped with
the 2-Inch Paper Core Attachment installed.
For borderless printing on A1 (594 mm) or A2 (420 mm) rolls, attach the included Spacer for Borderless Printing to the Roll
Holder.

Using Rolls with a 2-inch Paper Core Using Rolls with a 3-inch Paper Core

Holder Stopper Roll Holder Side Holder Stopper Roll Holder Side

For 2-inch paper cores No Attachment Needed For 3-inch paper cores 3-Inch Paper Core Attachment

Caution
• Set the roll on a table or other flat surface so that it does not roll or fall. Rolls are heavy, and dropping a roll

may cause injury.

Handling Paper > Handling rolls >
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Important
• When handling the roll, be careful not to soil the printing surface. This may affect the printing quality. We

recommend wearing clean cloth gloves when handling rolls to protect the printing surface.
• Use scissors or a cutting tool to cut the edge of the roll paper if it is uneven, dirty, or has tape residue. Other-

wise, it may cause feeding problems and affect the printing quality. Be careful not to cut through any barco-
des printed on the roll.

• Align the edges of the paper on both ends of the roll. Otherwise, it may cause feeding problems.

Note
• For details on supported sizes and types of rolls, see Paper Sizes or the Paper Reference Guide.  (See "Paper

Sizes.") →P.774   (See "Types of Paper.") →P.773

• To view instructions as you attach the Roll Holder, press the Navigate button.  (See "How to View Instruc-
tions with Navigate.") →P.895

1. Remove the Holder Stopper from the Roll Holder.

2. Insert the attachments for the roll paper on the Roll Holder.

• Using rolls with a 3-inch paper core
Attach the included 3-Inch Paper Core Attachment on the Roll Holder.
Align the triangular part (b) of the 3-Inch Paper Core Attachment (a) with the triangular part (c) of the Roll
Holder as shown, and insert the 3-Inch Paper Core Attachment into the Roll Holder.

Handling Paper > Handling rolls >

Loading Rolls on the Roll Holder iPF6300S
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Use the Holder Stopper for 3-inch paper cores.

• Borderless printing on A1 or A2 rolls
Attach the included Spacer for Borderless Printing to the Roll Holder.
Insert the protrusions (b) of the Spacer for Borderless Printing (a) into the holes (c) of the Roll Holder, as
shown.

3. With the Roll Holder resting horizontally and the edge of the roll paper facing forward as shown, insert the roll in
the Roll Holder from the left. Insert the roll firmly until it touches the flange (a) of the Roll Holder, leaving no gap.

Important
• Always have the Roll Holder resting horizontally when loading rolls. Attempting to load rolls with

the Roll Holder upright may damage the Roll Holder.

Handling Paper > Handling rolls >
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4. Insert the Holder Stopper from the left in the Roll Holder as shown. Push it firmly in until the flange (a) of the Hold-
er Stopper touches the roll.
Attach the appropriate Holder Stopper for the size of the paper core.

Loading Rolls in the Printer
Follow these steps to load rolls in the printer.

Important
• Always load rolls when the printer is on. If the printer is off when you load a roll, the paper may not be

advanced correctly when you turn the printer on.
• Before loading a roll, confirm whether the inside of the Top Cover or the Ejection Guide is soiled. If soiled,

we recommend cleaning in advance.  (See "Cleaning Inside the Top Cover.") →P.998

1. Press the Load button.

Handling Paper > Handling rolls >
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2. Press ▲ or ▼ to select Roll Paper, and then press the OK button.

Note
• If any paper has been advanced that will not be used, a message is shown requesting you to remove it.

Press ▲ or ▼ to select "Yes", and then press the OK button. Remove the paper and go to the next
step.

3. Open the Roll Feed Unit Cover.

4. Holding the Roll Holder flange (a), load the Roll Holder shaft into the guide grooves (b) on both sides of the Roll
Holder Slot. At this time, load the shaft so that the color of the Roll Holder shaft (c) matches the color of the guide
groove.

Caution
• Do not release the flanges until you load the holder fully in the Roll Holder Slot. Rolls are heavy, and

dropping a roll may cause injury.
• Be careful not to pinch your fingers between the guide grooves (b) and the Roll Holder shaft (c) when

loading rolls.

Handling Paper > Handling rolls >

iPF6300S Loading Rolls in the Printer

6

785



Important
• Do not force the Roll Holder into the printer with the right and left ends reversed. Otherwise, it may

damage the printer or Roll Holder.

Note
• If it is difficult to load rolls from the front of the printer, load rolls from the back of the printer.

5. Insert the edge of the roll in the Paper Feed Slot (a) and advance the roll until you hear the feed tone.

Important
• Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect the

printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the print-
ing surface.

• If the paper is wrinkled or warped, straighten it out before loading it.
• Load paper straight so it is not fed askew.

6. Once paper feeding starts, you will need to do the following, based on the ManageRemainRoll setting and the bar-
code printed on rolls.  (See "Keeping Track of the Amount of Roll Paper Left.") →P.794

ManageR-
emainRoll Barcodes Printer Operation After the Paper is Fed

Off Printed A menu for selection of the type of paper is shown on the Display Screen.
Press ▲ or ▼ to select the type of paper, and then press the OK button.Not prin-

ted

On Printed The type and amount of paper left is automatically detected based on the barcode printed
on the roll.
There is no need to specify the type and length of the paper.

Handling Paper > Handling rolls >
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ManageR-
emainRoll Barcodes Printer Operation After the Paper is Fed

On Not prin-
ted

A menu for selection of the type and length of paper is shown on the Display Screen.
Press ▲ or ▼ to select the type and length of paper loaded, and then press the OK button.

Note
• For details on types of paper to select, see the Paper Reference Guide.  (See "Types of Paper.")

→P.773

7. Close the Roll Feed Unit Cover.

Important
• Cut the edge of the roll using the Paper Cutting function if the edge is creased or soiled.  (See

"Specifying the Cutting Method for Rolls.") →P.797

Note
• Adjusting the printhead alignment with the type of paper to be used in printing may enhance printing

quality.  (See "Automatic Adjustment to Straighten Lines and Colors (Head Posi. Adj.).")
→P.827

Changing the Type of Paper
Follow these steps to change the type of paper specified on the printer after you have loaded paper.
If you will continue using this type of paper later, selecting Keep Paper Type > On will save the time and effort of config-
uring the media type setting when you load the paper again. The current media type settings before you select On will be
automatically selected at that time.  (See "Using the Same Type of Paper Regularly.") →P.788

Important
• For best printing results, the printer fine-tunes the print head height and the feed amount for each type of

paper. Be sure to select the type of paper to use correctly before printing.
• Because the printer fine-tunes the feed amount for each type of paper, the margins and the size of printed

images may vary depending on the type of paper used. If margins and the size of images are not as you ex-
pected, adjust the paper feed amount.
 (See "Adjusting the Feed Amount.") →P.833

Handling Paper > Handling rolls >
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Changing the Type of Paper

Note
• When you load a roll, a menu for selection of the type of paper is shown on the Display Screen. Select the

type of paper, and then press the OK button.
If no barcode has been printed on the roll and you have set ManageRemainRoll to On, specify the roll
length after the type of paper.  (See "Specifying the Paper Length.") →P.789

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Chg. Paper Type, and then press the OK button.

4. Press ▲ or ▼ to select the type of paper loaded ( Roll Paper or Manual ), and then press the OK button.

5. Press ▲ or ▼ to select the type of paper loaded in the printer, and then press the OK button.

Important
• Be sure to select the correct paper type. If this setting does not match the loaded paper, it may cause

feed errors and affect printing quality.

Note
• For details on types of paper, see the Paper Reference Guide.  (See "Types of Paper.") →P.773  By

default, Plain Paper is selected.

Using the Same Type of Paper Regularly
Configure this setting so that current media type settings will be automatically selected when you load the same type of
paper later.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Paper tab ( ).

Handling Paper > Handling rolls >

Changing the Type of Paper iPF6300S
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Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Keep Paper Type, and then press the OK button.

4. Press ▲ or ▼ to select On, and then press the OK button.

Note
• The specified media type setting is updated in the following situations.

• When using sheets, if you send a print job before loading a sheet, the media type setting is updated to
match the type of paper specified by the print job.

• When you have selected ManageRemainRoll > On on the Control Panel and a barcode is printed on the
roll, the media type setting is updated to match the type of paper specified by the barcode.

• To change the media type setting, see "Changing the Type of Paper." →P.788

Specifying the Paper Length
When changing the length of paper after the paper has been advanced, specify the length as follows.

Note
• Specify the paper length when you have set ManageRemainRoll to On.  (See "Keeping Track of the

Amount of Roll Paper Left.") →P.794

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Chg. Paper Size, and then press the OK button.

4. Press ▲ or ▼ to select Roll Length, and then press the OK button.

Handling Paper > Handling rolls >
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5. Press ▲ or ▼ to select the length of paper loaded in the printer, and then press the OK button.
Specify the roll length as follows.

1. Press the ◀ or ▶ button to move to the next field for input.

2. Press the ▲ or ▼ button to enter the value.

3. Repeat steps 1 and 2 to finish entering the value, and then press the OK button.

Removing the Roll from the Printer
Remove rolls from the printer as follows.

Important
• Once a roll has been advanced, do not pull the paper out by force. This will prevent further feeding, and the

printer will be unable to keep track of the amount of roll paper left.
If you accidentally pull out paper, follow these steps to remove the roll, and open the paper feed slot.

Note
• If you need to cut the roll, see "Specifying the Cutting Method for Rolls." →P.797

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the ( Paper tab ) .

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Eject Paper, and then press the OK button.

4. Press ▲ or ▼ to select "Yes", and then press the OK button.
The roll is now rewound and ejected.

Important
• If you have selected ManageRemainRoll > On in the Control Panel menu, a barcode is printed on

the leading edge of the roll.
Do not remove the roll before the barcode is printed. You will be unable to keep track of the amount
of roll paper left.  (See "Keeping Track of the Amount of Roll Paper Left.") →P.794

Handling Paper > Handling rolls >
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5. Open the Roll Feed Unit Cover.

6. Using both hands, rotate the Roll Holder toward the back to rewind the roll.

7. Holding the Roll Holder flange (a), remove the holder from the Roll Holder Slot.

Note
• For instructions on removing rolls from the Roll Holder, see "Removing Rolls From the Roll Hold-

er." →P.792

Handling Paper > Handling rolls >
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8. Close the Roll Feed Unit Cover.

Note
• To load new paper in the printer at this point, see "Loading Rolls in the Printer." →P.784

Removing Rolls From the Roll Holder

1. Remove the Holder Stopper from the Roll Holder.

2. Remove the roll from the Roll Holder.

3. Remove any attachments as follows.

• 3-Inch Paper Core Attachment

Handling Paper > Handling rolls >

Removing Rolls From the Roll Holder iPF6300S

6

792



Spread the tips (b) of the 3-Inch Paper Core Attachment that protrude by the triangular label (a) of the Roll
Holder as shown and remove the 3-Inch Paper Core Attachment.

• Spacer for Borderless Printing
Remove the Spacer for Borderless Printing from the Roll Holder as shown.

Important
• Store the roll in the original bag or box, away from high temperature, humidity, and direct sunlight. If paper

is not stored properly, the printing surface may become scratched, which may affect the printing quality
when you use it again.

Feeding Roll Paper Manually
After a roll has been advanced, you can press the Feed button to feed or retract the roll with the ▲ and ▼ buttons.

Handling Paper > Handling rolls >
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1. Press the Feed button.

2. Press the ▲ or ▼ button to advance or retract the roll.
Press ▲ to retract the roll manually.
Press ▼ to advance the roll manually.

Note
• If you hold down ▲ or ▼ for less than a second, the roll will move about 1 mm (0.04 in).

If you hold down ▲ or ▼ for more than a second, the roll will move until you release the button. Release the
button when the Display Screen indicates "End of paper feed. Cannot feed paper more.".

Keeping Track of the Amount of Roll Paper Left
Setting ManageRemainRoll to On in the Paper Menu of the Control Panel will print a barcode with text on the roll when
the roll is removed that identifies the type of paper and amount left. When ManageRemainRoll is On and you load rolls
with printed barcodes, the type of paper and amount left are automatically detected after rolls are loaded. The barcode will
be cut off after it has been read.

Important
• If the barcode on the roll is not detected, enter the type and length of paper on the Control Panel.

Follow these steps to set ManageRemainRoll to On as follows.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select ManageRemainRoll, and then press the OK button.

4. Press ▲ or ▼ to select On, and then press the OK button.

Handling Paper > Handling rolls >

Keeping Track of the Amount of Roll Paper Left iPF6300S

6

794



Specifying the Ink Drying Time for Rolls
When you are using paper that takes longer for ink to adhere, ink may be transferred onto the paper surface during ejection,
soiling it. In that case, you may be able to improve the condition by setting the time to wait for the ink to dry after printing.

Note
• If the Cutter touches the print surface on which the ink is not dry, the paper surface may become scratched or

soiled, or the paper surface may rub against the output stacker when the paper falls and the surface may be-
come soiled.
To wait for the ink to dry without allowing printed documents to fall after printing, set Cutting Mode on the
menu of the printer to Eject.  (See "Specifying the Cutting Method for Rolls.") →P.797

Windows

1. Display the printer driver dialog box.
 (See "Accessing the Printer Driver Dialog Box from the Operating System Menu (Windows).") →P.213

2. Select the Main sheet and click C Advanced Settings in A Media Type.

Handling Paper > Handling rolls >
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3. In the Paper Detailed Settings dialog box displayed next, select the desired settings values in B Between Pages
and C Between Scans in A Drying Time, and then click OK.
 (See "Paper Detailed Settings Dialog Box (Windows).") →P.220

Mac OS X

1. Choose Print in the application menu.

2. Select the Main pane and click C Settings in A Media Type.

Handling Paper > Handling rolls >
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3. In the Paper Detailed Settings dialog box displayed next, select the desired settings values in C Between Pages
and D Between Scans in B Drying Time, and then click OK.
 (See "Paper Detailed Settings Dialog Box (Mac OS X).") →P.500

Specifying the Cutting Method for Rolls
How rolls are cut after ejection varies depending on printer settings.

Cutting Method Printer Setting Driver Setting

Automatic The roll is automatically cut by the Cutter Unit
following printer driver settings.

Media
Menu >
Paper
Details >
(Various
Types of
Paper) >
Cutting
Mode

Automat-
ic

Auto Cut
 (See
"Cutting
Roll Pa-
per After
Printing.")
→P.196

Yes

Eject
→P.798

Select this to move the cutter by key operation
and cut paper. Although there are cases with
Automatic in which the paper falls and the pa-
per surface is scratched when the paper rubs the
Output Stacker, you can avoid damaging the pa-
per with this method since you can cut by hold-
ing the paper with your hand so that the paper
does not fall when cutting, Also, since you can
cut while visually confirming the drying of the
ink, you can avoid ejecting paper before the ink
has dried.
To cut the roll with the Cutter Unit, press the
Cut button.

Eject Yes

Man-
ual
→P.800

Choose this setting when using media that can-
not be cut using the Cutter Unit.

Manual No Yes Print
Cut Guideline

Handling Paper > Handling rolls >
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Cutting Method Printer Setting Driver Setting
Man-
ual
→P.800

Use scissors to cut each document from the roll
after printing. For continuous printing (if you
will cut each page later), select Auto Cut > Yes
or select Print Cut Guideline.

Media
Menu >
Paper
Details >
(Various
Types of
Paper) >
Cutting
Mode

Auto Cut
 (See
"Cutting
Roll Pa-
per After
Printing.")
→P.196

Manual No Yes Print
Cut Guideline

Paper
Cut-
ting
→P.801

Choose this option if you want to cut pages by
pressing Cutter Unit buttons for manual cutting
after printing when Auto Cut > No is selected
or Print Cut Guideline is selected in the printer
driver.
Otherwise choose this option if you want to cut
the roll edge after loading a roll.

Cut but-
ton press-
ed

Yes No Print Cut
Guideline

Note
• Automatic and Eject are valid only when you have selected Auto Cut > Yes in the printer driver.
• With Eject, printing does not resume after a series of jobs have been printed continuously until the roll is cut.
• Eject is the preset selection in Cutting Mode for some types of paper. For this paper, we recommend keep-

ing the preset cutting mode.
• If documents printed using Automatic, Eject, or manual cutting are short, rolls are advanced a specific

amount before cutting to prevent problems with cutting and paper ejection. This may create a wider bottom
margin, in some cases.

Cut rolls manually in the following cases:

Eject (when the paper surface is being scratched / to wait for ink to dry)

Important
• When cutting wide printed documents after ejection, have two people support the documents. If the paper

drops, printed documents may be damaged.
• Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect the

printing quality or cause rough cut edges.

Handling Paper > Handling rolls >
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1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button. The Paper Menu is displayed.

3. Press ▲ or ▼ to select Paper Details, and then press the OK button.

4. Press ▲ or ▼ to select the type of paper, and then press the OK button.

5. Press ▲ or ▼ to select Cutting Mode, and then press the OK button.

6. Press ▲ or ▼ to select Eject, and then press the OK button.

7. Print the job.
When printing is finished, the printer will stop without cutting.

8. Holding the printed document to prevent it from dropping, press the Cut button to cut the roll.

Handling Paper > Handling rolls >
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Manual (when using media that cannot be cut with the Cutter Unit )

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button. The Paper Menu is displayed.

3. Press ▲ or ▼ to select Paper Details, and then press the OK button.

4. Press ▲ or ▼ to select the type of paper, and then press the OK button.

5. Press ▲ or ▼ to select Cutting Mode, and then press the OK button.

6. Press ▲ or ▼ to select Manual, and then press the OK button.

7. Print the job.
The printer stops advancing the paper after printing.

8. Press the Feed button.

Handling Paper > Handling rolls >

Specifying the Cutting Method for Rolls iPF6300S

6

800



Roll paper is fed to the specified cut position and then automatically stopped.

9. Cut the roll paper manually with scissors or the like.

10. Press the OK button.

After the roll is rewound, it stops automatically.

Paper cutting (to have the roll cut at your specified position)

1. Press the Feed button.

Handling Paper > Handling rolls >
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2. Press the ▼ button to advance the roll to the position for cutting.

3. Press the Cut button.

4. Press ▲ or ▼ to select Yes, and then press the OK button.
After the roll paper is cut, it is rewound automatically.

Cutting the Leading Edge of Roll Paper Automatically
If the leading edge of a roll is crooked or warped, it may cause an error message or printing problems. In this case, set Trim
Edge First to Automatic or On in the Paper Menu on the Control Panel to have the printer cut the leading edge to make
the edge straight after you load a roll.
Trim Edge First offers the following options.

• Automatic
If the left and right side of the leading edge of the roll ((a) and (b)) are uneven by 3 mm (0.12 in) or more when you
load the roll, the edge is cut an amount relative to the slant to ensure a straight edge, and scraps are removed. The edge
is not cut if the unevenness is less than 3 mm. However, paper may sometimes be cut, depending on the state of the
leading edge.

• Off
The edge is not cut and scraps are not removed. This setting is Off for most types of paper, by default. For more infor-
mation, see the Paper Reference Guide.  (See "Types of Paper.") →P.773

Handling Paper > Handling rolls >
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• On
The leading edge is cut off when you load a roll, and scraps are removed. The amount of paper cut from the leading
edge varies depending on the type of paper. For more information, see the Paper Reference Guide.  (See "Types of
Paper.") →P.773

Important
• If the width of the paper differs, setting Skew Check Lv. to Loose relaxes the accuracy of the paper skew

detection feature, and setting it to Off ignores the skew detection feature. However, when Off is selected and
the paper is loaded skewed, a paper jam may result or the Platen may become soiled.

Note
• In the condition at the time of factory shipment, the setting differs depending on the paper. For details, refer

to the Paper Reference Guide.  (See "Types of Paper.") →P.773

Follow these steps to change the Trim Edge First setting.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Paper Details, and then press the OK button.

4. Press ▲ or ▼ to select the type of paper, and then press the OK button.

5. Press ▲ or ▼ to select Trim Edge First, and then press the OK button.

6. Press ▲ or ▼ to select the desired setting option, and then press the OK button.
This setting takes effect the next time you load a roll.

Handling Paper > Handling rolls >
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Reducing Dust from Cutting Rolls
For media such as Backlit Film that are more likely to generate debris when cut, select CutDustReduct. > On in the Paper
Menu of the Control Panel. This option reduces debris from cutting by printing black lines at the leading and trailing edges
of documents. It may help prevent Printhead damage. You can specify for CutDustReduct. to be activated for particular
types of paper.

Important
• Do not set CutDustReduct. to On for paper that wrinkles easily, such as Plain Paper or lightweight paper.

This may impair cutting and cause paper jams.
• Borderless printing is not available when CutDustReduct. is set to On. To use borderless printing, select

CutDustReduct. > Off.

Set CutDustReduct. to On as follows.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Paper Details, and then press the OK button.

4. Press ▲ or ▼ to select the type of paper loaded in the printer, and then press the OK button.

5. Press ▲ or ▼ to select CutDustReduct., and then press the OK button.

6. Press ▲ or ▼ to select On, and then press the OK button.

Handling Paper > Handling rolls >
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Roll Holder Set
Load a roll on the roll holder and then load the holder in the printer. The Roll Holder in the Roll Holder Set RH2-25 is for
use with both 2-inch and 3-inch paper cores. Use the correct attachment for the particular paper core. For borderless printing
on A1 (594 mm) or A2 (420 mm) rolls, attach the included Spacer for Borderless Printing to the Roll Holder.  (See "Load-
ing Rolls on the Roll Holder.") →P.781

• Roll Holder Set RH2-25

• Roll Holder (for 2- and 3-inch paper cores)

• Attachments

Using Rolls with a 2-inch Paper Core Using Rolls with a 3-inch Paper Core

Holder Stopper (for 2-inch paper cores) Holder Stopper (for 3-inch paper cores) 3-Inch Paper Core Attachment

• Borderless Printing on A1 or A2 Rolls
Spacer for Borderless Printing

Removing the Roll Feed Unit

Important
• Always turn off the printer before removing the Roll Feed Unit. The printer may be damaged if you do not

turn it off first.

1. Remove the roll from the Roll Feed Unit.  (See "Removing the Roll from the Printer.") →P.790

Handling Paper > Handling rolls >
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2. Use a coin or screwdriver to loosen the screws (a) on both sides of the back of the Roll Feed Unit, and remove the
screws.

3. Holding the Carrying Handles (a) of the Roll Feed Unit, remove the Roll Feed Unit from the printer.

Installing the Roll Feed Unit

Important
• Always turn off the printer before attaching the Roll Feed Unit. The printer may be damaged if you do not

turn it off first.

Handling Paper > Handling rolls >
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1. Holding the Roll Feed Unit by the Carrying Handles (a), insert the two pins of the Roll Feed Unit (b) into the each
hole on the back of the printer (c).

Handling Paper > Handling rolls >
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2. Use a coin or screwdriver to tighten the two screws on the back of the Roll Feed Unit (a) to secure it to the printer.

Handling Paper > Handling rolls >
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Handling sheets
Loading Sheets in the Feed Slot ..................................................................................................................... 809
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Loading Sheets in the Feed Slot
When printing on individual sheets, load the sheet in the Top Paper Feed Slot. However, for heavyweight paper such as
POP board, load the sheet in the Front Paper Feed Slot.

Selecting the Paper Source and Type of Paper

• If a print job was received
Sheets are automatically selected, and the media type and size specified by the print job are shown on the Display
Screen.

1. Press ▲ or ▼ to select Load Paper, and then press the OK button.

2. Load the sheet in the Top Paper Feed Slot or Front Paper Feed Slot, depending on the type of paper specified by the
print job.

• If a type of paper other than POP Board is selected
Loading Sheets in the Top Paper Feed Slot →P.810

• If POP Board is selected
Loading Heavyweight Sheets in the Front Paper Feed Slot →P.812

• If no print job was received

1. Press the Load button.

2. Press ▲ or ▼ to select Manual Paper, and then press the OK button.

Note
• If any paper has been advanced that will not be used, a message is shown requesting you to remove it.

Press ▲ or ▼ to select "Yes", and then press the OK button. Remove the paper and go to the next
step.
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3. Press ▲ or ▼ to select the type of paper, and then press the OK button.
When printing on heavyweight paper, select POP Board and load the sheet in the Front Paper Feed Slot.  (See
"Loading Heavyweight Sheets in the Front Paper Feed Slot .") →P.812
When printing on other types of paper, select the type of paper and load the sheet in the Top Paper Feed Slot.  (See
"Loading Sheets in the Top Paper Feed Slot .") →P.810

Note
• For details on types of paper to select, see the Paper Reference Guide.  (See "Types of Paper.")

→P.773

Loading Sheets in the Top Paper Feed Slot

Important
• One sheet of paper can be loaded at a time. Do not load multiple sheets. This may cause paper jams.
• Before feeding paper or printing, make sure the sheet is flat against the Paper Tray Cover. The sheet may jam

if it curls before feeding or printing and the trailing edge drops toward the front.
• Paper that is wrinkled or warped may jam. If necessary, straighten the paper and reload it.
• Load the paper straight. Loading paper askew will cause an error.

Note
• Store unused paper in the original package, away from high temperature, humidity, and direct sunlight.

1. Open the Paper Tray Cover (a), and then open the Tray Extension (b).
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2. Slide the Width Guide (a) to align it with the mark for the size of paper you will load.

3. Load one sheet, printing-side up, in the Top Paper Feed Slot.
Insert the paper until it touches the far end of the tray lightly.

Important
• If you load a sheet larger than A2, the sheet may fall behind the printer under its own weight. Put

your hand under the sheet to support it and prevent it from falling.
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4. Move the Width Guide (a) to match the size of paper loaded.
Set the Width Guide against the edge of the paper to prevent the paper from becoming crooked or wrinkled.

5. Press the OK button.

• If a print job was received
After the paper is advanced, the printer starts printing the print job.

• If no print job was received
The printer now starts feeding the paper.

Loading Heavyweight Sheets in the Front Paper Feed Slot

Important
• Always load POP Board in the Front Paper Feed Slot for printing. Loading it in other ways may impair op-

eration and damage the printer.
• One sheet of paper can be loaded at a time. Do not load multiple sheets. This may cause paper jams.
• Straighten paper if it is warped before loading it.
• Load the paper straight. Loading paper askew will cause an error.
• Once you load the paper, you cannot shift it sideways. Load the paper straight.

Note
• Store unused paper in the original package, away from high temperature, humidity, and direct sunlight.
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1. If the message "Leave 70cm (28") space behind printer." is displayed, check the space behind the printer, pull up
the four Front Tray Guides above the Ejection Guide, and press the OK button.

Note
• Sufficient space behind the printer is required when loading paper in the Front Paper Feed Slot. For

details on the installation space required, see "Specifications." →P.1078

2. After "Open Upper Cover" is displayed, open the Top Cover.

3. Set the leading edge of one sheet, printing-side up, on the Front Tray Guides, and insert the sheet in the Front Paper
Feed Slot, keeping it level.

Important
• When you insert the sheet in the Front Paper Feed Slot, keep the sheet level, relative to the paper feed

slot. Failure to do this may scratch the printing surface.
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4. As you look inside the Top Cover, insert the leading edge of the sheet between the Platen and Paper Retainer (a),
keeping it parallel to the Paper Retainer (a), and align the paper with the Paper Alignment Line (b) of the Front Tray
Guides.
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Important
• Do not touch the Linear Scale (a) or Carriage Shaft (b). This may stain your hands and damage the

printer.

5. When "Close top cover." is displayed, close the Top Cover and press the OK button.

The sheet is held between the Platen and Back Cover, and feeding begins.

• If a print job was received
After the paper is advanced, the printer starts printing the print job.

• If no print job was received
The printer now starts feeding the paper.

6. After printing, the printer will temporarily stop advancing the paper while the trailing edge is still in the rollers to
prevent the sheet from dropping.
Once you press the OK button, the paper can be removed.
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7. Remove the sheet, keeping the front edge level as you pull it out.

Important
• If POP Board is accidentally removed at an angle, it may scratch the printed surface.

8. Press the OK button.

9. Lift the four Front Tray Guides above the Ejection Guide, store them toward the front, and then press the OK button.

Removing Sheets
Remove sheets from the printer as follows.

• Removing sheets from the top paper feed slot →P.818

• Removing heavyweight sheets from the front paper feed slot →P.818
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Removing sheets from the top paper feed slot

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Eject Paper, and then press the OK button.

4. Press ▲ or ▼ to select "Yes", and then press the OK button.
The paper is ejected from the front of the printer.

Important
• If the trailing edge of a sheet is not ejected, pull the sheet out, keeping the front edge level. Acciden-

tally removing the sheet at an angle may scratch the printed surface.

Removing heavyweight sheets from the front paper feed slot

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Eject Paper, and then press the OK button.

4. Press ▲ or ▼ to select "Yes", and then press the OK button.
As the printer ejects the paper, the paper is stopped momentarily with the trailing edge still held in the rollers.

5. Press the OK button.
The sheet can now be removed.
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6. Remove the sheet, keeping the front edge level as you pull it out.

Important
• If POP Board is accidentally removed at an angle, it may scratch the printed surface.

7. Press the OK button.

Important
• Always remove the sheet before pressing the OK button. If you do not remove the sheet before step

7, it may go back inside the printer, leaving roller marks across the trailing edge of paper.

8. Lift the four Front Tray Guides above the Ejection Guide, store them toward the front, and then press the OK button.
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Output Stacker
Output Stacker Precautions ............................................................................................................................ 820
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Output Stacker Precautions
Documents can be stored in the Output Stacker after printing from rolls.
To use the Output Stacker, push down Basket Rod #1 (b) fully toward the front, keeping it even on the left and right so that
Basket Rod #2 (a) is not slanted.

The Output Stacker can hold one sheet. When printing multiple pages, remove each sheet after it is printed.
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Use the Output Stacker in the regular position (a). The stacker may also be used in the extended position (b) for some types
of paper. The extended position enables easy removal after printing. For information on types of paper you can use with the
stacker in extended position, refer to the Paper Reference Guide.  (See "Types of Paper.") →P.773

Using the Output Stacker
This topic describes how to use the Output Stacker.
Use the Output Stacker in position (1) when storing printed documents.
When the Output Stacker is not used, fold the stacker to stow it in position (2).
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Important
• When storing printed documents on the Output Stacker, always use it in position (1). If you do not, printed

documents may not be dropped into the Output Stacker, and the printed surface may become soiled.
• The Output Stacker can hold one sheet. When printing multiple pages, remove each sheet after it is printed.

Use the Output Stacker in the regular position (a).
The stacker may also be used in the extended position (b) for some types of paper. To switch to the extended position, move
the Support Rod to position (b). The extended position enables easy removal after printing.
For information on types of paper you can use with the stacker in extended position, refer to the Paper Reference Guide.
 (See "Types of Paper.") →P.773
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Adjustment for high-precision printing
Enhancing Printing Quality .............................................................................................................................. 825

Enhancing Printing Quality
With some types of paper and under some conditions, adjusting the printer as follows with the paper to be used can enhance
printing quality when printing fine lines/text or photos.
Two adjustment options are available: standard adjustment (with the Printhead height set to Automatic ) and supplemental
adjustment (used if standard adjustment is not effective).

Important
• Ideal temperature and humidity during adjustment and for printing in general when the Printhead height is set

to Automatic are 20–30ºC and 30–60%. Under other environmental conditions, adjustment may not enhance
printing quality.

Note
• Paper used for adjustment must conform to the following specifications.

Type: Glossy or semi-glossy photo paper, or proofing paper (in either case, roll paper only)
Thickness/weight: 300 μm or less, or 300 g/m² or less
Width: 25.4 cm (10 in.) or more

Standard Adjustment
Perform standard adjustment with the Printhead height set to Automatic.

1. Load paper in the printer.

• Loading Rolls on the Roll Holder →P.781

• Loading Rolls in the Printer →P.784

2. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• Auto(Expansion) may be unavailable in some cases, even if it is displayed in the menu.

If so, execute Auto(Advanced) once.
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5. Press ▲ or ▼ to select Head Posi. Adj., and then press the OK button.

6. Press ▲ or ▼ to select Auto(Expansion), and then press the OK button.

A test pattern is printed for adjustment. This process will take about 11 minutes.
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Note
• If standard adjustment does not enhance printing quality, next try supplemental adjustment, which may be

helpful.

Supplemental Adjustment
Perform supplemental adjustment with the Printhead height set to Super Low.

Important
• Printing with Head Height set to Super Low may enhance printing quality, but it may also cause paper to

rub against or become caught on the Printhead, which may cause paper jams or soiling on printed documents.

1. Set Head Height to Super Low.  (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.831

Note
• If Super Low is not available, select Lowest.

2. In Head Posi. Adj., select Auto(Expansion).

Note
• If paper rubs against the Printhead or becomes jammed during Printhead height adjustment, try select-

ing a higher level in Head Height and performing Auto(Expansion) again.
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Adjusting the Printhead
Adjusting the Printhead ................................................................................................................................... 827

Automatic Adjustment to Straighten Lines and Colors (Head Posi. Adj.) .................................................... 827
Manual Adjustment to Straighten Lines and Colors (Head Posi. Adj.) ........................................................ 829

 

Troubleshooting Paper Abrasion and Blurry Images (Head Height) ............................................................... 831

Adjusting the Printhead
If printed documents are affected by the following problems, try adjusting the printhead.

• Printing is faint or affected by banding in different colors
Execute Nozzle Check to check for printhead nozzle clogging.
For instructions, see "Checking for Nozzle Clogging." →P.980

• Printed vertical lines are warped or colors are out of alignment
Execute Head Posi. Adj. to adjust the printhead position.
Normally, execute Auto(Standard), Auto(Advanced), or Auto(Expansion). However, when using special paper or if
printing is not improved after executing Auto(Advanced), try Manual.
 (See "Automatic Adjustment to Straighten Lines and Colors (Head Posi. Adj.).") →P.827
 (See "Manual Adjustment to Straighten Lines and Colors (Head Posi. Adj.).") →P.829

• Paper rubs against the printhead, or image edges are blurred
Executing Head Height to adjust the printhead height may improve printing results.
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).") →P.831

Automatic Adjustment to Straighten Lines and Colors (Head Posi. Adj.)
If vertical lines in printed documents are warped or colors are out of alignment, execute Head Posi. Adj.. The printer will
print and read a test pattern, and the Printhead position will be adjusted automatically.
There are three modes for automatic Printhead adjustment: Auto(Standard), Auto(Advanced) and Auto(Expansion).

• Auto(Standard)
Fixes slight distortion and color misalignment.

• Auto(Advanced)
Try adjustment in this mode if Auto(Standard) does not improve printing.

• Auto(Expansion)
Try adjustment in this mode if vertical lines are warped or colors are out of alignment when the printer driver option
Print Priority is set to Proof.
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Important
• This function is not available with CAD Tracing Paper or CAD Translucent Matte Film.

If adjustment is not possible as expected using highly transparent film or similar media, try another type of
paper, or try Manual adjustment.
 (See "Manual Adjustment to Straighten Lines and Colors (Head Posi. Adj.).") →P.829

Note
• Because the results of adjustment vary depending on the type of paper used for adjustment, use the same type

of paper as you will use for printing. Even if you will print on a different type of paper, we recommend using
Auto(Advanced) for adjustment.

• If Auto(Advanced) does not improve printing, try adjustment in Manual mode.
 (See "Manual Adjustment to Straighten Lines and Colors (Head Posi. Adj.).") →P.829

• Advanced adjustment can enable superior printing quality when printing fine lines or text at high precision
on glossy or semi-glossy photo or proofing paper.
 (See "Enhancing Printing Quality.") →P.825

Items to Prepare
When Using Rolls An unused roll at least 10 inches wide

When Using Sheets Auto(Standard) : Two sheets of unused paper, A4/Letter size
Auto(Advanced) : Ten sheets of unused paper, A4/Letter size (or five sheets when using A2)
Auto(Expansion) : Seven sheets of unused paper, A4/Letter size (or four sheets when using A2)

Perform adjustment as follows.

1. Load paper.

• Loading Rolls on the Roll Holder →P.781

• Loading Rolls in the Printer →P.784

• Loading Sheets in the Feed Slot →P.809

Important
• Always make sure the loaded paper matches the type of paper specified on the printer. Adjustment

cannot be completed correctly unless the loaded paper matches the settings.

2. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.
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5. Press ▲ or ▼ to select Head Posi. Adj., and then press the OK button.

6. Press ▲ or ▼ to select Auto(Standard), Auto(Advanced), or Auto(Expansion), and then press the OK button.
A test pattern is printed for adjustment.
Adjustment is now finished if you have printed on a roll.

Note
• Auto(Expansion) may be unavailable in some cases, even if it is displayed in the menu.

If so, execute Auto(Advanced) once.

7. If you are printing on sheets, a confirmation message is displayed requesting you to continue printing. Press the OK
button and follow the instructions displayed.

Manual Adjustment to Straighten Lines and Colors (Head Posi. Adj.)
If printed vertical lines are warped or colors are out of alignment, execute Head Posi. Adj. to adjust the Printhead align-
ment.
Normally, execute Auto(Standard), Auto(Advanced), or Auto(Expansion).
 (See "Automatic Adjustment to Straighten Lines and Colors (Head Posi. Adj.).") →P.827
However, when printing on special paper, or if printing is not improved after Auto(Advanced), try Manual.
Manual adjustment requires you to examine the printed test pattern and enter an adjustment value.

Note
• We recommend using the type of paper you use most often for adjustment.

Items to Prepare
When Using Rolls An unused roll at least 10 inches wide

When Using Sheets Two sheets of unused paper, A4/Letter size (or one sheet when using A2)

Perform adjustment as follows.

1. Load the paper.

• Loading Rolls on the Roll Holder →P.781

• Loading Rolls in the Printer →P.784

• Loading Sheets in the Feed Slot →P.809

Important
• Always make sure the loaded paper matches the type of paper specified on the printer. Adjust-

ment cannot be completed correctly unless the loaded paper matches the settings.
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2. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5. Press ▲ or ▼ to select Head Posi. Adj., and then press the OK button.

6. Press ▲ or ▼ to select Manual, and then press the OK button.
A test pattern is printed for adjustment.

Note
• Manual may be unavailable in some cases, even if it is displayed in the menu.

If so, execute Auto(Advanced) once.

7. Press ▲ or ▼ to select D, and then press the OK button.

8. Press ▲ or ▼ to select D-1, and then press the OK button.

9. Examine adjustment test pattern D-1 and determine the number with straight lines.

Note
• If two patterns seem equally good and you cannot decide which one is better, choose an intermediate

value.
For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.
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10. Press ▲ or ▼ to select the pattern number you have decided, and then press the OK button.

11. Repeat steps 8–10 to specify the adjustment value for D-1 to D-8, D-10 to D-12, D-25 to D-32, and D-34 to D-36.

12. Press the Back button.

13. Press ▲ or ▼ to select Register Setting, and then press the OK button.

14. Press ▲ or ▼ to select Yes, and then press the OK button.
The adjustment value is now registered, and adjustment is complete.

Troubleshooting Paper Abrasion and Blurry Images (Head Height)
The Printhead height setting affects printing quality.
Specifying a low Printhead height makes images clearer and enhances printing quality but may cause paper to rub against
the Printhead.
On the other hand, specifying a high Printhead height will prevent paper from rubbing against the Printhead but may reduce
the printing quality.

Important
• Paper rubbing against or becoming caught on the Printhead may jam or result in printed documents that are

soiled.

Note
• Raise or lower the printhead, depending on the nature of the problem.

 (See "Paper rubs against the printhead.") →P.1027
 (See "The edges of the paper are dirty.") →P.1028
 (See "Image edges are blurred or white banding occurs.") →P.1032

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Paper Details, and then press the OK button.
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4. Press ▲ or ▼ to select the type of paper, and then press the OK button.

Note
• When Head Height is set to Automatic, the setting value selected for the previous print job is dis-

played (to the right of Automatic ) once you select the type of paper currently supplied.
However, the value is cleared when the printer is turned off or the paper is replaced.

5. Press ▲ or ▼ to select Head Height, and then press the OK button.

6. Press ▲ or ▼ to select the desired setting value, and then press the OK button.

Note
• Using Automatic will ensure that the printer adjusts the Printhead height to the optimal level before

printing, accounting for the ambient temperature and humidity. When a setting other than Automatic
is used, that value will always be applied.

• Depending on the type of paper, some setting values may not be available.
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Adjusting the Feed Amount
If printed documents are affected by the following problems, try adjusting the feed amount.

• Banding in different colors
• Line length is not accurate in the direction paper is fed

To adjust the feed amount, do the following, in this order.

1. Depending on the issue, adjust Adj. Priority to suit the particular type of paper.
 (See "Selecting a Feed Amount Adjustment Method (Feed Priority).") →P.833

2. Execute Adj. Quality or Adjust Length, depending on the selection in Adj. Priority.
 (See "Automatic Banding Adjustment (Adj. Quality).") →P.834
 (See "Manual Banding Adjustment (Adj. Quality).") →P.836
 (See "Adjusting Line Length (Adjust Length).") →P.838

3. After executing Adj. Quality, execute Adj. Fine Feed for further adjustment as needed.
 (See "Fine-Tuning the Paper Feed Amount (Adj. Fine Feed).") →P.838

Selecting a Feed Amount Adjustment Method (Feed Priority)
Methods of adjusting the amount paper is fed are set in Adj. Priority.
Adjust Adj. Priority to suit your particular printing application.

• Print Quality : Adjusts the feed amount to reduce banding across the sheet in printed documents.
Adj. Quality settings are applied. When Adj. Fine Feed is executed, the Adj. Fine Feed settings are applied in addi-
tion to the Adj. Quality settings.

• Print Length : Adjusts the feed amount for better accuracy of lines in printed documents.
The settings of A:High or B:Standard/Draft in Adjust Length are applied.

• Automatic : Print Quality or Print Length is selected, depending on Print Priority as selected in the printer driver at
the time of printing.
Image or Office Document : Print Quality is selected.
Line Drawing/Text : Print Length is selected.
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Note
• Either A:High or B:Standard/Draft in the Adjust Length menu is applied, depending on printer driver set-

tings at the time of printing.
• If you have selected Easy Settings in the printer driver, follow these steps to confirm the Print Priority

setting.

• Windows: Click View Settings on the Main tab to display the View Settings dialog box.
• Mac OS X: Click View set. on the Main pane to display the View settings dialog box.

Follow these steps to configure the settings.

1. Load the paper.

• Loading Rolls on the Roll Holder →P.781

• Loading Rolls in the Printer →P.784

• Loading Sheets in the Feed Slot →P.809

2. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5. Press ▲ or ▼ to select Feed Priority, and then press the OK button.

6. Press ▲ or ▼ to select Adj. Priority, and then press the OK button.

7. Press ▲ or ▼ to select Automatic, Print Quality, or Print Length, and then press the OK button.

Automatic Banding Adjustment (Adj. Quality)
If printed images are affected by banding in different colors across the sheet, execute Adj. Quality for automatic adjustment
of the paper feed amount.
There are two modes of automatic adjustment to correct banding: Auto(GenuinePpr) and Auto(OtherPaper). In either
mode, the printer prints and reads a test pattern for automatic adjustment of the feed amount.

• Auto(GenuinePpr)
Use this mode with paper identified in the Paper Reference Guide.
 (See "Types of Paper.") →P.773
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• Auto(OtherPaper)
Use this mode with paper not in the Paper Reference Guide, or if Auto(GenuinePpr) does not eliminate banding.
 (See "Types of Paper.") →P.773

Important
• Adjustment is not possible with Auto(GenuinePpr) and Auto(OtherPaper) when using highly transparent

media.
In this case, use Manual adjustment.
 (See "Manual Banding Adjustment (Adj. Quality).") →P.836

Note
• Use paper of the same type and size for adjustment as you will use for printing.
• Always check the Adj. Priority values before using Auto(GenuinePpr) or Auto(OtherPaper).

 (See "Selecting a Feed Amount Adjustment Method (Feed Priority).") →P.833

• If additional fine-tuning is necessary after Auto(GenuinePpr) and Auto(OtherPaper), execute Adj. Fine
Feed.
 (See "Fine-Tuning the Paper Feed Amount (Adj. Fine Feed).") →P.838

• Use Adjust Length to ensure that lines in CAD drawings are printed at exactly the right length.
 (See "Adjusting Line Length (Adjust Length).") →P.838

• This may take some time, depending on the type of paper.

Items to Prepare
When Using Rolls An unused roll at least 10 inches wide

When Using Sheets Auto(GenuinePpr) : One sheet of unused paper, A4/Letter size
Auto(OtherPaper) : Two sheets of unused paper, A4/Letter size (or one sheet when using A2)

Perform adjustment as follows.

1. Load the paper.

• Loading Rolls on the Roll Holder →P.781

• Loading Rolls in the Printer →P.784

• Loading Sheets in the Feed Slot →P.809

Important
• Always make sure the loaded paper matches the type of paper specified in the settings. Adjustment

cannot be completed correctly unless the loaded paper matches the settings.

2. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.
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3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5. Press ▲ or ▼ to select Feed Priority, and then press the OK button.

6. Press ▲ or ▼ to select Adj. Quality, and then press the OK button.

7. Press ▲ or ▼ to select Auto(GenuinePpr) or Auto(OtherPaper), and then press the OK button.
A test pattern is printed for adjustment.
Adjustment is now finished if you have printed on a roll or a sheet of A2 size or larger.

8. If you are printing on sheets smaller than A2 size for Auto(OtherPaper), a confirmation message is shown on the
Display Screen requesting you to continue printing.
Press the OK button and follow the instructions on the Display Screen.

Manual Banding Adjustment (Adj. Quality)
If printed images are affected by banding in different colors, execute Adj. Quality for adjustment of the paper feed amount.
Use Manual adjustment with highly transparent media or other paper for which Auto(GenuinePpr) or Auto(OtherPaper)
cannot be used.
 (See "Automatic Banding Adjustment (Adj. Quality).") →P.834
Manual adjustment requires you to enter an adjustment value after a test pattern is printed.

Note
• Use paper of the same type and size for adjustment as you will use for printing.
• Always check the Adj. Priority values before using Manual adjustment.

 (See "Selecting a Feed Amount Adjustment Method (Feed Priority).") →P.833

• If additional fine-tuning is necessary after Manual adjustment, use Adj. Fine Feed
 (See "Fine-Tuning the Paper Feed Amount (Adj. Fine Feed).") →P.838

• Use Adjust Length to ensure that lines in CAD drawings are printed at exactly the right length.
 (See "Adjusting Line Length (Adjust Length).") →P.838

Paper to Prepare
When Using Rolls An unused roll at least 10 inches wide

When Using Sheets Two sheets of unused paper of at least A4/Letter size

Perform adjustment as follows.

1. Load the paper.

• Loading Rolls on the Roll Holder →P.781

• Loading Rolls in the Printer →P.784

• Loading Sheets in the Feed Slot →P.809

Important
• Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be com-

pleted correctly unless the loaded paper matches the settings.
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2. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5. Press ▲ or ▼ to select Feed Priority, and then press the OK button.

6. Press ▲ or ▼ to select Adj. Quality, and then press the OK button.

7. Press ▲ or ▼ to select Manual, and then press the OK button.
Test pattern A is printed for manual adjustment.

Note
• When printing on sheets, follow the instructions on the Display Screen and remove the sheet.

8. Examine test pattern A for adjustment. Determine the pattern in which banding is least noticeable.

Note
• If banding seems least noticeable in two patterns but you cannot decide which one is better, choose an

intermediate value.
For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.

9. Press ▲ or ▼ to select the pattern number you have decided, and then press the OK button.
Test pattern B is printed for adjustment.

Note
• If you printed test pattern A on a sheet, follow the instructions on the Display Screen and use another

sheet of the same type of paper.
Additionally, after test pattern B is printed, follow the instructions on the Display Screen and remove
the sheet.
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10. Examine test pattern B for adjustment. Determine the pattern in which banding is least noticeable.

11. Press ▲ or ▼ to select the pattern number you have decided, and then press the OK button.
The adjustment value is now registered, and adjustment is complete.

Fine-Tuning the Paper Feed Amount (Adj. Fine Feed)
If the contrast is uneven or banding in different colors appears at 50 mm (2.0 in) intervals in printed documents, try execut-
ing Adj. Fine Feed during printing to fine-tune the feed amount.

Note
• Always execute Adj. Quality before Adj. Fine Feed.

Once you execute Adj. Quality, the Adj. Fine Feed value will revert to 0.
 (See "Automatic Banding Adjustment (Adj. Quality).") →P.834
 (See "Manual Banding Adjustment (Adj. Quality).") →P.836

Perform adjustment as follows.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Adj. Fine Feed, and then press the OK button.

4. Press ▲ or ▼ to select a setting value in the range -5 to +5, and then press the OK button.
The setting is now applied.

Adjusting Line Length (Adjust Length)
To ensure that lines in CAD drawings are printed at exactly the right length, use Adjust Length to adjust the amount that
paper is advanced.
There are two options in Adjust Length : AdjustmentPrint and Change Settings.

• AdjustmentPrint
After a test pattern is printed, you will measure the discrepancy based on the results of printing.

• Change Settings
No test pattern is printed. Instead, you will measure a document already printed to determine the discrepancy.
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Additionally, two modes are available in both AdjustmentPrint and Change Settings : A:High or B:Standard/Draft.
Choose the mode that suits your particular printing application.

• A:High
This setting is applied when Highest quality or High is selected in Print Quality in the printer driver.

• B:Standard/Draft
This setting is applied when Standard or Fast is selected in Print Quality in the printer driver.

Note
• Always check the Adj. Priority values before using Adjust Length.  (See "Selecting a Feed Amount Ad-

justment Method (Feed Priority).") →P.833

• Use paper of the same type and size for adjustment as you will use for printing.

Paper to Prepare
When Using Rolls • An unused roll at least 10 inches wide

• High-precision ruler

When Using Sheets • One sheet of unused paper of at least A4/Letter size

• High-precision ruler

Perform adjustment as follows.

1. Load the paper.

• Loading Rolls on the Roll Holder →P.781

• Loading Rolls in the Printer →P.784

• Loading Sheets in the Feed Slot →P.809

Important
• Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be com-

pleted correctly unless the loaded paper matches the settings.

2. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5. Press ▲ or ▼ to select Feed Priority, and then press the OK button.
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6. Press ▲ or ▼ to select Adjust Length, and then press the OK button.

7. Press ▲ or ▼ to select AdjustmentPrint or Change Settings, and then press the OK button.
When you select AdjustmentPrint, a test pattern is printed for you to measure the scale and calculate the discrepan-
cy. The scale bar shows Millimeter in 50 mm units and Inch in 1 inch units.

Note
• A test pattern is printed in black when you choose A:High or in magenta if you choose B:Standard/

Draft.
• To cancel printing the test pattern for adjustment, hold down the Stop button. When "Stop print-

ing?" is displayed, press ▲ or ▼ to select "Yes", and then press the OK button.

8. Press ▲ or ▼ to enter the amount of discrepancy, and then press the OK button.
If the scale is shorter than the actual size, use a positive setting value. If it is longer, use a negative value.
The feed amount can be adjusted in 0.02% increments.

Adjusting Color on the Trailing Edge of Sheets
If printed sheets are affected by banding in different colors by the trailing edge (about 20–30 mm (0.8–1.2 in) from the
edge), try adjusting the feed amount of the trailing edge of sheets.

Important
• This adjustment is only possible when feeding paper from the Top Paper Feed Slot that can be set up with a

margin on the trailing edge of 3 mm (0.12 in). Paper that does not allow a margin of 3 mm on the trailing
edge is automatically ejected, and the adjustment is not available.

Note
• We recommend using the type of paper you use most often for adjustment.
• For banding in different colors over the entire printed area of sheets or rolls (not only at the trailing edge of

sheets), try adjusting the overall feed amount.  (See "Automatic Banding Adjustment (Adj. Quality).")
→P.834

Items to Prepare
Sheets One sheet of unused paper of at least A4/Letter size

Perform adjustment as follows.

1. Load the paper.

• Loading Sheets in the Feed Slot →P.809
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Important
• Always make sure the loaded paper matches the type of paper specified in the settings. Adjustment

cannot be completed correctly unless the loaded paper matches the settings.

2. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5. Press ▲ or ▼ to select Adj Far Ed Feed, and then press the OK button.

6. Press ▲ or ▼ to select Yes, and then press the OK button.
A test pattern is printed for adjustment.

C1 is displayed on the Control Panel.

7. Examine test pattern C1. Determine the pattern in which banding is least noticeable. Press ▲ or ▼ to select this
pattern number, and then press the OK button.
C2 is displayed on the Control Panel.
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8. Examine test pattern C2. Again, determine the pattern in which banding is least noticeable. Press ▲ or ▼ to select
this pattern number, and then press the OK button.
The adjustment value is now registered, and adjustment is complete.

Note
• If streaks seem least noticeable in two patterns but you cannot decide which one is better, choose an

intermediate value. For example, choose 17 if you cannot decide whether pattern 16 or 18 is better.

Adjusting the Vacuum Strength (VacuumStrngth)
When printing on heavyweight paper or paper that curls or wrinkles easily, if the Printhead rubs against paper, adjusting the
level of suction against paper on the Platen may improve results.

Important
• Paper rubbing against or becoming caught on the Printhead may jam or result in printed documents that are

soiled.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Paper Details, and then press the OK button.
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4. Press ▲ or ▼ to select the type of paper, and then press the OK button.

Note
• When VacuumStrngth is set to Automatic, the setting value selected for the previous print job is

displayed (to the right of Automatic ) once you select the type of paper currently supplied.
However, the value is cleared when the printer is turned off or the paper is replaced.

5. Press ▲ or ▼ to select VacuumStrngth, and then press the OK button.

6. Press ▲ or ▼ to select the desired setting value, and then press the OK button.
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Using Color Calibration for Color Adjustment

What is Color Calibration?
Color calibration improves color consistency by compensating for slight differences in how color appears when printing due
to individual variations or aging among the printers.
Executing color calibration will print a test pattern, which will be read automatically by a sensor built in the printer.
By this operation, an adjustment value reflecting the print result of the test pattern is set automatically.

Important
• For better color consistency, execute color calibration under the same conditions of temperature and humidi-

ty each time.
If you execute color calibration under various conditions of temperature and humidity, correct adjustment
may not be possible.

• If you execute color calibration with paper classified for common calibration, continue to use the same type
of paper for better color consistency.
If you execute color calibration with multiple paper types, correct adjustment may not be possible.

• Before color calibration, ensure the printer is not exposed to direct sunlight or other strong sources of light.
If the printer is exposed to strong sources of light, correct adjustment may not be possible.

Recommend Timing for Color Calibration
We recommend color calibration in the following situations.

• After initial printer installation
• After Printhead replacement
• If colors seem different from before, despite using the same printing environment, under the same conditions
• To ensure uniform colors when printing on multiple printers (however, be sure to use the same version of firmware and

printer driver, under the same settings)
• When the Execution Guide is displayed (Specifying Execution Guide →P.847 )

Note
• You can confirm information of color calibration such as the execution date and executed paper type by the

following method.
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Confirm it on the Control Panel of
the printer.

From Set./Adj. Menu, select Adjust Printer > Calibration > Cal-
ibration Log.
 (See "Menu Settings.") →P.914

Print information about the printer. From Set./Adj. Menu, select Test Print > Status Print.
 (See "Status Print.") →P.926

Confirm with imagePROGRAF
Status Monitor. (Windows)

On the Information sheet of imagePROGRAF Status Monitor,
click the View Calibration Log button.
 (See "The Features of imagePROGRAF Status Monitor.")
→P.425

Confirm this in the Printer Infor-
mation dialog box of the printer
driver. (Mac OS X)

In the Printer Information dialog box, click the Information tab,
and click the View Calibration Log button.
 (See "Main Pane (Mac OS X).") →P.494

Adjustment Types of Color Calibration
Two types of color calibration are available: common calibration and unique calibration.
The adjustment type in which calibration is to be classified is decided in advance according to the paper type for which
calibration is to be executed. To confirm the adjustment type in which calibration is to be classified, refer to Paper that can
be used in Color Calibration →P.848 .

• Common calibration
If you execute color calibration with paper classified for common calibration, the color calibration adjustment value is
set for all print qualities of all paper types (including paper types for which color calibration cannot be executed).
If executing color calibration per paper type is unnecessary, you can operate calibration easily in a short time.
For better color consistency, continue to use the same type of paper in color calibration.

• Unique calibration
If you execute color calibration with paper types classified for unique calibration, the color calibration adjustment val-
ue is set for only the executed paper. The set adjustment value is not applied to paper types other than that for which
color calibration was executed.
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If unique calibration is not executed, the adjustment value of common calibration is applied when printing.

Executing Color Calibration
Perform adjustment as follows.

1. You can confirm whether the paper to be loaded can be used in color calibration.

• Paper that can be used in Color Calibration →P.848

2. Load the paper.

• Loading Rolls on the Roll Holder →P.781

• Loading Rolls in the Printer →P.784

• Loading Sheets in the Feed Slot →P.809

3. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select ( Settings/Adj. tab ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

4. Press the OK button.
Set./Adj. Menu is displayed.

5. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

6. Press ▲ or ▼ to select Calibration, and then press the OK button.
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7. Press ▲ or ▼ to select Auto Adjust, and then press the OK button.
After the environment measurements and paper are confirmed, and color calibration is executed, the adjustment val-
ue is set automatically.

Note
• A confirmation message may be displayed depending on the paper type.

Although you attempted to execute common calibration, since the pa-
per type differs from that executed the previous time, replace it with
the same paper type for which calibration was executed the previous
time.
Press ▲ or ▼ to select Stop, and then press the OK button.

This is displayed in the case of unique calibration.
To continue color calibration, press ▲ or ▼ to select Continue, and
then press the OK button.

• The application of the adjustment value when printing can be set in the printer driver or on the menu
of the Control Panel.
However, when the setting value of the printer driver and the setting value of the Control Panel differ,
the setting of the printer driver is prioritized.

Configure on the printer driver
menu. (Windows)

Configure Calibration Value.
 (See "Paper Detailed Settings Dialog Box (Windows).")
→P.220

Configure on the printer driver
menu. (Mac OS X)

Configure Calibration Value.
 (See "Paper Detailed Settings Dialog Box (Mac OS X).")
→P.500

Configure on the menu of the
Control Panel.

From Set./Adj. Menu, select Adjust Printer > Calibration
> Use Adj. Value.
 (See "Menu Settings.") →P.914

• After executing color calibration, you can also adjust colors as desired in the printer driver.  (See
"Adjusting the Color in the Printer Driver.") →P.55

Specifying Execution Guide
Execution Guide is a function in which a guide is displayed on the Control Panel, imagePROGRAF Status Monitor (Win-
dows), imagePROGRAF Printmonitor (Macintosh), or RemoteUI when you execute color calibration.
If you enable this function, an Execution Guide is displayed in the following cases.

• When a new Printhead has been installed
• When a certain amount of printing has been executed after color calibration is executed
• When the data of color calibration has been initialized

To enable the function, set "Set Exec. Guide" to On on the menu of the Control Panel.
 (See "Menu Settings.") →P.914
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Paper that can be used in Color Calibration

Recommended Environment for Use of Paper
Since the recommended use environment varies according to the paper type, use within the recommended environment
range suiting the paper type.
For details, refer to the Paper Reference Guide.

Paper Type and Adjustment Type
In color calibration, you can use any of the following paper types.
Also, the adjustment type of color calibration is decided according to the paper type.  (See "Using Color Calibration for
Color Adjustment.") →P.844
For details, refer to the Paper Reference Guide.

Paper Type

Country or Region of Use selected when the print-
er driver was installed

Adjustment Type
Japan, Asia,

Oceania EU
North or

South Ameri-
ca

HW Coated Available Available Available Common calibration

GlossyPhotoHG170 Available Available Available Common calibration

SemGlsPhotoHG170 Available Available Available Common calibration

GlossyPhotoHG255 Available Available Available Common calibration

SemGlsPhotoHG255 Available Available Available Common calibration

Premium Gl2 280 Available Available Available Common calibration

Prem.SemiGl2 280 Available Available Available Common calibration

Poster Semi-Gl Available Available Available Common calibration

SatinPhoto 190 Available Available Available Common calibration

Photo Pro Plat. Available Available Available Common calibration

Proofing Paper Available Not available Available Common calibration

Proofing Paper3 Available Not available Available Unique calibration

FineArt Photo Available Available Available Common calibration

FneArt HW Photo Available Available Available Common calibration

GlossyPhoto 190 Not available Available Available Common calibration

GlossyPhoto 240 Not available Available Available Common calibration

SatinPhoto 240 Not available Available Available Common calibration

RC Photo Luster Not available Not available Available Unique calibration

Comm Proofing Not available Available Available Common calibration

SemiGlProof 195 Not available Available Not available Unique calibration

Paper Sizes that can be Used in Color Calibration
Paper sizes that can be used in color calibration differ for sheets and rolls.
For details, refer to the Paper Reference Guide.
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When Using Rolls An unused roll at least 10 inches wide
(however, a roll at least 16 inches wide depending on the paper type)

When Using Sheets One sheet of unused paper of at least A4/Letter size
(however, one sheet of unused paper of at least A2 size depending on the paper type)

Registration and Confirmation of Paper Information

• To Register Paper Information on the Printer
When using newly released paper, paper information must be registered on the printer and the printer driver. Download
the new version of Media Information File from the Canon website and install it.
 (See "Types of Paper.") →P.773

• To Confirm the Paper Information Registered on the Printer
When confirming the paper information registered on the printer, select Paper Details on the Control Panel menu, and
print the detailed information of the paper.
In the Calibration column, OK(Common) is displayed for the paper for which common calibration is executed,
OK(Unique) is displayed for the paper for which unique calibration is executed, and N/A is displayed for the paper for
which color calibration cannot be executed.

Important
• If, when reinstalling the printer driver, you change the region selection of the Media Configuration Tool, the

region-specific paper information originally registered on the printer before installation will be deleted.
Using paper with deleted information when executing color calibration will prevent the resulting calibration
adjustment value from being applied to all other types of the paper.
To apply the color calibration, prepare paper compatible with color calibration in the newly selected region
and perform color calibration again.
(See Media Configuration Tool →P.447 .)
(See Media Configuration Tool →P.676 .)

• To restore the default settings, set Reset PaprSetngs to Yes in System Setup in the Control Panel menu.
Because paper information added or modified by the Media Configuration Tool is deleted, if you have cali-
brated the printer using paper with information added by the Media Configuration Tool, color calibration
executed this way can no longer be applied to any type of paper.
If you wish to apply calibration results, prepare calibration-compatible paper that was in the original settings
and perform calibration again.
(See Media Configuration Tool →P.447 .)
(See Media Configuration Tool →P.676 .)
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Printing in Ideal Colors for Light in the Viewing Environment
You can print in the colors that look best when viewed under the light where the printed image will be displayed.
There are two ways to adjust the color tone for the ambient light, as follows.

• By selecting color tones on Chart before printing
On the printed Chart, note the number of the set of colors with the desired color tone and enter this number in the
printer driver before printing.

Important
• This function is only supported in Windows and Mac OS X 10.4 or later.
• The colors in this function may differ slightly depending on the system software used (Windows 32/64

bit or Macintosh).

For instructions on selecting color tones on Chart before printing, refer to the following topic:

• Selecting Color Tones on Charts Before Printing (Windows) →P.850

• Selecting Color Tones on Charts Before Printing (Mac OS X) →P.855

• Printing in Colors Matching the Measured Ambient Light
Measure the light level in the viewing environment and enter the results in the printer driver before printing.

Important
• This function requires the i1 spectrophotometer. The Light Source Measure Tool must also be installed.
• You can install the Light Source Measure Tool from the User Software CD-ROM.
• For a list of supported i1 devices, refer to the manual provided with the Light Source Measure Tool.
• This function is only supported in Windows and Mac OS X 10.4 or later.
• The colors in this function may differ slightly depending on the system software used (Windows 32/64

bit or Macintosh).

For instructions on measuring light levels before printing, refer to the following topic:

• Printing in Colors Matching the Measured Ambient Light (Windows) →P.859

• Printing in Colors Matching the Measured Ambient Light (Mac OS X) →P.863

Selecting Color Tones on Charts Before Printing (Windows)
Print Chart, note the number of the chart with your desired color tone, and enter this number in the printer driver before
printing.

Important
• This function requires that the Light Source Check Tool be installed.

Note
• You can install the Light Source Check Tool from the User Software CD-ROM.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box.(See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded (for example, Glossy Photo Paper HG 170 ).

Important
• You can execute Ambient Light Adjust only when F Print Quality is set to High.

5. Click D Advanced Settings to switch the print mode.
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6. In F Print Quality, click High.

Important
• You can execute Ambient Light Adjust only when F Print Quality is set to High.

7. Click Color in the G Color Mode list.

8. Click H Color Settings to display the Color Settings dialog box.

9. Click the Matching tab to display the Matching sheet.

10. Make sure Driver Matching Mode is selected in A Matching Mode.

Note
• To specify monitor matching, select Monitor Matching in B Matching Method. In this case, select

the same color space as when the file was opened in C Color Space and the monitor color tempera-
ture in D Monitor White Point.

11. Select E Use ambient light adjustment.
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12. Click F Ambient Light Adjust to display the Ambient Light Adjust dialog box.

13. Confirm that By selecting a chart number is selected in A Setting Method.
If it is not selected already, select it.

14. Click B Print Chart.
Light Source Check Tool now starts up.
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15. Check the settings and click D Print.
The Chart is printed.

16. In the viewing environment, determine the number of the set of images on the Chart in which all four vertical im-
ages have the best overall color tone.

Note
• Choose the number of the set of images in which the people, the blue of the sky, and the red of the

strawberries look the most natural overall.

17. In the Ambient Light Adjust dialog box, select the number of your preferred chart in C Chart Number.

18. If Matching Method is set to Monitor Matching on the Matching sheet, enter the D Color Temperature and
E Illuminance as measured during monitor calibration.

19. Click OK.
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20. Confirm the print settings and print as desired.

Selecting Color Tones on Charts Before Printing (Mac OS X)
Print Chart, note the number of the chart with your desired color tone, and enter this number in the printer driver before
printing.

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box. (See "Accessing the Printer Driv-
er Dialog Box from Applications (Mac OS X).") →P.493

3. Make sure the Main panel is displayed.

4. In the A Media Type list, select the type of paper that is loaded (for example, Glossy Photo Paper HG 170 ).

Important
• You can execute Ambient Light Adjust only when F Print Quality is set to High.
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5. Click D Advanced Settings to switch the print mode.

6. In F Print Quality, click High.

Important
• You can execute Ambient Light Adjust only when F Print Quality is set to High.

7. Click Color in the H Color Mode list.

8. Click I Set to display the Color Settings dialog box.

Adjustments for Better Print Quality > Color adjustment >

Selecting Color Tones on Charts Before Printing (Mac OS X) iPF6300S

7

856



9. Click the Matching tab to display the Matching panel.

10. Make sure Driver Matching Mode is selected in A Matching Mode.

Note
• To specify monitor matching, select Monitor Matching in B Matching Method. In this case, select

the same color space as when the file was opened in C Color Space and the monitor color tempera-
ture in D Monitor White Point.

11. Select E Use ambient light adjustment.

12. Click F Ambient Light Adjust to display the Ambient Light Adjust dialog box.
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13. Confirm that By selecting a chart number is selected in A Setting Method.
If it is not selected already, select it.

14. Click B Print Chart.
Light Source Check Tool now starts up.

15. Check the settings and click D Print.
The Chart is printed.
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16. In the viewing environment, determine the number of the set of images on the Chart in which all four vertical im-
ages have the best overall color tone.

Note
• Choose the number of the set of images in which the people, the blue of the sky, and the red of the

strawberries look the most natural overall.

17. In the Ambient Light Adjust dialog box, select the number of your preferred chart in C Chart Number.

18. If Matching Method is set to Monitor Matching on the Matching panel, enter the D Color Temperature and
E Illuminance as measured during monitor calibration.

19. Click OK.

20. Confirm the print settings and print as desired.

Printing in Colors Matching the Measured Ambient Light (Windows)
Measure the light level in the viewing environment and enter the results in the printer driver before printing.

Important
• This function requires the i1 spectrophotometer. The Light Source Measure Tool must also be installed.

Note
• You can install the Light Source Measure Tool from the User Software CD-ROM.
• For a list of supported i1 devices, refer to the manual provided with the Light Source Measure Tool.

1. Using the i1 spectrophotometer and the Light Source Measure Tool, determine the Lighting Source Type, Color
Temperature, and Illuminance in the viewing environment.

Note
• For detailed instructions on the i1 and Light Source Measure Tool, refer to the provided instructions.
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2. Choose Print in the application menu.

3. Select the printer in the dialog box, and then display the printer driver dialog box. (See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")

4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded (for example, Glossy Photo Paper HG 170 ).

Important
• You can execute Ambient Light Adjust only when F Print Quality is set to High.
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6. Click D Advanced Settings to switch the print mode.

7. In F Print Quality, click High.

Important
• You can execute Ambient Light Adjust only when F Print Quality is set to High.

8. Click Color in the G Color Mode list.

9. Click H Color Settings to display the Color Settings dialog box.
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10. Click the Matching tab to display the Matching sheet.

11. Make sure Driver Matching Mode is selected in A Matching Mode.

Note
• To specify monitor matching, select Monitor Matching in B Matching Method. In this case, select

the same color space as when the file was opened in C Color Space and the monitor color tempera-
ture in D Monitor White Point.

12. Select E Use ambient light adjustment.

13. Click F Ambient Light Adjust to display the Ambient Light Adjust dialog box.

14. Select By entering values directly in A Setting Method.
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15. Select the B Lighting Source Type and D Color Temperature determined in step 1.
If you have selected Monitor Matching in Matching Method on the Matching sheet, also select E Illuminance.

Note
• If you will print repeatedly using the settings values you set this one time, we recommend completing

the settings by accessing the printer driver dialog box from the operating system menu.(See "Access-
ing the Printer Driver Dialog Box from the Operating System Menu (Windows) →P.213 ")

16. Click OK.

17. Confirm the print settings and print as desired.

Printing in Colors Matching the Measured Ambient Light (Mac OS X)
Measure the light level in the viewing environment and enter the results in the printer driver before printing.

Important
• This function requires the i1 spectrophotometer. The Light Source Measure Tool must also be installed.
• You can install the Light Source Measure Tool from the User Software CD-ROM.
• For a list of supported i1 devices, refer to the manual provided with the Light Source Measure Tool.

1. Using the i1 spectrophotometer and the Light Source Measure Tool, determine the Lighting Source Type, Color
Temperature, and Illuminance in the viewing environment.

Note
• For detailed instructions on the i1 and Light Source Measure Tool, refer to the provided instructions.

2. Choose Print in the application menu.

3. Select the printer in the dialog box, and then display the printer driver dialog box. (See "Accessing the Printer Driv-
er Dialog Box from Applications (Mac OS X).") →P.493
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4. Make sure the Main panel is displayed.

5. In the A Media Type list, select the type of paper that is loaded (for example, Glossy Photo Paper HG 170 ).

Important
• You can execute Ambient Light Adjust only when F Print Quality is set to High.

6. Click D Advanced Settings to switch the print mode.
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7. In F Print Quality, click High.

Important
• You can execute Ambient Light Adjust only when F Print Quality is set to High.

8. Click Color in the H Color Mode list.

9. Click I Set to display the Color Settings dialog box.

10. Click the Matching tab to display the Matching panel.

11. Make sure Driver Matching Mode is selected in A Matching Mode.

Note
• To specify monitor matching, select Monitor Matching in B Matching Method. In this case, select

the same color space as when the file was opened in C Color Space and the monitor color tempera-
ture in D Monitor White Point.

12. Select E Use ambient light adjustment.
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13. Click F Ambient Light Adjust to display the Ambient Light Adjust dialog box.

14. Select By entering values directly in A Setting Method.

15. Select the B Lighting Source Type and D Color Temperature determined in step 1.
If you have selected Monitor Matching in Matching Method on the Matching panel, also select E Illuminance.

16. Click OK.

17. Confirm the print settings and print as desired.
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Printing Images to Match Monitor Colors
Adjusting the colors printed so that they more closely match the colors displayed on the monitor is called "monitor match-
ing." Using this mode requires adjustment or configuration of the settings of your monitor, the source application, the file
for printing, and the printer driver.

Important
• Monitor matching may not be applied, or these settings may not be configurable or adjustable, depending on

your monitor and the source application.

Note
• Printing in exactly the same colors as displayed on the monitor may not be possible due to differences in the

monitor and printer color gamuts.
• Calibrating your monitor requires a measuring device.
• Because colors appear different under sunlight at different times of day, we recommend following this proce-

dure in a room not exposed to sunlight.
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• Monitor Matching
The sequence in monitor matching is as follows.

1. Calibrate the printer.
Calibration improves color consistency by compensating for slight differences in how color appears due to individu-
al variation among printheads or conditions in various printing environments.
 (See "Using Color Calibration for Color Adjustment.") →P.844

2. Calibrate the monitor.
Normally, you can use a colorimeter such as the i1-Display.
Set the white point to 6500 K or 5000 K, the gamma to 2.2, and the brightness to 120 cd, and activate light source
measurement.
The exact procedure varies depending on your monitor and measurement device.

3. Open the file to print and configure settings in the source application.
Display the file in the sRGB or Adobe RGB color space.
Configure settings to prevent color conversion by the application.
In Photoshop CS3, for example, select Color Management in the Print dialog box, and then select No Color Man-
agement in Color Handling.

4. Configure and adjust printer driver settings.
Select Monitor Matching in Matching Method. Specify the Monitor White Point set during monitor calibration
and the Color Temperature and Illuminance measured in the ambient light.
In Color Space, select the color space used when displaying the file in the source application.
If you own an i1-Pro, using Light Source Measure Tool enables more precision measurement of the ambient light.

Note
• If you will print repeatedly using the settings values you set this one time, we recommend completing

the settings by accessing the printer driver dialog box from the operating system menu. (See "Ac-
cessing the Printer Driver Dialog Box from the Operating System Menu (Windows) →P.213 ")

For instructions on configuring printer driver settings for monitor matching, refer to the following topic, as appropriate for
your computer and operating system.

• Printing Images to Match Monitor Colors (Windows) →P.868

• Printing Images to Match Monitor Colors (Mac OS X) →P.871

Printing Images to Match Monitor Colors (Windows)
By calibrating your monitor and configuring settings in the source application in advance, you can complete settings to print
in colors that are as close as possible to the colors displayed on the monitor.

Important
• Before using this feature, you must calibrate the monitor and configure settings in the source application.

(See "Printing Images to Match Monitor Colors →P.867 ")

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box. (See "Accessing the Printer Driv-
er Dialog Box from Applications (Windows) →P.211 ")
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3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded (for example, Glossy Photo Paper HG 170 ).

Important
• You can execute Ambient Light Adjust only when F Print Quality is set to High.

5. Click D Advanced Settings to switch the print mode.
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6. In F Print Quality, click High.

Important
• You can execute Ambient Light Adjust only when F Print Quality is set to High.

7. Click Color in the G Color Mode list.

8. Click H Color Settings to display the Color Settings dialog box.

9. Click the Matching tab to display the Matching sheet.

10. Make sure Driver Matching Mode is selected in A Matching Mode.

11. In B Matching Method, select Monitor Matching.

12. In C Color Space, select the color space used when displaying the file in the source application.

13. In D Monitor White Point, select the white point set on the monitor.

Note
• For greater precision in monitor matching, we recommend configuring the settings for ambient light

matching. (See "Printing in Ideal Colors for Light in the Viewing Environment →P.850 ")

14. Click OK.

15. Confirm the print settings and print as desired.
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Printing Images to Match Monitor Colors (Mac OS X)
By calibrating your monitor and configuring settings in the source application in advance, you can complete settings to print
in colors that are as close as possible to the colors displayed on the monitor.

Important
• Before using this feature, you must calibrate the monitor and configure settings in the source applica-

tion. (See "Printing Images to Match Monitor Colors.") →P.867

1. Choose Print in the application menu.

2. Select the printer in the dialog box, and then display the printer driver dialog box. (See "Accessing the Printer Driv-
er Dialog Box from Applications (Mac OS X).") →P.493

3. Make sure the Main panel is displayed.

4. In the A Media Type list, select the type of paper that is loaded (for example, Glossy Photo Paper HG 170 ).

Important
• You can execute Ambient Light Adjust only when F Print Quality is set to High.
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5. Click D Advanced Settings to switch the print mode.

6. In F Print Quality, click High.

Important
• You can execute Ambient Light Adjust only when F Print Quality is set to High.

7. Click Color in the H Color Mode list.

8. Click I Set to display the Color Settings dialog box.
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9. Click the Matching tab to display the Matching panel.

10. Make sure Driver Matching Mode is selected in A Matching Mode.

11. In B Matching Method, select Monitor Matching.

12. In C Color Space, select the color space used when displaying the file in the source application.

13. In D Monitor White Point, select the white point set on the monitor.

Note
• For greater precision in monitor matching, we recommend configuring the settings for ambient light

matching. (See "Printing in Ideal Colors for Light in the Viewing Environment.") →P.850

14. Click OK.

15. Confirm the print settings and print as desired.
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Front

Standard With the Ejection Guide removed

a. Top Cover
Open this cover to install the Printhead and remove any jammed paper from inside the printer, as needed.  (See "Top
Cover (Inside).") →P.877

b. Paper Tray Cover
Open this cover to load a sheet in the Top Paper Feed Slot.  (See "Paper Feed Slots.") →P.878

c. Roll Feed Unit
Load rolls in this unit. You can also load sheets manually.

d. Roll Feed Unit Cover
Open this cover to load rolls.  (See "Inside the Roll Feed Unit Cover.") →P.879

e. Control Panel
Use this panel to operate the printer and check the printer status.  (See "Control Panel.") →P.890
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f. Ejection Guide
Supports paper to prevent it from rising.

g. Output Tray ( Front Paper Feed Slot )
All printed documents are ejected from this slot. When loading heavyweight paper, insert it here.  (See "Paper Feed
Slots.") →P.878

h. Cutter Unit
A round-bladed cutter for automatic roll cutting.

i. Maintenance Cartridge
Absorbs excess ink.

j. Ink Tank Cover
Open this cover to replace an Ink Tank.  (See "Ink Tank Cover (Inside).") →P.880

k. Stand
A stand that holds the printer. Equipped with casters to facilitate moving it.  (See "Stand.") →P.888

l. Output Stacker
Printed documents are ejected into the output stacker. The Output Stacker can hold one sheet.  (See "Output Stacker
Precautions.") →P.820

Back

a. USB Port
Connect a USB cable to this port. The printer is compatible with Hi-Speed USB connections.

b. Ethernet Port
Connect an Ethernet cable to this port.
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c. Power Supply Connector
Connect the power cord to this connector.

d. Carrying Handles (at six positions)
When carrying the printer, hold it by these handles under both sides.

Top Cover (Inside)

a. Carriage
Moves the Printhead. The carriage serves a key role in printing.  (See "Carriage.") →P.880

b. Carriage Shaft
The Carriage slides along this shaft.

c. Paper Retainer
Important in supplying the paper. This retainer holds paper as it is fed.

d. Platen
The Printhead moves across the platen to print. Vacuum holes on the platen hold paper in place.

e. Borderless Printing Ink Grooves
For catching ink outside the edges of paper during borderless printing.

f. Cleaning Brush
When cleaning inside the printer under the Top Cover, use this brush to sweep away paper dust on the Platen.
Also use the brush to move the blue Switch on the Platen.

g. Linear Scale
The linear scale serves a key role in detecting the Carriage position. Be careful not to touch this part when cleaning
inside the Top Cover or clearing paper jams.

h. Switch
Set the switch to the side opposite ● if the edges of printed images are blurred. Set the switch to the ● side before
borderless printing.  (See "Setting the Blue Switch on the Platen.") →P.1033
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Paper Feed Slots

a. Tray Extension
When loading a sheet manually, open this tray after opening the Paper Tray Cover.

b. Width Guide
When loading a sheet, move the guide to match the paper size.

c. Top Paper Feed Slot
When loading a sheet, insert it here.

d. Front Paper Feed Slot ( Output Tray )
When loading a heavyweight sheet, insert it here. All printed documents are ejected from this slot.

e. Front Tray Guides
Lift all of the guides before printing on heavyweight paper. When feeding heavyweight paper, rest the sheet on these
guides, align it to the right, and insert the leading edge up to the Paper Alignment Line.

f. Paper Alignment Line
Load heavyweight sheets parallel to this line.
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Inside the Roll Feed Unit Cover

a. Roll Holder
Load the roll on this holder.

b. Holder Stopper
Secure rolls on the Roll Holder with this part.

c. Roll Holder Slot
Slide the Roll Holder into this slot.
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Carriage

a. Printhead Fixer Cover
Holds the Printhead in place. Do not open this part except during Printhead replacement.

b. Printhead
The printhead is equipped with ink nozzles. It serves a key role in printing.

c. Printhead Fixer Lever
Locks the Printhead Fixer Cover. Do not open this part except during Printhead replacement.

Ink Tank Cover (Inside)
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a. Ink Tank
Cartridges of ink in various colors.

b. Ink Tank Lock Lever
A lever that locks the Ink Tank in place and protects it. Lift and press down the lever when replacing an Ink Tank.

c. Ink Lamp (Red)
Indicates the state of the Ink Tank as follows when the Ink Tank Cover is opened.

• On
The Ink Tank is installed correctly.

• Off
No Ink Tank is installed, or the ink level detection function is off.

• Flashing Slowly
Not much ink is left.

• Flashing Rapidly
Ink tank is empty.

d. Ink Color Label
Load an Ink Tank that matches the color and name on this label.
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iPF6300S Ink Tank Cover (Inside)

8

881



Vents
There are vents at three positions of the printer as shown: on top (1), on the right (2), and on the bottom on the right (3).

Important
• Do not block these vents.
• Also, avoid setting paper or other light objects near the vents.
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Hard Disk
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Erasing Data on the Printer's Hard Disk .......................................................................................................... 886

Printer Hard Disk Operations
Printer hard disk operations are available through the Control Panel and in the printer driver, imagePROGRAF Print Plug-
In, RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.
The hard disk operations available through each interface are as follows.

Operation

Printer Driv-
er or image-
PROGRAF

Print Plug-In

image-
PROGRAF

Status Moni-
tor or image-
PROGRAF
Printmonitor

Remo-
teUI

Control
Panel

Saving print jobs Print Yes No No No

Save in mail box Yes No No No

Save data before printing(*1) Yes No No No

Print without saving jobs in
the shared mailbox

No No No Yes

Save print jobs sent from
sources other than the printer
driver

No No No Yes

Operations with saved
jobs

Print saved jobs No Yes Yes Yes

Delete saved jobs No Yes Yes Yes

Job queue management Display job queue No Yes Yes Yes

Delete No Yes Yes Yes

Priority No Yes Yes Yes

Mail box management Move saved jobs No Yes Yes No

Modify saved jobs No Yes Yes No

Modify mail boxes No Yes Yes No

Print a list of saved jobs No No No Yes

Display a list of saved jobs No Yes Yes Yes

Other operations Display free hard disk space No Yes Yes Yes

Initialize hard disk No No No Yes

Error recovery No No No Yes

Display error messages No Yes Yes Yes

*1:  This option is available in combination with Print. Print jobs are saved and then printed.
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Checking the Free Hard Disk Space
Check the space available on the printer's hard disk as follows.
This operation is available from the Control Panel, in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF
Printmonitor.

Using the Control Panel

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Job Menu is displayed.

3. Press ▲ or ▼ to select HDD Information, and then press the OK button.
 
 

Using RemoteUI
To view the box list, select Stored Job in Job Management. On the Stored Job page, the free hard disk space is shown in
the upper-right corner when boxes are listed.

For details, refer to the RemoteUI help file.
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Using imagePROGRAF Status Monitor
The Hard Disk sheet shows the free hard disk space.

For details, refer to the imagePROGRAF Status Monitor help file.
 
 

Using imagePROGRAF Printmonitor
The Hard Disk pane shows the free hard disk space.
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For details, refer to the imagePROGRAF Printmonitor help file.

Erasing Data on the Printer's Hard Disk
When erasing all data on the hard disk, choose from the following three options.
This operation is only available from the Control Panel.

Erasure
Method Details

High
Speed

Erases file management data for print job data stored on the printer's hard disk. Choose this method for
relatively fast erasure. Because only the file management data is erased, the print job data itself is not
erased. Note that it may be possible to read this data using commercial data recovery software.

Secure
High Spd.

Overwrites the entire hard disk with random data. No verification is performed to check if the data was
correctly written. Choose this method to erase highly confidential data. Note that it may be possible to
read the overwritten data using specialized data recovery tools.

Secure Overwrites the entire hard disk with 00, FF, and random data (one time each). Verification is performed
to check if the data was correctly written. Choose this method to erase especially confidential data. It is
virtually impossible to recover the overwritten data. Conforms to the DoD5220.22-M standard of the U.S.
Department of Defense.

Important
• For a more secure method of preventing data recovery, we recommend physically or magnetically destroying

the hard disk. In this case, the hard disk can no longer be used.
• Erase HDD Data is not available if there is a job queue.

Additionally, print jobs are not processed during execution of Erase HDD Data.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select System Setup, and then press the OK button.

4. Press ▲ or ▼ to select Erase HDD Data, and then press the OK button.
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5. Press ▲ or ▼ to select High Speed, Secure High Spd., or Secure, and then press the OK button to display the
confirmation screen.

Note
• If a password has been set on the printer, the Admin.Pswd screen is displayed. In this case, enter the

password and press the OK button to go to the next step.
• As for the time required for deletion, confirm it on the Control Panel. However, when High Speed is

selected, this finishes in several seconds.

6. Press the OK button to start erasure.
After the printer hard disk is erased, the printer automatically restarts.
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Optional accessories
Stand ............................................................................................................................................................... 888

Stand
The following Stand can be used with the printer.

• Printer Stand ST-25

Important
• Always unlock the locking casters before moving the Stand, by moving the switch to OFF. Accidentally

moving the Stand while the locking casters are locked may scratch the floor.

Note
• For instructions on installing the Stand, refer to the instructions provided with the Stand.
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Operations and Display Screen 890

Printer Menu 900

Control Panel >

iPF6300S

9

889



Operations and Display Screen
Control Panel ................................................................................................................................................... 890

 

Control Panel Display ...................................................................................................................................... 892
How to View Instructions with Navigate .......................................................................................................... 895
Checking Instructions During Printer Operations ............................................................................................ 897

Control Panel

a. Display Screen
Shows printer menus, as well as the printer status and messages.

b. Power button (green)
Turns the printer on and off.  (See "Turning the Printer On and Off.") →P.3

The Power button is lit when the printer is on or in Sleep mode.

c. Stop button
Cancels print jobs in progress and ends the ink drying period.

d. Navigate button
Enables you to check instructions for loading and removing paper or replacing ink tanks or printheads, as well as other
operations.  (See "How to View Instructions with Navigate.") →P.895

e. Arrow buttons

• ◀ button
Press this button on the Tab Selection screen to move to another tab.
In menu items requiring numerical input, press this button to move to another digit.

• ▲ button
Press this button when viewing menus to display the next menu item or setting value.

• ▶ button
Press this button on the Tab Selection screen to move to another tab.
In menu items requiring numerical input, press this button to move to another digit.

Control Panel > Operations and Display Screen >
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• ▼ button
Press this button when viewing menus to display the next menu item or setting value.

f. OK button
Press this button on the Tab Selection screen to display the menu of the tab shown.
Pressing this button in menu items of each tab for which  is displayed at left will move to the lower level of the
menu item, enabling you to execute menu commands or set menu values.
Also press this button if the Display Screen indicates to press the OK button.

g. Back button
Displays the screen before the current screen.

h. Menu button
Displays the Tab Selection screen.  (See "Menu Settings.") →P.914

i. Cut button
Pressing this button when rolls are loaded cuts the paper, if you have specified Automatic or Eject in Cutting Mode
in the Control Panel menu.  (See "Specifying the Cutting Method for Rolls.") →P.797

j. Feed button
Pressing this button when rolls are loaded enables you to reposition the paper.  (See "Feeding Roll Paper Manually.")
→P.793

k. Load button
Press this button when loading or replacing paper.
 (See "Loading Rolls in the Printer.") →P.784

 (See "Loading Sheets in the Feed Slot.") →P.809

l. Cut Sheet lamp (green)
Lit when Tray or Front Paper Feed Slot is selected as the paper source.

m. Roll Media lamp (green)
Lit when rolls are selected as the paper source.

n. Message Lamp (orange)

• On
A warning message is displayed.

• Flashing
An error message is displayed.

• Off
The printer is off or is operating normally.

o. Data Lamp (green)

• Flashing
During printing, the Data lamp flashes when the printer is receiving or processing print jobs. Otherwise, this lamp
flashes when the print job is paused or the printer is updating the firmware.

• Off
There are no active print jobs when the Data lamp is off.

Note
• To recover from Sleep mode, any button can be pressed on the Control Panel.
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Control Panel Display
After the printer starts up, the Tab Selection screen is displayed.
Each of the four tabs presents status, menus, and error information related to the particular tab.

Types of tabs
The Tab Selection screen presents four tabs. Each tab is represented by an icon in the top row. Press the ◀ or ▶ button to
access other tabs.

Paper tab A tab indicating status and showing menus related to paper. Pressing the OK button when
this tab is highlighted will display the Paper Menu.

• Top line displayed
The paper icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu names.

• Bottom line displayed
The first and second lines display the paper type and size.

Ink tab A tab indicating status and showing menus related to ink. Pressing the OK button when
this tab is highlighted will display the Ink Menu.

• Top line displayed
The ink icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu names.

• Bottom line displayed
Here, the remaining ink level is indicated.  (See "Checking Ink Tank Levels.")
→P.978

Job tab A tab indicating status and showing menus related to print jobs. Pressing the OK button
when this tab is highlighted will display the Job Menu menu.

• Top line displayed
The job icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu names.

Settings/Adj. tab A tab indicating status and showing menus related to settings and adjustment. Pressing the
OK button when this tab is highlighted will display the Set./Adj. Menu.

• Top line displayed
The settings/adjustment icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu names.

• Bottom line displayed
The remaining Maintenance Cartridge capacity is shown on the first line and Tot.Print
Area on the second. The display unit for Tot.Print Area can be specified in the
Length Unit menu.  (See "Menu Settings.") →P.914
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Printer status and modes
Printer status is classified according to the following five modes.

Standby The printer is ready to receive jobs sent from the computer. Jobs sent from the computer
are printed immediately.

Printing Paused Printing is paused on the printer. Any jobs sent from the computer are held without being
printed.

Printing Printing is in progress on the printer. Jobs sent from the computer are printed after the cur-
rent job. The time left until printing is finished is indicated in the upper-right corner of the
screen. (Values exceeding 10 hours are not shown.)

Sleep The printer is in power-saving mode. The printer automatically enters Sleep mode to con-
serve power when idle for a specific period (by default, five minutes), that is, if no print
jobs are received or buttons are pressed while all covers are closed.
You can specify the period before the printer enters Sleep mode in the Sleep Timer menu.
 (See "Menu Settings.") →P.914
After entering Sleep mode from Standby mode, the printer automatically recovers if print
jobs are received, and the jobs are printed.

Error The printer requires your attention. Any jobs sent from the computer cannot be processed.
The tab related to the error is displayed.
For information about the display in the case of multiple errors, see "Error display."
→P.895
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Mode transition

• Mode display
The printer mode is indicated as follows.

*1: The printer automatically enters Sleep mode when idle for a specific period (by default, five minutes), that is, if no
print jobs are received or buttons are pressed while all covers are closed. However, it does not enter Sleep mode while
error messages are displayed or when a roll can be manually advanced by pressing the Feed button.

Control Panel > Operations and Display Screen >

Control Panel Display iPF6300S

9

894



*2: When the printer is in Sleep mode, you can press any button except the Power button to recover from Sleep mode.
Sleep mode is also terminated if a print job is received or a command is issued from RemoteUI.

• Error display
Mode transition during error display is as follows.
If multiple errors occur, tabs related to errors other than the error currently shown flash. Press the ◀ or ▶ button to
access other tabs and check those errors. If multiple errors occur that are related to the Job tab and Settings/Adj. tab,
each error message is displayed for 4 seconds on each tab before another message is shown.

How to View Instructions with Navigate
You can refer to instructions for loading paper, replacing ink tanks, and performing other operations on the printer control
panel.

1. Press the Navigate button.

2. Press ▲ or ▼ to select the desired navigation menu.

3. Press ▲ or ▼ to select View Op. Guide, and then press the OK button.
Instructions are now displayed.
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･ Example: Loading sheets
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Checking Instructions During Printer Operations
You can refer to instructions on the printer control panel when loading paper, replacing ink tanks, or performing other oper-
ations.

How to view instructions
Once you complete an action described in the instructions, the printer detects the action and switches to the next instruction
screen.
 

In the case of actions the printer cannot detect, instruction screens are switched every four seconds, and the sequence of
operations is shown repeatedly.
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When all actions in the sequence are finished, the instruction screen for the next step is displayed.
･ Example: Ink tank replacement
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Note
• During a continuous display of instructions, you can press the ◀ button to pause the instructions on the cur-

rent screen.
Press the ◀ or ▶ button to display the previous or next screens. If you do not press the ◀ or ▶ button
within 30 seconds, continuous display is resumed.
Press the OK button to display the instruction screen for the next step.
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Printer Menu
Printer Menu Operations ................................................................................................................................. 900
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Printer Menu Operations
The printer menu is classified into menu items available when no print job is in progress and menu items only available
during printing.

• Menu operations when no print job is in progress →P.900

• Menu operations during printing →P.900

Menu operations when no print job is in progress
To view available menus organized on tabs, select a tab on the Tab Selection screen and press the OK button.

Note
• If the Tab Selection screen is not displayed, press the Menu button.

The following operations are available from the menu.

• Paper Menu
Paper menu settings

• Ink Menu
Ink menu operations

• Job Menu
Menu operations to manage print jobs

• Set./Adj. Menu
Menu operations for printer adjustment and maintenance

For a description of specific menu items available, see "Menu Settings." →P.914
For instructions on selecting menu items, see "Menu Operations." →P.901

Note
• By default, menu settings apply to all print jobs. However, for settings that are also available in the printer

driver, the values specified in the printer driver take priority.

Menu operations during printing
To display menus during printing, select a tab on the Tab Selection screen on the Control Panel, and then press the OK
button. Other menus are available after printing is finished.

Note
• If the Tab Selection screen is not displayed, press the Menu button.
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The following operations are available from the menu during printing.
 
 

• Ink Menu
Ink menu operations

• Job Menu
Menu operations to manage print jobs

• Set./Adj. Menu
Fine-tuning paper feeding
Display of printer-related information

For a description of specific menu items available during printing, see "Menu Settings (During Printing)." →P.924
For instructions on selecting menu items during printing, see "Menu Operations." →P.901

Menu Operations
To view available menus organized on tabs, select a tab on the Tab Selection screen and press the OK button. For details,
see "Menu Settings." →P.914

• Menus (when the Ink tab is selected and the OK button is pressed)

Note
• If the Tab Selection screen is not displayed, press the Menu button.

Simply press buttons on the Control Panel to access menus on various tabs from the Tab Selection screen and set or exe-
cute Menu items.
The following section describes menu operations.

• Accessing menus →P.901

• Specifying menu items →P.903

• Specifying numerical values →P.903

• Executing menu commands →P.904

Accessing menus
Printer menus are grouped by function.
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Menus are displayed with the upper line selected. You can use the buttons on the Control Panel to access each menu.

• Press Back to access a higher menu in the menu list, and press OK to access a lower one. If not all menu items are
displayed, hold down ▲ or ▼ to scroll through higher and lower menu items. Items you select are highlighted.

The scroll bar at right indicates the current position in the overall menu.

• Lower menus are available if  is displayed at left next to the second and subsequent rows. To access the lower me-
nus, select the menu and press the OK button.
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Specifying menu items
Menu items can be set as follows.

1. Press ▲ or ▼ to select the desired setting, and then press the OK button.

After two seconds, the display reverts to the upper level menu.

Note
• If a confirmation message is displayed regarding the setting you entered, press the OK button. The

setting is applied, and the printer is now in Standby.

Specifying numerical values
Follow these steps to enter numbers. In this example, network settings items are entered.

1. Press the ◀ or ▶ button to move to the next field for input.

2. Press the ▲ or ▼ button to enter the value.

Note
• Hold down ▲ or ▼ to increase or decrease the value continuously.

3. Repeat steps 1 and 2 to complete the settings, and then press the OK button.

Note
• If a confirmation message is displayed regarding the setting you entered, press the OK button. The

setting is applied, and the printer is now in Standby.
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Executing menu commands
Menu commands can be executed as follows.

1. Press ▲ or ▼ to select the action to execute, and then press the OK button.
The menu command is now executed.

Menu Structure
The menu structure is organized by tabs, as follows. Values at right indicated by an asterisk are the defaults.

• Paper Menu →P.904

• Ink Menu →P.906

• Job Menu →P.906

• Set./Adj. Menu →P.907

For instructions on menu operations, see "Menu Operations." →P.901
For details on menu items, see "Menu Settings." →P.914

Paper Menu

First Level Second Level Third Level Fourth Level Fifth Level

Load Paper Roll Paper

Manual Paper

Eject Paper

Chg. Paper Type
(*1 →P.906 )

Roll Paper (The paper type is displayed here.) (*1 →P.906 )

Manual Paper

Chg. Paper Size Manual PaperSize (The size of paper is displayed here.) (*2 →P.906 )

CustomPaperSize (Set the length)

Roll Length
(*3 →P.906 )

(Set the length)

ManageRemainRoll Off *

On

Paper Details (The paper type is
displayed here.)
(*1 →P.906 )

Head Height Automatic *

Highest

High

Standard

Low

Lowest

Super Low

Skew Check Lv. High Accuracy

Standard *

Loose

Off
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First Level Second Level Third Level Fourth Level Fifth Level
Paper Details (The paper type is

displayed here.)
(*1 →P.906 )

Cutting Mode
(*5 →P.906 )

Automatic

Eject

Manual

Cut Speed Fast

Standard

Slow

Trim Edge First Automatic

Off

On

CutDustReduct. Off

On

VacuumStrngth Automatic *

Strongest

Strong

Standard

Weak

Weakest

Scan Wait Time Dry time Off *

1 sec.

3 sec.

5 sec.

7 sec.

9 sec.

Area
(*4 →P.906 )

Entire area *

Leading edge

Roll DryingTime Off

30 sec.

1 min.

3 min.

5 min.

10 min.

30 min.

60 min.

NearEnd RollMrgn 3mm

20mm

NearEnd Sht Mrgn 3mm

20mm

Bordless Margin Automatic

Control Panel > Printer Menu >
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First Level Second Level Third Level Fourth Level Fifth Level
Paper Details (The paper type is

displayed here.)
(*1 →P.906 )

Bordless Margin Fixed

Manual Feed Front

Top

Return Defaults

Paper Details

Keep Paper Type Off *

On

*1: For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See Paper Ref-
erence Guide .) Types of paper in the printer driver and related software (as well as on the Control Panel ) are
updated when you install the printer driver from the User Software CD-ROM or if you update paper informa-
tion with the Media Configuration Tool.  (See "Updating paper information.") →P.778

*2: For information on the sizes of paper the printer supports, see "Paper Sizes." →P.774

*3: Available only if ManageRemainRoll is On.
*4:  Leading edge is not available as a setting option in the Paper Detailed Settings dialog box of the printer driv-

er.
*5: see "Specifying the Cutting Method for Rolls." →P.797

Ink Menu

First Level

Rep. Ink Tank

Head Cleaning A

Job Menu

First Level Second Level Third Level Fourth Level Fifth Level

Print Job Job List (Choose a print job.) Delete

Preempt Jobs (*1 →P.907 )

Stored Job Mailbox List (Enter a password if
one has been set.)

Job List Print

Delete

Print Job List

Job Log (Choose from infor-
mation about the lat-
est three print jobs.)

Document Name

User Name

Page Count

Job Status OK

CANCELED

Print Start Time yyyy/mm/dd hh:mm:ss

Print End Time yyyy/mm/dd hh:mm:ss

Print Time xxxsec.

Output Img. Size (The image size is displayed)

Media Type
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First Level Second Level Third Level Fourth Level Fifth Level
Job Log (Choose from infor-

mation about the lat-
est three print jobs.)

Paper Consumed

Paper Length

Paper Width

Interface USB

Network

HDD

Ink Consumed (The ink color is dis-
played here.)

xxx.xxx ml

Print settings

Head Height

Temp./Humidity

Adjustment req.

Print Job Log

Pause Print Off *

On

HDD Information Total capacity

Box free space

*1: If a pending job is selected, Print Anyway is displayed.

Set./Adj. Menu

First Level Second
Level Third Level Fourth Lev-

el Fifth Level Sixth Level Seventh Level

Test Print Nozzle Check

Status Print

Interface Print

Paper Details

Print Job Log

Menu Map

Adjust
Printer

Head Posi.
Adj.

Auto(Standard)

Auto(Advanced)

Auto(Expansion) (*1 →P.913 )

Manual (*1 →P.913 )

Feed Priori-
ty

Adj. Priori-
ty

Automatic *

Print Quality

Print Length

Adj. Quali-
ty
(*2
→P.913 )

Auto(GenuinePpr)

Auto(OtherPaper)

Manual
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First Level Second
Level Third Level Fourth Lev-

el Fifth Level Sixth Level Seventh Level

Adjust
Printer

Feed Priori-
ty

Adjust
Length
(*3
→P.913 )

Adjust-
mentPrint

A:High

B:Standard/Draft

Change Set-
tings

A:High

B:Standard/Draft

Adj Far Ed Feed

Calibration Auto Adjust

Calibration
Log

Date

Paper Type

Adjustment Type

Use Adj.
Value

Disabled

Enabled *

"Set Exec.
Guide"

Off *

On

Return Defaults

Mainte-
nance

Head
Cleaning

Head Cleaning A

Head Cleaning B

Nozzle Check

Replace
P.head

Printhead L

Printhead R

Repl. maint cart

Head Info Printhead L ProductName:

s/n:

Days elapsed:

Count [Mdot]:

Printhead
R

ProductName:

s/n:

Days elapsed:

Count [Mdot]:

Clean Platen

Interface
Setup

EOP Timer
(*8
→P.913 )

10 sec.

30 sec.

1 min.

2 min.

5 min.

10 min. *

30 min.

60 min.
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First Level Second
Level Third Level Fourth Lev-

el Fifth Level Sixth Level Seventh Level

Interface
Setup

TCP/IP
(*8
→P.913 )

IPv4 IPv4 Mode Automatic

Manual *

Protocol
(*4
→P.913 )

DHCP On

Off *

BOOTP On

Off *

RARP On

Off *

IPv4 Set-
tings
(*9
→P.913 )

IP Address xxx.xxx.xxx.xxx

Subnet Mask xxx.xxx.xxx.xxx

Default G/W xxx.xxx.xxx.xxx

DNS Set-
tings
(*9
→P.913 )

DNS Dync
update

On

Off *

Pri. DNS SrvAddr

Sec. DNS SrvAddr

DNS Host Name

DNS Domain Name

IPv6 IPv6 Sup-
port

On

Off *

IPv6 Stles-
sAddrs
(*10
→P.914 )

On *

Off

DHCPv6
(*10
→P.914 )

On

Off *

DNS Set-
tings
(*9
→P.913 )

(*10
→P.914 )

DNS Dync
update

Statefull
Addr

On

Off *

Stateless
Addr

On

Off *

Pri. DNS SrvAddr

Sec. DNS SrvAddr

DNS Host Name

DNS Domain Name

NetWare
(*8
→P.913 )

NetWare On

Off *

Frame
Type
(*5
→P.913 )

Auto Detect

Ethernet 2

Ethernet 802.2 *
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First Level Second
Level Third Level Fourth Lev-

el Fifth Level Sixth Level Seventh Level

Interface
Setup

NetWare
(*8
→P.913 )

Frame
Type
(*5
→P.913 )

Ethernet 802.3

Ethernet SNAP

Print Serv-
ice
(*5
→P.913 )

BinderyPServer

RPrinter

NDSPServer *

NPrinter

AppleTalk
(*8
→P.913 )

On

Off *

Ethernet
Driver
(*8
→P.913 )

Auto Detect On *

Off

Comm.Mod
e
(*6
→P.913 )

Half Duplex *

Full Duplex

Ethernet
Type
(*6
→P.913 )

10 Base-T *

100 Base-TX

1000 Base-T

Spanning
Tree

Not Use *

Use

MAC Ad-
dress

xxxxxxxxxxxx

Interface Print (*8 →P.913 )

Return Defaults (*8 →P.913 )

System Set-
up

Sleep Timer
(*11
→P.914 )

5 min. *

10 min.

15 min.

20 min.

30 min.

40 min.

50 min.

60 min.

240 min.

Buzzer Off

On *

Contrast
Adj.

-4,-3,-2,-1,0*,+1,+2,+3,+4
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First Level Second
Level Third Level Fourth Lev-

el Fifth Level Sixth Level Seventh Level

System Set-
up

Date &
Time
(*8
→P.913 )

Date
yyyy/mm/dd (*7 →P.913 )

 Time
hh:mm

Date For-
mat
(*8
→P.913 )

yyyy/mm/dd *

dd/mm/yyyy

mm/dd/yyyy

Language

Time Zone
(*8
→P.913 )

0:London (GMT)

+1:Paris,Rome

+2:Athens,Cairo

+3:Moscow

+4:Eerevan,Baku

+5:Islamabad

+6:Dacca

+7:Bangkok

+8:Hong Kong

+9:Tokyo,Seoul

+10:Canberra

+11NewCaledonia

+12:Wellington

-12:Eniwetok

-11:Midway is.

-10Hawaii(AHST)

-9:Alaska(AKST)

-8:Oregon (PST)

-7:Arizona(MST)

-6:Texas (CST)
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First Level Second
Level Third Level Fourth Lev-

el Fifth Level Sixth Level Seventh Level

System Set-
up

Time Zone
(*8
→P.913 )

-5:NewYork(EST)

-4:Santiago

-3:Buenos Aires

-2:

-1:Cape Verde

Length Unit meter *

feet/inch

Detect Mis-
match

Pause

Warning

None *

Hold Job

Paper Size
Basis

Roll Selec-
tion 1

ISO A3 (297mm) *

300mm Roll

Roll Selec-
tion 2

10in. (254mm) *

JIS B4 (257mm)

Keep Paper
Size

Off *

On

TrimEdge
Reload

Automatic

Off *

On

Rep.P.head
Print

Off

On *

Nozzle
Check

Frequency Standard *

1 page

Warning Off *

On

Use Remo-
teUI
(*8
→P.913 )

On *

Off

Reset PaprSetngs (*8 →P.913 )

Erase HDD
Data

High Speed (*8 →P.913 )

Secure High Spd. (*8 →P.913 )

Secure (*8 →P.913 )

Output
Method

Print *

Print (Auto Del)

Save: Box XX

Print After
Recv

Off *
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First Level Second
Level Third Level Fourth Lev-

el Fifth Level Sixth Level Seventh Level

System Set-
up

Print After
Recv

On

Common
Box Set.
(*4
→P.913 )

Print *

Print (Auto Del)

Show Job
Log
(*8
→P.913 )

Off

On *

Prep.MovePrinter

Admin.
Menu
(*8
→P.913 )

Change
Password
(*9
→P.913 )

(The screen for setting the password is displayed)

Init.Admin.Pswd (*9 →P.913 )

Printer Info Paper Info

Ink Info

Head Info ProductName:

s/n:

Days elapsed:

Count [Mdot]:

Printhead L ProductName:

s/n:

Days elapsed:

Count [Mdot]:

Printhead
R

ProductName:

s/n:

Days elapsed:

Count [Mdot]:

System Info

Error Log

Other Counter

*1: Available after you have used Auto(Advanced) in Head Posi. Adj. once.
*2: Available if Adj. Priority is Automatic or Print Quality.
*3: Available if Adj. Priority is Automatic or Print Length.
*4: Not displayed if IPv4 Mode is Manual.
*5: Not displayed if NetWare is Off.
*6: Not displayed if Auto Detect is On.
*7: Follows the setting in Date Format.
*8: Viewing and configuration is possible for administrators, and only viewing for other users.
*9: Viewing and configuration is possible for administrators only.

Control Panel > Printer Menu >

iPF6300S Menu Structure

9

913



*10: Not displayed if IPv6 Support is Off.
*11: Default setting for the time to enter the power save mode/Sleep mode is recommended.

Menu Settings
Menu items are as follows.
For instructions on selecting menu items, see "Menu Operations." →P.901
For details on menu levels and values, see "Menu Structure." →P.904

Paper Menu

Setting Item Description, Instructions

Load Paper Select either manually loaded sheets or rolls and load the pa-
per.

Eject Paper Choose this item before removing loaded paper.

Chg. Paper Type (*1 →P.916 ) Change the type of paper loaded.  (See "Changing the Type
of Paper.") →P.787

Chg. Paper Size Change the size of paper loaded.  (See "Specifying the Paper
Length.") →P.789   (See "Paper Sizes.") →P.774

ManageRemainRoll Choose On to print a barcode at the end of a roll before you
remove it. The printed barcode can be used in managing the
amount of roll paper left. Choose Off if you prefer not to
print the barcode.
 (See "Keeping Track of the Amount of Roll Paper Left.")
→P.794

Paper Details (The type of pa-
per is displayed
here.)
(*1 →P.916 )

Head Height Adjust the Printhead height.  (See "Troubleshooting Paper
Abrasion and Blurry Images (Head Height).") →P.831

Skew Check
Lv.

If you print on Japanese paper (washi) or other handmade pa-
per that has an irregular width, choose Loose for a higher
skew detection threshold, or choose Off to disable skew de-
tection. However, if paper is loaded askew when detection is
Off, note that paper jams or Platen soiling may occur.

Cutting Mode Specify whether or not to cut with the standard round-bladed
cutter.
If you choose Automatic, the roll will be cut automatically
using the Cutter Unit, depending on the printer driver set-
tings. If you choose Manual, the paper will not be cut after
printing. Instead, a line will be printed at the cut position.
Choose Eject if you prefer not to have documents dropped
immediately after printing, as when waiting for ink to
dry. (See "Specifying the Cutting Method for Rolls.")
→P.797

Cut Speed Choose the cutting speed. The preset selection represents the
optimal cutting speed for the type of paper. We recommend
keeping the preset cutting speed.
If you use adhesive paper, choosing Slow helps prevent adhe-
sive from sticking to the cutter and keeps the cutter sharp.

Trim Edge
First

If a roll is loaded, the end of the paper will be cut.
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Setting Item Description, Instructions
Paper Details (The type of pa-

per is displayed
here.)
(*1 →P.916 )

CutDustRe-
duct.

If you choose On, a line will be printed at the cut position
when paper cutting is selected. This option reduces the
amount of debris given off after cutting. It also helps prevent
adhesive from sticking to the cutter and keeps the cutter sharp
if you use adhesive paper.  (See "Reducing Dust from Cut-
ting Rolls.") →P.804

Vac-
uumStrngth

Specify the level of suction that holds paper against the Plat-
en.  (See "Adjusting the Vacuum Strength (Vac-
uumStrngth).") →P.842

Scan Wait
Time

Select Entire area to apply the ink drying time after each
scan until the document is fully printed.
If you select Leading edge, the drying time is entered per
each scan until about 110–140 mm (4.3–5.5 in) from the lead-
ing edge of the paper, and colors may be uneven in the boun-
dary between the areas with and without a drying time. (The
applicable length varies depending on the Print Quality set-
ting.)

Roll Drying-
Time

Specify the time to wait for the ink to dry for each sheet.

NearEnd
RollMrgn

Specify the minimum margin at the leading edge of roll paper
to ensure better printing quality at the leading edge.
Note that if you choose 3mm, it may lower the printing quali-
ty at the leading edge and affect feeding accuracy. The prin-
ted surface may be scratched, and ink may adhere to the lead-
ing edge. It may also cause the Platen to become soiled.

NearEnd Sht
Mrgn

Specify a margin at the leading edge of sheets to ensure better
printing quality at the leading edge.
Note that if you choose 3mm, it may lower the printing quali-
ty at the leading edge and affect feeding accuracy. The prin-
ted surface may be scratched, and ink may adhere to the lead-
ing edge.

Bordless Mar-
gin

Adjust the margin during borderless printing.
Choose Automatic to have the printer automatically detect
the paper width and configure the margin settings for border-
less printing. If margins are mistakenly created when Auto-
matic is selected, choose Fixed. In this case, the paper width
is not detected automatically, and the document is printed
without borders, using the margin settings required by the
printer.

Manual Feed Select the Paper Feed Slot to use when printing on sheets.
Normally, select Top. When printing on heavyweight paper
such as POP Board, select Front.

Return De-
faults

Choose OK to restore Paper Details to the default values.

Paper Details Print the paper settings as specified in Paper Details.

Keep Paper Type Select On when printing on a particular type of paper regular-
ly.  (See "Changing the Type of Paper.") →P.787
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*1: For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See Paper Ref-
erence Guide .) Types of paper in the printer driver and related software (as well as on the Control Panel ) are
updated when you install the printer driver from the User Software CD-ROM or if you update paper informa-
tion with the Media Configuration Tool.  (See "Updating paper information.") →P.778

Ink Menu

Setting Item Description, Instructions

Rep. Ink Tank Replace the Ink Tank at this point. Follow the instructions
displayed to complete the required procedure.  (See "Re-
placing Ink Tanks.") →P.972

Head Cleaning A Printhead cleaning options.  (See "Cleaning the Print-
head.") →P.981
Execute Head Cleaning A if printing is faint, oddly col-
ored, or contains foreign substances.

Job Menu

Setting Item Description, Instructions

Print
Job

Job List (Choose
a print
job)

Delete Delete the current job or queued jobs.  (See "Managing the
Job Queue (Deleting or Preempting Other Jobs).")
→P.724

Preempt Jobs Print the job first after the current print job is finished.
 (See "Managing the Job Queue (Deleting or Preempt-
ing Other Jobs).") →P.724

Stored
Job

Mailbox
List

(Enter a
pass-
word if
one has
been
set.)

Job List Print Print the saved job.

Delete Delete the saved job.

Print Job List Print a list of saved print jobs.

Job Log (Choose
from in-
forma-
tion
about the
last three
print
jobs.)

Document Name Indicates the document name of the selected print job.

User Name Indicates the name of the user who sent the print job.

Page Count Indicates the number of pages in the job.

Job Status Indicates the printing results.

Print Start Time Indicates when the print job was started.

Print End Time Indicates when the print job was finished.

Print Time Indicates the time required to print the job.

Output Img. Size Indicates the image size in the print job.

Media Type Indicates the type of paper in the print job.

Paper Consumed Indicates the total amount of paper consumed.

Paper Length Indicates the length of paper.

Paper Width Indicates the width of paper.

Interface Indicates the interface used for the print job.

Ink Consumed Indicates a rough estimate of how much ink was consumed
per job.(*1 →P.917 )
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Setting Item Description, Instructions
Job Log (Choose

from in-
forma-
tion
about the
last three
print
jobs.)

Print settings A counter for maintenance purposes. Indicates job print
settings.

Head Height A counter for maintenance purposes. Indicates the head
height when jobs wereprinted.

Temp./Humidity A counter for maintenance purposes. Indicates the temper-
ature and humiditywhen jobs were printed.

Adjustment req. A counter for maintenance purposes. Indicates adjustment
conditions appliedto jobs.

Print Job Log Print a record of print jobs, including the paper type and
size, amount of ink consumed, and so on. Ink consumption
indicates a rough estimate of the amount of ink consumed
per print job.(*1 →P.917 )

Pause Print Choose On to stop printing.

HDD Information Indicates the total hard disk capacity and the mail box free
space.

*1: A rough estimate of the amount of ink consumed per print job is displayed. Actual ink consumption may be
different. The average margin of error for estimates calculated according to Canon measurement conditions for
ink costs is ±15%. Canon does not guarantee the accuracy of these estimates. Estimates may vary depending on
conditions of use. Calculation of these estimates does not include ink consumed when cleaning printheads by
forceful ejection of ink.

Set./Adj. Menu

Setting Item Description, Instructions

Test
Print

Nozzle Check Print a test pattern to check the nozzles.

Status Print Print information about the setting values and condi-
tion of the printer.

Interface Print Print interface settings information.

Paper Details Print the paper settings as specified in Paper Details.

Print Job Log Print a record of print jobs, including the paper type
and size, amount of ink consumed, and so on. Ink con-
sumption indicates a rough estimate of the amount of
ink consumed per print job.(*1 →P.924 )

Menu Map Print the menu structure.

Adjust
Printer

Head
Posi.
Adj.

Auto(Standard) The printer prints and reads a test pattern for automat-
ic adjustment of Printhead alignment relative to the
printing direction.  (See "Automatic Adjustment to
Straighten Lines and Colors (Head Posi. Adj.).")
→P.827

Auto(Advanced) The printer prints and reads a test pattern for automat-
ic adjustment of Printhead alignment relative to the
printing direction and spacing between nozzles and
colors.  (See "Automatic Adjustment to Straighten
Lines and Colors (Head Posi. Adj.).") →P.827
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Setting Item Description, Instructions
Adjust
Printer

Head
Posi.
Adj.

Auto(Expansion) The printer prints and reads a test pattern for automat-
ic adjustment of Printhead alignment relative to the
printing direction and spacing between nozzles and
colors. Adjustment is performed at a higher level of
precision than Auto(Advanced).  (See "Automatic
Adjustment to Straighten Lines and Colors (Head
Posi. Adj.).") →P.827

Manual Print a test pattern for adjustment of Printhead align-
ment relative to the printing direction. Enter the ad-
justment value manually based on the resulting pat-
tern.  (See "Manual Adjustment to Straighten Lines
and Colors (Head Posi. Adj.).") →P.829

Feed
Priori-
ty

Adj.
Priori-
ty

Automatic Specify exact paper feeding, if desired. Normally, se-
lect Automatic. Choose Print Quality for attractive
printing. Choosing Print Quality also makes banding
less noticeable. Choose Print Length if you prefer to
feed the paper an exact amount. However, note that
slight banding may occur in the direction of carriage
scanning when Print Length is selected.

Print Quality

Print Length

Adj.
Quali-
ty

Auto(GenuinePpr) Specify this mode with paper identified in the Paper
Reference Guide.(See Paper Reference Guide .)
The printer prints and reads a test pattern for automat-
ic adjustment of the feed amount.  (See "Automatic
Banding Adjustment (Adj. Quality).") →P.834

Auto(OtherPaper) Specify this mode with paper not in the Paper Refer-
ence Guide.(See Paper Reference Guide .)
The printer prints and reads a test pattern for automat-
ic adjustment of the feed amount. Note that this func-
tion takes more time and consumes more ink than Au-
to(GenuinePpr).  (See "Automatic Banding Adjust-
ment (Adj. Quality).") →P.834

Manual Use this mode with highly transparent media or other
paper for which Auto(GenuinePpr) or Auto(Other-
Paper) cannot be used.
Print a test pattern for adjustment of the feed amount
based on the type of paper.  (See "Manual Banding
Adjustment (Adj. Quality).") →P.836

Adjust
Length

Ad-
just-
ment-
Print

A:High Print a test pattern for particular types of paper to
compensate for paper stretching or shrinkage, after
which you enter the amount of adjustment.  (See "Ad-
justing Line Length (Adjust Length).") →P.838

B:Standard/Draft

Chang
e Set-
tings

A:High Displayed when you have selected Feed Priority >
Adj. Priority > Print Length.
Adjustment relative to the amount of stretching or
shrinkage of the current paper.
Enter either the adjustment results from Adjustment-
Print or the discrepancy that you measured (as a per-
centage).
For paper that tends to stretch, increase the feed
amount by choosing a higher adjustment value. For
paper that tends to shrink, decrease the feed amount
by choosing a lower adjustment value.

B:Standard/Draft
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Setting Item Description, Instructions
Adjust
Printer

Adj Far Ed Feed Choose Yes to adjust the feed amount for the trailing
edge.

Cali-
bration

Auto Adjust Choose Yes for automatic adjustment of the adjust-
ment value after a test pattern for color calibration is
printed.

Calibration Log The Date, Paper Type, and Adjustment Type for
which color calibration was executed are displayed on
the Display Screen where you can confirm them.
 

Common calibration and unique calibration are the
Adjustment Type of color calibration.
When paper is set in the printer, the history of effec-
tive color calibration for the set paper is displayed.
When paper is not set in the printer, the latest history
among common calibration or unique calibration is
displayed.
Also, a hyphen (-) is displayed when there are no exe-
cution results.
 (See "Using Color Calibration for Color Adjust-
ment.") →P.844
 (See "Paper that can be used in Color Calibra-
tion.") →P.848

Use Adj. Value Choose Disabled > OK if you prefer not to apply the
color calibration adjustment value in print jobs. How-
ever, printer driver settings are given priority.
Choose Enabled > OK to apply the color calibration
adjustment value in print jobs. However, printer driver
settings are given priority.

"Set Exec. Guide" If you select On, a message is displayed on the con-
trol panel at the timing recommended for executing
color calibration.

Return Defaults Clear the color calibration adjustment value and the
execution log.

Main-
te-
nance

Head Cleaning Clean the Printhead.  (See "Cleaning the Printhead.")
→P.981

Choose Head Cleaning A if printing is faint, oddly
colored, or contains foreign substances.
Choose Head Cleaning B if no ink is printed at all, or
if printing is not improved by Head Cleaning A.

Nozzle Check Print a test pattern to check the nozzles.

Replace P.head Execute when replacing the Printhead. Follow the in-
structions displayed to complete the required proce-
dure.  (See "Replacing the Printhead.") →P.982
Not displayed during a warning message that the re-
maining Maintenance Cartridge capacity is low.

Repl. maint cart Execute when replacing the Maintenance Cartridge.
Follow the instructions displayed to complete the re-
quired procedure.  (See "Replacing the Maintenance
Cartridge.") →P.990

Head
Info

Printhead L Indicates information about the printhead.

Printhead R
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Setting Item Description, Instructions
Main-
te-
nance

Clean Platen Move the Carriage in preparation for cleaning the
Platen.

Inter-
face
Setup

EOP Timer Specify the timeout period before cancellation of print
jobs that cannot be received by the printer.

TCP/
IP

IPv4 IPv4 Mode Choose whether the printer IP address is configured
automatically or a static IP address is entered manual-
ly.

Proto-
col

DHCP Specify the protocol used to configure the IP address
automatically.BOOTP

RARP

IPv4
Set-
tings

IP Address Specify the printer network information when using a
static IP address.
Enter the IP address assigned to the printer, as well as
the network subnet mask and default gateway.
The value that was automatically configured is dis-
played if you have set IPv4 Mode to Automatic.

Subnet Mask

Default G/W

DNS
Set-
tings

DNS Dync update Specify whether DNS server registration is updated
automatically.

Pri. DNS
SrvAddr

Specify the DNS server address.

Sec. DNS
SrvAddr

DNS Host Name Specify the DNS host name.

DNS Domain
Name

Specify the DNS domain name.

IPv6 IPv6 Support Specify whether to connect via IPv6.

IPv6 StlessAddrs Specify whether a IPv6 stateless address is used.

DHCPv6 Specify whether DHCPv6 settings are used.

DNS
Set-
tings

DNS
Dync
update

State-
full
Addr

Specify whether DNS server registration is updated
automatically.

State-
less
Addr

Pri. DNS
SrvAddr

Specify the DNS server address.

Sec. DNS
SrvAddr

DNS Host Name Specify the DNS host name.

DNS Domain
Name

Specify the DNS domain name.

Net-
Ware

NetWare Specify the NetWare protocol. To apply your changes,
choose Register Setting.

Frame Type Specify the frame type to use.

Control Panel > Printer Menu >
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Setting Item Description, Instructions
Inter-
face
Setup

Net-
Ware

Print Service Choose the print service.

AppleTalk Specify whether to use the AppleTalk protocol. To ap-
ply your changes, choose Register Setting.

Ether-
net
Driver

Auto Detect Specify the communication method. To apply your
changes, choose Register Setting.
Choose On for automatic configuration of the LAN
communication protocol. Choose Off to use settings
values of Comm.Mode and Ethernet Type.

Comm.Mode Choose the LAN communication method.

Ethernet Type Choose the LAN transfer rate.

Spanning Tree Choose whether spanning-tree packets are supported
over the LAN.

MAC Address Indicates the MAC address.

Interface Print Print interface settings information.

Return Defaults Choose OK to restore Interface Setup settings to the
default values.

System
Setup

Sleep Timer Specify the period before the printer enters sleep
mode.

Buzzer Choose On for the buzzer to sound once for warnings
and three times for errors.

Contrast Adj. Adjust the Display Screen contrast level.

Date &
Time

Date Set the current date.

Time Set the current time. Available only if the Date setting
is specified.

Date Format Specify the date format.

Language Specify the language used on the Display Screen.

Time Zone Specify the time zone. Time zone options indicate a
main city in this time zone and the difference from
Greenwich Mean Time.

Length Unit Choose the display unit for length. Change the unit
displayed for the remaining amount of roll paper,
Tot.Print Area, and so on.

Detect Mismatch Specify printing behavior if the type and size of paper
specified in the printer menu does not match the type
and size in the printer driver.
Choose Pause to have printing paused under these cir-
cumstances. Choose Warning to continue printing af-
ter notification. Choose None to continue printing
without notification. Choose Hold Job to store jobs
with mismatched types and sizes of paper on the print-
er hard disk, in a print queue awaiting processing.
 (See "Using the Printer Hard Disk.") →P.719

Paper
Size
Basis

Roll Selection 1 If roll size detection is activated, choose whether ISO
A3 (297mm) or 300mm Roll is applied when a roll of
an intermediate width is detected.
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Setting Item Description, Instructions
System
Setup

Paper
Size
Basis

Roll Selection 2 If roll size detection is activated, choose whether
10in. (254mm) or JIS B4 (257mm) is applied when a
roll of an intermediate width is detected.

Keep Paper Size Choose On to use the paper size setting as the basis
for printing instead of other settings. The margin set-
ting of the printer menu will be used instead of the
margin setting of the printer driver if the latter is
smaller, which may prevent text or images in the mar-
gin from being printed.

Choose Off to give priority to margin settings. The
larger value is used if the margin specified in the
printer driver does not match the margin in the printer
menu.

TrimEdge Reload Specify whether to trim the leading edge of the cur-
rently retracted roll when the roll is advanced. Cut the
edge if you are concerned about any marks left on the
roll when the roll is left in the retracted position.
Specify On to have rolls cut when printing begins af-
ter Sleep mode or when the power is restored. Select-
ing Automatic will trim the edge when the roll has
been in the retracted position for two days or more.

Rep.P.head Print Choose On to have the printer automatically execute
the Advanced Adj. operations after you replace the
Printhead.  (See "Automatic Adjustment to Straight-
en Lines and Colors (Head Posi. Adj.).") →P.827

Nozzle Check In Frequency, specify the timing for automatic
checks of nozzle clogging. Choose Standard to have
the printer adjust the timing for checks based on the
frequency of nozzle use. Choose 1 page to check once
per page.
Select Warning > On to display warnings if the noz-
zles clog during printing.

Use RemoteUI Choosing Off prohibits access from RemoteUI. Set-
tings can only be configured from the control panel.

Control Panel > Printer Menu >
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Setting Item Description, Instructions
System
Setup

Reset PaprSetngs Restores settings that you have changed with Media
Configuration Tool to the default values.

Erase
HDD
Data

High Speed Erases file management data for print job data stored
on the printer's hard disk.  (See "Erasing Data on the
Printer's Hard Disk.") →P.886

Secure High Spd. Overwrites the entire hard disk with random data.
 (See "Erasing Data on the Printer's Hard Disk.")
→P.886

Secure Overwrites the entire hard disk with 00, FF, and ran-
dom data (one time each). Verification is performed to
check if the data was correctly written.  (See "Erasing
Data on the Printer's Hard Disk.") →P.886

Output
Meth-
od

Print Select the printing method for jobs received from soft-
ware other than the printer driver. When using the
printer driver, configure settings on the printer.
To print as usual, select Print. Selecting Print (Auto
Del) will print the job and then delete the data from
the printer's hard disk. Selecting Save: Box 01 will
only save the print job in the box, without printing it.

Print (Auto Del)

Save: Box XX

Print After Recv A setting for jobs received from software other than
the printer driver. When using the printer driver, con-
figure settings on the printer. Select On to print the
job after it has been saved.

Common Box Set. Select Print (Auto Del) to print without saving jobs
in the box shared among multiple users.

Show Job Log Selecting Off prevents display of the log in Job
Menu > Job Log. Additionally, the log is not printed
if you choose Job Menu > Print Job Log. Note that
because job logs are not collected, the Status Monitor
accounting functions will not work correctly.

Prep.MovePrinter When transferring the printer to another location,
choose the level of transfer and follow the instructions
on the screen.  (See "Preparing to Transfer the Print-
er.") →P.1003
Not displayed during a warning message that the re-
maining Maintenance Cartridge capacity is low.

Admin.
Menu

Change Password By setting a password, you can restrict menu display
and configuration as follows. Enter a number in the
range 0–9999999.

• Viewing and configuration by administrators
only
IPv4 Settings
Change Password
Init.Admin.Pswd

• Viewing and configuration by
administrators, and only viewing by other
users
Interface Setup settings (except IPv4 Settings )
Date & Time
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Setting Item Description, Instructions
Admin.
Menu

Change Password Date Format
Time Zone
Use RemoteUI
Reset PaprSetngs
Common Box Set.

Init.Admin.Pswd Choose OK to restore the Admin. Menu password to
the default values.

Printer
Info

Paper Info Indicates the current paper size, type, and related
printer settings.

Ink Info Indicates ink levels and maintenance cartridge capaci-
ty.

System Info Indicates the firmware version, serial number, and in-
terface information.

Error Log Indicates the most recent error messages (up to five).

Other Counter Indicates the total printing volume of the printer.

*1: A rough estimate of how much ink was consumed per job is displayed. Actual ink consumption may be differ-
ent. The average margin of error for estimates calculated according to Canon measurement conditions for ink
costs is ±15%. Canon does not guarantee the accuracy of these estimates. Estimates may vary depending on
conditions of use. Calculation of these estimates does not include ink consumed when cleaning printheads by
forceful ejection of ink.

Menu Settings (During Printing)
Menu items are described in the following tables.
For instructions on selecting menu items, see "Menu Operations." →P.901
For details on menu levels and values, see "Menu Structure." →P.904

Ink Menu

Setting Item Description, Instructions

Rep. Ink Tank Replace the Ink Tank at this point. Follow the instructions displayed to complete
the required procedure.  (See "Replacing Ink Tanks.") →P.972

Head Cleaning A Clean the Printhead.  (See "Cleaning the Printhead.") →P.981
Execute Head Cleaning A if printing is faint, oddly colored, or contains foreign
substances.

Job Menu

Setting Item Description, Instructions

Print Job Job List (Choose a
print job)

Delete Delete the current job or queued
jobs.  (See "Managing the Job
Queue (Deleting or Preempt-
ing Other Jobs).") →P.724
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Setting Item Description, Instructions
Print Job Job List (Choose a

print job)
Preempt Jobs Print the job first after the cur-

rent print job is finished.  (See
"Managing the Job Queue
(Deleting or Preempting Other
Jobs).") →P.724

Print Anyway Displayed when a job being held
is selected.  (See "Managing
Pending Jobs (Printing or De-
leting Jobs on Hold).")
→P.727

Stored Job Mailbox List (Enter a pass-
word if one
has been set.)

Job List Print Print the saved job.

Delete Delete the saved job.

Print Job List Print a list of saved print jobs.

Job Log (Choose from
information
about the last
three print
jobs.)

Document Name Indicates the document name of
the selected print job.

User Name Indicates the name of the user
who sent the print job.

Page Count Indicates the number of pages in
the job.

Job Status Indicates the printing results.

Print Start Time Indicates when the print job was
started.

Print End Time Indicates when the print job was
finished.

Print Time Indicates the time required to
print the job.

Print Size Indicates the paper size in the
print job.

Media Type Indicates the type of paper in the
print job.

Interface Indicates the interface used for
the print job.

Ink Consumed Indicates a rough estimate of
how much ink was consumed
per job.(*1 →P.926 )

Print Job Log Print a record of print jobs, in-
cluding the paper type and size,
amount of ink consumed, and so
on. Ink consumption indicates a
rough estimate of the amount of
ink consumed per print job.
(*1 →P.926 )

Pause Print If you set this option to On,
printing is stopped at that point
and the printer enters a state in
which printing is paused.
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Setting Item Description, Instructions

HDD Information Indicates the total hard disk ca-
pacity and the mail box free
space.

*1: A rough estimate of how much ink was consumed per job is displayed. Actual ink consumption may be different.
The average margin of error for estimates calculated according to Canon measurement conditions for ink costs is
±15%. Canon does not guarantee the accuracy of these estimates. Estimates may vary depending on conditions
of use. Calculation of these estimates does not include ink consumed when cleaning printheads by forceful ejec-
tion of ink.

Set./Adj. Menu

Setting Item Description, Instructions

Adj. Fine Feed Displayed when you have selected Feed Priority > Adj.
Priority > Automatic or Print Quality. Fine-tune the feed
amount manually.

Printer Info Paper Info Indicates the current paper size, type, and related printer
settings.

Ink Info Indicates ink levels and maintenance cartridge capacity.

Head Info Indicates the model name, serial number, number of days
used, and dot count of the current printhead

System Info Indicates the firmware version, serial number, and interface
information.

Error Log Indicates the most recent error messages (up to five).

Other Counter Indicates the total printing volume of the printer.

Status Print
You can print a Status Print report indicating the current status of the printer.
With Status Print, information is printed regarding the printer firmware version, various settings, and the status of consum-
ables.

Printing Status Print reports

1. Load paper.
When using sheets, load paper of A4/Letter size. You will need at least four sheets.
The required sheet quantity varies depending on the execution log quantity of unique calibration.

2. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select Settings/Adj. tab ( ).

Control Panel > Printer Menu >
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Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Test Print, and then press the OK button.

5. Press ▲ or ▼ to select Status Print, and then press the OK button.

Checking the information in Status Print reports
The following information is included in Status Print reports.

Canon imagePROGRAF iPFxxxx Status Print Printer model

Firm Firmware version

Boot Boot ROM version

MIT(DBF) MIT database format version

MIT(DB) MIT database version

S/N Printer serial number

Date Indicates when the status print report was prin-
ted.

Paper Menu Information on the loaded paper.

 Paper Type

 Roll Media

Cut Sheet

ManageRemainRoll

Keep Paper Type

Job Menu Job-related information.

 Job Log A counter for maintenance purposes.
Various information about previous jobs.

HDD Information Indicates the total hard disk capacity and the mail box free
space. Total capacity

Box free space

Set./Adj. Menu Settings and adjustment information.

 System Setup Printer system settings, as well as settings re-
garding warnings and errors. Sleep Timer

Buzzer

Contrast Adj.

Date Format

Control Panel > Printer Menu >
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  Language Printer system settings, as well as settings re-
garding warnings and errors.

Time Zone

Length Unit

Detect Mismatch

Paper Size Basis Paper-related settings.

 Roll Selection 1

Roll Selection 2

Keep Paper Size

TrimEdge Reload

Rep.P.head Print Settings after a test pattern was printed follow-
ing head replacement.

Show Job Log Show Job Log settings.

Nozzle Check Nozzle-check settings.

 Frequency

Warning

Use RemoteUI Settings used by RemoteUI.

Output Method Print job settings.

Print After Recv

Common Box Set.

Adjust Printer Adjustment settings.

 Head Posi. Adj. A counter for maintenance purposes.
Head position adjustment values for previous
jobs. Adjust Log

Calibration Color calibration settings.

 Calibration Log (Common Cali-
bration)

A record of when common calibration was
performed.

 Date Indicates the date when calibration was per-
formed and the type of paper used.Paper Type

Use Adj. Value A setting value indicating whether color cali-
bration adjustment values are to be applied to
printing.

Set Exec. Guide A setting value indicating whether to display a
message recommending the execution of color
calibration.

Printer Info Ink information, RAM usage, and a record of
errors.

 Ink Info Ink-related information.

 MC Maintenance Cartridge capacity (%)

GY, MBK, PC, Y, C, M, PM, BK Ink levels.
The remaining ink is displayed in a five-level
scale.

System Info Indicates the total amount of RAM.
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   Indicates the total amount of RAM.RAM

Error Log The past five error codes.

HEAD LOT NUMBER Printhead lot number.

 LOT L: R:

PARTS STATUS Utilization status of replacement parts that require servic-
ing. COUNTER

COUNTER Utilization status of the cutter, media, and other items (indi-
cating how much they have been used). CUTTER

MEDIA

 LIFE TTL

LIFE ROLL

LIFE CUTSHEET

MEDIA 1-7,OTHER

 NAME

TTL

ROLL

CUTSHEET

AFTER INSTALLATION

DUTY Counters for maintenance purposes. Needed when service
is requested. UNIT:m2

UNIT:sq.f

UNIT:A4 Sheet

UNIT:Letter Sheet

Set./Adj. Menu Settings and adjustment information.

 Adjust Printer Adjustment settings.

 Calibration Color calibration settings.

 Calibration Log (Unique Calibra-
tion)

A record of when unique calibration was per-
formed.

 No. Log number.

Paper Type Indicates the date when calibration was per-
formed and the type of paper used.Date

Printing Interface Setting Reports
You can print an Interface Print report indicating the current interface settings values of the printer.
Interface Print reports indicate settings values for TCP/IP, NetWare, and other settings.
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Printing Interface Print reports

1. Load the paper.
If using sheets, load paper A4/Letter-sized, you will need at least three sheets.

2. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Test Print, and then press the OK button.

5. Press ▲ or ▼ to select Interface Print, and then press the OK button.

Confirming Interface Print information
The following information is included in the Interface Print report.

Canon imagePROGRAF iPFxxxx Interface Print Printer model

Firm Firmware Version

Boot Boot ROM Version

MIT(DBF) MIT Database Format Version

MIT(DB) MIT Database Version

S/N Printer serial number

Date The date when the interface setup print report
was printed.

EOP Timer Specify the timeout period before cancellation
of print jobs that cannot be received by the
printer.

TCP/IPv4 Frame Type IPv4 settings values.

Use DHCP

Use BOOTP

Use RARP

Enable DNS Dynamic Update

Control Panel > Printer Menu >
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TCP/IPv4 Use Zeroconf Function IPv4 settings values.

IP Address

Subnet Mask

Gateway Address

LPD Printing

IPP Printing

IPP Printer URI

RAW Printing

Raw Mode Bi-direction

FTP Printing

Use Discovery

Scope

Primary DNS Server Address

Secondary DNS Server Address

DNS Host Name

DNS Domain Name

MulticastDNS ServiceName

SNMPv1

SNMPv3

TCP/IPv6 Use IPv6 IPv6 settings values.

Use DHCPv6 Stateful Address

Prefix Length

Primary DNS Server Address

Secondary DNS Server Address

Use a stateless address Stateless Address 1

Prefix Length 1

Stateless Address 2

Prefix Length 2

Stateless Address 3

Prefix Length 3

Stateless Address 4

Prefix Length 4

Stateless Address 5

Prefix Length 5

Stateless Address 6

Prefix Length 6

Use a link-local Address Link-Local Address

Prefix Length

Control Panel > Printer Menu >
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TCP/IPv6 Use a manual address IP Address IPv6 settings values.

Prefix Length

Default Router Address

Prefix Length

Primary DNS Server Address

Secondary DNS Server Address

Use the same host name and do-
main name as IPv4

DNS Host Name

DNS Domain Name

Perform dynamic updating of stateful addresses

Dynamically update the stateless address

Dynamically update the manual address

NetWare Frame Type NetWare settings
values.IPX External Network Number

Node Number

Print Application

Bindery PServer File Server Name

Print Server Name

Print Server Password

Polling Interval

RPrinter Print Server Name

Printer Number

NDS PServer Tree Name

Context Name

Print Server Name

Print Server Password

Polling Interval

NPrinter Print Server Name

Printer Number

AppleTalk Phase Type AppleTalk settings
values.Name

Network Number

Zone

Network Interface Physical Interface Network interface
settings values.Transmission Rate

MAC Address

Auto Detect

Communication

Ethernet Type

Control Panel > Printer Menu >
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Network Interface Spanning Tree Network interface
settings values.

Use the Jumbo Frame Function

Control Panel > Printer Menu >
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Network Setting

Network Environment 935

Using RemoteUI 938

Initial Settings 941

NetWare Settings 950

Mac OS X Settings 960

Other Settings 967
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Network Environment
Network Environment ...................................................................................................................................... 935

Network Environment

System requirements
The system requirements, which vary depending on your network, are as follows.

• Printing over a TCP/IP network (when using IPv4)

• Compatible operating systems

• Windows XP (Home Edition or Professional)
• Windows Server 2003 (Standard Edition)
• Windows Vista (Home Basic/Business/Ultimate)
• Windows Server 2008 (Standard Edition or Enterprise Edition)
• Windows 7
• Windows XP Professional x64 Edition
• Windows Server 2003 x64 Edition
• Windows Vista x64
• Windows Server 2008 x64
• Windows 7 x64
• Mac OS X 10.2.8 or later
• Unix (Solaris 9)
• Unix (Red Hat 9)

• Compatible computer

• A computer that runs one of the above operating systems

• Printing over a TCP/IP network (when using IPv6)

• Compatible operating systems

• Windows Vista (Home Basic/Business/Ultimate)
• Windows Server 2008 (Standard Edition or Enterprise Edition)
• Windows 7
• Windows Vista x64
• Windows Server 2008 x64
• Windows 7 x64
• Mac OS X 10.3.9 or later

Note
• When using IPv6, you must specify IPv6 on the Control Panel or in RemoteUI. For instructions, see

"Configuring TCP/IPv6 Network Settings." →P.944  or see "Configuring the Printer's TCP/IP Net-
work Settings With RemoteUI ." →P.946

• The imagePROGRAF printer driver is supported in Mac OS X 10.4.11 or later.
• The imagePROGRAF printer driver is not compatible with Unix.

Network Setting > Network Environment >
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• Printing over an AppleTalk network

• Compatible operating systems

• Mac OS X 10.2.8–10.4
• Compatible computer

• A computer that runs one of the above operating systems

Note
• The printer cannot be used over a LocalTalk network.
• Compatible with EtherTalk Phase 2.
• The imagePROGRAF printer driver is not compatible with AppleTalk.

• Printing over a NetWare network

• Compatible servers

• Novell NetWare 4.2/5.1/6.0
• Compatible clients

• Windows XP (Professional)
• Compatible computer

• A computer that runs one of the above operating systems

Note
• In NetWare 6.0, iPrint is not supported.

Network Environment
After confirming what type of network environment you will connect the printer to, set up the printer and computers as
needed.

• Example of a Windows network
In Windows networks, print over TCP/IP.

Note
• NetBIOS is not supported.

Network Setting > Network Environment >
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• Example of a Macintosh network
In Macintosh networks, print over AppleTalk (EtherTalk) or TCP/IP, using Bonjour (Zeroconf) functions.

Note
• The imagePROGRAF printer driver is not compatible with AppleTalk.

• Example of a NetWare network

Note
• Even if there is a NetWare server in your network environment, you can use it in conjunction with TCP/

IP or AppleTalk. In this case, complete the settings for each protocol you will use.

Network Setting > Network Environment >
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Using RemoteUI
Using RemoteUI ............................................................................................................................................. 938

Using RemoteUI
RemoteUI is software with which you can access the printer via the network from your Web browser to confirm the printer
status, operate jobs, and configure the settings. Since the software (Web server) for using RemoteUI is built in the printer,
preparing software other than a Web browser is unnecessary. You can use RemoteUI if an imagePROGRAF printer on a
network is connected to your computer. If you start your Web browser and specify the IP address of the printer, the Remo-
teUI screen is displayed, and you can use RemoteUI.

Important
• To use RemoteUI, an IP address must be set on the printer in advance. For the method of setting an IP ad-

dress, see "Configuring the IP Address on the Printer." →P.941

What You Can Do With RemoteUI
With RemoteUI, you can access the printer via a network, configure network settings, and display the current status of the
printer, various types of information, the processing status of jobs, etc.

Starting RemoteUI
Start RemoteUI by the following operations.

1. Start your Web browser.

2. Enter the following URL in Address or Location.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

Network Setting > Using RemoteUI >
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3. The RemoteUI screen is displayed.

Note
• The screen slightly differs depending on the model of printer.

Configuring the Network With RemoteUI
For details on configuring printer settings for networks, refer to the following topics.

• Configuring the Printer's TCP/IP Network Settings With RemoteUI →P.946

• Configuring the Printer's AppleTalk Network Settings →P.965

• Configuring the Printer's NetWare Network Settings With RemoteUI →P.957

• Specifying Printer-Related Information →P.967
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Important
• For the Web browser, use Netscape Navigator 6.0 or later, Internet Explorer 5.01 or later, or Firefox 1.5 or

later. For Mac OS X, Safari 1.32 or later or 2.03 or later also is supported.
• This cannot be used connected via a proxy server. In environments where a proxy server is used, add the

printer's IP address to Exceptions (addresses accessed without a proxy server) in the web browser proxy
server settings. (Settings may vary depending on the network environment.)

• Enable JavaScript and cookies in the web browser.
• If you access RemoteUI with the printer name instead of its IP address, make sure the DNS settings are cor-

rectly configured.
• Depending on the network environment, you may not be able to start RemoteUI.
• Confirm whether System Setup > Use RemoteUI is set to On on the Control Panel of the printer.

Note
• RemoteUI also offers many other features. You can display the ink levels, check error messages and other

status information, and cancel print jobs.
• By factory default, the English screen is displayed. To change the display language, select the desired lan-

guage under Language before logging on in administrator mode.
• If you login in Administrator Mode, you can configure to use the Jumbo Frame function in the Network

page. However, this function might not be able to be used depending on the network environment.
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Configuring the IP Address on the Printer
You must configure the printer's IP address before using the printer in a TCP/IP network.
The printer's IP address is configured automatically when you install the printer driver following the instructions in the Set-
up Guide.
Configure the IP address by using imagePROGRAF Device Setup Utility, the printer Control Panel, or ARP or PING com-
mands, if the IP address is changed, or if you change the printer connection mode to a network connection. For details on
configuring the IP address, refer to the following topics.

• Configuring the IP Address Using imagePROGRAF Device Setup Utility →P.442  (Windows)
• Configuring the IP Address Using the Printer Control Panel →P.942

• Configuring the IP Address Using ARP and PING Commands →P.943

Important
• If you use a DHCP server for automatic assignment of the printer's IP address, printing may no longer be

possible after the printer is turned off and on. This is because an IP address different from before has been
assigned. Thus, when using DHCP server functions, consult your network administrator and configure the
settings in one of the following ways.

• Configure the setting for dynamic DNS updating
In the printer menu, either set DNS Dync update to On, or activate the setting Enable DNS Dynamic
Update in RemoteUI.
 (See "Menu Settings.") →P.914
 (See "Configuring the Printer's TCP/IP Network Settings With RemoteUI .") →P.946

• Configure the setting for assignment of the same IP address each time the printer starts up

Note
• We recommend configuring the printer's IP address even if you will use the printer in networks other than

TCP/IP networks. Configuring the printer's IP address enables you to use RemoteUI to configure the network
settings and manage the printer with a web browser.
For details on RemoteUI, see "Using RemoteUI ." →P.938
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Configuring the IP Address Using the Printer Control Panel
This topic describes how to configure the printer's IP address on the Control Panel.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4. Press ▲ or ▼ to select TCP/IP, and then press the OK button.

5. Press ▲ or ▼ to select IPv4, and then press the OK button.

6. Press ▲ or ▼ to select IPv4 Settings, and then press the OK button.

7. Press ▲ or ▼ to select IP Address, and then press the OK button.

8. After you press ◀ or ▶ to select the input field, numerical input is possible.

9. Press the ▲ or ▼ button to enter the value.

Note
• Hold down ▲ to increase the value continuously. However, 0 follows 2 for digits of 100 and 0 fol-

lows 9 for digits of 10 and 1.
• Hold down ▼ to decrease the value continuously. However, 2 follows 0 for digits of 100 and 9 fol-

lows 0 for digits of 10 and 1.
• Hold down ▲ or ▼ to increase or decrease the value continuously.
• Make sure the IP address you enter for the printer is not the same as any computer IP address in your

network.

10. Repeat steps 8 and 9 to complete the settings, and then press the OK button.
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11. Press the Menu button.
If you have changed the settings, a confirmation message is displayed. Press ▲ or ▼ to select Yes, and then press
the OK button.

Important
• Be sure to complete step 11. This will activate the values you have entered.
• If an error message is displayed, check the settings and correct any invalid values.

Note
• You can also specify the subnet mask and default gateway on the Control Panel.
• The DNS can also be configured from the printer Control Panel.

Configuring the IP Address Using ARP and PING Commands
This topic describes how to configure the IP address using ARP and PING commands.
To use the ARP and PING commands, you will need to know the printer's MAC address. You can confirm the MAC ad-
dress on the Control Panel.

1. Check the printer's MAC address.
You can confirm the MAC address on the Control Panel as follows:

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4. Press ▲ or ▼ to select Ethernet Driver, and then press the OK button.

5. Press ▲ or ▼ to select MAC Address, and then press the OK button.

Note
• If the Tab Selection screen is not displayed, press the Menu button.
• You can investigate the MAC address by printing an interface setting report.

 (See "Printing Interface Setting Reports.") →P.929

2. In Windows, open a command prompt, or in Mac OS X, start Terminal.
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3. Execute the following command to add entries to the ARP table for managing IP addresses and corresponding MAC
addresses.
arp -s [IP address] [the printer's MAC address you have verified]
Example: arp -s xxx.xxx.xxx.xxx xx-xx-xx-xx-xx-xx

Note
• In Mac OS X when using Terminal, enter the arp command in the format

arp -s xxx.xxx.xxx.xxx xx-xx-xx-xx-xx-xx.
For details, refer to the help file for the command line.

4. Execute the following command to send the IP address to the printer and configure it.
ping [IP address as specified in the ARP command] -l 479
Example: ping xxx.xxx.xxx.xxx -l 479

Note
• In -l, the l is the letter l.
• In Mac OS X when using Terminal, enter the ping command in the format

ping -s 479 xxx.xxx.xxx.xxx.
For details, refer to the help file for the command line.

Note
• The subnet mask and default gateway are set to 0.0.0.0. Use RemoteUI to change the subnet mask and de-

fault gateway to match your network settings.
For details on RemoteUI, see "Using RemoteUI ." →P.938

Configuring TCP/IPv6 Network Settings
When printing in a TCP/IPv6 network, you must configure the TCP/IPv6 settings on the Control Panel.
Follow the steps below to configure the TCP/IPv6 network settings.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4. Press ▲ or ▼ to select TCP/IP, and then press the OK button.
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5. Press ▲ or ▼ to select IPv6, and then press the OK button.

6. Press ▲ or ▼ to select IPv6 Support, and then press the OK button.

7. Press ▲ or ▼ to select On, and then press the OK button.

Important
• Once you set IPv6 Support to On, the IPv6 StlessAddrs setting takes effect.

Note
• You can also configure IPv6 StlessAddrs and DHCPv6 from the printer Control Panel.
• The DNS can also be configured from the printer Control Panel.

Configuring the Printer Driver Destination (Windows)
This topic describes how to specify the printer driver destination if the printer's IP address is changed, or if you will use the
printer over a network connection instead of via USB connection.
The procedure described below is the configuration based on the LPR or Raw protocol using the standard TCP/IP port in
Windows ( Standard TCP/IP Port ).

Important
• If you will use the printer in a TCP/IP network, make sure the printer's IP address is configured correctly.

• Configuring the IP Address on the Printer →P.941

1. Open the Printers and Faxes (or Printers, Devices and Printers ) window.

2. Right-click the icon of this printer and choose Properties (For Windows 7 and Windows Vista, Printer Proper-
ties ) to open the printer properties window.

3. Click the Port tab to display the Port sheet.

4. Click Add Port to display the Printer Ports dialog box.

5. In the Available Port list, select Standard TCP/IP Port.

6. Click New Port.
After the wizard starts, a window is displayed for the Welcome to the Add Standard TCP/IP Printer Port Wiz-
ard.

7. Click Next.

8. In Printer Name or IP Address, enter the printer's IP address. If the DNS is configured, you can also enter the DNS
Domain Name.

9. Follow the instructions on the screen to add a printer port.
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10. Click Close to close the Printer Ports dialog box.

11. Make sure the printer port you added is displayed under Ports, and that the port is selected.

12. Click Close to close the printer properties window.

Configuring the Printer Driver Destination (Mac OS X)
Specify the printer driver destination as follows if the printer's IP address is changed, or if you will use the printer over a
network connection instead of via USB connection.

• If you switch to printing in a TCP/IP network, or if the printer's IP address is changed, see "Configuring the Destina-
tion in TCP/IP Networks ." →P.960

• If you switch to printing in a Bonjour network, see "Configuring the Destination for Bonjour Network ." →P.962

Configuring the Printer's TCP/IP Network Settings With RemoteUI
Follow the steps below to configure the TCP/IP network settings.

When using an IPv4 IP address

1. Start the web browser and enter the following URL in the Location (or Address ) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.

3. If a password has been set on the printer, enter the password.

4. Click Network in the Device Manager menu at left to display the Network page.

5. Click Edit in the upper-right corner of the TCP/IPv4 group to display the Edit TCP/IP Protocol Settings page.

6. Refer to the TCP/IP Settings Items table to complete the settings.

TCP/IP Settings Items
Item Details Default Setting

Use DHCP Activate this setting to use DHCP for configuring the IP address. Off

Use BOOTP Activate this setting to use BOOTP for configuring the IP address. Off

Use RARP Activate this setting to use RARP for configuring the IP address. Off

Enable DNS Dy-
namic Update

Activate this setting to perform DNS server registration automati-
cally.

Off

Use Zeroconf Func-
tion

Activate this setting to use Bonjour. On

IP Address Specify the printer's IP address. 0.0.0.0
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Item Details Default Setting

Subnet Mask Specify the printer's subnet mask. 0.0.0.0

Gateway Address Specify the printer's default gateway. 0.0.0.0

LPD Printing Activate this setting to use LDP Printing. On

IPP Printing Activate this setting to use IPP Printing. On

IPP Printer URI Specify the URI of the printer used for IPP printing using up to
252 characters.

printer

RAW Printing Activate this setting to use Raw Printing. On

RAW Mode Bi-di-
rection

Activate this setting to use Raw mode bidirectional communica-
tion.

Off

FTP Printing Activate this setting to use FTP Printing. On

Use Discovery Activate this setting to use SLP Discovery function. On

Scope Enter the SLP search range. default

SMTP Server Ad-
dress

Specify the SMTP server's IP address.
You can also specify the SMTP server domain name, if desired.

0.0.0.0

Primary DNS Serv-
er Address

Specify the IP address of the primary DNS server. 0.0.0.0

Secondary DNS
Server Address

Specify the IP address of the secondary DNS server. 0.0.0.0

DNS Host Name Specify the printer host name, up to 63 characters (1–63 charac-
ters). Use single-byte letters, numbers, and - (hyphens). Do not use
numbers or - for the first character or - for the last character.

NB-18GBipxxxxxx

DNS Domain Name Specify the printer domain name, up to 63 characters. Use single-
byte letters, numbers, - (hyphens), and . (periods). Do not use
numbers, -, or . for the first character, or - or . for the last charac-
ter.

blank

Multicast DNS Serv-
ice Name

Specify the printer's Multicast DNS service name. (1–63 charac-
ters)
This name will be displayed when Bonjour functions are used.

Canon iPFxxxx
(xxxxxx)

7. Click OK to display the Network page.

Note
• If you specify to configure the IP address using DHCP, BOOTP, or RARP, there must be a server that sup-

ports such protocol running in the network.
• If you specify to configure the IP address using DHCP, BOOTP, or RARP, the IP address obtained by this

method is used first. If you cannot obtain the IP address, the address specified in IP Address is used.
• It takes up to two minutes to determine whether DHCP, BOOTP, or RARP are available. We recommend

clearing check boxes of options you will not use.
• If you are using a DNS server, select Enable DNS Dynamic Update and enter the IP Address for DNS serv-

ers and DNS domain name in Primary DNS Server Address, Secondary DNS Server Address and DNS
Domain Name, respectively.
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When using an IPv6 IP address

1. Start the web browser and enter the following URL in the Location (or Address ) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.

3. If a password has been set on the printer, enter the password.

4. Click Network in the Device Manager menu at left to display the Network page.

5. Click Edit in the upper-right corner of the TCP/IPv6 group to display the Edit TCP/IPv6 Protocol Settings page.

6. Refer to the TCP/IPv6 Settings Items table to complete the settings.

TCP/IPv6 Settings Items
Item Details Default Setting

Use IPv6 Activate to enable IPv6. Off

Use DHCPv6 Activate when using a DHCPv6 server to acquire the
IP address.

Off

Use a stateless address Activate when using an IPv6-compatible router to ac-
quire the IP address.

On

Use a manual address Activate when configuring the IP address manually. Off

IP Address Enter the printer's IP address. ::

Prefix Length Enter the IP address prefix length. 0

Default Router Ad-
dress

Enter the default router address. ::

Prefix Length Enter the prefix length of the default router address. 0

Primary DNS Server Address Specify the IP address of the primary DNS server. ::

Secondary DNS Server Address Specify the IP address of the secondary DNS server. ::

Use the same host name and do-
main name as IPv4

Activate when using the same DNS host and domain
names as for IPv4.

Off

DNS Host Name Specify the printer host name, up to 63 characters (1–
63 characters). Use single-byte letters, numbers, and -
(hyphens). Do not use numbers or - for the first charac-
ter or - for the last character.

NB-18GBip6xxxxxx

DNS Domain Name Specify the printer domain name, up to 63 characters.
Use single-byte letters, numbers, - (hyphens), and . (pe-
riods). Do not use numbers, -, or . for the first charac-
ter, or - or . for the last character.

blank

Perform dynamic updating of
stateful addresses

Activate this setting to automatically register the state-
ful address with the DNS server.

Off

Dynamically update the stateless
address

Activate this setting to automatically register the state-
less address with the DNS server.

Off
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Item Details Default Setting

Dynamically update the manual
address

Activate this setting to automatically register the man-
ual address with the DNS server.

Off

7. Click OK to display the Network page.

Note
• If you are using a DNS server, select Enable DNS Dynamic Update and enter the IP Address for DNS serv-

ers and DNS domain name in Primary DNS Server Address, Secondary DNS Server Address and DNS
Domain Name, respectively.
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Configuring NetWare Network Settings
Follow these steps to configure the network environment when using the printer in a NetWare network.

Important
• To configure network settings, you must be logged in with administrative rights such as Administrator. We

recommend that your network administrator configure the network settings.

1. Configure the Ethernet frame type to be used in communication by the printer with the computer.
For details on configuring settings, see "Specifying the Printer's Frame Type." →P.951

2. Configure the NetWare print service such as the print server and queue.
For details on configuring settings, see "Specifying NetWare Print Services." →P.955

3. Configure the NetWare protocol details other than the frame type.
For details on configuring settings, see "Configuring the Printer's NetWare Network Settings With RemoteUI."
→P.957

After completing the settings of this procedure, configure the settings on each computer for printing in a NetWare
network.

4. Connect to the NetWare network.
Install the NetWare client software on all computers that are to perform printing, and log in to the NetWare server or
tree. For details on connecting, refer to the documentation for NetWare or your operating system.

5. Install the printer driver.
According to the instructions of your network administrator, install the printer driver on all computers that are to
perform printing. When installing, select Network Printer as the printer connection destination, and select the
queue created when configuring the NetWare print service.

6. Configure the printer port by the following procedure. If you configured the printer connection destination while
installing the printer driver, this procedure is unnecessary.

1. Open the Printers and Faxes (or Printers, Devices and Printers ) window.

2. Right-click the icon of this printer and choose Properties (For Windows 7 and Windows Vista, Printer Prop-
erties ) to open the printer properties window.

3. Click the Port (or Advanced ) tab to display the Port (or Advanced ) sheet.

4. Configure the print destination port to the print queue created when configuring the NetWare print service.
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Specifying the Printer's Frame Type
To enable communication between the printer and computers on your network, specify the Ethernet frame type in your Net-
Ware environment.
Follow the steps below to specify the frame type by using imagePROGRAF Device Setup Utility or the printer Control
Panel.

Important
• Before specifying the frame type, make sure the printer is on and connected to the network.

Note
• You can specify the frame type by using RemoteUI if the printer's IP address is configured.
• For instructions on installing imagePROGRAF Device Setup Utility, see "Installing imagePROGRAF De-

vice Setup Utility." →P.442 .

Specifying the frame type using imagePROGRAF Device Setup Utility

1. Start imagePROGRAF Device Setup Utility.

2. In the list of printers, select the printer to configure.

3. Choose Protocol Settings from the Printer menu.
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4. Click the NetWare tab and select the frame type in the NetWare Frame Type list.
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5. Select the IPv4 tab. In IP Address, enter the IP address assigned to the printer, and then enter the subnet mask in
Subnet Mask and the default gateway in Gateway Address.

Important
• You must specify the IP address here to be able to configure NetWare protocol settings using Remo-

teUI.

6. Click Set.

7. Click OK after the Confirmation message is displayed.

8. Exit imagePROGRAF Device Setup Utility.

Network Setting > NetWare Settings >

iPF6300S Specifying the Printer's Frame Type

10

953



Specifying the frame type using the printer Control Panel

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4. Press ▲ or ▼ to select NetWare, and then press the OK button.

5. Press ▲ or ▼ to select NetWare, and then press the OK button.

6. Press ▲ or ▼ to select On, and then press the OK button.
The display reverts to the NetWare menu.

7. Press ▲ or ▼ to select Frame Type, and then press the OK button.

8. Press ▲ or ▼ to select the frame type to use, and then press the OK button.
The display reverts to the NetWare menu.

9. Press ▲ or ▼ to select Print Service, and then press the OK button.

10. Press ▲ or ▼ to select the desired print service, and then press the OK button.
The display reverts to the NetWare menu.

11. Press the Menu button.
If you have changed any settings, a confirmation message is displayed. In this case, press the OK button.

Important
• Be sure to complete step 11. This will activate the values you have entered.
• If an error message is displayed, check the settings and correct any invalid values.
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Note
• To cancel this process, press the Back button.

Specifying NetWare Print Services
Before printing in a NetWare network, you must configure print services such as print servers, print queues, and so on. You
can configure the print service settings from a computer using any of the following Novell software provided with NetWare.

• NWADMIN
• PCONSOLE

Important
• If you use NWADMIN to configure the print service settings, Novell Client (the Novell NetWare client soft-

ware) must be installed as the client software application.
• NetWare networking is unsupported in Windows Vista, Windows Server 2008 and Windows 7.

This topic gives instructions for configuring NetWare print services. The order of this procedure may vary depending on the
environment.

Choosing the type of print services
Before completing print service settings, choose the type of print service. Refer to the following descriptions as needed.

Note
• In NetWare 5.1 or 6.0, NDPS may also be used as the print service. If you use NDPS, use the Novell printer

gateway included with NetWare. For details on configuring NDPS, refer to the NetWare documentation.

• NDS (Novell Directory Service) and bindery
NDS and bindery are both supported. Use the mode that is compatible with your network environment.

• Queue server mode and remote printer mode
Queue server mode and remote printer mode are both supported.

• Queue server mode
When using queue server mode, all print server functions are supported, so there is no need for other print server
software or hardware. In NDS queue server mode (NDS PServer), the NDS print server is used for printing. In
bindery queue server mode (Bindery PServer), the bindery print server is used for printing. Note that if you use
queue server mode, a NetWare user license is required for each network interface.

• Remote printer mode
In remote printer mode, the printer is controlled by the NetWare print server. Thus, a NetWare print server is re-
quired. In NDS remote printer mode (NPrinter), the NDS print server is used for printing, and in bindery remote
printer mode (RPrinter), the bindery print server is used for printing.

Using NWADMIN or PCONSOLE to set up the print server
Use NWADMIN to set up the print server if NDS queue server mode or remote printer mode is used.

1. Log into NetWare as Administrator or with equivalent rights, and then start NWADMIN.

2. Run Quick Setup.

1. Choose Print Services Quick Setup in the Tools menu.
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2. Enter a desired name in Print Server Name. To use an existing print server, click the button at right and
choose the name from the list.

3. Enter a desired printer name in Name.

4. To use the printer in queue server mode, choose Other/Unknown in Type. To use the printer in remote printer
mode, choose Parallel in Type, click Communications, and set Ports to LPT1 and Connection Type to
Manual Load.

5. Enter a desired queue name in Name.

6. In Volume, enter the volume object (that is, the object representing the physical volume on the network) where
the print queue will be created. Click the button at right to choose from a list.

7. Complete other settings as needed and click OK.

Note
• The print server name will be required when configuring the printer's protocol settings. Write down

the print server name for future reference.
• When running Quick Setup, the printer is assigned printer number 0. When using the printer in queue

server mode, do not change the printer number from 0.

3. Set a password.

1. Right-click the print server created in step 2 and choose Details.

2. Click Change Password to open the password input dialog box. Enter the password.

3. Click OK to close the password input dialog box.

4. Click OK or Cancel to close the details dialog box.

4. To use the printer in remote printer mode, start the print server.
To use the NetWare file server as the print server, enter LOAD PSERVER.NLM at the file server and press the
Enter key.

Note
• This procedure is not required when using queue server mode.

Use PCONSOLE to set up the print server if bindery queue server mode or remote printer mode is used.

1. Log into NetWare as Admin and start PCONSOLE.

2. Switch to bindery mode.

3. If the print server has not been created, create it.

1. In Available Options, select Quick Setup, and press the Enter key.

2. Enter the name of the new print server, the new printer, and the queue.

Note
• The print server name will be required when configuring the printer's protocol settings. Write down

the print server name for future reference.
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4. Specify the printer type.

1. To use the printer in queue server mode, choose Other/Unknown in Type. To use remote printer mode, set
Printer Type to Parallel and Position to Manual Load.

2. Press the Esc key.

3. After the confirmation message is displayed, choose Yes and press the Enter key.

5. Set a password.

1. In Available Options, select Print Servers and press the Enter key.

2. Select the print server created in step 2 and press the Enter key.

3. Select Password, and press the Enter key to display the password input dialog box.

4. Enter the password and press the Enter key.

6. Press the Esc key several times to display the dialog box for confirming that PCONSOLE is finished.

7. Click Yes to exit PCONSOLE.

Configuring the Printer's NetWare Network Settings With RemoteUI
Follow the steps below to configure NetWare protocol settings other than the frame type by using RemoteUI.

Note
• For details on RemoteUI, see "Using RemoteUI ." →P.938

1. Start the web browser and enter the following URL in the Location (or Address ) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.

3. If a password has been set on the printer, enter the password.

4. Click Network in the Device Manager menu at left to display the Network page.

5. Click Edit in the upper-right corner of the NetWare group to display the Edit NetWare Protocol Settings page.

6. Refer to the NetWare Settings Items table to complete the settings.

NetWare Settings Items

Item Details Default
Setting

Frame Type Specify the type of frame to use in NetWare. Disabled

NCP Burst Mode Activate this setting to use NCP Burst Mode. On
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Item Details Default
Setting

NCP Burst Mode This mode supports fast data transfer when printing in queue
server mode. Normally, leave the setting On.

On

Print Application Choose the print service.
The print service selected here is enabled. Multiple print services
cannot be enabled simultaneously.

• Bindery PServer

• RPrinter

• NDS PServer

• NPrinter

NDS
PServer

Packet Signature Select If Requested by Server to use packet signature. If Re-
quested
by Server

Bindery PSer-
ver

File Server
Name

Specify the name of a file server that has a NetWare print server.
(0–47 characters)

—

Print Server
Name

Specify the name of a NetWare print server.
(0–47 characters)

—

Print Server
Password

Set a password for the print server.
(0–20 characters)

—

Polling Interval Specify the interval to confirm jobs.
(1–15 seconds)

5

RPrinter Print Server
Name

Specify the name of a NetWare print server.
(0–47 characters)

—

Printer Number Specify the number of the printer connected to the NetWare print
server.
(0-15)

0

NDS PServer Tree Name Specify the name of an NDS tree that has a NetWare print server.
(0–32 characters)

—

Context Name Specify the name of a context that has a NetWare print server.
(0–255 characters)

—

Print Server
Name

Specify the name of a NetWare print server.
(0–64 characters)

—

Print Server
Password

Set a password for the print server.
(0–20 characters)

—

Polling Interval Specify the interval to confirm jobs.
(1–255 seconds)

5

NPrinter Print Server
Name

Specify the name of a NetWare print server.
(0–47 characters)

—

Printer Number Specify the number of the printer connected to the NetWare print
server.
(0-254)

0

7. Complete the following settings based on the selected service.

• If you have selected Bindery PServer: Queue Server Mode (Using a Bindery Print Server)

1. In File Server Name, enter the file server name.
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2. In Print Server Name, enter the name of the print server created in "Specifying NetWare Print Serv-
ices →P.955 ."

3. In Print Server Password, enter the password of the print server created in "Specifying NetWare Print
Services →P.955 ."

4. In Polling Interval, specify the interval at which the printer checks the NetWare print queue.

• If you have selected RPrinter: Remote Printer Mode (Using a Bindery Print Server)

1. In Print Server Name, enter the advertising name of the print server created in "Specifying NetWare
Print Services →P.955 ."

2. In Printer Number, enter the same printer number specified in "Specifying NetWare Print Serv-
ices →P.955 ."

• If you have selected NDS PServer: Queue Server Mode (Using an NDS Print Server)

1. In Tree Name and Context Name, enter the tree and context name of the print server.

2. In Print Server Name, enter the name of the print server created in "Specifying NetWare Print Serv-
ices →P.955 ."

3. In Print Server Password, enter the password of the print server created in "Specifying NetWare Print
Services →P.955 ."

4. In Polling Interval, specify the interval at which the printer checks the NetWare print queue.

• If you have selected NPrinter: Remote Printer Mode (Using a NDS Print Server)

1. In Print Server Name, enter the advertising name of the print server created in "Specifying NetWare
Print Services →P.955 ." Usually, the advertising name is the same as the name of the print server.

2. In Printer Number, enter the same printer number specified in "Specifying NetWare Print Serv-
ices →P.955 ."

8. Click OK to display the Network page.
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Mac OS X Settings
Configuring the Destination in TCP/IP Networks ............................................................................................ 960
Configuring the Destination for Bonjour Network ........................................................................................... 962
Configuring the Destination for AppleTalk Networks ...................................................................................... 964
Configuring the Printer's AppleTalk Network Settings ..................................................................................... 965

Configuring the Destination in TCP/IP Networks
Follow these steps to configure the destination when using the printer in a TCP/IP network.

Important
• If you use the printer in a TCP/IP network, make sure the printer's IP address is configured correctly.  (See

"Configuring the IP Address Using the Printer Control Panel.") →P.942

Configuring the Destination (Mac OS X)

1. Navigate to Applications > Canon Utilities > imagePROGRAF PrinterSetup and double-click imagePROGRAF
PrinterSetup.app.

2. Click Next.
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3. Click Registering IP Address.

4. Select the model and type and then enter the IP address before clicking the Next button.

5. Complete Printer Name and Location as desired and click Register.
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6. Click Finish.

Configuring the Destination for Bonjour Network
Follow the steps below to configure the destination if you are using the printer in a network that uses the Bonjour function.

Important
• Bonjour and IP Print (Auto) do not support printing to a printer on other network groups that require a rout-

er for connection. Make sure the computer and printer are on the same network. For information about net-
work settings, ask your network administrator.

• By default, Bonjour is activated on the printer. You can activate or deactivate the Bonjour function or change
the printer name by using RemoteUI. For instructions on changing it, see "Using RemoteUI ." →P.938

1. Navigate to Applications > Canon Utilities > imagePROGRAF PrinterSetup and double-click imagePROGRAF
PrinterSetup.app.

2. Click Next.
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3. Select the printer to register and click Next.

4. Complete Printer Name and Location as desired and click Register.

5. Click Finish.
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Configuring the Destination for AppleTalk Networks
To print over an AppleTalk network, activate the AppleTalk protocol and configure the destination as follows.

Activating AppleTalk on the printer

Important
• By default, the AppleTalk protocol is disabled on the printer.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4. Press ▲ or ▼ to select AppleTalk, and then press the OK button.

5. Press ▲ or ▼ to select On, and then press the OK button.

6. Press the Menu button.
If you have changed any settings, a confirmation message is displayed. In this case, press the OK button.

Important
• Be sure to complete step 6. This will activate the values you have entered.

Note
• By using RemoteUI, you can also specify the object name used for AppleTalk, as well as the printer zone

name.
For details on RemoteUI, see "Using RemoteUI ." →P.938
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Configuring the Destination (Mac OS X)

Important
• AppleTalk is supported in Mac OS X 10.2.8–10.4.

Note
• The following procedures are based on Mac OS X 10.4. The method of configuring the destination varies

depending on the version of Mac OS X.
• The imagePROGRAF printer driver is not compatible with AppleTalk.

1. In System Preferences, click Network to display the Network window.

2. In Show, choose Built-in Ethernet. Next, click AppleTalk, select Make AppleTalk Active, and click Apply now.

3. Close the Network window and save the settings.

Configuring the Printer's AppleTalk Network Settings
Follow the steps below to configure the AppleTalk network settings.

1. Start the web browser and enter the following URL in the Location (or Address ) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.
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3. If a password has been set on the printer, enter the password.

4. Click Network in the Device Manager menu at left to display the Network page.

5. Click Edit in the upper-right corner of the AppleTalk group to display the Edit AppleTalk Protocol Settings page.

6. Refer to the AppleTalk Settings Items table to complete the settings.

AppleTalk Settings Items
Item Details Default Setting

Phase
Type

Specify whether to use AppleTalk.
If you will use AppleTalk, choose Phase 2.
If you will not use AppleTalk, choose Disabled.

Disabled

Name
(*1)

Specify the object name used by AppleTalk (in up to 31 single-byte or 15 double-
byte characters).
However, do not use the following single-byte characters: @, *, :, and =.

Canon
NB-18GB
(xxxxxx)

Zone (*2) Specify the printer zone name, up to 31 single-byte characters.
However, do not use the following single-byte characters: Also avoid using * (which
represents the default zone) in the middle of a string.

*

*1:  The object name you have specified in Name is displayed in Printer Setup Utility (or Print Center ) in Mac
OS X 10.2.8–10.4. If you use multiple printers in the same zone, assign a unique name to each printer. By de-
fault, the network interface name is Canon NB-18GB (xxxxxx). (Here, xxxxxx is the last six digits of the print-
er's MAC address.)

*2:  If zones have been created on the network, enter the name of the printer's zone. If there are no zones, leave the
asterisk * entry (for the default zone) as it is. If you enter a network zone name that does not match created
zones, the printer will not be detected by Macintosh computers. Consult your network administrator for informa-
tion on zone names.

7. Click OK to display the Network page.
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Other Settings
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Specifying Printer-Related Information
Follow the steps below to specify device information and security settings.

1. Start the web browser and enter the following URL in the Location (or Address ) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.

3. If a password has been set on the printer, enter the password.

4. Click Information in the Device Manager menu at left to display the Information page.

5. To display the relevant settings page, click Edit in the upper-right corner of Device Information or Security, de-
pending on what information you want to specify.
To change the administrator password, click the Change Password button in the Security group.

6. Refer to the table of settings for device information and security as you complete these settings.
Security setting items are displayed when you click the Change Password button in the Security group.

Device Information Settings
Item Details Default Setting

Device Name Enter a device name.
(0–32 characters)

blank

Location Enter the location where the device is installed.
(0–32 characters)

blank

Administrator Enter the administrator's name.
(0–32 characters)

blank

Phone Enter the administrator's contact information.
(0–32 characters)

blank

Comments(E-mail) Enter any comments regarding the administrator.
(0–32 characters)

blank

Security Settings
Item Details Default Setting

New Password Enter the new password.
(0-9999999)

blank

Confirm Enter the new password again to confirm it.
(0-9999999)

blank
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*1: On the Security settings screen, besides entering a password, you can specify other security-related information,
such as IP address-based SNMP or TCP usage restrictions, MAC address-based access restrictions, or IPP and
FTP authentication settings.

7. Click OK to activate the settings.

Configuring the Communication Mode Manually
This topic gives instructions for configuring the communication mode manually.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4. Press ▲ or ▼ to select Ethernet Driver, and then press the OK button.

5. Press ▲ or ▼ to select Auto Detect, and then press the OK button.

6. Press ▲ or ▼ to select Off, and then press the OK button.
The display reverts to the Ethernet Driver menu.

7. Press ▲ or ▼ to select Comm.Mode, and then press the OK button.

8. Press ▲ or ▼ to select the communication mode, and then press the OK button.
The display reverts to the Ethernet Driver menu.

9. Press ▲ or ▼ to select Ethernet Type, and then press the OK button.

10. Press ▲ or ▼ to select the Ethernet type, and then press the OK button.
The display reverts to the Ethernet Driver menu.

11. Press ▲ or ▼ to select Spanning Tree, and then press the OK button.

12. Press ▲ or ▼ to enable or disable spanning tree support, and then press the OK button.
The display reverts to the Ethernet Driver menu.
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13. Press the Menu button.
After the confirmation message is displayed, press the OK button.
The new settings will take effect after the printer restarts.

Note
• Communication can also be configured on the Network page in RemoteUI.

Email Notification When Printing is Finished or Errors Occur
The printer can notify you of the printer status by email. Even when you are away from the printer, you can know when
printing is finished or if errors occur. Receive notification via email on your mobile phone or at your computer.

Use the imagePROGRAF Status Monitor (Windows) function to set up email recipients and message timing. Besides being
informed of finished print jobs or errors, you can also complete settings for email notification when service is needed or it's
time to replace consumables. For detailed instructions,see "Specifying Printer-Related Information." →P.967

Note
• For details on email notification using imagePROGRAF Status Monitor (in Windows), refer to the image-

PROGRAF Status Monitor help.
• Mail server authentication is only supported with imagePROGRAF Status Monitor.

Initializing the Network Settings
Use RemoteUI to restore the network settings to the default values as follows.
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Important
• Initializing the network settings will also restore the default value of the printer's IP address. As a result, the

RemoteUI page cannot be displayed in the web browser after this procedure.
• For instructions on reconfiguring the IP address, see "Configuring the IP Address on the Printer." →P.941

• For details on RemoteUI, see "Using RemoteUI ." →P.938

1. Start the web browser and enter the following URL in the Location (or Address ) box to display the RemoteUI
page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.

3. If a password has been set on the printer, enter the password.

4. Click Network in the Device Manager menu at left to display the Network page.

5. Click Reset to Default settings in the lower-right corner of the Network Interface group.

6. After confirming the message, click OK to restore the network settings to the default values.

Note
• You can also use imagePROGRAF Device Setup Utility or the Control Panel to restore the default network

settings.
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Maintenance and Consumables

Ink Tanks 972

Printheads 980

Maintenance Cartridge 990

Cleaning the Printer 998

Other Maintenance 1003

Consumables 1009
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Ink Tanks
Ink Tanks ......................................................................................................................................................... 972
Replacing Ink Tanks ........................................................................................................................................ 972
Checking Ink Tank Levels ............................................................................................................................... 978

 

When to Replace Ink Tanks ............................................................................................................................ 979

Ink Tanks
When purchasing ink tanks, make sure the following Ink Tank serial numbers are printed on the label.

• 130 ml (4.4 fl oz.) per color

• MBK Ink Tank PFI-105MBK
• BK Ink Tank PFI-105BK
• C Ink Tank PFI-105C
• M Ink Tank PFI-105M
• Y Ink Tank PFI-105Y
• PC Ink Tank PFI-105PC
• PM Ink Tank PFI-105PM
• GY Ink Tank PFI-105GY

Note
• For instructions on Ink Tank replacement, see "Replacing Ink Tanks." →P.972

Replacing Ink Tanks

Compatible ink tanks
For information on supported ink tanks, see "Ink Tanks." →P.972

Precautions when handling ink tanks
Take the following precautions when handling ink tanks.

Caution
• For safety, keep ink tanks out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.
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Important
• There may be ink around the ink supply section of ink tanks you removed. Handle ink tanks carefully during

replacement. The ink may stain clothing.
• Do not install used ink tanks in another model of printer.

This will prevent correct ink level detection, which may damage the printer or cause other problems.
• We recommend using up an Ink Tank in the course of printing within six months after breaking the seal.

Printing quality may be affected if you use older ink tanks.
• Do not leave the printer without ink tanks installed for extended periods (a month or more). Residual ink may

become clogged inside the printer and affect printing quality.
• If you pause printing to replace an ink tank, it may cause uneven colors in the printed image.

Confirm the message
When the ink level becomes low, a message is displayed on the Display Screen.
According to the message, replace the ink tank or prepare a new ink tank.  (See "When to Replace Ink Tanks.") →P.979

If a message requests you to replace an Ink Tank, press the OK button. In this case, you can skip the step Access the menu
for ink tank replacement. Follow the instructions in Remove the ink tanks.

Important
• Do not remove an Ink Tank during initialization immediately after turning on the printer, or during printhead

cleaning. Ink may leak out.

Note
• Ink Tank replacement is possible even when print jobs are being canceled or if paper is being advanced.

Access the menu for Ink Tank replacement

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Ink tab ( ).
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Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Ink Menu is displayed.

3. Press ▲ or ▼ to select Rep. Ink Tank, and then press the OK button.
A message on the Display Screen requests you to open the Ink Tank Cover. Remove the Ink Tank at this point.

Remove the Ink Tanks

1. Open the Ink Tank Cover and check the ink lamps.
Ink lamps flash when there is little ink left.

2. Press the tip of the Ink Tank Lock Lever of the color for replacement horizontally and lift the Ink Tank Lock Lever
to open it.
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3. Hold the Ink Tank by the grips and remove it. Press the OK button.

Important
• If there is still ink in the Ink Tank you removed, store it with the ink holes (a) facing up. Otherwise,

ink may leak and cause stains. Put the Ink Tank in a plastic bag and seal it.

Note
• Dispose of used ink tanks according to local regulations.
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Install the ink tanks

1. Before opening the pouch, gently agitate the Ink Tank seven or eight times. Agitate the ink in the Ink Tank by slow-
ly rotating the Ink Tank upside-down and right side up repeatedly.

Important
• Do not remove and agitate ink tanks that have already been installed in the printer. Ink may leak out.
• If you do not agitate the Ink Tank, the ink may settle, which may affect printing quality.

2. Open the pouch and remove the Ink Tank.

Important
• Never touch the ink holes or electrical contacts. This may cause stains, damage the Ink Tank, and

affect printing quality.
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3. Press the OK button and insert the Ink Tank into the holder facing as shown, with the ink holes down.

Important
• Ink tanks cannot be loaded in the holder if the color or orientation is incorrect.

If the Ink Tank does not fit in the holder, do not force it into the holder. Make sure the color of the
Ink Tank Lock Lever matches the color of the Ink Tank, and check the orientation of the Ink Tank
before reloading it.

4. Push the Ink Tank Lock Lever closed until it clicks into place.

5. Make sure the Ink Lamp is lit in red.
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Note
• If the Ink Lamp is not lit, reload the tank.

6. Close the Ink Tank Cover.

Checking Ink Tank Levels
On the Display Screen, you can check how much ink is left in the ink tanks.
To check remaining Ink Tank levels, access the Tab Selection screen on the Control Panel and press ◀ or ▶ to select the

Ink tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.
• If an error has occurred and the Tab Selection screen cannot be displayed, display Ink Info as follows.

1. Press the OK button to display Printer Info.
2. Press the ▲ or ▼ button to select Ink Info.
3. Press the OK button.

The remaining ink levels shown on the Display Screen correspond to the inks identified by the Color Label on the bottom of
the Display Screen.
These symbols may be displayed above the ink level: ! if ink is low, × if no ink is left, and ? if you have deactivated ink
level detection.
The remaining ink level is indicated as shown below.
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If the Display Screen indicates to replace the Ink Tank, replace the Ink Tank. If a message is displayed indicating to check
the remaining ink levels, or after tasks that consume a lot of ink such as large-format printing or head cleaning, check the
remaining levels and replace Ink Tank as needed.  (See "Replacing Ink Tanks.") →P.972

When to Replace Ink Tanks
Replace or prepare to replace ink tanks in the following situations.

If a message for checking the ink is shown on the Display Screen
When there is little ink left, the Message Lamp is lit and "Not much ink is left." is shown on the Display Screen. You can
continue to print, but prepare to replace the Ink Tank.  (See "Checking Ink Tank Levels.") →P.978

Before print jobs and maintenance that consume a lot of ink
If little ink is left, there may not be enough for large-format printing, head cleaning, and maintenance, which require a lot of
ink. In this case, replace or prepare to replace the Ink Tank before maintenance.

If a message for ink replacement is shown on the Display Screen
When ink runs out, the Message Lamp flashes, a message regarding Ink Tank replacement is shown on the Display Screen,
and printing is disabled. Replace the Ink Tank at this point.
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Printhead

• Printhead PF-05

Note
• For instructions on replacing the Printhead, see "Replacing the Printhead." →P.982

Checking for Nozzle Clogging
If printing is faint or affected by banding in different colors, make sure the Printhead nozzles are clear by printing a test
pattern to check the nozzles.

Note
• Nozzles are periodically checked to ensure they are clear. Configure the settings on the Control Panel menu

in Nozzle Check.  (See "Menu Settings.") →P.914

Paper to Prepare
When Using Rolls An unused roll at least 10 inches wide

When Using Sheets One sheet of unused paper of at least A4/Letter size

1. Load paper.

• Loading Rolls on the Roll Holder →P.781

• Loading Rolls in the Printer →P.784

• Loading Sheets in the Feed Slot →P.809
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2. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Test Print, and then press the OK button.

5. Press ▲ or ▼ to select Nozzle Check, and then press the OK button.
The printer now prints a test pattern for checking the nozzles.

6. Check the printing results.
If the horizontal lines are not faint or incomplete, the nozzles are clear.

If some sections of the horizontal lines are faint or incomplete, the nozzles for those colors are clogged.

If horizontal lines are faint or incomplete, follow the steps below and check again for nozzle clogging.

1. Clean the Printhead.  (See "Cleaning the Printhead.") →P.981

2. Print a test pattern to check the nozzles.

Important
• If you repeat these steps several times but the horizontal lines are still faint or incomplete, contact

your Canon dealer.

Cleaning the Printhead
If printing is faint, cleaning the Printhead may improve results.
Choose one of two Printhead cleaning modes ( Head Cleaning A or Head Cleaning B ), depending on the problem to
resolve.

• Head Cleaning A
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Use this mode if printing is faint or contains foreign substances. This method of cleaning consumes the least amount of
ink.
It takes about five minutes to complete.

• Head Cleaning B
Use this mode if no ink is ejected at all, or if Head Cleaning A does not solve the problem.
It takes about six minutes to complete.

Important
• Do not remove the Maintenance Cartridge or ink tanks during either Head Cleaning A or Head Cleaning B.

Ink may leak or an error may occur.
• If printing does not improve even if you execute Head Cleaning B, try repeating Head Cleaning B once or

twice. If this still does not improve printing, the Printhead may have reached the end of its useful life. Con-
tact your Canon dealer for assistance.

Note
• Nozzles are periodically checked to ensure they are clear. Configure the settings on the Control Panel menu

in Nozzle Check.  (See "Menu Settings.") →P.914

Perform cleaning as follows.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Maintenance, and then press the OK button.

4. Press ▲ or ▼ to select Head Cleaning, and then press the OK button.

5. Press ▲ or ▼ to select Head Cleaning A or Head Cleaning B, and then press the OK button.
Head cleaning is now executed.

6. Print a test pattern to check the nozzles, and determine whether cleaning has cleared the nozzles.  (See "Checking
for Nozzle Clogging.") →P.980

Replacing the Printhead

When to replace the Printhead
This printer is equipped with two printheads.
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Replace one or both printheads in the following situations.

• If the printing quality does not improve even after one or two cycles of Head Cleaning B from the printer
menu
Replace any printheads with poor printing performance.

• If the Display Screen indicates "Open top cover and replace the left printhead."
Replace the Printhead on the left side.

• If the Display Screen indicates "Open top cover and replace the right printhead."
Replace the Printhead on the right side.

• If your Canon dealer has advised Printhead replacement
Replace the Printhead as directed.

Compatible printheads
For information on compatible printheads, see "Printhead." →P.980

Precautions when handling the Printhead
Take the following precautions when handling the Printhead.

Caution
• For safety, keep the Printhead out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.
• Do not touch the Printhead immediately after printing. The Printhead becomes extremely hot, and there is a

risk of burns.

Important
• There may be ink around the nozzles of the Printhead you remove. Handle the Printhead carefully during

replacement. The ink may stain clothing.
• Do not open the Printhead pouch until immediately before installation. After removing the Printhead from

the pouch, install it right away. If the Printhead is left after the pouch is opened, the nozzles may dry out,
which may affect printing quality.

Access the menu for Printhead replacement

Caution
• When replacing the Printhead immediately after printing, wait a few minutes before replacing it. The metal

parts of the Printhead become hot during printing, and there is a risk of burns from touching these parts.

Important
• Your hands may become dirty during Printhead replacement. Use the gloves provided with the new Printhead

for replacement.

Note
• Prepare a new Ink Tank when ink levels are low.
• When the remaining capacity of Maintenance cartridge is low, prepare a new Maintenance cartridge.

1. Remove any paper that has been advanced by selecting Eject Paper in the Control Panel menu.

• When using a roll, rewind it.
 

 (See "Removing the Roll from the Printer.") →P.790
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• When using sheets, remove the sheet.
 

 (See "Removing Sheets.") →P.817

2. Clean inside the Top Cover.  (See "Cleaning Inside the Top Cover.") →P.998

3. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

4. Press the OK button.
The Set./Adj. Menu is displayed.

5. Press ▲ or ▼ to select Maintenance, and then press the OK button.

6. Press ▲ or ▼ to select Replace P.head, and then press the OK button.

7. Press ▲ or ▼ to select the Printhead for replacement.
Select Printhead L when replacing the left printhead and Printhead R when replacing the right printhead. Make
sure your selection is correct.

8. Press the OK button.
Ink is now filled.
After about three minutes, a message is shown on the Display Screen instructing you to open the Top Cover.

Replace the Printhead

1. Open the Top Cover.

Instructions are now shown on the Display Screen regarding Printhead replacement.
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2. If the Printhead Fixer Cover or Printhead Fixer Lever is dirty, use a damp cloth that you have wrung out completely
to wipe it clean.

Important
• Do not touch the Linear Scale (a) or Carriage Shaft (b). This may stain your hands and damage the

printer.

• Never touch the metal contacts of the Carriage. This may damage the printer.
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3. Pull the Printhead Fixer Lever forward all the way to open it completely.

4. Pull up the Printhead Fixer Cover to open it completely.

5. Remove the Printhead and press the OK button.
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Note
• Dispose of the used Printhead in accordance with local regulations.

6. Holding the new Printhead by the grips (a), remove it from the pouch.

Important
• When handling the Printhead, always hold it by the grips (a). Never touch the nozzles (b) or metal

contacts (c). This may damage the Printhead and affect printing quality.
• Never touch the ink supply section (d). This may cause printing problems.

• If you need to put a Printhead somewhere temporarily before installation, do not keep the nozzles and
metal contacts facing down. If the nozzles or metal contacts are damaged, it may affect the printing
quality.

7. While firmly holding the Printhead you have removed, use your other hand to remove the orange Protective Part (a).
Squeeze the grips (c) of Protective Part (b) and pull it down to remove it.
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Important
• The inside surface of the Protective Part (a) and Protective Part (b) is coated with ink to protect the

nozzles. Be careful not to touch these surfaces when removing the caps.
• The Printhead contains ink to protect the nozzles. We recommend removing Protective Part (b) as you

hold it over the Printhead package or safely out of the way to avoid spilling ink and staining your
clothes or the surrounding area. If ink accidentally spills, wipe off the ink with a dry cloth.

• Do not reattach the Protective Part or protective material. Dispose of these materials in accordance
with local regulations.

8. With the nozzles facing down and the metal contacts toward the back, insert the Printhead into the Carriage. Careful-
ly push the printhead firmly into the Carriage, ensuring that the nozzles and metal contacts do not touch the carriage.

9. Pull the Printhead Fixer Cover down toward the front to lock the Printhead in place.
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10. Push the Printhead Fixer Lever toward the back of the printer until it clicks.

11. Close the Top Cover.

Ink is being filled. It takes about nine minutes for ink to fill the system.

Important
• While ink is being filled, definitely do not remove the Ink Tank. Ink may leak out.

Note
• The procedure is now finished if you have set Rep.P.head Print to Off in the Control Panel menu.

If so, execute Head Posi. Adj. > Auto(Advanced) in the Control Panel menu.
 (See "Automatic Adjustment to Straighten Lines and Colors (Head Posi. Adj.).") →P.827

12. Follow the instructions on the Display Screen and supply paper that you will use for printing. After the paper is
advanced, Head Posi. Adj. will be executed automatically.
 (See "Automatic Adjustment to Straighten Lines and Colors (Head Posi. Adj.).") →P.827

Note
• When printing fine lines or text at high precision on glossy or semi-glossy photo or proofing paper,

set the optimal Printhead height before aligning the printhead.
 (See "Enhancing Printing Quality.") →P.825
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Maintenance Cartridge

• Maintenance Cartridge MC-16

Note
• For instructions on replacing the Maintenance Cartridge, see "Replacing the Maintenance Cartridge."

→P.990

Replacing the Maintenance Cartridge

Compatible maintenance cartridges
For information on compatible maintenance cartridges, see "Maintenance Cartridge." →P.990

Precautions when handling the Maintenance Cartridge
Take the following precautions when handling the Maintenance Cartridge.

Caution
• For safety, keep the Maintenance Cartridge out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.

Important
• Do not remove the Maintenance Cartridge except to replace it. Ink may leak out.
• To prevent ink from leaking from a used Maintenance Cartridge, avoid dropping the cartridge or storing it at

an angle. Otherwise, ink may leak and cause stains.
• Ink adheres to the top of the Maintenance Cartridge after it has been used. Handle the Maintenance Cartridge

carefully during replacement. The ink may stain clothing.

Maintenance and Consumables > Maintenance Cartridge >

Maintenance Cartridge iPF6300S

11

990



Confirm the message
When the Maintenance Cartridge is almost empty, a message is shown on the Display Screen. According to the message,
replace the Maintenance Cartridge or prepare a new Maintenance Cartridge.  (See "When to Replace the Maintenance
Cartridge.") →P.997

If a message is displayed requesting Maintenance Cartridge replacement, you can skip the step Access the menu for Main-
tenance Cartridge replacement. Follow the instructions in Replace the Maintenance Cartridge.

Important
• Do not replace the Maintenance Cartridge during initialization immediately after turning on the printer, dur-

ing Printhead cleaning, or when ink is being absorbed. Ink may leak out.

Access the menu for Maintenance Cartridge replacement

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Maintenance, and then press the OK button.

4. Press ▲ or ▼ to select Repl. maint cart, and then press the OK button.
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Replace the Maintenance Cartridge

1. Remove the Ejection Guide.

2. Pull out the used Maintenance Cartridge by the grip (a). Holding the cartridge by the handles (b) on both sides, keep
the cartridge level as you remove it.

Important
• Used maintenance cartridges are heavy. Always grasp the cartridge firmly and keep the cartridge lev-

el during removal and storage. If you drop a used Maintenance Cartridge or store it at an angle, ink
may leak and cause stains.

• The remaining Maintenance Cartridge capacity is recorded on each printer. Do not install a used
Maintenance Cartridge in another printer.
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3. Open the box of the new Maintenance Cartridge and remove the plastic bag and packaging material. Holding the
handles (a) on both sides, pull out the cartridge.

Important
• Never touch the metal contacts (a). This may damage the Maintenance Cartridge.
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4. Keep the used Maintenance Cartridge level as you put it in the plastic bag that was in the box, as shown.

5. Expel excess air from the plastic bag as you seal the zipper. Fold the bag in half.

Maintenance and Consumables > Maintenance Cartridge >

Replacing the Maintenance Cartridge iPF6300S

11

994



6. Put the used Maintenance Cartridge and packaging material in the box, just as the new Maintenance Cartridge was
originally packaged, and store the used cartridge keeping it level.

Important
• Always put the used Maintenance Cartridge back in the box and store the box on a flat surface. Other-

wise, ink may leak and cause stains.

Note
• In accordance with active and ongoing environmental programs, Canon supports recycling of used

maintenance cartridges. Follow the instructions provided with the new Maintenance Cartridge that
describe how to process the used Maintenance Cartridge.

7. Holding the handles (a) on both sides of the new Maintenance Cartridge, insert it completely, keeping it level.
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8. Hold the Ejection Guide on both sides by the near end. Aligning the Ejection Guide with the guides (a), insert it into
the printer until it locks in place.

9. Press the OK button.

The printer now initializes the Maintenance Cartridge.

Checking the Remaining Maintenance Cartridge Capacity
The Maintenance Cartridge absorbs excess ink from borderless printing, printhead cleaning, and other processes. You can
confirm the remaining capacity of the Maintenance Cartridge by checking the Maintenance Cartridge capacity shown on the
Display Screen.
To check remaining Maintenance Cartridge capacity, access the Tab Selection screen on the Control Panel and press ◀ or

▶ to select the Settings/Adj. tab ( ).
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Note
• If the Tab Selection screen is not displayed, press the Menu button.

If the Display Screen indicates to replace the Maintenance Cartridge, replace the Maintenance Cartridge. If a message is
displayed indicating to check the remaining capacity of the Maintenance Cartridge, or before tasks that deplete much of the
capacity such as head cleaning or preparations to move the printer, check the remaining Maintenance Cartridge capacity and
prepare a new Maintenance Cartridge as needed.  (See "Replacing the Maintenance Cartridge.") →P.990

When to Replace the Maintenance Cartridge
Replace or prepare to replace the Maintenance Cartridge in the following situations.

If a message for checking the Maintenance Cartridge is shown on the Display Screen
When the Maintenance Cartridge is almost full, the Message Lamp is lit and "The level is low" is shown on the Display
Screen. You can continue to print, but check the remaining Maintenance Cartridge capacity and prepare to replace the
Maintenance Cartridge with a new one.  (See "Checking the Remaining Maintenance Cartridge Capacity.") →P.996

When much of the Maintenance Cartridge capacity is depleted
Printhead cleaning, Printhead replacement, and preparations to transfer the printer deplete much of the Maintenance Car-
tridge capacity. (In particular, preparing to move the printer depletes a lot of the capacity.)
Check the remaining Maintenance Cartridge capacity before this maintenance and replace the Maintenance Cartridge if nec-
essary.

If a message for the Maintenance Cartridge replacement is shown on the Display Screen
When the Maintenance Cartridge is almost empty, the Message Lamp lights, a message to replace the Maintenance Car-
tridge is displayed on the Display Screen, and you cannot print. Replace the Maintenance Cartridge with a new one.
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Cleaning the Printer Exterior
Clean the printer regularly to maintain better printing quality and help prevent problems.
About once a month, clean the printer exterior.

1. Turn the printer off.  (See "Turning the Printer On and Off.") →P.3

2. Unplug the power cord from the outlet.

Caution
• Always turn off the printer and unplug the power cord before cleaning or maintenance. Accidentally

leaving the printer on poses a risk of injury if you touch moving parts inside the printer.

3. Using a damp cloth that you have wrung out completely, wipe the exterior surfaces of the printer. Dry the surfaces
with a dry cloth.

Warning
• Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come into con-

tact with electrical components inside the printer, there is a risk of fire or electrical shock.

Important
• If the Ejection Guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend

cleaning the Ejection Guide even if it does not appear dirty, because it may actually be covered with
paper dust.

4. Plug the power cord into the outlet.

Cleaning Inside the Top Cover
Clean inside the Top Cover about once a month to maintain better printing quality and help prevent problems.
Also clean inside the Top Cover in the following situations to ensure optimal operation.

• If the printed surface or the underside of paper is dirty after printing
• After you have used up a roll
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• After borderless printing
• After printing on small paper
• After printing on paper that generates a lot of cutting debris
• If you have replaced the roll
• After printing on paper that generates a lot of paper dust
• If the message "Blue platen switch is dirty." is displayed

Important
• If the Platen inside the Top Cover becomes dirty, it may soil the underside of paper. We recommend cleaning

the Platen after borderless printing or printing on small paper.
• If the Ejection Guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend clean-

ing the Ejection Guide even if it does not appear dirty, because it may actually be covered with paper dust.

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Maintenance, and then press the OK button.

4. Press ▲ or ▼ to select Clean Platen, and then press the OK button.
A message on the Display Screen requests you to open the Top Cover.

5. Open the Top Cover.
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6. If paper dust has accumulated in the Vacuum holes (a) on the Platen or in the Borderless Printing Ink Grooves (b),
use the Cleaning Brush (c), provided with the printer, to wipe it away.

Note
• If the Cleaning Brush is dirty, rinse it in water.

7. Using a damp cloth that you have wrung out completely, wipe inside the Top Cover to clean it. Wipe away any ink
residue on the Platen as a whole, on the Paper Retainer, Borderless Printing Ink Grooves, and blue Switch.
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Warning
• Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come into con-

tact with electrical components inside the printer, there is a risk of fire or electrical shock.

Important
• Do not use a dry cloth to wipe inside the Top Cover. This may create a static charge, which may at-

tract dust and affect the printing quality.
• Do not touch the Linear Scale (a) or Carriage Shaft (b). This may stain your hands and damage the

printer.

8. Close the Top Cover.

Cleaning the Paper Retainer
Clean the Paper Retainer about once a month to maintain better printing quality and help prevent problems.
Also clean the Paper Retainer in the following situations to ensure optimal operation.

• If the printed surface or the underside of paper is dirty after printing
• After printing on small paper
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Important
• During cleaning, use paper that does not generate much cutting dust, such as Plain Paper. It may affect print-

ing quality if you use film or other media that are more likely to generate debris when cut, or that have a
surface finish that may come off.

1. Turn the printer off.  (See "Turning the Printer On and Off.") →P.3

2. Unplug the power cord from the outlet.

Caution
• Always turn off the printer and unplug the power cord before cleaning or maintenance. Accidentally

leaving the printer on poses a risk of injury if you touch moving parts inside the printer.

3. Remove the Roll Feed Unit.  (See "Removing the Roll Feed Unit.") →P.805

4. Fold a sheet of Plain Paper two or three times (a) and insert it under the Paper Retainer (b) from behind the printer to
wipe the entire surface of the Paper Retainer clean.

5. Attach the Roll Feed Unit.  (See "Installing the Roll Feed Unit.") →P.806

6. Plug the power cord into the outlet.
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Other Maintenance
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Preparing to Transfer the Printer
To protect the internal parts in transit, always follow these steps before transferring the printer to a new location.
Refer to the Setup Guide for details on packing the printer and installing it after transfer.

Important
• Avoid tilting the printer excessively in transit. This may cause ink in the printer to leak and cause stains. If it

is necessary to tilt the printer in transit, contact your Canon dealer.
• It is not possible to prepare the printer for transfer if the Display Screen requests you to replace the Mainte-

nance Cartridge or check the remaining capacity. Replace the Maintenance Cartridge before transfer prepara-
tions. In this case, you will need one new Maintenance Cartridge.  (See "Replacing the Maintenance Car-
tridge.") →P.990

Note
• Depending on the state of the printer, part replacement may be necessary when preparing to transfer the

printer (that is, when you execute the printer menu item to prepare for transfer).

Remove paper

1. Remove the paper.

• Rolls  (See "Removing the Roll from the Printer.") →P.790

• Sheets  (See "Removing Sheets.") →P.817

Access the Prep.MovePrinter menu

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Prep.MovePrinter, and then press the OK button to display the confirmation screen.
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4. Press ▲ or ▼ to select Yes, and then press the OK button.
Once preparations are finished, a message on the Display Screen requests you to open the Ink Tank Cover.

Important
• If consumables must be replaced, the message "Consumables must be replaced. Call for service."

is shown on the Display Screen and preparation is not possible. If this message is displayed, press the
OK button and contact your Canon dealer for assistance.

Remove the Ink Tank

1. Open the Ink Tank Cover.

2. Lift the ink tank lock levers and remove all ink tanks.

Maintenance and Consumables > Other Maintenance >

Preparing to Transfer the Printer iPF6300S

11

1004



Put the ink tanks in a plastic bag and seal it.

Important
• Store the ink tanks you removed with the ink holes (a) facing up. Otherwise, ink may leak and cause

stains.

3. Close all ink tank lock levers, and then close the Ink Tank Cover.

At this point, ink is drawn out from inside the tubes.

Important
• Do not remove the Maintenance Cartridge during this process. Ink may leak out.

When the process is finished, "Completed! Turn Power Off!!" is displayed.

Pack the printer

1. Press the Power button and turn off the printer.
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Important
• Turn off the printer before you unplug it. It may damage the printer if you unplug it before it is off

and transfer it in that state. If you accidentally unplug the printer, plug it in again, reinstall the ink
tanks, and follow this procedure again.

2. Disconnect the power cord and interface cable.

3. Open the Top Cover.

4. Pinch the Belt together, insert it between the Belt Stopper, and affix the Belt Stopper to the Carriage Shaft.
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Important
• Do not touch the Linear Scale (a) or Carriage Shaft (b). This may stain your hands and damage the

printer.

Note
• Here, the Belt Stopper is the one that was removed and stored after initial installation.

5. Close the Top Cover.

6. Tape down printer covers to secure them, in the reverse order of tape removal during installation.

7. Repack the Roll Holder, Holder Stopper, and printer in shipping materials, and then package them in a shipping box.
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Updating the Firmware
Update the printer firmware to take advantage of new and improved printer functions.

Confirming the firmware version

1. On the Tab Selection screen of the Control Panel, press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Printer Info, and then press the OK button.

4. Press ▲ or ▼ to select System Info, and then press the OK button.
The firmware version is displayed.

Updating the Firmware
To obtain the latest firmware, visit the Canon website. If the firmware available online is newer than the installed firmware,
update the printer firmware. For details on downloading and updating the firmware, visit the Canon website.

Maintenance and Consumables > Other Maintenance >
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Consumables
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Printhead ......................................................................................................................................................... 980
Maintenance Cartridge .................................................................................................................................... 990
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Frequently Asked Questions
Frequently Asked Questions ......................................................................................................................... 1011

Frequently Asked Questions
This section presents frequently asked questions and answers. To view more detailed explanations, click the hyperlinks in
the answer column.

Question Answer

I want to easily create
vertical or horizontal
banners.

You can print originals that are in landscape (or portrait) orientation automatically enlarged
to fit the roll width. This is an easy way to create vertical or horizontal banners.
⇒"Printing Vertical or Horizontal Banners (Large-Format Printing) →P.122 "

A replacement mes-
sage for the Mainte-
nance Cartridge was
displayed.

If a replacement message for the Maintenance Cartridge is displayed, replace it with a new
Maintenance Cartridge.
⇒"When to Replace the Maintenance Cartridge →P.997 "

I want to perform en-
largement copying
from a Color image-
RUNNER.

By using Color imageRUNNER Enlargement Copy (iR enlargement copy), you can print en-
largements of scanned originals from a Color imageRUNNER.
⇒"Printing Enlargements of Scanned Originals from a Color imageRUNNER →P.304 "
⇒"Printing Enlargements of Scanned Originals from a Color imageRUNNER →P.604 "

I want to tilt and trans-
fer the printer.

Avoid tilting the printer excessively in transit. This may cause ink in the printer to leak and
cause stains. If it is necessary to tilt the printer in transit, contact your Canon dealer.
⇒"Preparing to Transfer the Printer →P.1003 "

I want to know the
time to replace the Ink
Tank.

Normally, replace it when an Ink Tank replacement message is displayed.
Ink Tank replacement is possible even when print jobs are being canceled, or when paper is
being advanced.
⇒"When to Replace Ink Tanks →P.979 "

Does this printer sup-
port sub-ink tank sys-
tem?

This printer does not support sub-ink tank system.
Thus, the ink tank cannot be replaced during printing.
⇒"Replacing Ink Tanks →P.972 "

I want to know how to
configure roll cutting.

You can select the cutting method by the setting of the printer driver and the setting of the
printer.
To cut rolls automatically after printing, set Cutting Mode of the printer to Automatic and
Automatic Cutting of the printer driver to Yes.
When using paper for which ink adhesion takes time or the print surface is easily scratched,
we recommend that you set the Cutting Mode setting of the printer to Eject.
⇒"Specifying the Cutting Method for Rolls →P.797 "
⇒"Cutting Roll Paper After Printing →P.196 "

I want to configure so
that the roll is cut auto-
matically after waiting
for the ink to dry.

In the printer driver, you can set the time for waiting until the ink dries.
Also, you can set likewise on the printer.
⇒"Specifying the Ink Drying Time for Rolls →P.795 "
⇒"Menu Structure →P.904 "

I want to replace the
Printhead myself.

Acquire a Printhead supported by the printer. You can replace it yourself.
⇒"Replacing the Printhead →P.982 "

How do I print without
borders?

When printing on rolls, you can perform borderless printing by configuring the printer driver.
(when printing on cut sheets, you cannot perform borderless printing)
⇒"Borderless Printing on Paper of Equivalent Size →P.107 "
⇒"Borderless Printing by Resizing Originals to Fit the Roll Width →P.114 "
⇒"Borderless Printing at Actual Size →P.99 "
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Question Answer

I want to know the pa-
per types that can be
used in this printer.

Concerning the paper that can be used in this printer, refer to the imagePROGRAF home
page or the Paper Reference Guide.
⇒"Types of Paper →P.773 "

The paper type that I
want to print is not dis-
played on the Display
Screen.

When using newly released paper, paper information must be registered on the printer and
the printer driver. Download the new version of Media Information File from the image-
PROGRAF website and install it.
⇒"Types of Paper →P.773 "

What type of function
is color calibration?

Color calibration improves color consistency by compensating for slight differences in how
color appears when printing due to individual variations or aging among the printers.
We recommend color calibration in the following situations.

• After initial printer installation

• After Printhead replacement

• When you sense a change of color compared to previously

• To print with colors aligned from multiple printers

• When the execution guide is displayed

⇒"Using Color Calibration for Color Adjustment →P.844 "

How do I print without
wasting paper?

To conserve paper, you can specify in the printer driver to rotate originals 90 degrees or to
print without top and bottom margins.
⇒"Conserving Roll Paper by Rotating Originals 90 Degrees →P.172 "
⇒"Conserving Roll Paper by Printing Originals Without Top and Bottom Mar-
gins →P.178 "

Can I perform duplex
printing?

This printer cannot perform duplex printing.
If you use the Folded Duplex function in the free layout of Windows software, you can print
two pages one-sided, fold them at the center and suspend them to substitute for duplex print-
ing.
⇒"Prints using Folded Duplex →P.290 "

I want to perform en-
largement printing.

With the printer driver, you can specify the ratio matching the document with the paper size
and width and perform enlargement printing or reduction printing.
⇒"Resizing Originals to Match the Paper Size →P.73 "
⇒"Resizing Originals to Fit the Roll Width →P.79 "
⇒"Resizing Originals by Entering a Scaling Value →P.85 "
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Problems Regarding Paper
Clearing Jammed Paper (Paper Feed Slot) .................................................................................................. 1013
Clearing Jammed Roll Paper ......................................................................................................................... 1014
Clearing a Jammed Sheet, Fed Manually ..................................................................................................... 1018

 

Roll paper cannot be inserted into the paper feed slot .................................................................................. 1021
Cannot load sheets ........................................................................................................................................ 1021

 

Paper is not cut neatly ................................................................................................................................... 1021
Paper is not cut .............................................................................................................................................. 1022

 

Depression on the leading edge is left .......................................................................................................... 1022
 

Margins are wide ........................................................................................................................................... 1022

Clearing Jammed Paper (Paper Feed Slot)
Follow these steps to clear jams deep in the Paper Feed Slot →P.1013  or to remove any scraps left in the slot when
you are clearing jams →P.1013 .

Clear any jammed paper deep in the Paper Feed Slot
If paper is jammed deep in the Paper Feed Slot, remove the Roll Feed Unit and clear the paper jam as follows.

1. Turn the printer off before removing the Roll Feed Unit from the printer.  (See "Removing the Roll Feed Unit.")
→P.805

2. Remove the jammed paper from the Paper Feed Slot.

3. Attach the Roll Feed Unit to the printer.  (See "Installing the Roll Feed Unit.") →P.806

Remove scraps left in the Paper Feed Slot
Follow these steps to remove any scraps left in the Paper Feed Slot after you clear jammed sheets or roll paper.

1. Press the Load button.

2. Press ▲ or ▼ to select Manual Paper, and then press the OK button.
A menu for selection of the type of paper is displayed.

3. Select POP Board and press the OK button.
Instructions for feeding POP Board are now displayed on the Control Panel, but follow this procedure to remove
the jammed paper.
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4. Open the Top Cover.

5. Fold an A4 sheet lengthwise four times and insert it through the gap of the Back Cover. Push the scrap out toward
the Platen.

6. Remove the scrap when it is pushed out onto the Platen.

7. If any scraps remain inside the paper feed slot, repeat steps 5 and 6.

8. Close the Top Cover.

9. Turn the printer off.  (See "Turning the Printer On and Off.") →P.3

Clearing Jammed Roll Paper
If paper from a roll becomes jammed, "Paper jam" is shown on the Display Screen of the Control Panel. Remove the jam-
med paper as follows.

Important
• For instructions on removing scraps from the paper feed slot after clearing jammed roll paper, see "Clearing

Jammed Paper (Paper Feed Slot)." →P.1013

1. Open the Roll Feed Unit Cover. Use a commercially available cutter or the like to cut the paper of the loaded roll.

Caution
• When cutting paper, be careful to avoid injury or damage to the printer.
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2. Press the OK button.

3. Remove the jammed paper.

• If paper is jammed inside the Top Cover

1. Open the Top Cover and move the Carriage to the side.

2. Clear any jammed paper from inside the Top Cover.
After removing the paper, make sure there are no other scraps of paper in the printer.

3. Close the Top Cover.
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Important
• Do not move the Carriage over jammed paper. This may damage the Printhead.
• Do not touch the Linear Scale (a) or Carriage Shaft (b). This may stain your hands and damage the

printer.

• If paper from a roll is jammed by the Paper Feed Slot

1. Open the Roll Feed Unit Cover.

2. Remove the jammed paper from the Paper Feed Slot.
After removing the paper, make sure there are no other scraps of paper in the printer.
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If paper is jammed deep in the Paper Feed Slot, remove the roll feed unit, and then clear the paper jam.
 (See "Clearing Jammed Paper (Paper Feed Slot).") →P.1013

• If the paper is jammed by the Ejection Guide
Remove the jammed paper from the Output Tray.
After removing the paper, make sure there are no other scraps of paper in the printer.

4. Press the OK button.
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Clearing a Jammed Sheet, Fed Manually
If a sheet you have fed manually becomes jammed, "Paper jam" is shown on the Display Screen of the Control Panel.
Remove the jammed paper as follows.

1. Press the OK button.

2. Remove the jammed paper.

• If paper is jammed inside the Top Cover

1. Open the Top Cover and manually move the Carriage to the side.

2. Clear any jammed paper from inside the Top Cover.
After removing the paper, make sure there are no other scraps of paper in the printer.

3. Close the Top Cover.
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Important
• Do not move the Carriage over jammed paper. This may damage the Printhead.
• Do not touch the Linear Scale (a) or Carriage Shaft (b). This may stain your hands and damage the

printer.

• If the paper is jammed by the Paper Feed Slot of the Top Paper Feed Slot
Remove the jammed paper from the Paper Feed Slot.
After removing the paper, make sure there are no other scraps of paper in the printer.
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If paper is jammed deep in the Paper Feed Slot, remove the roll feed unit, and then clear the paper jam.  (See
"Clearing Jammed Paper (Paper Feed Slot).") →P.1013

• If the paper is jammed by the Ejection Guide
Remove the jammed paper from the Output Tray.
After removing the paper, make sure there are no other scraps of paper in the printer.

• If paper is jammed in the back of the printer
Remove the jammed paper from the back of the printer.
After removing the paper, make sure there are no other scraps of paper in the printer.
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3. Press the OK button.

Roll paper cannot be inserted into the paper feed slot

Cause Corrective Action

The roll paper is warped. Straighten out curls and reload the roll.

Paper is jammed by the paper feed slot. Remove the jammed paper.
 (See "Clearing Jammed Roll Paper.") →P.1014
 (See "Clearing a Jammed Sheet, Fed Manually.") →P.1018

After a roll was advanced, the paper was manually
pulled out by force, closing the Paper Feed Slot.

Remove the roll and open the paper feed slot.
 (See "Removing the Roll from the Printer.") →P.790

Cannot load sheets

Cause Corrective Action

The paper source selection is incorrect. Press the Load button and select the paper source.

Paper is not cut neatly

Cause Corrective Action

The paper is bent or curled at the cut position. Straighten out any curling by the edges of the paper.

Paper rises by the ends of the cut position be-
fore it is cut.

Reload the paper correctly.

You are using paper that cannot be cut with
the Cutter Unit.

Specify Manual in Cutting Mode in the Control Panel menu and use
scissors or a cutting tool to cut the roll after printing.
 (See "Specifying the Cutting Method for Rolls.") →P.797

Cut Speed is not configured correctly in the
Control Panel menu.

Change the Cut Speed setting in the Control Panel menu.
 (See "Menu Structure.") →P.904

During cutting, printed documents fall out at
an angle.

In the Control Panel menu, set Cutting Mode to Eject. Hold docu-
ments after printing, as they are cut.
 (See "Specifying the Cutting Method for Rolls.") →P.797
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Paper is not cut

Cause Corrective Action

The printed document became caught on a foreign ob-
ject by the Output Tray, which lifted the document. The
Cutter passed under the paper.

Remove the foreign object by the Output Tray to enable the
printer to eject the printed document, keeping it level.

In the printer driver, No or Print Cut Guideline is
specified in Auto Cut.

Specify Yes in Auto Cut in the printer driver.

In the Control Panel menu, Cutting Mode is set to
Eject or Manual.

If the Cutting Mode is Eject, press the Cut button to cut
the paper.
If the Cutting Mode is Manual, cut rolls with scissors or
the like.

Depression on the leading edge is left

Cause Corrective Action

Keeping a roll in the printer for a long
time without printing on it may leave a de-
pression on the leading edge.

When printing quality is most important, we recommend setting Tri-
mEdge Reload to On or Automatic so that the paper edge is automati-
cally cut before printing.
 (See "Menu Structure.") →P.904

Margins are wide

Cause Corrective Action

Rolls are advanced a specific amount before cutting to prevent problems with cutting and
paper ejection.

This operation is normal.
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Printing does not start
The Data lamp on the Control Panel does not light up .................................................................................. 1023
The printer does not respond even if print jobs are sent ............................................................................... 1023

 

Ink Filling.. is displayed .................................................................................................................................. 1023
The display screen indicates Agitating .......................................................................................................... 1024

The Data lamp on the Control Panel does not light up

Cause Corrective Action

The printer is not on. Make sure the power cord is securely plugged in, all the way. Press the Power but-
ton to turn on the printer.

The target printer was not selec-
ted when printing. (The printer is
in Sleep mode.)

In Windows, select the printer by clicking Select Printer or Printer in the printing
dialog box and try printing again.

In Mac OS X, open the dialog box of the printer driver, select the printer from the
list of Printer, and try printing again.

The print job is paused. (The
printer is in Sleep mode.)

In Windows, restart the print job as follows.

1. Select the printer icon in the Printers and Faxes (or Printers ) window.

2. Clear Pause Printing in the File menu to restart the print job.

In Mac OS X, restart the print job as follows.

1. Click Print & Fax. (This is identified as Printer Setup Utility or Print Center
in other versions of Mac OS X.)

2. Select the printer, and then Resume Printer (or Start Jobs ) in the Printers
menu to restart the print job.

The printer does not respond even if print jobs are sent

Cause Corrective Action

In the Control Panel menu, Pause Print is
On.

Set Pause Print to Off.
 (See "Pausing Printing.") →P.19

You have selected Save in mail box in
Output Method on the printer.

Print the job saved on the printer's hard disk.
 (See "Printing Saved Jobs.") →P.729

Print jobs are pending. Manage the jobs on hold and print as needed.
 (See "Managing Pending Jobs (Printing or Deleting Jobs on Hold).")
→P.727

Ink Filling.. is displayed

Cause Corrective Action

The printer was forced off during operation. Wait until the system has been filled with ink.
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The display screen indicates Agitating

Cause Corrective Action

Ink agitation is in pro-
gress.

Please wait until ink agitation is finished.
The time for agitation varies depending on how long the printer has been off. (Between about
30 seconds and two minutes.)

Troubleshooting > Printing does not start >
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The printer stops during a print job
An error message is shown on the Display Screen ....................................................................................... 1025
The printer ejects blank, unprinted paper ...................................................................................................... 1025

An error message is shown on the Display Screen

Status Corrective Action

An error message is displayed during printing. Check the error message and take action as necessary.
 (See "Error Messages.") →P.1049

The last portion of roll paper was used during a print job,
and paper could not be advanced because the trailing
edge is taped to the roll.

Remove the used roll and insert a new roll.
 (See "Removing the Roll from the Printer.") →P.790
 (See "Removing Rolls From the Roll Holder.") →P.792
 (See "Loading and Printing on Rolls.") →P.5

The printer ejects blank, unprinted paper

Status Corrective Action

The leading edge of the roll paper
was cut to straighten it.

The leading edge of rolls may be cut to straighten it if you have selected Trim
Edge First > On or Automatic in the Control Panel menu.
 (See "Cutting the Leading Edge of Roll Paper Automatically.") →P.802

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and make sure the Printhead is in good
condition for printing.
 (See "Checking for Nozzle Clogging.") →P.980

A print job was received from an
incompatible printer driver.

Use the correct imagePROGRAF printer driver for the printer and try printing
again.

The printer is damaged. Contact your Canon dealer for assistance.
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Problems with the printing quality
Printing is faint ............................................................................................................................................... 1026
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The back side of the paper is dirty ................................................................................................................. 1029
Roller marks are left across the trailing edge of paper .................................................................................. 1029
Immediately after borderless printing, the trailing edge margin is soiled during regular printing ........................................... 1029
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Banding in different colors occurs ................................................................................................................. 1030
Colors in printed images are uneven ............................................................................................................. 1031
Image edges are blurred or white banding occurs ........................................................................................ 1032

Setting the Blue Switch on the Platen ....................................................................................................... 1033
The contrast becomes uneven during printing .............................................................................................. 1036

 

The length of printed images is inaccurate in the feeding direction ............................................................... 1036
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Documents are printed in monochrome ........................................................................................................ 1036
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Borderless printing is not possible ................................................................................................................. 1038
 

Problems with the printing quality caused by the type of paper .................................................................... 1038

Printing is faint

Cause Corrective Action

You may be printing on the wrong
side of the paper.

Print on the printing surface.

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if they are clogged.
 (See "Checking for Nozzle Clogging.") →P.980

Because the printer was left with-
out ink tanks installed for some
time, ink has become clogged in
the ink supply system.

After the ink tanks have been installed for 24 hours, run Head Cleaning B from
the Control Panel.
 (See "Cleaning the Printhead.") →P.981

Paper is jammed inside the Top
Cover.

Follow the steps below to remove the jammed piece of paper inside the Top Cov-
er.

1. Open the Top Cover and make sure the Carriage is not over the Platen.

2. Remove any scraps of paper inside the Top Cover.
 (See "Clearing Jammed Roll Paper.") →P.1014
 (See "Clearing a Jammed Sheet, Fed Manually.") →P.1018

3. Close the Top Cover.

The ink was not dry when paper
was cut.

Specify a longer drying period in the Control Panel menu, in Paper Details >
Roll DryingTime.
 (See "Menu Settings.") →P.914
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Cause Corrective Action

Printing may be faint if Print
Quality in Advanced Settings in
the printer driver is set to Stand-
ard or Fast.

In Advanced Settings of the printer driver, choose Highest quality or High in
Print Quality.
Printing in Fast or Standard mode is faster and consumes less ink than in High-
est quality or High modes, but the printing quality is lower.
 (See "Giving Priority to Particular Graphic Elements and Colors for Print-
ing.") →P.64

You are printing on paper that
tends to generate dust when cut.

In the Control Panel menu, set CutDustReduct. in Paper Details to On.
 (See "Reducing Dust from Cutting Rolls.") →P.804

Paper rubs against the printhead

Cause Corrective Action

The type of paper specified in the
printer driver does not match the
type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

Make sure the same type of paper is specified in the printer driver as you have
loaded in the printer.

1. Press the Stop button and stop printing.

2. Change the type of paper in the printer driver and try printing again.

Paper has been loaded incorrectly,
causing it to wrinkle.

Reload the paper.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

The Printhead is set too low in the
Control Panel menu.

In the Control Panel menu, set Head Height to Automatic.
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.831

You are printing on heavyweight
paper or paper that curls or wrin-
kles easily after absorbing ink.

When printing on Heavyweight Coated Paper or other paper-based media, choose
a VacuumStrngth setting of Strong or Strongest in the Control Panel menu. If
rubbing still occurs, in the Control Panel menu, use a higher Head Height set-
ting.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.842
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.831

When printing on CAD Tracing Paper or other film-based media, choose a Vac-
uumStrngth setting of Standard, Strong, or Strongest in the Control Panel
menu. If rubbing still occurs, in the Control Panel menu, use a higher Head
Height setting.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.842
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.831

When printing on paper 0.1 mm (0.004 in) thick or less, choose a Vac-
uumStrngth setting of Weakest in the Control Panel menu. If rubbing still oc-
curs, in the Control Panel menu, use a higher Head Height setting.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.842
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.831

If edges of the paper curl and become soiled when printing on rolls of glossy
photo paper, in Paper Detailed Settings in the printer driver, set Near End
Margin to 20mm.
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Cause Corrective Action

When you have loaded paper, the
paper you have loaded does not
match the type selected on the
Control Panel.

Be sure to select the correct type of paper in the Control Panel menu when load-
ing paper.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

The edges of the paper are dirty

Cause Corrective Action

The Platen has become dirty after
borderless printing or printing on
small paper.

Open the Top Cover and clean the Platen.
 (See "Cleaning Inside the Top Cover.") →P.998

The type of paper as specified on
the printer does not match the type
specified in the printer driver.

Make sure the same type of paper is specified on the printer as in the printer
driver.
 (See "Changing the Type of Paper.") →P.787

Make sure the same paper type is specified in the printer driver as on the printer.

1. Press the Stop button and stop printing.

2. Change the type of paper in the printer driver and try printing again.

The paper is wrinkled or warped. Straighten out the wrinkles or curls and reload the paper. Do not use paper that
has been printed on previously.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

A cut line is printed because Cut-
DustReduct. is On in the Control
Panel menu to reduce cutting dust.

If this function is not needed, set CutDustReduct. to Off in the Control Panel
menu.
 (See "Menu Settings.") →P.914

The Printhead is set too low in the
Control Panel menu.

In the Control Panel menu, set Head Height to Automatic.
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.831

You are printing on heavyweight
paper or paper that curls or wrinkles
easily after absorbing ink.

When printing on Heavyweight Coated Paper or other paper-based media,
choose a VacuumStrngth setting of Strong or Strongest in the Control Panel
menu. If rubbing still occurs, in the Control Panel menu, use a higher Head
Height setting.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.842
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.831

When printing on CAD Tracing Paper or other film-based media, choose a Vac-
uumStrngth setting of Standard, Strong, or Strongest in the Control Panel
menu. If rubbing still occurs, in the Control Panel menu, use a higher Head
Height setting.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.842
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.831

The Ejection Guide is soiled. Clean the Ejection Guide.
 (See "Cleaning the Printer Exterior.") →P.998
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The surface of the paper is dirty

Cause Corrective Action

The Paper Retainer is soiled. Clean the Paper Retainer.
 (See "Cleaning Inside the Top Cover.") →P.998

You are using a paper that
does not dry easily.

In the Control Panel menu, set Roll DryingTime to at least 1 min.
 (See "Menu Settings.") →P.914

When paper that does not dry easily is used for printing, it may curl during printing
and touch the Output Tray.
In this case, in the Control Panel menu, set Scan Wait Time to an option other than
Off.
However, note that printing will now take longer.
 (See "Menu Settings.") →P.914

The back side of the paper is dirty

Cause Corrective Action

The Platen has become dirty after borderless
printing or printing on small paper.

Open the Top Cover and clean the Platen.
 (See "Cleaning Inside the Top Cover.") →P.998

The Platen suction is too strong. In the Control Panel menu, reduce the level of VacuumStrngth.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.842

Roller marks are left across the trailing edge of paper

Cause Corrective Action

The paper was removed without pressing the OK
button after printing from the Front Paper Feed Slot.

Following the instructions displayed, press the OK button, and
after removing the paper, press the OK button again.

Wipe the rollers to clean them.
 (See "Cleaning Inside the Top Cover.") →P.998
 (See "Cleaning the Paper Retainer.") →P.1001

Immediately after borderless printing, the trailing edge margin is soiled during regular
printing

Cause Corrective Action

Depending on your printing environment, af-
ter borderless printing in which the leading
and trailing edge of the roll is cut automatical-
ly, any ink adhering to the cutter unit may rub
off on the next printed document.

Follow these steps to change the Between Pages setting of Drying
Time to a value between about 30 seconds and 3 minutes before try-
ing borderless printing again.

1. On the Main sheet of the printer driver, click Advanced Settings
by Media Type.

2. Select an ink drying time in the list for the Between Pages setting
of Drying Time.
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Printed colors are inaccurate

Cause Corrective Action

Color adjustment has not been activated in the Advanced Settings
of the printer driver.

In the Advanced Settings of the printer driver,
access Color Settings in Color Mode to adjust
colors.

Colors have not been adjusted on the computer or monitor. Refer to the computer and monitor documenta-
tion to adjust the colors.

Adjust the settings of the color management soft-
ware, referring to the software documentation as
needed.

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if
they are clogged.
 (See "Checking for Nozzle Clogging.")
→P.980

In the Windows printer driver, Application Color Matching Pri-
ority is not selected.

Click Special Settings on the Layout sheet of the
printer driver and select Application Color
Matching Priority in the dialog box.

There may be a slight difference in how colors are printed after
Printhead replacement because of individual variation among
printheads.

Execute color calibration.

Printhead characteristics gradually change through repeated use,
and colors may change.

Execute color calibration.

Color may change slightly even on the same model of printer if
you use a different version of the firmware or printer driver, or
when you print under different settings or in a different printing
environment.

Follow these steps to prepare the printing envi-
ronment.

1. Use the same version of firmware or printer
driver.

2. Specify the same value for all settings items.

3. Execute color calibration.

When reinstalling the printer driver, you changed the region selec-
tion of the Media Configuration Tool.
Changing the region selection of the Media Configuration Tool
deletes the region-specific paper information originally registered
on the printer before installation. Using paper with deleted infor-
mation when executing color calibration will prevent the resulting
calibration adjustment value from being applied to all other types
of the paper.

Prepare paper compatible with calibration in the
newly selected region and perform calibration
again.

Banding in different colors occurs

Cause Corrective Action

The paper feed amount is out of ad-
justment.

Adjust the feed amount.
 (See "Adjusting the Feed Amount.") →P.833

If printed sheets are affected by banding in different colors by the trailing edge
(about 20–30 mm (0.8–1.2 in) from the edge), try adjusting the feed amount of
the trailing edge of sheets.
 (See "Adjusting Color on the Trailing Edge of Sheets.") →P.840
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Cause Corrective Action

Printing does not proceed smoothly
because print jobs are interrupted
during transmission.

Exit other applications and cancel other print jobs.

In the Control Panel menu, Adj.
Priority is set to Print Length.

Setting Adj. Priority to Print Quality in the Control Panel menu and adjusting
the feed amount may improve results.
 (See "Adjusting the Feed Amount.") →P.833

The Printhead is out of alignment. Adjust the Printhead alignment.
 (See "Automatic Adjustment to Straighten Lines and Colors (Head Posi.
Adj.).") →P.827

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if they are clogged.
 (See "Checking for Nozzle Clogging.") →P.980

Streaks may occur if you set the
Print Quality too low.

Choose a higher level of Print Quality in the Advanced Settings of the printer
driver and try printing again.
Printing in Fast or Standard mode is faster and consumes less ink than in
Highest quality or High modes, but the printing quality is lower.
 (See "Giving Priority to Particular Graphic Elements and Colors for Print-
ing.") →P.64

The type of paper specified in the
printer driver does not match the
type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

Make sure the same type of paper is specified in the printer driver as you have
loaded in the printer.

1. Press the Stop button and stop printing.

2. Change the type of paper in the printer driver and try printing again.

Colors in printed images are uneven

Cause Corrective Action

Line Drawing/Text is selected when
printing images in many solid colors.

In Print Priority in the Advanced Settings of the printer driver, choose Im-
age.

You are printing on paper that curls
easily.

Printed colors may appear uneven on the leading edge of paper that is suscepti-
ble to curling. Select a stronger level in VacuumStrngth in the Control Panel
menu to increase suction against the paper, or specify a leading margin of 20
mm (0.79 in) or more.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.842

Printed colors may be uneven if you
set the Print Quality too low.

Choose a higher level of Print Quality in the Advanced Settings of the printer
driver.
Printing in Fast or Standard mode is faster and consumes less ink than in
Highest quality or High modes, but the printing quality is lower.
 (See "Giving Priority to Particular Graphic Elements and Colors for Print-
ing.") →P.64

Color may be uneven between dark
and light image areas.

Select Unidirectional Printing in the Advanced Settings of the printer driver.

When borderless printing is used, the
edge of the paper is cut during print-
ing. Thus, ink density may be slight-
ly uneven at the leading edges.

Specify No in Auto Cut in the printer driver before printing. In this case, the
paper can be printed without borders on the left and right sides only. Cut the
printed document ejected from the printer, and then use scissors or a cutting
tool to cut away the edges on the top and bottom.
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Cause Corrective Action
When borderless printing is used, the
edge of the paper is cut during print-
ing. Thus, ink density may be slight-
ly uneven at the leading edges.

Choose a higher level of Print Quality in the Advanced Settings of the printer
driver.
 (See "Giving Priority to Particular Graphic Elements and Colors for Print-
ing.") →P.64

The Printhead is out of alignment. Adjust the Printhead alignment.
 (See "Automatic Adjustment to Straighten Lines and Colors (Head Posi.
Adj.).") →P.827

Allowing printed documents to dry
on top of each other may cause un-
even colors.

To avoid uneven colors, we recommend drying each sheet separately.

Density may be uneven if you use
Glossy Paper or Coated Paper.

In Advanced Settings of the printer driver, choose Highest quality or High in
Print Quality.

The type of paper specified in the
printer driver does not match the
type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

Make sure the same type of paper is specified in the printer driver as you have
loaded in the printer.

1. Press the Stop button and stop printing.

2. Change the type of paper in the printer driver and try printing again.

Colors may be uneven at the trailing
edge when you print on heavyweight
sheets even if you execute Adj Far
Ed Feed.

For heavyweight sheets or similar paper, execute Adj Far Ed Feed with the
Front Tray Guides raised. Also keep the Front Tray Guides raised during print-
ing.
Lower the Front Tray Guides when printing on paper other than heavyweight
sheets.

Scan Wait Time > Area in the Con-
trol Panel menu is set to Leading
edge.

When Scan Wait Time > Area is set to Leading edge, colors may be uneven
110–140 mm from the leading edge. (The position varies depending on the
Print Quality setting.)
In this case, select Scan Wait Time > Area > Entire area.
However, note that printing will now take longer.
 (See "Menu Settings.") →P.914

When you load paper in the Front
Paper Feed Slot and print, colors
may be uneven at the leading edge of
the paper.

Choose a higher level of Print Quality in the Advanced Settings of the printer
driver.
Printing in Fast or Standard mode is faster and consumes less ink than in
Highest quality or High modes, but the printing quality is lower.
 (See "Giving Priority to Particular Graphic Elements and Colors for Print-
ing.") →P.64

Straighten the paper if it is warped, and then load it straight into the printer.
 (See "Loading Sheets in the Feed Slot.") →P.809

Image edges are blurred or white banding occurs

Cause Corrective Action

The Platen suction is too strong. In the Control Panel menu, reduce the level of VacuumStrngth.
 (See "Adjusting the Vacuum Strength (VacuumStrngth).") →P.842

Close the blue Switch on the platen so that it matches the paper size.
 (See "Setting the Blue Switch on the Platen.") →P.1033
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Cause Corrective Action

Incorrect Printhead alignment
value.

When printing fine lines or text at high precision on glossy or semi-glossy photo or
proofing paper, set the optimal Printhead height before aligning the printhead.
 (See "Enhancing Printing Quality.") →P.825

In the Control Panel menu, set Head Height to a lower height.
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.831

The type of paper specified in
the printer driver does not
match the type loaded in the
printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

Make sure the same type of paper is specified in the printer driver as you have loa-
ded in the printer.

1. Press the Stop button and stop printing.

2. Change the type of paper in the printer driver and try printing again.

Setting the Blue Switch on the Platen
If printed documents exhibit the following symptoms, adjust the setting of the blue Switch on the Platen.

• Image edges are blurred
• Image edges are affected by white banding

Important
• Always set the blue Switch on the Platen to the ● side for borderless printing. Printing quality may be affec-

ted if the Switch is incorrectly set.

1. Remove any loaded paper that will not be used.

• Rolls  (See "Removing the Roll from the Printer.") →P.790

• Sheets  (See "Removing Sheets.") →P.817

2. Open the Top Cover.
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3. Remove the Cleaning Brush (a).

4. Using the back of the Cleaning Brush, move the first Switch to the side opposite ●.

Troubleshooting > Problems with the printing quality >

Setting the Blue Switch on the Platen iPF6300S

12

1034



5. Refer to the following table to confirm the number on the Platen (a) that corresponds to the size of paper for print-
ing.

Number Dimensions Paper Size

2 254 mm (10 in) or 257 mm 10"x12", 8"x10", or JIS B4

3 355 mm (14 in) 14"x17"

4 406 mm (16 in), 420 mm, or 432 mm (17 in) 16-in. Roll (406.4mm), ISO A2, 17-in. Roll (431.8mm), or
ANSI C

5 515 mm (20 in) JIS B2 or JIS B3

6 610 mm (24 in) ISO A1, ISO A2, or 20"x24"

6. Using the back of the Cleaning Brush, move the Switch to the side opposite ●, corresponding to the size of the paper
for printing.
In this case, note that you will move the switch in the opposite direction from the direction in step 4.

7. Close the Top Cover.

Troubleshooting > Problems with the printing quality >

iPF6300S Setting the Blue Switch on the Platen

12

1035



The contrast becomes uneven during printing

Cause Corrective Action

The paper feed amount is out of adjust-
ment.

Adjust the feed amount.
 (See "Adjusting the Feed Amount.") →P.833

The type of paper specified in the printer
driver does not match the type loaded in
the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

Make sure the same type of paper is specified in the printer driver as you
have loaded in the printer.

1. Press the Stop button and stop printing.

2. Change the type of paper in the printer driver and try printing again.

The length of printed images is inaccurate in the feeding direction

Cause Corrective Action

In the Control Panel menu, Adj. Priority
is set to Print Quality.

Set Adj. Priority to Print Length in the Control Panel menu, and then ex-
ecute Adjust Length.
 (See "Adjusting the Feed Amount.") →P.833

The type of paper specified in the printer
driver does not match the type loaded in
the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

Make sure the same type of paper is specified in the printer driver as you
have loaded in the printer.

1. Press the Stop button and stop printing.

2. Change the type of paper in the printer driver and try printing again.

Images are printed crooked

Cause Corrective Action

In the Control Panel menu, Skew Check Lv. is
set to Loose or Off.

In the Control Panel menu, set Skew Check Lv. to High Accuracy
or Standard.

Documents are printed in monochrome

Cause Corrective Action

In the Advanced Settings of the printer driv-
er, Monochrome or Monochrome (Photo), is
specified in Color Mode.

In the Advanced Settings of the printer driver, specify Color in Col-
or Mode and try printing again.

The Printhead nozzles are clogged. Print a test pattern to check the color ink nozzles and see if they are
clogged.
 (See "Checking for Nozzle Clogging.") →P.980
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Line thickness is not uniform

Cause Corrective Action

In the Special Settings dialog box of the Windows printer
driver, Fast Graphic Process is selected.

Access the printer driver Properties dialog box from Print
in the File menu of the source application, and follow these
steps to print.

1. Clear the option Open Preview When Print Job Starts
on the Main sheet.

2. Clear the option Page Layout on the Layout sheet.

3. Click the Special Settings button on the Layout sheet to
display the Special Settings dialog box, and then clear
the option Fast Graphic Process.

The blue Switch on the platen is set incorrectly. Move the Switch numbered corresponding to the size of pa-
per for printing opposite to the ● position.
 (See "Setting the Blue Switch on the Platen.") →P.1033

The type of paper specified in the printer driver does not
match the type loaded in the printer.

Load paper of the same type as you have specified in the
printer driver.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

Make sure the same type of paper is specified in the printer
driver as you have loaded in the printer.

1. Press the Stop button and stop printing.

2. Change the type of paper in the printer driver and try
printing again.

Incorrect Printhead alignment value. When printing fine lines or text at high precision on glossy
or semi-glossy photo or proofing paper, set the optimal
Printhead height before aligning the printhead.
 (See "Enhancing Printing Quality.") →P.825

In the Control Panel menu, use a lower Head Height set-
ting.
 (See "Troubleshooting Paper Abrasion and Blurry Im-
ages (Head Height).") →P.831

Depending on the type of paper, the thickness of printed
lines may be noticeably inconsistent.

Specify Proof in Print Priority in the printer driver.
 (See "Giving Priority to Particular Graphic Elements and
Colors for Printing.") →P.64

Lines or colors are misaligned

Cause Corrective Action

The Printhead is not being aligned
correctly.

Adjust the Printhead alignment.
 (See "Automatic Adjustment to Straighten Lines and Colors (Head Posi.
Adj.).") →P.827
 (See "Manual Adjustment to Straighten Lines and Colors (Head Posi.
Adj.).") →P.829

When printing fine lines or text at high precision on glossy or semi-glossy photo
or proofing paper, set the optimal Printhead height before aligning the printhead.
 (See "Enhancing Printing Quality.") →P.825
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Cause Corrective Action
The Printhead is not being aligned
correctly.

In the Control Panel menu, use a lower Head Height setting.
 (See "Troubleshooting Paper Abrasion and Blurry Images (Head Height).")
→P.831

The type of paper specified in the
printer driver does not match the
type loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

Make sure the same type of paper is specified in the printer driver as you have
loaded in the printer.

1. Press the Stop button and stop printing.

2. Change the type of paper in the printer driver and try printing again.

Depending on the type of paper,
printed lines may be noticeably
misaligned.

Specify Proof in Print Priority in the printer driver.
 (See "Giving Priority to Particular Graphic Elements and Colors for Print-
ing.") →P.64

Borderless printing is not possible

Cause Corrective Action

When executing borderless printing on A1 (594
mm) or A2 (420 mm) rolls, the Spacer for Border-
less Printing was not attached to the Roll Holder.

For borderless printing on A1 (594 mm) or A2 (420 mm) rolls,
attach the included Spacer for Borderless Printing to the Roll
Holder.
 (See "Loading Rolls on the Roll Holder.") →P.781

Problems with the printing quality caused by the type of paper
For paper-specific troubleshooting tips to improve the printing quality, refer to the Paper Reference Guide.  (See "Types of
Paper.") →P.773
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Cannot connect the printer to the network

Cause Corrective Action

The Ethernet cable
is not connected
correctly to the
printer's Ethernet
port.

1. Make sure the printer is connected to the network with the correct Ethernet cable, and then
turn the printer on. For instructions on connecting the cable, refer to the Setup Guide.

2. Make sure the Link indicator is lit.
The top and bottom indicators are lit if the printer is connected via 1000Base-T. The bottom
indicator is green if the printer is connected via 100BASE-TX, and the top indicator is orange
if connected via 10BASE-T.
If the Link indicator is not lit, check the following points.

• Make sure the hub is on.

• Make sure the end of the Ethernet cable is connected correctly.
Insert the Ethernet cable until it clicks and locks in place.

• Make sure there is no problem with the Ethernet cable.
If there is any problem, replace the Ethernet cable.

• Check the communication mode with the hub.
Although the printer normally detects the hub communication mode and transmission rate
automatically (in auto negotiation mode), sometimes the hub settings cannot be detected.
In this case, configure the connection method manually, specifying the communication
mode in use.
 (See "Configuring the Communication Mode Manually.") →P.968

Cannot print over a TCP/IP network

Cause Corrective Action

The printer's IP address is not
configured correctly.

Make sure the printer's IP address is configured correctly.
 (See "Configuring the IP Address Using imagePROGRAF Device Setup Utili-
ty.") →P.442
 (See "Configuring the IP Address Using the Printer Control Panel.") →P.942

The printer's TCP/IP network
settings are not configured cor-
rectly.

Make sure the printer's TCP/IP network settings are configured correctly.
 (See "Configuring the Printer's TCP/IP Network Settings With RemoteUI .")
→P.946

The computer you are trying to
print from is not configured cor-
rectly.

Make sure the computer's TCP/IP network settings are configured correctly.
 (See "Configuring the Printer Driver Destination (Windows).") →P.945
 (See "Configuring the Destination in TCP/IP Networks .") →P.960
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Cannot print over a NetWare network

Cause Corrective Action

The printer's NetWare set-
tings are not configured
correctly.

Make sure the printer's NetWare settings are configured correctly. In particular, make
sure a valid frame type is selected.
 (See "Configuring the Printer's NetWare Network Settings With RemoteUI.")
→P.957

The computer you are try-
ing to print from is not
configured correctly.

Make sure the computer's NetWare settings are configured correctly.
 (See "Configuring NetWare Network Settings.") →P.950

The NetWare server and
services are not configured
correctly.

Check the following points.

1. Make sure the NetWare file server is running.

2. Make sure there is enough free disk space on the NetWare file server. Insufficient
disk space may prevent you from processing large print jobs.

3. Start NWADMIN or PCONSOLE and confirm that the print service is configured
correctly and the print queue is available.

4. If data transmission to a printer on another subnet fails, deactivate NCP burst mode in
that printer's network protocol settings.

5. If the printer is used in queue server mode, specify Other/Unknown as the printer
type.

Cannot print over AppleTalk or Bonjour networks

Cause Corrective Action

The AppleTalk protocol is not
enabled on the printer.

Activate AppleTalk on the printer.
 (See "Configuring the Printer's AppleTalk Network Settings.") →P.965

The computer you are trying to
print from is not configured cor-
rectly.

Make sure the computer's AppleTalk settings are configured correctly.
 (See "Configuring the Destination for AppleTalk Networks .") →P.964
 (See "Configuring the Destination for Bonjour Network .") →P.962

The computer and printer are not
on the same network.

Due to the nature of Bonjour, you cannot print if the printer is on another network
behind a router. Make sure the computer and printer are on the same network. For
information about network settings, ask your network administrator.
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Installation problems
Removing Installed Printer Drivers ................................................................................................................ 1041

Removing Installed Printer Drivers
Follow these steps to remove installed printer drivers and utilities.

Removing printer drivers (Windows)
Remove the printer driver as follows.

Note
• The following instructions are for Windows XP. The method of removing printer drivers varies depending on

the version of Windows.

1. From the Windows start menu, select Programs > Canon Printer Uninstaller > imagePROGRAF Printer Driv-
er Uninstaller to display the Delete Printer window.

2. Select the printer in the list and click Delete.

3. Click Yes after the Warning message is displayed.

4. Make sure that the printer has been removed from the list, and then click Exit.

Removing printer drivers and imagePROGRAF Printmonitor (Macintosh)
Remove the printer driver or imagePROGRAF Printmonitor as follows.

1. Insert the User Software CD-ROM provided with the printer in the CD-ROM drive.

2. Start the printer driver installer included in the User Software CD-ROM.
Open the OS X folder and double-click iPF Driver Installer X.

3. In the upper left menu, choose Uninstall, and then click Uninstall.

4. Follow the instructions on the screen to remove the printer driver or imagePROGRAF Printmonitor.

Removing imagePROGRAF Status Monitor (Windows)
Remove imagePROGRAF Status Monitor as follows.

Note
• The following instructions are for Windows XP. The method of removing printer drivers varies depending on

the version of Windows.

1. Select Control Panel from the start menu.

2. Select Add or Remove Programs.
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3. Select imagePROGRAF Status Monitor, and then click the Change/Remove button.

Removing imagePROGRAF Device Setup Utility (Windows)
Remove imagePROGRAF Device Setup Utility as follows.

Note
• The following instructions are for Windows XP. The method of removing printer drivers varies depending on

the version of Windows.

1. From the Windows start menu, select Programs > imagePROGRAF Device Setup Utility > Uninstaller (image-
PROGRAF Device Setup Utility) to start the wizard.

2. In the wizard window, click Delete, and then click Next.

3. Follow the instructions on the screen to remove imagePROGRAF Device Setup Utility.
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The printer does not go on

Cause Corrective Action

The printer is unplugged. Plug the power cord into the outlet, and then turn on the printer.

The specified voltage is not supplied. Check the voltage of the outlet and breaker.
 (See "Specifications.") →P.1078

The printer takes time to start up

Cause Corrective Action

The printer may have shut down incorrectly last time. This
may happen after power outages or if the printer is unplugged
before it is turned off.
In this case, the next time power is restored, the printer's hard
disk is checked, and startup may take some time.

Please wait a while, because it may take several mi-
nutes to finish checking the hard disk.
If an error message is displayed after the hard disk
check, follow the instructions indicated to resolve the
problem.
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If the Printer Makes a Strange Sound

Cause Corrective Action

The printer
makes a sound
during opera-
tion.

The following sounds do not indicate a problem with the printer.

• There is a sound of suction from the Platen.
To prevent paper from rising, paper is held against the Platen by suction from Vacuum holes under
it.

• Roll paper makes a fluttering sound during printing.
There may be a fluttering sound when large paper is advanced.

• You suddenly hear the sound of cleaning operations.
At regular intervals, for printer maintenance, cleaning operations will begin automatically, even if
the printer is in Sleep mode.

• You suddenly hear the sound of ink agitation.
At regular intervals, to ensure optimal printing quality, the ink is agitated automatically, even if the
printer is in Sleep mode. Ink agitation takes about 30 seconds.
The ink is also agitated automatically under the following conditions. Note that other operations
are not possible while "Agitating" is displayed on the control panel.

• After the printer is turned on

• After data transmission

• After ink tank replacement

In other cases, contact your Canon dealer.

Messages advising to check the maintenance cartridge are not cleared

Cause Corrective Action

The printer has not detected the new Maintenance Cartridge that was
used to replace the old one.

Remove the new Maintenance Cartridge you
have just installed and insert it again firmly.

Restart the printer.

The printer consumes a lot of ink

Cause Corrective Action

Many full-page color images
are printed.

In print jobs such as photos, images are filled with color. This consumes a lot of ink.
This does not indicate a problem with the printer.

Head Cleaning B in the Con-
trol Panel menu is executed
frequently.

Head Cleaning B in the Control Panel menu consumes a lot of ink. This does not
indicate a problem with the printer. Unless the printer has been moved or stored for a
long period or you are troubleshooting Printhead problems, we recommend not per-
forming Head Cleaning B, to the extent possible.

You have just finished initial
installation, when more ink is
consumed to fill the system.

After initial installation or at the first-time use after transfer, ink flows into the sys-
tem between the Ink Tank and Printhead, which may cause the ink level indicators to
drop to 80%. This does not indicate a problem with the printer.

The Printhead nozzles are
clogged.

Check for nozzle clogging.
 (See "Checking for Nozzle Clogging.") →P.980
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Ink Level Detection
Ink level detection will be deactivated if you load ink tanks once emptied.

Ink level detection
Ink tanks specified for this printer feature an ink level detection function to prevent the ink from running out during print-
ing, which prevents printer damage.  (See "Ink Tanks.") →P.972
This function will not work correctly if you use refill ink tanks. As a result, printing stops. Thus, before using refill ink
tanks, you must cancel the ink level detection.
Printing with the ink level detection canceled may lead to printer damage and printing problems. Canon Inc. is not liable for
any damage that may occur as a result of refilling ink.

Important
• After ink level detection has been released, this function cannot be reactivated for currently loaded Ink Tank.

To use ink level detection again, replace the Ink Tank with new ones specified for use with the printer.
• Repeatedly removing and inserting an Ink Tank may damage the connection between the Ink Tank and the

printer, which may cause ink leakage from the Ink Tank and damage the printer.

Releasing ink level detection

1. On the Display Screen, a message indicates that the ink level cannot be detected. After checking the message, press
the ▶ button.

2. Press ▲ or ▼ to select Information, and then press the OK button.

3. A confirmation message is shown on the Display Screen about releasing ink level detection. After checking the mes-
sage, press the ▶ button.

Troubleshooting > Other problems >
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4. After checking the message, press the ▶ button.

5. Press ▲ or ▼ to select Yes, and then press the OK button.

6. Check the message and press the ▶ button.

7. Check the message and press the ▶ button.

8. Press ▲ or ▼ to select Yes, and then press the OK button.

Troubleshooting > Other problems >
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9. A confirmation message about updating ink information is shown on the Display Screen. After checking the mes-
sage, press the ▶ button.

10. Press ▲ or ▼ to select Yes, and then press the OK button.

Ink level detection is now released.

Troubleshooting > Other problems >
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Error Message

Error Messages 1049

Messages regarding paper 1051

Messages regarding ink 1062

Messages regarding printing or adjustment 1065

Messages regarding printheads 1068

Messages regarding the maintenance cartridge 1070

Messages regarding the hard disk 1072

Other Messages 1074
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Error Messages
Before borderless printing, move the blue platen switch. .............................................................................. 1067
Blue platen switch is dirty. ............................................................................................................................. 1067
Borderless printng not possible. ................................................................................................................... 1060

 

Calibration There is a problem with the multi-sensor. .................................................................................. 1075
Cannot adjust paper feed. ............................................................................................................................. 1067
Cannot adjust printhead. ............................................................................................................................... 1068
Cannot calibrate. .......................................................................................................................................... 1066
Cannot cut paper. ......................................................................................................................................... 1059
Cannot detect papr ....................................................................................................................................... 1058
Cannot execute this command. Use other paper. ........................................................................................ 1065
Cannot feed paper. ....................................................................................................................................... 1059
Cannot print as specified. .............................................................................................................................. 1065
Check printed document. ............................................................................................................................... 1067
Close Ink Tank Cover ................................................................................................................................... 1063

 

End of paper feed. ......................................................................................................................................... 1060
ERROR Exxx-xxxx (x represents a letter or number) .................................................................................... 1074
Excessive temperature or humidity. ............................................................................................................. 1066
Execute printhead cleaning. ......................................................................................................................... 1069

 

File read error. .............................................................................................................................................. 1072
 

GARO Wxxxx (x represents a number) ......................................................................................................... 1074
 

Hard disk error. ............................................................................................................................................. 1072
Hardware error. xxxxxxxx-xxxx (x represents a letter or number) ................................................................. 1074

 

Ink insufficient. .............................................................................................................................................. 1062
Insufficient paper for job ............................................................................................................................... 1055

 

Mail box full. Delete unwanted data .............................................................................................................. 1073
Mail box full. Now printing without saving data. ............................................................................................ 1072
Mail box nearly full. ....................................................................................................................................... 1073
Maint. cart. The level is low ........................................................................................................................... 1070
Maintenance cartridge full. ........................................................................................................................... 1070
Maintenance cartridge problem. ................................................................................................................... 1071
Manual printing is selected, but a roll is loaded. ............................................................................................ 1057
Manual printing is selected. .......................................................................................................................... 1057
Maximum jobs stored. .................................................................................................................................. 1073
MediaType Mismatch ................................................................................................................................... 1052
Move the blue platen switch No.xx to the right. (xx represents a number) .................................................... 1067
Multi-sensor error .......................................................................................................................................... 1076

 

No ink left. ...................................................................................................................................................... 1062
No ink tank loaded. ....................................................................................................................................... 1063
No Maintenance Cartridge capacity. ............................................................................................................. 1070
No maintenance cartridge. ............................................................................................................................ 1070
No Roll Unit. .................................................................................................................................................. 1057
No x printhead (x is L, R, or not displayed) ................................................................................................... 1069
Not much ink is left. ....................................................................................................................................... 1063

 

Paper loaded askew. .................................................................................................................................... 1058
Paper mismatch ............................................................................................................................................ 1051
Paper not aligned with right guide. ............................................................................................................... 1058
Paper size not detected. ................................................................................................................................ 1054

Error Message > Error Messages >

iPF6300S

13

1049



PaprWidth Mismatch ..................................................................................................................................... 1053
Parts replacement time has passed. ............................................................................................................. 1075
PHeads: wrong pos. ..................................................................................................................................... 1068
Please calibrate using above paper. ............................................................................................................ 1066
Please execute calibration. ........................................................................................................................... 1066
Prepare for parts replacement. ...................................................................................................................... 1075

 

Remaining level of the ink cannot be correctly detected. .............................................................................. 1062
Roll feed unit error. ........................................................................................................................................ 1056
Roll paper is not securely in contact with roll holder. ..................................................................................... 1061
Roll printing is selected, but manual paper is loaded. ................................................................................... 1056
Roll printing is selected. ................................................................................................................................ 1055

 

The mail box is full. ....................................................................................................................................... 1072
The paper is too small. ................................................................................................................................. 1052
The paper is too small. ................................................................................................................................. 1053
The roll is empty. ........................................................................................................................................... 1056
This paper cannot be used. .......................................................................................................................... 1055

 

Unknown file. ................................................................................................................................................ 1075
 

Wrong ink tank. .............................................................................................................................................. 1064
Wrong maintenance cartridge. ...................................................................................................................... 1070
Wrong paper feed slot for manual paper. ...................................................................................................... 1057
Wrong x printhead. (x is L, R, or not displayed) ............................................................................................ 1068

 

x printhead error (x is L, R, or not displayed) ................................................................................................ 1069
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Messages regarding paper
Paper mismatch ............................................................................................................................................ 1051
MediaType Mismatch ................................................................................................................................... 1052
The paper is too small. ................................................................................................................................. 1052
The paper is too small. ................................................................................................................................. 1053
PaprWidth Mismatch ..................................................................................................................................... 1053
Paper size not detected. ................................................................................................................................ 1054
Insufficient paper for job ............................................................................................................................... 1055
This paper cannot be used. .......................................................................................................................... 1055

 

Roll printing is selected. ................................................................................................................................ 1055
Roll printing is selected, but manual paper is loaded. ................................................................................... 1056
The roll is empty. ........................................................................................................................................... 1056
Roll feed unit error. ........................................................................................................................................ 1056
No Roll Unit. .................................................................................................................................................. 1057

 

Manual printing is selected. .......................................................................................................................... 1057
Manual printing is selected, but a roll is loaded. ............................................................................................ 1057
Wrong paper feed slot for manual paper. ...................................................................................................... 1057

 

Paper loaded askew. .................................................................................................................................... 1058
Paper not aligned with right guide. ............................................................................................................... 1058
Cannot detect papr ....................................................................................................................................... 1058
Cannot feed paper. ....................................................................................................................................... 1059
Cannot cut paper. ......................................................................................................................................... 1059
End of paper feed. ......................................................................................................................................... 1060

 

Borderless printng not possible. ................................................................................................................... 1060
 

Roll paper is not securely in contact with roll holder. ..................................................................................... 1061

Paper mismatch

Cause Corrective Action

You tried to print a test pattern for
printer adjustment on several sheets,
but sheets of different types or sizes
of paper were used.

When printing a test pattern for adjustment, use sheets of the same size and
type of paper, in the required quantity.
Press ▲ or ▼ to select Change Paper, press the OK button, and replace the
paper.
 (See "Loading and Printing on Sheets.") →P.9
The printer now starts printing the test pattern.

Replace the paper as follows and perform adjustment again.

1. Press ▲ or ▼ to select Stop Printing, and then press the OK button.

2. Replace the paper.
 (See "Loading and Printing on Sheets.") →P.9

3. Execute adjustment again from the control panel menu.

Error Message > Messages regarding paper >
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MediaType Mismatch

Cause Corrective Action

When Detect Mismatch in the Control Panel
menu is set to Pause, the type of paper loa-
ded does not match the type specified in the
printer driver.

Follow these steps to ensure the paper type matches on the printer and
in the printer driver.

1. Press ▲ or ▼ to select Stop Printing, and then press the OK but-
ton.

2. Change the paper type setting in the printer driver to the type loa-
ded in the printer and try printing again.

Follow these steps to ensure the paper type matches on the printer and
in the printer driver.

1. Press ▲ or ▼ to select Change Paper, and then press the OK but-
ton.

2. Replace the loaded paper with paper of the type and size you have
specified in the printer driver.
 (See "Loading and Printing on Rolls.") →P.5
 (See "Loading and Printing on Sheets.") →P.9

Press ▲ or ▼ to select Print, and then press the OK button to resume
printing.
However, note that this error may cause paper jams and affect the
printing quality.

When Detect Mismatch in the Control Panel
menu is set to Warning, the type of paper
loaded does not match the type specified in
the printer driver.

You can continue to print, but note that this error may cause problems
in the printing results.

The paper is too small.

Cause Corrective Action

When Detect Mismatch in the Control Panel
menu is set to Pause or Hold Job, paper small-
er than the size specified in the printer driver is
loaded.

Press ▲ or ▼ to select Print, and then press the OK button to re-
sume printing.
However, note that this error may cause paper jams and affect the
printing quality.

Adjust the paper size setting in the printer driver to match the size
loaded in the printer as follows.

1. Press ▲ or ▼ to select Stop Printing, and then press the OK but-
ton.

2. Change the paper size setting in the printer driver to the size loa-
ded in the printer and try printing again.

Replace the loaded paper with paper of a size that matches the size
setting in the printer driver as follows.

1. Press ▲ or ▼ to select Change Paper, and then press the OK
button to stop printing.

2. Replace the loaded paper to match the paper width setting in the
printer driver and try printing again.

Error Message > Messages regarding paper >
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Cause Corrective Action

When Detect Mismatch in the Control Panel
menu is set to Warning, paper smaller than the
size specified in the printer driver is loaded.

You can continue to print, but note that this error may cause prob-
lems in the printing results.

The paper is too small.

Cause Corrective Action

A sheet has come out of the printer during
printing.

1. Press the OK button and remove the sheet.

2. Confirm the paper size and setting.

3. Reload the paper.
 (See "Loading Sheets in the Feed Slot.") →P.809

The loaded paper is too small.
(When you have attempted to print a test
print sheet or other printer status informa-
tion.)

Replace the roll with a roll 10 inches in width or larger as follows.

1. Press ▲ or ▼ to select Change Paper, and then press the OK button.
 (See "Removing the Roll from the Printer.") →P.790
 (See "Removing Rolls From the Roll Holder.") →P.792

2. Replace the roll with a roll 10 inches wide or larger.
 (See "Loading Rolls on the Roll Holder.") →P.781
 (See "Loading Rolls in the Printer.") →P.784
The printer will resume printing.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

PaprWidth Mismatch

Cause Corrective Action

When Detect Mismatch in the Control Panel menu
is set to Pause or Warning, the width of the loaded
roll does not match the width specified in Fit Roll
Paper Width in the printer driver.

Press ▲ or ▼ to select Print, and then press the OK button to
resume printing.
However, note that this error may cause paper jams and affect
the printing quality.

Press ▲ or ▼ to select Stop Printing, and then press the OK
button.

Follow these steps to replace the roll to match the width speci-
fied in the printer driver.

1. Press ▲ or ▼ to select Change Paper, and then press the
OK button.
 (See "Removing the Roll from the Printer.") →P.790
 (See "Removing Rolls From the Roll Holder.") →P.792

2. Replace the paper with paper compatible for borderless print-
ing.
 (See "Loading Rolls on the Roll Holder.") →P.781
 (See "Loading Rolls in the Printer.") →P.784
The printer now starts printing the print job.

Make sure the roll width selected in the dialog box displayed
when you select Fit Roll Paper Width in the printer driver
matches the width of the roll loaded in the printer, and then try
printing again.

Error Message > Messages regarding paper >
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Paper size not detected.

Cause Corrective Action

Paper has been loaded askew, or warped paper has been loaded. Follow these steps to reload the roll.

1. Press the OK button.

2. Adjust the right edge of the roll to make it paral-
lel to the right Paper Alignment Line.

3. If "Not finished printing. Finish printing re-
maining jobs?" is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on
which the error occurred.

 (See "Loading Rolls in the Printer.") →P.784

If this error recurs after you reload the roll, remove
the Roll Holder from the printer, push the roll firmly
in until it touches the Roll Holder flange, and reload
the Roll Holder in the printer.
 (See "Loading Rolls on the Roll Holder.")
→P.781

Follow these steps to reload the sheet.

1. Press the OK button.

2. Adjust the right edge of the sheet to make it par-
allel to the right Paper Alignment Line and the
trailing edge of the sheet to make it parallel to the
paper alignment line under the Paper Retainer.

3. If "Not finished printing. Finish printing re-
maining jobs?" is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on
which the error occurred.

 (See "Loading Sheets in the Feed Slot.")
→P.809

Error Message > Messages regarding paper >
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Insufficient paper for job

Cause Corrective Action

The printer has received a print job longer than the amount of roll paper left
when ManageRemainRoll in the Control Panel menu is On.

Press ▲ or ▼ to select Print, and
then press the OK button to resume
printing.
However, the roll paper may run out
during the print job and you may not
be able to print all of the document.

Press ▲ or ▼ to select Change Pa-
per, and then press the OK button.
Change the Paper Source of the
printer driver, or replace the roll
with a roll that has enough paper for
the print job, and then print.
 (See "Removing the Roll from the
Printer.") →P.790
 (See "Loading Rolls in the Print-
er.") →P.784

Press ▲ or ▼ and select Stop
Printing or press the Stop button to
stop printing.

This paper cannot be used.

Cause Corrective Action

Paper that is too large for the printer has been
loaded.

Press the OK button and load paper of the correct size.
 (See "Paper Sizes.") →P.774

Paper that is too small for the printer has been
loaded.

Press the OK button and load paper of the correct size.
 (See "Paper Sizes.") →P.774

Paper has been loaded that is too small to print
the test pattern for printhead adjustment or noz-
zle checking.

Press the OK button and load unused paper A4/Letter (vertical) or
larger. More than one sheet may be required depending on the ad-
justment.

Roll printing is selected.

Cause Corrective Action

You have attempted to print on a roll,
but no roll is loaded.

Press ▲ or ▼ to select Load Roll Paper, and then press the OK button.
Load the roll, and then print.
 (See "Loading Rolls on the Roll Holder.") →P.781
 (See "Loading Rolls in the Printer.") →P.784

Press ▲ or ▼ and select Stop Printing or press the Stop button to stop
printing.

Error Message > Messages regarding paper >
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Roll printing is selected, but manual paper is loaded.

Cause Corrective Action

A print job for rolls was received
when a sheet is loaded.

Follow these steps to load and print on a roll.

1. Press ▲ or ▼ to select Eject Paper, press the OK button, and remove the
sheet.
 (See "Removing Sheets.") →P.817

2. Load a new roll.
 (See "Loading Rolls in the Printer.") →P.784
The printer now starts printing the print job.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

The roll is empty.

Cause Corrective Action

The roll is empty. Follow these steps to replace the used roll with a new roll of the same type and size.

1. Press the OK button and remove the roll.
 (See "Removing the Roll from the Printer.") →P.790
 (See "Removing Rolls From the Roll Holder.") →P.792

2. Load the new roll.
 (See "Loading Rolls on the Roll Holder.") →P.781
 (See "Loading Rolls in the Printer.") →P.784

3. If no barcode was printed on the roll, specify the type of paper.
 (See "Changing the Type of Paper.") →P.787

4. When you have selected ManageRemainRoll > On in the control panel menu and a barcode
is not printed on the roll, also specify the paper length.
 (See "Specifying the Paper Length.") →P.789

5. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on which the error occurred.

There is remaining
roll paper, but be-
cause it could not
be advanced, it
could not be de-
tected.

The unused portion of the roll is heavy, and this is placing a burden on the printer. It may be help-
ful to change the printing mode, which will change the paper feed timing.
Choose a higher level of Print Quality in the Advanced Settings of the printer driver.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") →P.64

Roll feed unit error.

Cause Corrective Action

The Roll Feed Unit is not
working.

Turn off the printer, remove the Roll Feed Unit momentarily, and then reinstall it.
 (See "Removing the Roll Feed Unit.") →P.805
 (See "Installing the Roll Feed Unit.") →P.806

If the message is displayed again despite these measures, contact your Canon dealer for
assistance.

Error Message > Messages regarding paper >
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No Roll Unit.

Cause Corrective Action

The printer has received a print job, but the Roll Feed Unit is
not installed.

Press the Stop button and stop printing.

1. Turn the printer off and install the Roll Feed Unit.
Connect the Roll Unit Cable firmly and completely.

2. Turn the printer on and resend the print job.

Manual printing is selected.

Cause Corrective Action

You have attempted to print on a sheet, but
no sheet is loaded.

Press ▲ or ▼ to select Load Paper, and then press the OK button. Load
a sheet, and then print.
 (See "Loading and Printing on Sheets.") →P.9

Press ▲ or ▼ and select Stop Printing or press the Stop button to stop
printing.

Manual printing is selected, but a roll is loaded.

Cause Corrective Action

A print job for printing on
sheets was sent when a roll is
loaded.

1. Press ▲ or ▼ to select Remove Roll Paper, and then press the OK button to stop
printing.

2. After removing the roll, load and print on a sheet of the type and size of paper you
have specified in the printer driver.
 (See "Removing the Roll from the Printer.") →P.790
 (See "Loading and Printing on Sheets.") →P.9

Press ▲ or ▼ to select Stop Printing, and then press the OK button to stop printing.

Wrong paper feed slot for manual paper.

Cause Corrective Action

The Paper Feed Slot used to load
the sheet is different from the Paper
Feed Slot specified in Paper
Source in the printer driver.

Load the sheet in the Paper Feed Slot matching the printer driver Paper Source
setting as follows.

1. Press ▲ or ▼ to select Eject Paper, and then press the OK button to stop
printing.
The sheet is now ejected.

2. Load the paper in the Paper Feed Slot specified in the printer driver.
The printer will resume printing.

Change the printer driver Paper Source setting to match the Paper Feed Slot
where the sheet is loaded as follows.

1. Press ▲ or ▼ to select Stop Printing, and then press the OK button.

2. In the printer driver, change the Paper Source setting to match the Paper
Feed Slot where the sheet is loaded, and then resend the print job.

Error Message > Messages regarding paper >
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Paper loaded askew.

Cause Corrective Action

Paper loaded crooked was detected when the paper was advanced. Follow these steps to reload the roll.

1. Press the OK button.

2. Adjust the right edge of the roll to make it par-
allel to the orange Paper Alignment Line.

 (See "Loading Rolls in the Printer.") →P.784

If this error recurs after you reload the roll, re-
move the Roll Holder from the printer, push the
roll firmly in until it touches the Roll Holder
flange, and reload the Roll Holder in the printer.
 (See "Loading Rolls on the Roll Holder.")
→P.781

Follow these steps to reload a sheet.

1. Press the OK button.

2. Pull out the sheet.

3. Load the sheet. see "Loading Sheets in the
Feed Slot." →P.809

Important
• To disable this message (if it is displayed repeatedly despite reloading paper, for example), choose Off or

Loose in the Skew Check Lv. setting of the printer menu. However, this may cause jams and printing prob-
lems because paper may be askew when printed. Also, the Platen may become soiled, which may soil the
back of the next document when it is printed.

Paper not aligned with right guide.

Cause Corrective Action

When paper was loaded, it was not aligned with the guide
on the right side.

Follow these steps to reload the sheet.

1. Press the OK button to clear the error.

2. Reload the paper.
 (See "Loading Sheets in the Feed Slot.") →P.809

Cannot detect papr

Cause Corrective Action

The printer could not detect the paper. Reload the paper as follows.

1. Remove the paper and press the OK button.

2. Reload the paper.
 (See "Loading Sheets in the Feed Slot.") →P.809
 (See "Loading Rolls in the Printer.") →P.784

Error Message > Messages regarding paper >
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Cannot feed paper.

Cause Corrective Action

Paper could not be ad-
vanced correctly during
feeding.

1. Press the OK button.

2. Remove the paper.
 (See "Clearing Jammed Roll Paper.") →P.1014
 (See "Clearing a Jammed Sheet, Fed Manually.") →P.1018

3. Load the paper.
 (See "Loading Rolls in the Printer.") →P.784
 (See "Loading Sheets in the Feed Slot.") →P.809

4. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display
Screen, press the OK button.
Printing will resume, starting from the page on which the error occurred.

Paper could not be ad-
vanced correctly during
ejection.

1. Press the OK button.

2. Remove the paper.
 (See "Clearing Jammed Roll Paper.") →P.1014
 (See "Clearing a Jammed Sheet, Fed Manually.") →P.1018

Cannot cut paper.

Cause Corrective Action

There are sheets left on the
Ejection Guide.

1. Press the OK button and remove the paper.

2. Load paper.

3. If "Not finished printing. Finish printing remaining jobs?" is shown on the Dis-
play Screen, press the OK button.
Printing will resume, starting from the page on which the error occurred.

 (See "Loading Rolls in the Printer.") →P.784

There is a foreign object by
the Output Tray, obstructing
the Cutter Unit.

1. Lift the Top Cover and remove the foreign object.

2. If "Not finished printing. Finish printing remaining jobs?" is shown on the Dis-
play Screen, press the OK button.
Printing will resume, starting from the page on which the error occurred.

You are not using the printer
under the recommended en-
vironmental conditions for
the paper.

Use the printer only where the recommended environmental conditions for the paper
are met. Note that various environmental conditions are recommended for various types
of paper. For details on the recommended environmental conditions, see the Paper Ref-
erence Guide.
(See Paper Reference Guide .)

You are using paper that is
not compatible with auto-
matic cutting.

1. Specify Manual as the cutting method and use scissors or a cutting tool to cut the
roll.
 (See "Specifying the Cutting Method for Rolls.") →P.797
For information about paper that is compatible with automatic cutting, see the Paper
Reference Guide.
(See Paper Reference Guide .)

2. Press the OK button and remove the paper.

In other cases, the Cutter
Unit may be damaged.

Contact your Canon dealer for assistance.
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End of paper feed.

Cause Corrective Action

You are pressing the ▲ button on the Control Panel and trying to rewind the roll to the edge. Release the ▲ button.

Borderless printng not possible.

Cause Corrective Action

The print job received specifies a
type or width of paper that is not
compatible with borderless print-
ing.

Follow these steps to change the settings of the print job to enable borderless
printing.

1. Press ▲ or ▼ to select Stop Printing, and then press the OK button.

2. Make sure the correct printer driver for the printer is selected and try printing
again.
For information on types of paper compatible with borderless printing, refer to
the Paper Reference Guide.
(See Paper Reference Guide .)

Select None when you have set Detect Mismatch on the control panel to Warn-
ing.
However, note that this error may cause paper jams and affect the printing quality.

Press ▲ or ▼ to select Print With Border, and then press the OK button to con-
tinue printing. The document will be printed with a border.

The loaded paper is a size not
compatible with borderless print-
ing.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

Replace the paper with paper compatible for borderless printing as follows.

1. Press ▲ or ▼ to select Change Paper, and then press the OK button.
 (See "Removing the Roll from the Printer.") →P.790
 (See "Removing Rolls From the Roll Holder.") →P.792

2. Replace the paper with paper compatible for borderless printing.
 (See "Loading Rolls on the Roll Holder.") →P.781
 (See "Loading Rolls in the Printer.") →P.784
The printer now starts printing the print job.
For information on types of paper compatible with borderless printing, refer to
the Paper Reference Guide.
(See Paper Reference Guide .)

Press ▲ or ▼ to select Print With Border, and then press the OK button to con-
tinue printing. The document will be printed with a border.

Because paper expands or con-
tracts depending on the environ-
ment of use, it may become nar-
rower or wider than the supported
width for borderless printing.

Press the OK button to stop printing.
Use each type of paper only where the recommended environmental conditions are
met. For details on environmental conditions for various paper, see the Paper Ref-
erence Guide.
(See Paper Reference Guide .)

Select None when you have set Detect Mismatch in the Control Panel menu to
Warning.
However, note that this error may affect the printing quality.

The paper is loaded askew. Press ▲ or ▼ to select Change Paper and straighten the paper so that the edges
are between the ink grooves for borderless printing.
Insert the roll firmly until it touches the flange of the Roll Holder.

Error Message > Messages regarding paper >
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Cause Corrective Action
The paper is loaded askew. For borderless printing on A1 (594 mm or 23.4 in) or A2 (420 mm or 16.5 in)

rolls, attach the included Spacer for Borderless Printing to the Roll Holder.
 (See "Loading Rolls on the Roll Holder.") →P.781

Select None when you have set Detect Mismatch in the Control Panel menu to
Warning.
However, note that this error may affect the printing quality.

Press ▲ or ▼ to select Print With Border, and then press the OK button to con-
tinue printing. The document will be printed with a border.

Press ▲ or ▼ and select Stop Printing or press the Stop button to stop printing.

Roll paper is not securely in contact with roll holder.

Cause Corrective Action

When the roll was loaded, the roll was not in-
serted firmly all the way on the Roll Holder.

Follow these steps to reload the roll.

1. Press the OK button and remove the roll holder from the printer.

2. Insert the roll firmly on the Roll Holder until it touches the flange.
 (See "Loading Rolls on the Roll Holder.") →P.781

3. Load the Roll Holder in the printer.

Error Message > Messages regarding paper >

iPF6300S Roll paper is not securely in contact with roll holder.
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Messages regarding ink
Ink insufficient. .............................................................................................................................................. 1062
No ink left. ...................................................................................................................................................... 1062
Remaining level of the ink cannot be correctly detected. .............................................................................. 1062

 

Close Ink Tank Cover ................................................................................................................................... 1063
Not much ink is left. ....................................................................................................................................... 1063
No ink tank loaded. ....................................................................................................................................... 1063
Wrong ink tank. .............................................................................................................................................. 1064

Ink insufficient.

Cause Corrective Action

The ink level is low, so you cannot print, clean the Printhead, or do other op-
erations that require ink.

Press ▲ or ▼ to select Rep. Ink
Tank, and then press the OK button.
Replace the Ink Tank that is low with
a new Ink Tank.
 (See "Replacing Ink Tanks.")
→P.972

Press ▲ or ▼ to select Continue to
print, and then press the OK button to
resume printing. However, note that
this error may affect the printing quali-
ty.

Press the OK button and replace the
Ink Tank that is low with a new Ink
Tank.
 (See "Replacing Ink Tanks.")
→P.972

No ink left.

Cause Corrective Action

There is no ink left. Open the Ink Tank Cover and replace the Ink Tank for which the Ink Lamp is flashing.
 (See "Replacing Ink Tanks.") →P.972

Remaining level of the ink cannot be correctly detected.

Cause Corrective Action

Ink level detection cannot work cor-
rectly if you use refill ink tanks.

The refill ink tank can no longer be used. See the section Ink level detection
and take the appropriate action.  (See "Ink Level Detection.") →P.1045

Error Message > Messages regarding ink >

Ink insufficient. iPF6300S
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Close Ink Tank Cover

Cause Corrective Action

The Ink Tank Cover is open. Close the Ink Tank Cover.

Not much ink is left.

Cause Corrective Action

Not much ink is left. Prepare a new Ink Tank.
We recommend replacing the Ink Tank with a new Ink Tank at this
point if you plan to print large-format or high-quantity jobs.

No ink tank loaded.

Cause Corrective Action

There is no Ink Tank of the indicated color in the printer. Load the Ink Tank.
 (See "Replacing Ink Tanks.") →P.972

Error Message > Messages regarding ink >

iPF6300S Close Ink Tank Cover
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Cause Corrective Action

There is a problem with the Ink Tank. Replace it with a new Ink Tank.
 (See "Replacing Ink Tanks.") →P.972

Wrong ink tank.

Cause Corrective Action

The Ink Tank in the printer is incompatible. Load an Ink Tank specified for use with the printer.
 (See "Replacing Ink Tanks.") →P.972

Error Message > Messages regarding ink >

Wrong ink tank. iPF6300S
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Messages regarding printing or adjustment
Cannot execute this command. Use other paper. ........................................................................................ 1065
Cannot print as specified. .............................................................................................................................. 1065

 
 

Cannot calibrate. .......................................................................................................................................... 1066
Excessive temperature or humidity. ............................................................................................................. 1066
Please execute calibration. ........................................................................................................................... 1066
Please calibrate using above paper. ............................................................................................................ 1066

 

Before borderless printing, move the blue platen switch. .............................................................................. 1067
 

Blue platen switch is dirty. ............................................................................................................................. 1067
Move the blue platen switch No.xx to the right. (xx represents a number) .................................................... 1067

 

Cannot adjust paper feed. ............................................................................................................................. 1067
Check printed document. ............................................................................................................................... 1067

Cannot execute this command. Use other paper.

Cause Corrective Action

Paper compatible
with color calibration
is not loaded.

1. Press the OK button to clear the error.

2. Load paper that is compatible with color calibration.
See the Paper Reference Guide.
(See Paper Reference Guide .)

Always make sure the loaded paper matches the type of paper in the printer paper settings. Ad-
justment cannot be completed correctly unless the loaded paper matches the settings.

Cannot print as specified.

Cause Corrective Action

The loaded paper is too small.
(When you have attempted to print a test
print sheet or other printer status informa-
tion.)

Replace the paper with paper of A4/Letter (vertical) size or larger as fol-
lows.

1. Press ▲ or ▼ to select Change Paper, press the OK button, and re-
move the paper.
 (See "Removing Sheets.") →P.817

2. Switch to paper A4/Letter (vertical) or larger.
 (See "Loading and Printing on Sheets.") →P.9
The printer will resume printing.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

Error Message > Messages regarding printing or adjustment >

iPF6300S Cannot execute this command. Use other paper.
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Cannot calibrate.

Cause Corrective Action

The paper for printing a test pattern is soiled.
Otherwise, you have loaded colored paper.

Press the OK button to clear the error.
Load unused paper compatible with color calibration.
(See Paper Reference Guide .)

The test pattern was printed too faintly. Press the OK button to clear the error.
Take steps to remedy faint printing.
 (See "Printing is faint.") →P.1026

Direct sunlight or strong lighting may be shin-
ing on the printer and causing the sensor to
malfunction.

Press the OK button to clear the error.
Take steps to ensure the printer is not used when exposed to direct
sunlight or strong lighting.

Excessive temperature or humidity.

Cause Corrective Action

The temperature or humidity where
the printer is installed is out of the
acceptable range for operation.

Press ▲ or ▼ to select Stop, and then press the OK button to stop printing.
Use the printer under suitable environmental conditions. Also note that various
environmental conditions are recommended for various types of paper. For de-
tails on the recommended environmental conditions, see the Paper Reference
Guide.
(See Paper Reference Guide .)

Press ▲ or ▼ to select Continue, and then press the OK button to continue
with color calibration. However, note that correct adjustment may not be possi-
ble.

Please execute calibration.

Cause Corrective Action

There is not even one color calibration execution result.
This is displayed when paper is loaded in the printer and "Set Exec.
Guide" is set to On on the Control Panel menu.

Execute color calibration.
 (See "Using Color Calibration for Color
Adjustment.") →P.844

Set "Set Exec. Guide" to Off on the Con-
trol Panel menu.
 (See "Menu Structure.") →P.904

Please calibrate using above paper.

Cause Corrective Action

It has become the time for prompting the execution of color calibration.
This is displayed when paper is loaded in the printer and "Set Exec. Guide"
is set to On on the Control Panel menu.

Execute color calibration.
 (See "Using Color Calibration for Col-
or Adjustment.") →P.844

Set "Set Exec. Guide" to Off on the
Control Panel menu.
 (See "Menu Structure.") →P.904

Error Message > Messages regarding printing or adjustment >

Cannot calibrate. iPF6300S
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Before borderless printing, move the blue platen switch.

Cause Corrective Action

The blue Switch on the platen was set to the side
opposite ● when a borderless print job was re-
ceived.

Before borderless printing, set the blue Switch on the platen to
the ● side.
 (See "Setting the Blue Switch on the Platen.") →P.1033

Blue platen switch is dirty.

Cause Corrective Action

The blue Switch on the platen is dirty. Open the Top Cover and clean the blue Switch on the platen.
 (See "Cleaning Inside the Top Cover.") →P.998

Move the blue platen switch No.xx to the right. (xx represents a number)

Cause Corrective Action

The printer has detected that the blue Switch on the
platen needed in maintenance during printing is set
away from the ● mark.

Set blue platen Switch of the indicated number toward the ●
side.
 (See "Setting the Blue Switch on the Platen.") →P.1033

Cannot adjust paper feed.

Cause Corrective Action

The Printhead nozzles are clogged. Execute Adj. Quality again, as follows.

1. Press the OK button to clear the error.

2. Print a test pattern to check the nozzles.
 (See "Checking for Nozzle Clogging.") →P.980

3. Clean the Printhead if the nozzles are clogged.
 (See "Cleaning the Printhead.") →P.981

4. Execute Adj. Quality again.
 (See "Automatic Banding Adjustment (Adj. Quality).") →P.834

Highly transparent film is loaded
that cannot be used for automatic
feed amount adjustment.

Press the OK button to clear the error, and then adjust the feed amount manually.
 (See "Manual Banding Adjustment (Adj. Quality).") →P.836

Check printed document.

Cause Corrective Action

The Printhead nozzles are becoming clogged. If printing is faint, clean the Printhead.
 (See "Cleaning the Printhead.") →P.981

Error Message > Messages regarding printing or adjustment >

iPF6300S Before borderless printing, move the blue platen switch.
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Messages regarding printheads
Cannot adjust printhead. ............................................................................................................................... 1068

 

PHeads: wrong pos. ..................................................................................................................................... 1068
Wrong x printhead. (x is L, R, or not displayed) ............................................................................................ 1068
x printhead error (x is L, R, or not displayed) ................................................................................................ 1069
No x printhead (x is L, R, or not displayed) ................................................................................................... 1069
Execute printhead cleaning. ......................................................................................................................... 1069

Cannot adjust printhead.

Cause Corrective Action

The Printhead nozzles
are clogged.

Execute Head Posi. Adj. again, as follows.

1. Press the OK button to clear the error.

2. Print a test pattern to check the nozzles.
 (See "Checking for Nozzle Clogging.") →P.980

3. Clean the Printhead if the nozzles are clogged.
 (See "Cleaning the Printhead.") →P.981

4. Execute Head Posi. Adj. again.
 (See "Automatic Adjustment to Straighten Lines and Colors (Head Posi. Adj.).")
→P.827

The Printhead cannot
be aligned; highly
transparent film is
loaded.

Press the OK button to clear the error.
We recommend using a type of paper that you often use, other than film, for Printhead adjust-
ment.
 (See "Automatic Adjustment to Straighten Lines and Colors (Head Posi. Adj.).")
→P.827

PHeads: wrong pos.

Cause Corrective Action

The printheads are installed in the
wrong positions.

Open the Top Cover and switch the Printhead used once in the right side to the
right side. Switch the Printhead used once in the left side to the left side.

Wrong x printhead. (x is L, R, or not displayed)

Cause Corrective Action

An incompatible
Printhead has been in-
stalled.

Open the Top Cover. Replace the Printhead L with a new one if Printhead L is displayed and
the Printhead R if Printhead R is displayed. If neither left or right is indicated, replace both
Printhead L and Printhead R with new ones.
 (See "Replacing the Printhead.") →P.982

Error Message > Messages regarding printheads >

Cannot adjust printhead. iPF6300S
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x printhead error (x is L, R, or not displayed)

Cause Corrective Action

There is a prob-
lem with the
Printhead.

Follow these steps to replace the Printhead.

1. Open the Top Cover.

2. Replace the Printhead L with a new one if Printhead L is displayed and the Printhead R if
Printhead R is displayed. If neither left or right is indicated, replace both Printhead L and Print-
head R with new ones.
 (See "Replacing the Printhead.") →P.982

Follow these steps to replace the Printhead.

1. Turn off the printer, wait a while, and then turn it on again.

2. Open the Top Cover.

3. Replace the left printhead with a new one if Printhead L is displayed and the right one if Print-
head R is displayed. If neither left or right is indicated, replace both printheads.
 (See "Replacing the Printhead.") →P.982

No x printhead (x is L, R, or not displayed)

Cause Corrective Action

No Printhead is
installed.

Install the Printhead L if Printhead L is displayed and the Printhead R if Printhead R is dis-
played. If neither left or right is indicated, install both Printhead L and Printhead R.
 (See "Replacing the Printhead.") →P.982

Execute printhead cleaning.

Cause Corrective Action

The Printhead noz-
zles are clogged.

Follow these steps to clean the Printhead.

1. Stop printing by pressing ▲ or ▼ to select Stop Printing.

2. Clean the Printhead.
 (See "Cleaning the Printhead.") →P.981

If the message is still displayed when printing, replace the Printhead.
 (See "Replacing the Printhead.") →P.982

Press ▲ or ▼ to select Print, and then press the OK button to resume printing. However, note
that this error may affect the printing quality.

If OK is shown on the Display Screen, clean the Printhead.

1. Press the OK button on the Control Panel to stop printing.

2. Clean the Printhead.
 (See "Cleaning the Printhead.") →P.981

If the message is still displayed when printing, replace the Printhead.
 (See "Replacing the Printhead.") →P.982

Error Message > Messages regarding printheads >

iPF6300S x printhead error (x is L, R, or not displayed)
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Messages regarding the maintenance cartridge
No maintenance cartridge. ............................................................................................................................ 1070
Wrong maintenance cartridge. ...................................................................................................................... 1070

 

Maint. cart. The level is low ........................................................................................................................... 1070
No Maintenance Cartridge capacity. ............................................................................................................. 1070
Maintenance cartridge full. ........................................................................................................................... 1070
Maintenance cartridge problem. ................................................................................................................... 1071

No maintenance cartridge.

Cause Corrective Action

The Maintenance Cartridge is not installed. Install the Maintenance Cartridge.
 (See "Replacing the Maintenance Cartridge.") →P.990

Wrong maintenance cartridge.

Cause Corrective Action

A Maintenance Cartridge for a different model of printer
is installed.

Replace it with the Maintenance Cartridge for your partic-
ular model.

Maint. cart. The level is low

Cause Corrective Action

The Maintenance Cartridge is
almost full.

You can continue to print, but prepare a new Maintenance Cartridge to use when the
message for replacement is displayed.

No Maintenance Cartridge capacity.

Cause Corrective Action

The Maintenance Cartridge cannot absorb
enough ink for Printhead cleaning or other
operation.

After confirming that the printer has stopped operating, replace the
Maintenance Cartridge.
 (See "Replacing the Maintenance Cartridge.") →P.990

Maintenance cartridge full.

Cause Corrective Action

The Maintenance Car-
tridge is full.

After confirming that the printer has stopped operating, replace the Maintenance Cartridge.
 (See "Replacing the Maintenance Cartridge.") →P.990

Error Message > Messages regarding the maintenance cartridge >

No maintenance cartridge. iPF6300S
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Maintenance cartridge problem.

Cause Corrective Action

An incompatible or used Maintenance
Cartridge has been installed.

Install an unused Maintenance Cartridge specified for use with the printer.
 (See "Replacing the Maintenance Cartridge.") →P.990

Error Message > Messages regarding the maintenance cartridge >

iPF6300S Maintenance cartridge problem.
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Messages regarding the hard disk
Hard disk error. ............................................................................................................................................. 1072
File read error. .............................................................................................................................................. 1072

 

The mail box is full. ....................................................................................................................................... 1072
Mail box full. Now printing without saving data. ............................................................................................ 1072
Mail box nearly full. ....................................................................................................................................... 1073

 

Maximum jobs stored. .................................................................................................................................. 1073
Mail box full. Delete unwanted data .............................................................................................................. 1073

Hard disk error.

Cause Corrective Action

The format of the printer's
hard disk is invalid.

Press the OK button to start reformatting the hard disk. When formatting is finished,
data on the printer hard disk is erased and the printer automatically restarts.

File read error.

Cause Corrective Action

Files on the printer's hard disk have be-
come corrupted.

Restart the printer. Only the corrupted files will be deleted, and the printer
will restart.

The mail box is full.

Cause Corrective Action

There is no more space on the printer's
hard disk.

Press the Stop button and stop printing.

Delete print jobs from the queue.
 (See "Managing the Job Queue (Deleting or Preempting Other
Jobs).") →P.724

Delete unneeded jobs stored in personal boxes.
 (See "Deleting Saved Jobs.") →P.736

Mail box full. Now printing without saving data.

Cause Corrective Action

No more space is available on the printer's hard disk, so jobs are now prin-
ted without saving them. (Print jobs can no longer be saved on the hard
disk.)

After printing, this message is cleared.

Delete unneeded jobs stored in personal
boxes.
 (See "Deleting Saved Jobs.") →P.736

Error Message > Messages regarding the hard disk >

Hard disk error. iPF6300S
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Mail box nearly full.

Cause Corrective Action

There is now less than 1 GB available for personal boxes on the
printer hard disk.

Delete unneeded jobs stored in Personal Boxes.
 (See "Deleting Saved Jobs.") →P.736

Maximum jobs stored.

Cause Corrective Action

100 jobs are stored in the personal box. Delete unneeded jobs stored in personal boxes.
 (See "Deleting Saved Jobs.") →P.736

Mail box full. Delete unwanted data

Cause Corrective Action

100 jobs are stored in the Personal Box. Press the Stop button and stop printing.

Delete print jobs from the queue.
 (See "Managing the Job Queue (Deleting or Preempting Other Jobs).")
→P.724

Delete unneeded jobs stored in personal boxes.
 (See "Deleting Saved Jobs.") →P.736

Error Message > Messages regarding the hard disk >

iPF6300S Mail box nearly full.
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Other Messages
GARO Wxxxx (x represents a number) ......................................................................................................... 1074
ERROR Exxx-xxxx (x represents a letter or number) .................................................................................... 1074
Hardware error. xxxxxxxx-xxxx (x represents a letter or number) ................................................................. 1074

 

Prepare for parts replacement. ...................................................................................................................... 1075
Parts replacement time has passed. ............................................................................................................. 1075

 

Unknown file. ................................................................................................................................................ 1075
Calibration There is a problem with the multi-sensor. .................................................................................. 1075
Multi-sensor error .......................................................................................................................................... 1076

 

GARO Wxxxx (x represents a number)

Cause Corrective Action

There is a problem with the print job. Try printing again, using the correct printer driver.

It is also possible to continue printing in this state.
However, you may not be able to obtain the desired printing results.

ERROR Exxx-xxxx (x represents a letter or number)

Cause Corrective Action

An error requiring service may have occurred. Write down the error code and message, turn off the printer, and con-
tact your Canon dealer for assistance.

Hardware error. xxxxxxxx-xxxx (x represents a letter or number)

Cause Corrective Action

The last portion of roll paper was used during a print job.
The paper was not advanced because the trailing edge is ta-
ped to the roll.

Turn off the printer and remove the roll from the printer
before restoring power.

Fastening tape or the Belt Stopper has not been removed in-
side the Top Cover.

Turn off the printer, open the Top Cover and remove
the tape or the Belt Stopper before restoring power.

Error Message > Other Messages >

GARO Wxxxx (x represents a number) iPF6300S
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Cause Corrective Action

An error requiring service may have occurred. Turn off the printer and wait at least three seconds be-
fore restoring the power.
If the message is displayed again, write down the error
code and message, turn off the printer, and contact your
Canon dealer for assistance.

Prepare for parts replacement.

Cause Corrective Action

It is almost time to replace consuma-
bles for which service is required.

If "Parts replacement time has passed." is displayed, you can continue to
use the printer for some time.
Contact your Canon dealer for assistance.

Parts replacement time has passed.

Cause Corrective Action

It is past the recommended time to replace consumables for which service
is required.

Contact your Canon dealer for assistance.

Unknown file.

Cause Corrective Action

Data sent to keep the printer up to date (such as
paper information) is in the wrong format.

Check the data. Turn off the printer and wait a while before restor-
ing power, and then resend the data.

You have uploaded firmware for a different
model.

Check the firmware version. Turn off the printer and wait a while
before restoring power, and then resend the firmware.

If the message is displayed again, contact your Canon dealer for as-
sistance.

Calibration There is a problem with the multi-sensor.

Cause Corrective Action

The performance of a sensor inside the printer
may be impaired.

Press the OK button and cancel calibration. Contact your Canon
dealer for assistance.

Error Message > Other Messages >

iPF6300S Prepare for parts replacement.
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Multi-sensor error

Cause Corrective Action

Direct sunlight or strong lighting may be shin-
ing on the printer and causing the sensor to
malfunction.

Take steps to ensure the printer is not used when exposed to direct
sunlight or strong lighting.

The performance of a sensor inside the printer
may be impaired.

Turn off the printer and wait at least three seconds before restoring
the power.
If the message is displayed again, contact your Canon dealer for as-
sistance.

Error Message > Other Messages >

Multi-sensor error iPF6300S
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Printer Specifications
Specifications ................................................................................................................................................ 1078
Print Area ....................................................................................................................................................... 1081

Specifications

Important
• The following values may vary depending on the operating environment.

Printer

Power supply 100–120 V AC (50/60 Hz), 220–240 V
AC (50/60 Hz)

Power consumption During operation 100 W max.

Sleep mode 100–120 V: 6 W max.

220–240 V: 7 W max.

Off 1 W max. (*1 →P.1078 )

Operating noise (*2 →P.1078 ) During operation (sound pressure lev-
el/LWAd)

Approx. 47 dB (A) (6.4 bels)

Standby 35 dB (A) max.

Operating environment Temperature 15–30°C (59–86°F)

Humidity 10–80%, non-condensing

Dimensions (W × D × H) Printer only 1,177×670×344 mm (46.3×26.4×13.5
in)

With stand 1,177×870×991 mm (46.3×34.3×39.0
in)

Weight
(Not including printheads or ink
tanks)

Printer only 51 kg (112.4 lb)

With stand 66 kg (145.5 lb)

Space for installation
(*3 →P.1078 )

Printer only 1,477×1,770×644 mm (58.1×69.7×25.4
in)

With stand 1,477×1,970×1,291 mm
(58.1×77.6×50.8 in)

Applicable standards International Energy Star, Law on Promoting Green Purchasing (Japan), Eco
Mark, GPN, EU RoHS, The Eco Declaration (Europe), WEEE, U.S. presidential
directives, Chinese RoHS, ErP Lot6 (Europe)

*1: The printer uses a trace amount of power even when turned off. To stop all power consumption, turn off the
printer and unplug the power cord.

*2: Calculation based on ISO 7779. Operating conditions: On the Main sheet of the printer driver, Media Type >
Coated Paper, Advanced Settings > Print Priority > Image, and Print Quality > Standard.

*3: Normally, you will need to ensure an unobstructed space of 800 mm (31.5 in) in front of the printer, 300 mm
(11.8 in) behind, 150 mm (5.9 in) on both sides, and 300 mm (11.8 in) above the printer. Only when printing
from the Front Paper Feed Slot, leave 1,300 mm (51.2 in) of unobstructed space in front of the printer and 700
mm (27.6 in) behind it.

Specifications > Printer Specifications >
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Printing performance

Print method Bubblejet

Maximum resolution 2400 dpi horizontally (*1 →P.1079 ) × 1200 dpi vertically

Printhead PF-05 ×2

Number of nozzles C,PC,PM,GY : 2560 nozzles X 2
BK,MBK,M,Y: 2560 nozzles X 1

*1: Prints with a minimum 1/2400 inch dot pitch between ink droplets.

Interface

  Hi-Speed USB Format Internal port

Mode Full-speed (12 Mbps), high-speed (480 Mbps),
bulk transfer

Connector Series B (4-pin)

  Gigabit Ethernet Format Internal port

Specification IEEE 802.3 10Base-T, IEEE 802.3u 100Base-
TX/Auto-Negotiation, IEEE
802.3ab1000Base-T/Auto-Negotiation, IEEE
802.3x Full Duplex

Ink

Ink Tank BK Ink Tank ( Black Ink ) Pigment ink PFI-105BK

MBK Ink Tank ( Matte
Black Ink )

Pigment ink PFI-105MBK

C Ink Tank ( Cyan Ink ) Pigment ink PFI-105C

M Ink Tank ( Magenta
Ink )

Pigment ink PFI-105M

Y Ink Tank ( Yellow Ink ) Pigment ink PFI-105Y

PC Ink Tank ( Photo Cyan
Ink )

Pigment ink PFI-105PC

PM Ink Tank ( Photo Ma-
genta Ink )

Pigment ink PFI-105PM

GY Ink Tank ( Gray Ink ) Pigment ink PFI-105GY

Capacity 130 ml (4.4 fl oz) per color
(*1 →P.1079 )

*1: The provided Starter Ink Tanks contain 90 ml (3.0 fl oz) each.

Paper
For information on the types of paper the printer supports, refer to the Paper Reference Guide. (See Paper Reference
Guide .)

Paper width Rolls 203.2–610 mm (8.0–24.0 in)

Sheets Top Paper Feed Slot 203.2–610 mm (8.0–24.0 in)

Specifications > Printer Specifications >
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Paper width Sheets Front Paper Feed
Slot(*4 →P.1081 )

250–610 mm (9.9–24.0 in)

Minimum paper
length

Rolls 203.2 mm (8.0 in)

Sheets Top Paper Feed Slot 279.4 mm (11.0 in)

Front Paper Feed Slot 350 mm (13.8 in)

Maximum printable
length
(*1 →P.1081 )

Rolls 18 m (19.7 yd)

Sheets Top Paper Feed Slot 1,600 mm (63.0 in)

Front Paper Feed Slot 914 mm (36.0 in)

Thickness Rolls 0.07–0.8 mm (0.0028–0.031 in)

Sheets Top Paper Feed Slot 0.07–0.8 mm (0.0028–0.031 in)

Front Paper Feed Slot 0.5–1.5 mm (0.020–0.059 in)

Roll maximum outer diameter 150 mm (6 in) or shorter

Supported paper core inner diameter 2 inches / 3 inches

Paper Size Rolls 8-in. Roll (203.2mm), 10-in. Roll (254.0mm),
JIS B4 Roll (257.0mm), ISO A3/A4 Roll
(297.0mm), 300mm Roll (300.0mm), A3+
Roll (329.0mm), 14-in. Roll (355.6mm), 16-
in. Roll (406.4mm), ISO A2/A3 Roll
(420.0mm), 17-in. Roll (431.8mm), JIS B2/
B3 Roll (515.0mm), ISO A1/A2 Roll
(594.0mm), 24-in. Roll (609.6mm)

Sheets Top Paper Feed Slot ISO A1, ISO A2, ISO A2+, ISO A3, ISO
A3+, ISO A4, ISO B2, ISO B3, ISO B4, JIS
B2, JIS B3, JIS B4, 22"x34"(ANSI D),
17"x22"(ANSI C), 11"x17" (Ledger),
13"x19" (Super B), Letter (8.5"x11"), Legal
(8.5"x14"), 24"x36" (ARCH D), 18"x24"
(ARCH C), 12"x18" (ARCH B), 9"x12"
(ARCH A), DIN C2, DIN C3, DIN C4,
20"x24", 18"x22", 14"x17", 12"x16",
10"x12", 10"x15", US Photo 16"x20", Post-
er 20"x30", 13"x22", Poster 300x900mm

Front Paper Feed Slot ISO A1, ISO A2, ISO B2, JIS B2,
22"x34"(ANSI D), 17"x22"(ANSI C),
24"x36" (ARCH D), 18"x24" (ARCH C),
DIN C2, 20"x24", 18"x22", Poster
20"x30", 13"x22"

Print area Normal size Printable area

• Sheets ( Top Paper Feed Slot )
3 mm (0.12 in) from the top, 3 or 23 mm
(0.12 or 0.91 in) from the bottom, and 3
mm (0.12 in) from the left and right sides
(The bottom margin varies depending on
the type of paper.)

• Sheets ( Front Paper Feed Slot )
3 mm (0.12 in) from the top, 23 mm (0.91
in) from the bottom, and 3 mm (0.12 in)
from the left and right sides

• Rolls
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Print area Normal size 3 mm (0.12 in) from each side

For information on the recommended print
area, see "Print Area." →P.1081

Borderless printing (*2 →P.1081 ) Printable area (rolls)
0 mm from the top, 0 mm from the bottom,
and 0 mm from the left and right sides

Supported width for borderless printing 10-in. Roll (254.0mm), JIS B4 Roll
(257.0mm), 14-in. Roll (355.6mm), 16-in.
Roll (406.4mm), ISO A2/A3 Roll (420.0mm)
(*3 →P.1081 ), 17-in. Roll (431.8mm), JIS
B2/B3 Roll (515.0mm), ISO A1/A2 Roll
(594.0mm) (*3 →P.1081 ), 24-in. Roll
(609.6mm)

*1: Varies depending on the operating system or application.
*2: Printing may not be possible in some cases, depending on the type and size of paper.
*3: Borderless printing requires the Spacer for Borderless Printing.
*4:  POP Board, etc. for heavyweight paper.

Hard Disk

Hard disk capacity 160 GB

Personal mail boxes (Permanent stor-
age area)

92 GB

Print job storage capacity Common Box 100 jobs

Personal Boxes 100 jobs

Print Area
A margin required by the printer is added with respect to the size of paper loaded in the printer. Except in borderless print-
ing, the actual printing area corresponds to the paper size minus the space for this margin.

 
Printable Area Recommended Print Area

Top Edge Bottom Edge Sides Top Edge Bottom
Edge Sides

Sheets Top Pa-
per Feed
Slot

3 mm (0.12
in)

3 or 23 mm
(0.12 or 0.91
in)

3 mm (0.12
in)

20 mm
(0.79 in)

23 mm (0.91
in)

5 mm (0.20
in)

Front Pa-
per Feed
Slot

3 mm (0.12
in)

23 mm (0.91
in)

3 mm (0.12
in)

Rolls 0 or 3 mm (0
or 0.12 in)

0 or 3 mm (0
or 0.12 in)

0 or 3 mm (0
or 0.12 in)

20 mm
(0.79 in)

5 mm (0.20
in)

5 mm (0.20
in)
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Sheets

• Printable Area
Printing from the Top Paper Feed Slot requires a margin of 3 mm (0.12 in) on top, 3 mm (0.12 in) or 23 mm (0.91 in)
on bottom, and 3 mm (0.12 in) on the left and right sides. Some types of paper require a bottom margin of 23 mm (0.91
in). For more information, see the Paper Reference Guide.  (See "Types of Paper.") →P.773

Printing from the Front Paper Feed Slot requires a margin of 3 mm (0.12 in) on top, 23 mm (0.91 in) on bottom, and 3
mm (0.12 in) on the left and right sides.

• Recommended Print Area
A margin of 20 mm (0.79 in) on top, 23 mm (0.91 in) on bottom, and 5 mm (0.20 in) on left and right sides is required.

Important
• Choosing a bottom margin of 3 mm (0.12 in) may distort images by the bottom edge.

In this case, select Paper Source > Manual and specify a bottom margin of 23 mm (0.91 in).

Note
• Printable area: The area that can be printed.
• Guaranteed Print Area: We recommend printing within this area.
• To print so that your original matches the print area exactly, use an oversized paper size that includes the

required margin.  (See "Printing on Oversized Paper.") →P.93

• When printing from the Top Paper Feed Slot, you can choose a bottom margin of either 3 mm (0.12 in) or 23
mm (0.91 in).
Specifying Paper Source > Manual in the printer driver leaves a bottom margin of 23 mm (0.91 in). On the
other hand, choosing Manual (3mm margins) in Paper Source sets the bottom margin at 3 mm (0.12 in),
which provides a larger area for printing.
However, Manual (3mm margins) is not available with the following paper.

• Fine Art Photo Paper
• Fine Art Heavyweight Photo Paper
• Fine Art Textured Paper

• Types of paper are subject to change.
For details on types of paper, see the Paper Reference Guide.  (See "Types of Paper.") →P.773
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Rolls

• Printable Area
A margin of 3 mm (0.12 in) on all sides is required. During borderless printing, the margin on all sides is 0 mm. For
information on paper compatible with borderless printing, see the Paper Reference Guide.  (See "Types of Paper.")
→P.773

• Recommended Print Area
A margin of 20 mm (0.79 in) on top, 5 mm (0.20 in) on bottom, and 5 mm (0.20 in) on left and right sides is required.

Note
• Printable area: The area that can be printed.
• Guaranteed Print Area: We recommend printing within this area.
• To print so that your original matches the print area exactly, use an oversized paper size that includes the

required margin.  (See "Printing on Oversized Paper.") →P.93
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How to use this manual
About This User Manual ................................................................................................................................ 1085
Viewing Videos of Explanations .................................................................................................................... 1086
Searching Topics ........................................................................................................................................... 1086
HTML Version of the Manual for Printing ...................................................................................................... 1089

About This User Manual

• Symbols
The following symbols are used in this user manual to indicate safety information and explanations on restrictions or
precautions in use.

Warning Indicates warning items for which operating error poses a risk of death or serious injury. To en-
sure safe use, always follow these warnings.

Caution Indicates caution items for which operating error poses a risk of injury. To ensure safe use, al-
ways follow these cautions.

Important Indicates important information and restrictions that definitely are to be followed during opera-
tion. Be sure to read this information to prevent troubles, malfunctions, or damage to equipment
or property by operating errors.

Note Indicates helpful reference information and supplemental information on particular topics.

• Button names and user interface elements
Key and button names on the control panel and user interface elements in software (such as menus and buttons) are
indicated as follows in this user manual.

Control panel buttons Example: Press the OK button.

Control panel messages Example: Head Cleaning is displayed.

Software interface items
(menus and buttons)

Example: Click OK.

Keyboard keys Example: Press the Tab key.

• Cross-reference
Other pages or manuals that provide related information are indicated as follows in this user manual.

Cross-reference in the same user manual Example: see "Turning the Printer On and Off." →P.3
Click the link to jump to the corresponding page.

Cross-reference in related manuals Example: See the Paper Reference Guide .

Other cross-reference Example: See the printer driver help.

• Figures and software screens

• Figures in this user manual may be different from the actual appearance of the printer in some cases.
• Screens depicted in this user manual for the printer driver or other software may be different from the actual

screens because of subsequent updates.
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• Trademarks

• Canon, the Canon logo, and imagePROGRAF are trademarks or registered trademarks of Canon Inc.
• Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and other coun-

tries.
• Macintosh is a registered trademark of Apple Inc. in the United States and other countries.
• Adobe RGB is a color space proposed by Adobe Systems Incorporated and a trademark of this company.
• Other company and product names are trademarks or registered trademarks of their respective owners.

• Copyright
© CANON INC. 2011

• Unauthorized reproduction of this user manual in whole or part is prohibited.

• May we request
Thank you for understanding the following points.

• The information in this user manual is subject to change without notice.
• We strive to ensure accuracy of information in this user manual, but if you notice errors or omissions, please con-

tact us.

Viewing Videos of Explanations
To view videos related to topic pages, click the View Video button. The video will play in a separate window. This way,
you can learn by watching demonstrations of the actual procedures.

Video Requirements: In Windows, Adobe Flash Player must be installed to view the videos.
If it is not installed, download it by clicking the following URL.
→ http://www.adobe.com/products/flashplayer/

Note that this URL is subject to change. If you cannot access this URL, download Adobe Flash Player by visiting the main
Adobe website and navigating to the appropriate page.

Searching Topics
You can find information in topics of this User Manual by searching for relevant terms.

1. Enter a term and click the Search button.

Note
• To search for multiple terms at once, enter a space between each term.
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Search results are listed at left.

2. Click a topic you want to read.
The terms you searched for will be highlighted in the topic.
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To review multiple topics at once, select the check box of desired topics and click the Apply button.
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HTML Version of the Manual for Printing
You can select a group of topics in the table of contents or individual topics in this manual for printing.
The following procedure describes how to do this, using the information in Basic Printing Workflow as an example.

Printing a group of topics in the manual
When you access printable HTML versions of the content from section titles in the table of contents, you can specify a
group of topics to print.

1. Click a section title in the table of contents. Here, Basic Printing Workflow is used as an example.

2. Click Access to the HTML for printing in the title area.
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The topics in Basic Printing Workflow are displayed together in HTML format, ready for printing.

3. Clear the sections you will not print and click the Apply button.
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Printing a group of individual topics in the manual
When you access printable HTML versions from subtitles in the table of contents, you can specify a group of topics to print.

1. Click a section title in the table of contents. Here, Basic Printing Workflow is used as an example.

2. Under Basic Printing Workflow, click Printing Procedure.

Appendix > How to use this manual >

iPF6300S HTML Version of the Manual for Printing

15

1091



3. Click Access to the HTML for printing in the title area.

The topics in Printing Procedure are displayed together in HTML format, ready for printing.
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4. Clear the topics you will not print and click the Apply button.

Printing selected topics
Print selected topics as follows.

1. Access the printing dialog box as follows, depending on your computer's operating system.

• Windows
In Windows, right-click anywhere in the explanation area except on a figure or a link.In the shortcut menu,
click Print to display the Print dialog box.

Appendix > How to use this manual >

iPF6300S HTML Version of the Manual for Printing

15

1093



• Macintosh
On a Macintosh computer, click anywhere in the explanation area except on a figure or a link while holding the
Ctrl key. In the shortcut menu, click Print Frame to display the Print dialog box.

2. Specify conditions as needed, and then click Print (Windows) or Print (Macintosh).

• Windows
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• Macintosh

Note
• To print only individual topics that are displayed, use this method.
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Disposal of the product
WEEE Directive ............................................................................................................................................. 1097
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